1010data Insights Platform
Legacy Interface User's Guide
User Basics............................................................................................................................................... 8
Log in to 1010data................................................................................................................................. 8
Reset your password............................................................................................................................. 8
Environments........................................................................................................................................ 9
Sessions................................................................................................................................................ 9
Versions............................................................................................................................................... 10
Start Page........................................................................................................................................... 11
Folders and Tables Browser................................................................................................................ 12
Folders and Tables Toolbar.................................................................................................................. 16
Upload a table (Simple Upload)........................................................................................................... 17
Upload a table (Advanced Upload)....................................................................................................... 18
Add a subfolder.................................................................................................................................. 23
Merge tables..................................................................................................................................... 24
Reorder contents................................................................................................................................. 24
Move items....................................................................................................................................... 25
Delete items....................................................................................................................................... 25
Search for items................................................................................................................................. 25
Go to items....................................................................................................................................... 27
My Data and Other People's Data........................................................................................................ 28
View information about an item......................................................................................................... 28
Edit information about an item.......................................................................................................... 29
Share folders, tables, or queries......................................................................................................... 30
Add favorites..................................................................................................................................... 30
Remove favorites............................................................................................................................... 31
Workspace......................................................................................................................................... 31
Clear the cache................................................................................................................................. 32
Help.................................................................................................................................................. 33
Submit a support request.................................................................................................................... 34
Keyboard Shortcuts............................................................................................................................ 34
Log out of 1010data.............................................................................................................................. 36

Tables and Worksheets.......................................................................................................................... 37
Tables and Worksheets Toolbar......................................................................................................... 42
Go back one step................................................................................................................................. 42
Go forward one step............................................................................................................................ 43
Move tab to new window..................................................................................................................... 43
Clone a tab...................................................................................................................................... 43
Scroll Bars......................................................................................................................................... 43
View a table...................................................................................................................................... 46
Show table information....................................................................................................................... 46
View multiple rows at a time............................................................................................................... 46
View one row at a time........................................................................................................................ 47
Save as a new table............................................................................................................................ 47
Save and replace table......................................................................................................................... 48
Append results to an existing table.................................................................................................... 48
Merge tables..................................................................................................................................... 49
Upload a table (Simple Upload)........................................................................................................... 50
Upload a table (Advanced Upload)..................................................................................................... 51
Close a worksheet............................................................................................................................... 55
Rows and Columns................................................................................................................. 57
  Rows............................................................................................................................. 57
  Select rows.................................................................................................................. 57
  Select rows (shortcut).................................................................................................. 59
  Select rows (advanced).............................................................................................. 59
  Go to a specific row..................................................................................................... 60
  Find rows..................................................................................................................... 61
  Find rows (shortcut).................................................................................................... 61
  Find rows (advanced).................................................................................................. 62
  Sort the rows of a table.............................................................................................. 63
Columns.................................................................................................................................. 63
  Computed Columns...................................................................................................... 64
    Create a computed column....................................................................................... 65
  Fixed Columns.............................................................................................................. 66
  Show information about one column............................................................................ 70
  Show information about all columns........................................................................... 71
  Determine the data type of a column.......................................................................... 72
  Go to a specific column.............................................................................................. 73
  Rearrange columns.................................................................................................... 73
  Hide columns.............................................................................................................. 74

Summarizations and Tabulations.......................................................................................... 75
  Perform a quick summary............................................................................................ 76
    Types of Summarizations for Quick Summaries....................................................... 77
  Perform a tabulation.................................................................................................... 79
    Types of Summarizations for Tabulations............................................................... 81
  Perform a cross tabulation......................................................................................... 85
    Types of Summarizations for Cross Tabulations..................................................... 87

Linking Tables and Worksheets............................................................................................ 94
  How Rows Are Matched Up......................................................................................... 94
  Linking Columns with Different Types....................................................................... 96
  As-of Links.................................................................................................................. 101
  Link in another table.................................................................................................. 103
  Link in another worksheet......................................................................................... 105
  Link and select rows................................................................................................. 106

Actions and Queries.......................................................................................................... 109
  Edit actions as XML.................................................................................................... 109
  Edit actions using the GUI......................................................................................... 109
  Undo the last action................................................................................................... 112
  Undo all actions......................................................................................................... 112
  Save actions as a text file.......................................................................................... 112
  Writing Efficient Queries........................................................................................... 112

Quick Queries.................................................................................................................. 117
  Save as a Quick Query.............................................................................................. 117
  Input Types.................................................................................................................. 118
    Action: Select.......................................................................................................... 119
    Action: Sort.............................................................................................................. 122
<table>
<thead>
<tr>
<th>QuickQuery Editor</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action: New Column</td>
<td>123</td>
</tr>
<tr>
<td>Action: Link</td>
<td>123</td>
</tr>
<tr>
<td>Action: Tabulate</td>
<td>124</td>
</tr>
<tr>
<td>Action: Cross Tabulate</td>
<td>126</td>
</tr>
<tr>
<td>Action: Quick Summary</td>
<td>128</td>
</tr>
<tr>
<td>Run a Quick Query</td>
<td>129</td>
</tr>
<tr>
<td>Edit a Quick Query</td>
<td>129</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Query Scheduler</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Jobs</td>
<td>131</td>
</tr>
<tr>
<td>Other People’s Jobs (admin only)</td>
<td>132</td>
</tr>
<tr>
<td>Job Information</td>
<td>132</td>
</tr>
<tr>
<td>Run History</td>
<td>136</td>
</tr>
<tr>
<td>Create a job</td>
<td>136</td>
</tr>
<tr>
<td>Find a job</td>
<td>137</td>
</tr>
<tr>
<td>Edit a job</td>
<td>138</td>
</tr>
<tr>
<td>Delete a job</td>
<td>138</td>
</tr>
<tr>
<td>Run a job</td>
<td>139</td>
</tr>
<tr>
<td>Download a completed job report</td>
<td>139</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>QuickApp Editor</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget Builder</td>
<td>141</td>
</tr>
<tr>
<td>Properties</td>
<td>142</td>
</tr>
<tr>
<td>Class properties</td>
<td>143</td>
</tr>
<tr>
<td>View the examples in the QuickApp Editor</td>
<td>145</td>
</tr>
<tr>
<td>Data grid</td>
<td>153</td>
</tr>
<tr>
<td>Table</td>
<td>162</td>
</tr>
<tr>
<td>Graphics</td>
<td>163</td>
</tr>
<tr>
<td>Input field</td>
<td>168</td>
</tr>
<tr>
<td>Dropdown menu</td>
<td>172</td>
</tr>
<tr>
<td>Radio buttons</td>
<td>176</td>
</tr>
<tr>
<td>List</td>
<td>179</td>
</tr>
<tr>
<td>Sorter</td>
<td>183</td>
</tr>
<tr>
<td>Checkbox</td>
<td>187</td>
</tr>
<tr>
<td>Checklist</td>
<td>188</td>
</tr>
<tr>
<td>Slider</td>
<td>191</td>
</tr>
<tr>
<td>Button</td>
<td>194</td>
</tr>
<tr>
<td>Link</td>
<td>200</td>
</tr>
<tr>
<td>Date picker</td>
<td>202</td>
</tr>
<tr>
<td>Text</td>
<td>206</td>
</tr>
<tr>
<td>Image</td>
<td>208</td>
</tr>
<tr>
<td>Text/XML entry</td>
<td>209</td>
</tr>
<tr>
<td>Color picker</td>
<td>212</td>
</tr>
<tr>
<td>Text style picker</td>
<td>217</td>
</tr>
<tr>
<td>Folder browser</td>
<td>218</td>
</tr>
<tr>
<td>Editable grid</td>
<td>222</td>
</tr>
<tr>
<td>General properties</td>
<td>225</td>
</tr>
<tr>
<td>Ad-hoc properties</td>
<td>227</td>
</tr>
<tr>
<td>Add an ad-hoc property</td>
<td>228</td>
</tr>
<tr>
<td>Delete an ad-hoc property</td>
<td>228</td>
</tr>
<tr>
<td>Preview</td>
<td>229</td>
</tr>
<tr>
<td>Query</td>
<td>229</td>
</tr>
<tr>
<td>Blocks</td>
<td>230</td>
</tr>
<tr>
<td>Worksheets</td>
<td>231</td>
</tr>
</tbody>
</table>
Charting........................................................................................................................................ 252
Chart Builder ................................................................................................................................ 254
Data Columns............................................................................................................................... 256
Chart Parameters .......................................................................................................................... 258
Chart Settings............................................................................................................................... 260
Reset chart parameters................................................................................................................. 264
Enable chart interactions................................................................................................................ 264
Customization Settings .................................................................................................................. 264
General......................................................................................................................................... 265
Title............................................................................................................................................. 266
Axes............................................................................................................................................. 266
Ticks.............................................................................................................................................. 270
Data Series.................................................................................................................................... 270
Grid................................................................................................................................................ 270
Legend.......................................................................................................................................... 271
Info............................................................................................................................................... 271
XML Graphics Specification.......................................................................................................... 272
Toggle Chart Builder panels.......................................................................................................... 272
Chart Types................................................................................................................................... 274
Create a chart based on chart type................................................................................................. 281
Change an existing chart.................................................................................................................. 282
Resize a chart................................................................................................................................. 282
Freeze a chart................................................................................................................................. 283
Clone a chart................................................................................................................................ 283
Create QuickApp graphics widget.................................................................................................. 283
Export a chart to PDF...................................................................................................................... 284
Save a chart.................................................................................................................................... 284

Uploading and downloading........................................................................................................ 286
Uploading data............................................................................................................................... 286
Supported file formats................................................................................................................... 286
Text file format.............................................................................................................................. 287
XML file format............................................................................................................................. 288
Upload a table (Simple Upload)..................................................................................................... 292
Upload a table (Advanced Upload).................................................................................................. 293
Prerequisites................................................................................................................................ 297
Transfer a file to your FTP account................................................................................................. 298
File Information.............................................................................................................................. 301
Table Information.......................................................................................................................... 304
Column Information....................................................................................................................... 305
Download Data............................................................................................................................ 310
Download to Microsoft Excel........................................................................................................ 311
Excel Considerations...................................................................................................................... 311
Download as a comma-separated text file..................................................................................... 312
Download as a tab-separated text file............................................................................................. 312

© 2017 1010data, Inc. All rights reserved.
Localization .......................................................................................................................... 377

Appendix A: Missing Values .......................................................................................... 378
  Automatic Handling of N/A Values .................................................................................. 379
  Manual Handling of Missing or Invalid Values ................................................................. 380

Glossary .............................................................................................................................. 383
User Basics


This is where you can find answers to many of the questions you may have while working with the legacy interface of the 1010data Insights Platform and its web-based interface, the Trillion-Row Spreadsheet. The 1010data Insights Platform Legacy Interface User's Guide covers many of the concepts and tasks that are helpful to the beginner and advanced user alike. If you don't see the information you're looking for here, let us know, and we'll do our best to add the topic in a future revision.

For details on the 1010data Insights Platform Macro Language as well as the complete library of Insight Platform functions, check out the 1010data Reference Manual.

Before we get started, check out this short video about what the Insights Platform does:

Now, let's get started! We'll begin at a logical point: how to log in to the platform.

Log in to 1010data

You must log in to 1010data in order to access and analyze your data.

To log in to 1010data:

1. From a web browser, enter www.1010data.com/main/login. This will take you directly to a login screen for the 1010data web interface.

   **Note:** This URL will log you in to the version of 1010data specified for your user account; if a version is not specified for your user account, the default version for the company associated with the account will be used.

   **Note:** Some 1010data clients have custom environments that have been provisioned separately from 1010data's primary environment (www2). If you do not successfully log into 1010data via the link, and you aren't sure which URL to use, contact the 1010data administrator at your organization, or email support@1010data.com.

   If you would like to use a specific release of 1010data, you can specify it in the URL. See the following topic on versions for more information.

2. In the Username text box, enter your 1010data username.

   **Note:** If you do not have a 1010data username, contact support@1010data.com.

3. In the Password text box, enter your 1010data password.

   **Note:** If you forgot your password, click Forgot Your Password? See Reset your password on page 8 for detailed instructions.

4. Click Login.

   **Note:** If you already have an existing 1010data session, you will be prompted.

You will be logged into 1010data and presented with the Folders and Tables browser and Start Page.

Reset your password

If you have forgotten your password, 1010data gives you a way to reset it.

To reset your password:

1. From the login screen, click Forgot Your Password?

   You will be brought to the Password Reset page.

2. Enter your 1010data Username.
3. Enter the Email associated with your 1010data account.
4. Click Reset My Password.
   An email will be sent to you from support@1010data.com containing a link to reset your password.
5. Click on the link in the “1010data Password Reset” email.
   You will be directed to a Password Reset page where you can enter your new password. You will see your username in the Username text box.
6. Enter your New Password.
   Note: Passwords may only contain uppercase and lowercase letters and numbers. Symbols and spaces are not permitted.
7. In the Confirm Password text box, enter your new password again.
   Note: The values for New Password and Confirm Password must match.
8. Click Change My Password.
   You can click on the Return to Login link to go back to the 1010data login screen.

Environments

1010data environments are independent instances of its analytics platform and infrastructure.

In 1010data, an environment refers specifically to an autonomous implementation of 1010data’s analytics platform and supporting infrastructure. Typically, this means the necessary software and services for a 1010data environment are installed on one or more servers.

Tables, queries, and users are all specific to a given 1010data environment. Thus, if you have access to multiple environments, the tables you see in one will not be in the other(s) unless those tables have been loaded separately.

The environment you use can be determined by looking at the URL you use to login to 1010data. Most users login to the www2 environment, which can be found at the following URL:

https://www2.1010data.com

Most 1010data users login to the www2 environment. However, some 1010data clients have custom environments that exist outside of www2. For example, a company with a custom environment might use the following URL to login to 1010data:

https://mycompany.1010data.com

In both cases, the information which identifies the environment in use the first sub-domain of 1010data in the URL.

Sessions

A session in 1010data is an established period communication between the user and the system. Only one session per user may be active at a time.

In 1010data, a session refers to the period a user is connected to the system from the time they log in until the time they log out or have been logged out due to inactivity. Currently, only one session may be active at a time for each user account.

Sessions are an important part of 1010data’s design, and they provide numerous benefits. First, sessions permit caching of operations. Whenever a user performs an operation in 1010data, that operation and its results are stored in the session’s cache. This is done so that if the operation needs to be run again at a later time the results are already calculated and are accessible via the session cache. This design feature allows for a compositional, orderly approach to data analysis.
A session cache has physical limitations. Every account has a maximum amount of memory it is allowed to use for cached information and current processes. This limit is called the workspace.

When a user has an established 1010data session and attempts to login to the system via a different mechanism (e.g., another browser window or tab, a client-side tool like TenDo, etc.), you have the option to end the existing session and create a new one, or to re-enter the existing session. When done via the web interface, this presents the user with the following options at login:

![Login interface](image)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Re-enter existing sessions</td>
<td>Choosing this option means the user doesn't have to login again and has access to the cache from the active session.</td>
</tr>
<tr>
<td>End existing session</td>
<td>Choosing this option requires the user to login again. Once logged in the user has a brand new session and no operations or data in their cache.</td>
</tr>
</tbody>
</table>

**Note:** You cannot re-enter a session that was started via the 1010data API.

## Versions

The 1010data Insights Platform is available in both a stable production version of the system (Prime) and a version that provides access to the latest features (Beta).

The 1010data Insights Platform follows an iterative release cycle along three tracks: Prod, Prime, and Beta. Prime changes infrequently, one or two major updates a year, and focuses on stability. Beta changes frequently, roughly once a week, and focuses on providing the latest features of the system for testing and experimentation. The Prod track is no longer under active development, but when necessary may receive important updates such as security patches or bug fixes.

To access the newest version of each track, use the following URLs:

<table>
<thead>
<tr>
<th>Track</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prod</td>
<td><a href="https://www2.1010data.com/prod-latest">https://www2.1010data.com/prod-latest</a></td>
</tr>
<tr>
<td>Prime</td>
<td><a href="https://www2.1010data.com/prime-latest">https://www2.1010data.com/prime-latest</a></td>
</tr>
<tr>
<td>Beta</td>
<td><a href="https://www2.1010data.com/beta-latest">https://www2.1010data.com/beta-latest</a></td>
</tr>
</tbody>
</table>

For each release track, it is possible to access to access older versions. Each version of the system is assigned a version number. To access a specific version in each release track, use the following URL format:
For example, to access Prime version 10.48, enter the following URL:

https://www2.1010data.com/prime-10.48

It should be noted that versions reflect a snapshot of features, functions, and other system processes. However, versions do not affect the folders, tables, and queries a user can access. These items persist across all versions of the system, but are specific to each 1010data URL.

Start Page

The Start Page contains announcements, recent worksheets, favorites, and recently added or updated items.

A 1010data session always contains an initial tab, the Start Page, which consists of the following sections:

**Announcements**

This section contains recent announcements from 1010data pertaining to system-wide changes and updates. It may also include more specific information about your data, queries, etc.

**Recent Worksheets**

This section lists your most recent worksheets. This section will contain worksheets from your current session as well.

- To open a recent worksheet in a new tab, click the title of a worksheet (at which point it becomes a new worksheet).
- To navigate to the table associated with a recent worksheet in the Folders and Tables browser, click the icon to the left of the worksheet’s name. (An arrow will indicate where the table is in the browser.)

**Favorites**

This section lists your favorite tables, folders, queries, and reports. You can add favorites in the Folders and Tables browser.

- To open an item in a new tab, click its title. If the item is a folder, the Folders and Tables browser will open to its location. (An arrow will indicate where it is in the browser.)
- To navigate to an item in the Folders and Tables browser (without opening it), click on the icon to the left of its title. (An arrow will indicate where the item is in the browser.)
- To see the name of the item (including its full path), hover over its title or the icon to the left of its title.
- To remove the item from your favorites, click the delete icon (fa fa-times) to the right of its title. (You can also remove items from your favorites in the Folders and Tables browser.)

**Recently added or updated items**

This section lists the newest items in the system that you can access. It shows items that have recently been created as well as items that have recently been modified.

- To open an item in a new tab, click its title.
- To navigate to an item in the Folders and Tables browser, click on the icon to the left of its title. (An arrow will indicate where the item is in the browser.)
- To filter the list of items, select the type (All, Merged Tables, Quick Queries, Quick Queries with Parameters, Tables, and Uploaded Queries) from the Type drop-down menu.
To change the number of items displayed, select the desired quantity from the items drop-down menu.

**Folders and Tables Browser**

The Folders and Tables browser allows you to view and traverse the hierarchy of folders and tables that you have access to, and perform actions on those items.

The 1010data Folders and Tables browser is located on the left side of the screen when you log in.

![Folders and Tables Browser Screenshot](image)

It is essentially a file browser that lists all of the items that you have access to, including:

- Folders
- Tables
- Quick Queries
- Custom reports
- Merged tables

At the top of the Folders and Tables browser is a toolbar that allows you to perform actions such as uploading tables, creating subfolders, and moving or deleting tables. You may also search for tables or queries from here.

![Folders and Tables Browser Toolbar Screenshot](image)

Traverse the folder hierarchy by single-clicking the triangle icon to the left of a folder name to open it and to close it, or by double-clicking anywhere in that folder's row.
The **Folders and Tables** browser displays the number of items that a folder contains:

It also shows how many rows each table has as well as the date and time that table was last updated:
You can select a particular item by clicking on it. A selected item is highlighted in blue, and the full path for that item appears underneath the toolbar.

Note: The full path of an item is often referred to as its name, which is different from its title. In the example below, the table name is `pub.demo.weather.hourly90`, and the table title is Hourly U.S. Weather (1990).
The actions associated with a selected item appear next to its name underneath the toolbar:

<table>
<thead>
<tr>
<th>Item Title</th>
<th>Table Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>pub.demo.weather.hourly90</td>
<td>Table Name</td>
</tr>
<tr>
<td>Geographic Data</td>
<td></td>
</tr>
<tr>
<td>Demo</td>
<td></td>
</tr>
<tr>
<td>Weather</td>
<td></td>
</tr>
<tr>
<td>Stations</td>
<td></td>
</tr>
<tr>
<td>Station location</td>
<td></td>
</tr>
<tr>
<td>Present Weather Codes</td>
<td></td>
</tr>
<tr>
<td>Hourly U.S. Weather (1990)</td>
<td></td>
</tr>
<tr>
<td>Hourly U.S. Weather (1990)</td>
<td></td>
</tr>
<tr>
<td>Hourly United States weather observations</td>
<td></td>
</tr>
</tbody>
</table>

The actions associated with a selected item may include:

- **view info** - This brings up a dialog that displays information about the selected item.
- **edit info** - This brings up a dialog that allows you to modify the properties of the selected item. (This action is only available if you own the item or have permission to modify it.)
- **add favorite** - This action adds the selected item to the list of Favorites on the Start Page.
- **remove favorite** - This action removes the selected item from the list of Favorites on the Start Page (if it had been previously added).
- **edit query** - This action opens the Save As a Quick Query dialog. *(for Quick Queries only)*
- **download queries** - This action downloads a text file *(download.txt)* containing the selected query to your computer. *(for Quick Queries only)*

You can open any item by double-clicking on it. The item will be opened in a new tab, and the panel that contains the Folders and Tables browser will be hidden (unless it is pinned). It can be brought back into view by clicking the show browser icon on the left side of the screen:
If you want to hide a Folders and Tables browser that is currently displayed, click the hide browser icon (-cancel) in the top right corner of the browser:

If you want the Folders and Tables browser to remain displayed at all times (and not be hidden when an item is opened), you can pin it in place by clicking on the pin icon (pin):

**Folders and Tables Toolbar**

The Folders and Tables toolbar allows you to perform actions such as uploading tables, creating subfolders, and moving or deleting tables.

The Folders and Tables toolbar appears at the top of the Folders and Tables browser and consists of a number of icons as well as a text box used for searching and navigation:
The icons on the **Folders and Tables** toolbar are:

- **Upload** - Upload a table.
  
  You can only upload to folders you own (✓) or have permission to modify (○).

- **Add Subfolder** - Add a subfolder.
  
  You can only add a subfolder to folders you own (✓) or have permission to modify (○).

- **Merge** - Merge two or more tables together.
  
  You can only save a merged table to a folder you own (✓) or have permission to modify (○).

- **Reorder** - Reorder the contents of a folder you own.
  
  You can only reorder the contents of a folder you own (✓).

- **Move** - Move one or more items to a different folder.
  
  You can only move items you own (✓) to a folder you own (✓).

- **Delete** - Delete one or more items.
  
  You can only delete items you own (✓).

In addition, you can use the **Search for Tables and Queries** text box in tandem with the two icons to the right of the text box to either search for a particular item or navigate directly to it:

- **Search** - Search for the title or name (of a table or query) that matches the text in the **Search for Tables and Queries** text box.

- **Go** - Navigate directly to the table or query specified in the **Search for Tables and Queries** text box.

**Upload a table (Simple Upload)**

Upload a table to 1010data.

Before you begin, ensure the data is in a file format that 1010data can read. For more information, see **Supported file formats** on page 286.

To upload a table:

1. In the **Folders and Tables** browser, select the folder where you want to upload your table.

   **Note:** You can only upload tables to folders you own (✓) or have permission to modify (○).
2. On the **Folders and Tables** toolbar, click the **Upload** icon ( ).

1010data displays fields related to the table beneath the toolbar.

3. In the **Title** text box, enter the title of the table.

   The title is used to help describe the contents of a table (e.g., *Sales Detail by Customer*). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., *Uploaded 2014-01-02 15:14:05*).

   **Note:** If you specify a table title within the file you are uploading (e.g., *@tt Sales Item Detail* in a text file, or `<title>Sales Item Detail</title>` in an XML file), it will override the value you enter in the **Title** box.

4. In the **Full Path** text box, enter the table name.

   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., *t662528755_yourusername*). The path to the parent folder will be automatically prepended to the **Full Path**.

   **Note:** If you are uploading to the **My Data** folder, the path *uploads* will be automatically prepended to the **Full Path**, and a system-generated table name will be used (e.g., *uploads.t662528755_yourusername*). You will not be able to enter anything into the **Full Path** text box.

5. Click **Next**.

   You will be prompted to choose a file.

6. Click **Choose File** and select the file containing the table you wish to upload.

   See *Text file format* on page 287 and *XML file format* on page 288 for details on what the contents of this file may be.

   **Note:** Even though you can upload an XML file in the user interface, 1010data recommends using the *addtab* transaction in the 1010data API instead.

7. Click **Upload**.

   After the table has been successfully uploaded to 1010data, you can share the table with other 1010data users.

**Upload a table (Advanced Upload)**

Using the Advanced Upload feature, you can upload a table to 1010data with a finer grain of control.

Before you begin, ensure you have completed the necessary **Prerequisites** on page 297 and that the table is in a **supported file format**.

The Advanced Upload feature provides many options for fine-grained control over the data you are uploading. In addition, the Advanced Upload feature is recommended when uploading a file in the user interface that is larger than 20 MB in size.
When you perform an Advanced Upload, you have the option of choosing either a local file or a file in your 1010data FTP account. To choose a file from your FTP account, you must first use a third-party FTP client to transfer the file to 1010data. For instructions, see *Transfer a file to your FTP account* on page 298.

To upload a table using the Advanced Upload:

1. In the **Folders and Tables** browser, select the folder where you want to upload your table.
   
   **Note:** You can only upload tables to folders you own (✓) or have permission to modify (✓).

2. On the **Folders and Tables** toolbar, click the **Upload** (✓) icon.

   1010data displays fields related to the table beneath the toolbar.

3. In the **Title** field, enter the title of the table.

   The title is used to help describe the contents of a table (e.g., *Sales Detail by Customer*). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., *Uploaded 2014-01-02 15:14:05*).

4. In the **Full Path** field, enter the table name.

   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., *t662528755_yourusername*). The path to the parent folder will be automatically prepended to the **Full Path**.

   **Note:** If you are uploading to the **My Data** folder, the path **uploads** will be automatically prepended to the **Full Path**, and a system-generated table name will be used (e.g., *uploads.t662528755_yourusername*). You will not be able to enter anything into the **Full Path** text box.

5. Click **Advanced**.

   The **Powerloader** tab opens. By default, the **FTP** option is selected and any files transferred to your 1010data FTP account are listed.
The **Powerloader** tab is used to select the file you want to upload and to configure how that table should be formatted in 1010data.

6. Depending where the file you want to upload is located, do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **1010data FTP account** | In the field below the **Source** options, click the file containing the table you want to upload.  
**Note:** You must have already transferred the file to your 1010data FTP account. For instructions, see [Transfer a file to your FTP account](#) on page 298. |
| **Local file** | Click **Local File**, then click the **Choose Files** button and select the file containing the table you want to upload. |

7. Do one of the following:

- Click **Auto Spec**.

  Click this button to have 1010data automatically configure the settings for the table based on the data in the file. If the file is formatted and delineated properly, 1010data will identify the number of columns in your table, create a section for each column to provide the necessary information, and complete as much information as possible from the data in the file. While you may need to make some adjustments afterward, this option can save you a lot of time and effort compared to manually configuring the file yourself.
**Note:** The Auto Spec button cannot be used on a compressed file. If a saved specification file does not exist for the compressed file, you can either manually configure the upload file or you can create a new specification file. To create a new specification file for a compressed file, first prepare a small sample of the table that contains all of the columns in the table. Next, upload the sample file into 1010data using the Advanced Upload feature. Once the uncompressed sample is uploaded, click Auto Spec. After 1010data identifies each column in the table and completes the appropriate Column Information fields, you can either select the compressed file in the field below the Source options and continue with the compressed file upload or save the specification file for later use.

- Select a previously saved specification file from the existing spec files drop-down list and then click Load Spec.

Select this option to use a previously saved specification to configure the settings for the table. This option is best used if you regularly use the Advanced Upload feature to add tables to 1010data with the same data format. For example, if you upload weekly sales data, the specification file can automatically complete all of the configuration settings of the table for you.

1010data identifies each column in the table and completes the appropriate Column Information fields.
### File Information

<table>
<thead>
<tr>
<th>Type</th>
<th>Desc/Desc</th>
<th>Ignore/Nuke</th>
<th>Y/N</th>
<th>Record/Definition</th>
<th>Y/N</th>
<th>Read/Definer</th>
<th>Y/N</th>
<th>Ignore</th>
<th>Y/N</th>
<th>Save Spec</th>
</tr>
</thead>
</table>

* # of Records to Display: 

* User is able to: 

### Advanced Options

### Table Information

<table>
<thead>
<tr>
<th>Name:</th>
<th>Description</th>
<th>Type:</th>
<th>Ignore/Nuke</th>
<th>Y/N</th>
<th>Record/Definition</th>
<th>Y/N</th>
<th>Read/Definer</th>
<th>Y/N</th>
<th>Ignore</th>
<th>Y/N</th>
<th>Save Spec</th>
</tr>
</thead>
</table>

* Link Header: 

* Link header is used to denote foreign columns as the result of a link operation.

* User who can view the table: 

* User who can view the table: 

### Column Information

<table>
<thead>
<tr>
<th>Name:</th>
<th>Description</th>
<th>Type:</th>
<th>Ignore/Nuke</th>
<th>Y/N</th>
<th>Record/Definition</th>
<th>Y/N</th>
<th>Read/Definer</th>
<th>Y/N</th>
<th>Ignore</th>
<th>Y/N</th>
<th>Save Spec</th>
</tr>
</thead>
</table>

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 1.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 2.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 3.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 4.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 5.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 6.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 7.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 8.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 9.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 10.

* Advanced Options

---

* Choose a name (unique identifier) and title for the column, e.g., name=column, title=Column Name 11.

* Advanced Options
8. Complete or edit the **File Information**, **Table Information**, and **Column Information** fields and options.

   For details, see *File Information* on page 301, *Table Information* on page 304, and *Column Information* on page 305.

   **Note:** Required fields are titled in red.

9. As necessary, you can add, clone, move, or delete a column before uploading the file.

   For details, see *Table 6: Column Information icons* on page 308.

   **Note:** After configuring the fields and options in your file, you can create a specification file so the settings can be used again. This is helpful if you regularly upload files with the same data format. To save the settings, click **Save Spec**, name the file, and click **OK**. The specification file is added to the **existing spec files** drop-down list.

10. At the top right side of the **Powerloader** tab, click **Start Load**.

   1010data uploads the file and creates a new table. Once the process is complete, the **Folders and Tables** browser hides and the table opens in a new tab.

![Weekly Sales Item Detail](image)

After the file has been successfully uploaded to 1010data, you can share the table with other 1010data users.

**Add a subfolder**

Add a subfolder in 1010data.

To add a subfolder in 1010data:

1. In the **Folders and Tables** browser, select the folder where you want to add a subfolder.

   **Note:** You can only add a subfolder to folders you own ((strcmp(foldername, 'My Data') == 0)) or have permission to modify (strcmp(foldername, 'My Data'))). You cannot create a subfolder in **My Data**.

2. On the **Folders and Tables** toolbar, click the **Add Subfolder** icon (add_sub). You will be presented with a number of fields (regarding the subfolder) beneath the toolbar.
3. In the **Title** text box, enter the title of the subfolder.

   The title is used to help describe the contents of the subfolder (e.g., **Shared Queries and Tables**). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a default title will be used (e.g., **New Folder**).

4. In the **Full Path** text box, enter the subfolder name.

   The subfolder name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., `t662518159_yourusername`). The path to the parent folder will be automatically prepended to the **Full Path**.

5. Click **Add**.

---

**Merge tables**

Merge two or more tables together in 1010data.

To merge two or more tables together in 1010data:

1. In the **Folders and Tables** browser, select the tables you want to merge together.

   **Note:** The tables that you are merging together must have compatible columns (i.e., column names, column types, column formats); otherwise, you will receive an error when you attempt to merge them.

2. On the **Folders and Tables** toolbar, click the **Merge** icon ().

   The items you have selected will be highlighted in green. You can add more tables to merge at this point, or continue to the next step.

3. Click **Next**.

   You will be presented with a number of fields (regarding the destination folder) beneath the toolbar.

4. In the **Folders and Tables** browser, select the folder where you want to save the merged table.

   **Note:** You can only save a merged table to a folder you own () or have permission to modify ().

   The folder you select will be highlighted in red.

5. In the **Title** text box, enter the title of the merged table.

   The title is used to help describe the contents of a table (e.g., **Merged Sales Detail by Customer**). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., `Merged 2014-01-02 18:10:41`).

6. In the **Full Path** text box, enter the table name.

   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., `t662518159_yourusername`). The path to the destination folder will be automatically prepended to the **Full Path**.

   **Note:** If you are saving the merged table to the **My Data** folder, the path **uploads** will be automatically prepended to the **Full Path**, and a system-generated table name will be used (e.g., `uploads.t662528755_yourusername`). You will not be able to enter anything into the **Full Path** text box.

7. Click **Merge**.

---

**Reorder contents**

Reorder the contents of a folder in 1010data.
To reorder the contents of a folder in 1010data:

1. In the **Folders and Tables** browser, select the folder whose contents you wish to reorder.

   **Note:** You can only reorder the contents of a folder you own (✓). You cannot reorder the contents of your **My Data** folder.

2. On the **Folders and Tables** toolbar, click the **Reorder** icon (ترتيب).

   The folder you have selected (and its associated contents) will be highlighted in green.

3. Drag and drop the subfolders in the order that you want, then drag and drop the non-folder items (e.g., tables, queries, merged tables) in the order that you want.

   **Note:** Subfolders and non-folder items cannot be intermixed. Subfolders appear above all of the non-folder items. The subfolders and the non-folder items must be reordered separately.

4. Click **Save**.

**Move items**

Move items that you own (such as tables, folders, queries, or reports) to a different folder in 1010data.

To move items that you own to a different folder:

1. In the **Folders and Tables** browser, select the item (or items) you wish to move.

   **Note:** You can only move items you own (✓).

2. On the **Folders and Tables** toolbar, click the **Move** icon (متحركة).

   The items you have selected to move will be highlighted in green.

3. In the **Folders and Tables** browser, select the folder where you want to move the selected items.

   **Note:** You can only move items to a folder you own (✓) or have permission to modify (✓). You cannot move items to **My Data**.

   The destination folder will be highlighted in red. You will be presented with a dialog confirming that you want to move the selected items.

4. Click **OK**.

**Delete items**

Delete tables, folders, queries, or reports in 1010data.

To delete one or more items from 1010data:

1. In the **Folders and Tables** browser, select the item (or items) you wish to delete.

   **Note:** You can only delete items you own (✓).

2. On the **Folders and Tables** toolbar, click the **Delete** icon (حذف).

   You will be presented with a dialog confirming that you want to delete the items.

3. Click **OK**.

**Search for items**

Search for tables, folders, queries, or reports in 1010data.

To search for an item in 1010data:

1. On the **Folders and Tables** toolbar, in the **Search for Tables and Queries** text box, enter the text for the items you want to find.
Note: If you have a table or worksheet open, and you have keyboard shortcuts enabled, you can also access the Search for Tables and Queries text box by pressing the `g` key.

2. On the Folders and Tables toolbar, click the Search icon ( ), or press Enter.

The Folders and Tables browser will display all of the folders, tables, queries, and reports whose titles or names match the text you entered.

Note: The search is not case sensitive, and partial matches are listed.

Example

The below example shows the results of entering `train` in the Search for Tables and Queries text box and clicking the Search icon ( ).

![Folders and Tables browser with search results for `train`]

All of the tables and folders that contain `train` either in their names or titles are displayed in the Folders and Tables browser. The reasons are detailed below:

<table>
<thead>
<tr>
<th>Training Examples</th>
<th>This folder is listed because both its title (Training Examples) and its name (training) contain the search string <code>train</code>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retail</td>
<td>This folder is listed because it is a subfolder of the Training Examples folder, and therefore its name (training.retail) contains the search string <code>train</code>, even though its title does not.</td>
</tr>
<tr>
<td>My Training Examples</td>
<td>This folder is listed because its title (My Training Examples) contains the search string <code>train</code>, even though its name does not (retaildemo.randd.username.searchexample).</td>
</tr>
</tbody>
</table>
Go to items

Go directly to a particular folder, table, query, or report in 1010data.

To go directly to a particular item in 1010data:

1. On the **Folders and Tables** toolbar, in the **Search for Tables and Queries** text box, enter the text for the item you want to go to.

   **Note:** If you have a table or worksheet open, and you have keyboard shortcuts enabled, you can also access the **Search for Tables and Queries** text box by pressing the *g* key.

2. On the **Folders and Tables** toolbar, click the **Go** icon ( ), or press **Enter**.

   If an exact match is found, the **Folders and Tables** browser will display the desired item.
   - If the item is a folder, the folder will be opened and all of its contents will be displayed in the browser. (An arrow will indicate where the item is in the browser.)
   - If the item is a table, query, or report, it will be opened in a new tab.

   If a partial match is found, the **Folders and Tables** browser will display all of the folders, tables, queries, and reports whose titles or names match the text you entered. The behavior is similar to searching for items.

   **Note:** The match is not case sensitive.

Example

The below example shows the results of entering `pub.demo.retail.item` in the **Search for Tables and Queries** text box and clicking the **Go** icon ( ):
The Sales Item Detail table is displayed in the Folders and Tables browser, and the table is opened in a new tab.

**Note:** When the table is opened in a new tab, the Folders and Tables browser is automatically hidden (unless it is pinned). You must show the browser in order for it to appear as it does in the above example.

**My Data and Other People's Data**

**My Data** is a folder where you may save your data, such as tables, worksheets, queries, and reports. **Other People's Data** is a folder where you can access items in other users’ My Data folders that they have shared with you.

Each user has their own My Data folder, which can be found at the top of the Folders and Tables browser. The name of this folder is uploads. This folder is intended for users to store temporary tables, worksheets, queries, and reports. The My Data folder has limited space; therefore, it is not suggested that users attempt to save large tables here.

If you share something in your My Data folder with someone else, they can access it through their own Other People’s Data folder. Conversely, if someone shares something with you in their My Data folder, you can access it via your Other People’s Data folder.

**Note:** You cannot create subfolders in My Data, which means you would not be able to use the inherit permissions feature that 1010data provides. You would need to explicitly give permission to each user for those items you want to share in your My Data folder.

In most cases, users will also have a user folder that their company creates for them where they can save their data and in which they can create subfolders. They can then share those subfolders with other users or groups, which is the method that 1010data recommends.

**View information about an item**

You can find out the meta information about items in the Folders and Tables browser, including tables, folders, queries, or reports.

To view information about a table, folder, query, or report:
1. Navigate to the desired item in the **Folders and Tables** browser.
2. Click the item.

   The item is highlighted in blue, and the full path for that item appears underneath the **Folders and Tables** toolbar along with its associated actions.
3. In the list of actions underneath the toolbar, click **view info**.

   A subset of the following information will be displayed in a panel below the **Folders and Tables** toolbar:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the item.</td>
</tr>
<tr>
<td>Name</td>
<td>The full path of the item.</td>
</tr>
<tr>
<td>ID</td>
<td>The internal identification number for the item.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the table.</td>
</tr>
<tr>
<td>Owner</td>
<td>The username of the item's owner.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time the item was last updated.</td>
</tr>
<tr>
<td>Users</td>
<td>The list of users and groups that have access to this item.</td>
</tr>
<tr>
<td>Uploading</td>
<td>The list of users and groups that have permission to upload to this folder.</td>
</tr>
<tr>
<td>References</td>
<td>The table this query is applied to (and any tables that it is linked to).</td>
</tr>
<tr>
<td>Short Description</td>
<td>A concise description about the item.</td>
</tr>
<tr>
<td>Long Description</td>
<td>A more detailed explanation, which may include the Macro Language XML of the query.</td>
</tr>
</tbody>
</table>

4. Click the X to dismiss the panel.

### Edit information about an item

You can edit meta information about items that you own in the **Folders and Tables** browser.

To edit information about a folder, table, query, or any other item you own:

1. Navigate to the desired item in the **Folders and Tables** browser.

   **Note:** You can only edit information for items that have a key icon (�建) next to them in the **Folders and Tables** browser, which indicates that you own those items.
2. Click the item.

   The item is highlighted in blue, and the full path for that item appears underneath the **Folders and Tables** toolbar along with its associated actions.
3. In the list of actions underneath the toolbar, click **edit info**.

   A panel will be displayed below the **Folders and Tables** toolbar.
4. Change the desired information.

   You may change any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of this item.</td>
</tr>
<tr>
<td>Name</td>
<td>The base name of this item.</td>
</tr>
</tbody>
</table>

   **Note:** You cannot change the full path of the item, only its base name. However, you can move an item if you want to relocate it to a different folder.

   | Owner       | The username of this item's owner.                |
   | Users       | The list of users and groups that have access to this item. |
Inherit Users

If selected, the users that have access to the parent folder (the folder this item is in) will have access to this item.

Note: This takes precedence over the Users list for this item.

Uploader

The list of users and groups that have permission to upload to this folder

Inherit Uploaders

If selected, the users that have upload permission to the parent folder will have upload permission to this folder.

Note: This takes precedence over the Uploaders list for this item.

Short Description

A concise description about the item.

Long Description

A more detailed explanation.

5. Click Save Changes.

Upon successful completion, you will see a message underneath the Folders and Tables toolbar indicating that the file's information was modified.

Share folders, tables, or queries

You can share items that you own with others, giving them permission to see your tables or run your queries.

If you need to share items with multiple users, consider creating a group. For more information, see Create a new group on page 372.

To share your folder, table, query, or any other item you own:

1. Navigate to the desired item in the Folders and Tables browser.

   Note: You can only share items that have a key icon (مرافق) next to them in the Folders and Tables browser, which indicates that you own those items.

2. Click the item.

   The item is highlighted in blue, and the full path for that item appears underneath the Folders and Tables toolbar along with its associated actions.

3. In the list of actions underneath the toolbar, click edit info.

   A panel will be displayed below the Folders and Tables toolbar.

4. In the Users box, add the names of the 1010data users or groups, separated with a space, with whom you would like to share the selected item.

   If you select Inherit Users, the 1010data users that have access to the parent folder (the folder this item is in) will have access to this item.

   Note: Inherit Users takes precedence over the Users list for this item.

5. Click Save Changes.

   If you enter an invalid username, you will receive a message saying that the file was not updated.

   Upon successful completion, you will see a message underneath the Folders and Tables toolbar indicating that the file's information was modified.

   Note: Users to which you have granted access will not see the shared items until the next time they log in to a new session.

Add favorites

If you use a table, folder, query, or report often, add it to your favorites for quick and easy access.

To add an item to your favorites:
1. Navigate to the desired item in the **Folders and Tables** browser.

2. Click the item.

   The item is highlighted in blue, and the full path for that item appears underneath the **Folders and Tables** toolbar along with its associated actions.

3. In the list of actions underneath the toolbar, click **add favorite**.

   **Note:** If the item is already one of your favorites, **add favorite** will not appear in the list of actions; you will see **remove favorite** instead.

Once you add an item to your favorites, you can then find it quickly and easily in the **Favorites** section on the **Start Page**.

### Remove favorites

Remove items that you no longer use very often from your favorites.

To remove an item from your favorites:

There are two ways:

- **From the Start Page:**
  a) Click the **Start Page** tab.
  b) Click the delete icon (●) to the right of the item you want to delete.

- **From the Folders and Tables browser:**
  a) Navigate to the desired item in the **Folders and Tables** browser.
  b) Click the item.

   The item is highlighted in blue, and the full path for that item appears underneath the **Folders and Tables** toolbar along with its associated actions.
  c) In the list of actions underneath the toolbar, click **remove favorite**.

   **Note:** If the item is not already one of your favorites, **remove favorite** will not appear in the list of actions; you will see **add favorite** instead.

Once you remove an item from your favorites, it will no longer be listed in the **Favorites** section on the **Start Page**.

### Workspace

Your workspace is the amount of virtual memory that has been allocated to your 1010data session.

The size of your workspace is displayed in the top right corner of the 1010data web interface:

As you perform your analyses in 1010data, your workspace will be increased to reflect how much virtual memory you have used. You can think of this workspace value as a current high-water mark.

There are limits on the size of a process's virtual memory (i.e., on the amount of data that the 1010data session can handle at once). If you work with relatively small tables, your process(es) use small amounts of virtual memory, and you should never even come close to the limit. But if you are dealing with large tables with hundreds of millions of rows, it is possible that you may run into the limit **under certain circumstances**. This qualification is important: Just because you are dealing with large tables doesn't mean that you will have a problem.
1010data is designed to process data piecewise, dealing with relatively small amounts at a time rather than all of it at once. But there are cases when it may be necessary to process large amounts of data at one time, either because there is no practical way to do it piecewise or because doing it piecewise would seriously impact performance.

**Troubleshooting Workspace Issues**

If your current session starts to behave strangely (e.g., you see cryptic error messages) or stops responding altogether, it may be because you are approaching or have exceeded your virtual memory limit. Once the virtual memory limit is surpassed, the system can behave unpredictably.

**Note:** If you see any message containing the word `wsfull`, it is almost certainly a sign that you have hit the virtual memory limit.

Even if you do run out of virtual memory, the system as a whole is unaffected. There is generally no impact on other users, and you won't affect any of the data on the system. So, don't worry about crashing the system or anything as catastrophic as that.

You always have the option of logging in again. That will end your first session and set things right. But it is sometimes possible to recover without losing the session. Also, even if you start a new session, you will have to do things a bit differently the second time around; otherwise, you will end up in the same place.

Here are some steps we recommend:

- **Clear the cache**
  
  First, see if you can recover without logging in again by clearing the cache. See *Clear the cache* on page 32 for details.

  If the workspace value goes down, your session is OK; if it is still too high, you will have to log in again.

  **Note:** Remember to save your work before starting a new session. Save it as a Quick Query or save your actions as a text file. Or, if you are in the *Edit Actions (XML)* dialog, copy the XML code and paste it into a text editor.

- **Restructure your query**
  
  There is usually more than one way to do an analysis in 1010data, and some methods use significantly less memory (and run more quickly) than others.

  See *Writing Efficient Queries* on page 112 for suggestions.

- **Change your settings**
  
  If you've tried clearing the cache and restructuring your queries, and you believe you're still exceeding the virtual memory limit, click *Actions > Advanced* and change some of the settings that control memory utilization.

Unfortunately, it is essentially impossible to monitor virtual memory usage at every step in a process or to predict how much virtual memory a given query will use. The only way to ensure that you won't hit the limit would be to impose significant restrictions on all queries. However, such restrictions would end up disallowing many viable queries as well. Rather than imposing such arbitrary restrictions, we put the full power of 1010data under your control. This gives you the flexibility to run a greater variety of analyses using different methods to get the results you need using the most efficient queries possible. The downside, of course, is that you can encounter virtual memory problems; but, as noted above, you can recover and you cannot affect anyone else. However, keeping an eye on your workspace usage can help you steer clear of the virtual memory limit before hitting it.

### Clear the cache

Clearing the cache cleans out your workspace so that you have the maximum amount of virtual memory available to your 1010data session.

To clear the cache:

- Perform one of the following actions:
• Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Clear Cache**.
• On the menu bar for a table that you are viewing, click **Actions > Clear Cache**.

### Help

1010data provides a variety of resources to help you have the best experience possible as you use our system.

The following items are located under the **Help** menu on the top right corner of your 1010data session:

<table>
<thead>
<tr>
<th>Documentation Center</th>
<th>Shows the online repository of 1010data documentation and training materials.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1010data User’s Guide</strong></td>
<td>Opens the latest released version of the 1010data User’s Guide.</td>
</tr>
<tr>
<td><strong>Technical Interfaces</strong></td>
<td>Displays the <strong>Technical Interfaces</strong> page. This page provides download links to 1010data APIs, SDKs, drivers, and tools.</td>
</tr>
<tr>
<td><strong>Changes</strong></td>
<td>Shows the <strong>Change Log</strong> page. This page catalogs all of the fixes and enhancements contained within each release, listed chronologically by release date.</td>
</tr>
<tr>
<td><strong>Support</strong></td>
<td>Presents the <strong>Support</strong> dialog. This dialog allows users to solicit help, report bugs, request features, and generally communicate with 1010data support.</td>
</tr>
</tbody>
</table>

Help can also be obtained by clicking on the help icon (❓) in the top right corner of any of the dialogs in 1010data. This will open the 1010data User’s Guide to the topic related to that particular dialog or the task you are trying to accomplish.
Submit a support request

Send a support request to 1010data using the web interface.

To submit a support request:

1. From the top right corner of your 1010data session, click Help > Support.

   The Support dialog is presented.

2. Enter your email address in My Email.

3. Select Save my email address for this account if you want your email to be saved for future reference.

4. Select an Inquiry Type from the list:

   - **Query Help** is for help with queries.
   - **Bug Report** is used to submit problems using 1010data.
   - **Feature Request** allows users to submit suggestions for new or added functionality.
   - **Other** is for any communication that does not fit into one of the above categories.

5. Enter a Subject for this support request.

6. In the text box at the bottom of the dialog, enter a detailed explanation of the question, problem, or request.

7. Click Send.

   **Note:** You may also either email support@1010data.com or, for immediate assistance, call 866-405-DATA.

Keyboard Shortcuts

Keyboard shortcuts help to streamline your experience by giving you quick access to some of the most common actions in 1010data.

The following keyboard shortcuts are available by default.

<table>
<thead>
<tr>
<th><strong>Keyboard Shortcut</strong></th>
<th><strong>Action</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt+Left Arrow</td>
<td>Go back (history)</td>
</tr>
<tr>
<td>Keyboard Shortcut</td>
<td>Action</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Control+Left Arrow</td>
<td>Go forward (history)</td>
</tr>
<tr>
<td>Command+Left Arrow</td>
<td>Cycle through the open windows in your 1010data session</td>
</tr>
<tr>
<td>Backspace</td>
<td></td>
</tr>
<tr>
<td>Alt+Right Arrow</td>
<td></td>
</tr>
<tr>
<td>Control+Right Arrow</td>
<td></td>
</tr>
<tr>
<td>Command+Right Arrow</td>
<td></td>
</tr>
<tr>
<td>Shift+Left Arrow</td>
<td></td>
</tr>
<tr>
<td>Shift+Right Arrow</td>
<td></td>
</tr>
<tr>
<td>Control+Enter</td>
<td>Apply the set of actions that appear in the Edit Actions (XML) dialog</td>
</tr>
</tbody>
</table>

The following keyboard shortcuts are only enabled for interactive tables when Enable keyboard shortcuts is checked under the User Interface section of the Set Preferences dialog.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>f (or F)</td>
<td>Open the help topic that lists all the 1010data functions in the 1010data Reference Manual</td>
</tr>
<tr>
<td>r (or R)</td>
<td>Open the Search for Tables and Queries text box in the Folders and Tables browser</td>
</tr>
<tr>
<td>g (or G)</td>
<td>Show column information for all columns in the current table</td>
</tr>
<tr>
<td>i (or I)</td>
<td>Switch to previous tab (left)</td>
</tr>
<tr>
<td>j (or J)</td>
<td>Switch to next tab (right)</td>
</tr>
<tr>
<td>k (or K)</td>
<td>Open the Edit Actions (XML) dialog</td>
</tr>
</tbody>
</table>

The following keyboard shortcuts are used for finding and replacing text within the Edit Actions (XML) dialog.

**Note:** The cursor must be within the Edit Actions (XML) dialog in order to use these keyboard shortcuts.

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control+F</td>
<td>Search within the Edit Actions (XML) dialog for specified search text</td>
</tr>
<tr>
<td>Command+F</td>
<td></td>
</tr>
<tr>
<td>Keyboard Shortcut</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Control+G</td>
<td>Find next instance of search text in the Edit Actions (XML) dialog</td>
</tr>
<tr>
<td>Command+G</td>
<td></td>
</tr>
<tr>
<td>Shift+Control+G</td>
<td>Find previous instance of search text in the Edit Actions (XML) dialog</td>
</tr>
<tr>
<td>Shift+Command+G</td>
<td></td>
</tr>
<tr>
<td>Shift+Control+F</td>
<td>Replace each occurrence of specified text within the Edit Actions (XML) dialog with replacement text</td>
</tr>
<tr>
<td>Command+Option+F</td>
<td></td>
</tr>
<tr>
<td>Shift+Control+R</td>
<td>Replace all occurrences of specified text within the Edit Actions (XML) dialog with replacement text</td>
</tr>
<tr>
<td>Shift+Command+Option+F</td>
<td></td>
</tr>
</tbody>
</table>

**Log out of 1010data**

Log out of 1010data to close your active session.

To log out of 1010data:

Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Logout**.

You will be logged out, and your active session will be closed.

Current worksheets may be restored from the **Recent Worksheets** section of the **Start Page** the next time a session is started.

**Note:** If a session is also in use with the 1010data Excel Add-in, the session in the Excel Add-in will also be ended when you log out.
Tables and worksheets are the primary means by which you work with data in 1010data.

A **table** is a collection of data that is stored as rows and columns in 1010data. A **worksheet** is an instance of a table that has been opened in 1010data and has had any number of operations applied to it (such as selecting rows, performing summaries, or creating computed columns). You may have multiple worksheets open at the same time. (Technically, a table that has been opened in 1010data but has no operations applied to it is still considered a table, not a worksheet.)

Worksheets provide an easy way to perform actions on individual tables and then link them. For example, you may tabulate two tables separately and link the results.

Typically, your company's data is initially loaded onto the system by the 1010data support team. In addition, you can also upload tables to 1010data through the 1010data web interface as well as a number of other 1010data tools, such as the Excel Add-in and TenUp, or using the 1010data API.

1010data pre-loads certain published data sets onto your system, such as hourly U.S. weather observations, Federal Reserve economic data, and unemployment statistics. You may also have access to third-party data sets that you license through 1010data.

All of the tables to which you have access can be found in the **Folders and Tables** browser.

To view a table, double-click its entry in the **Folders and Tables** browser. The table will open as a worksheet in a new tab.

For instance, if you want to view the table **Monthly Statewide Non-Seasonally Adjusted Unemployment Statistics**, double-click that item in the browser. A new tab will be opened (next to the **Start Page** tab), and the table will be displayed in that tab. Also, the **Folders and Tables** browser will be hidden (unless it is pinned).
At the top of the table you will see a toolbar that includes the path to the table you are viewing in the current tab. You can click on any of the elements to open the corresponding folder in the Folders and Tables browser.
The toolbar also includes icons that are used for moving backward or forward through the steps of your analysis, opening the tab in a new window, and cloning the tab.

Underneath the toolbar, there is a menu bar that provides a number of items that you will use as you interact with your tables and worksheets.

Below that, the table is displayed.
**Note:** The number of columns and rows shown is dependent on the size of your browser window. If you resize your browser window, the number of visible rows and columns will change.

Under the table heading, you will see which columns and rows are currently displayed.

If the entire table cannot be displayed in the browser window (which is most likely the case for tables of any substantial size), you will see scroll bars on the side or the bottom of the table.
If you have more than one worksheet open, you will see multiple tabs at the bottom of your 1010data session, each one corresponding to a worksheet.

You can switch between worksheets by clicking on the desired tab.
Tables and Worksheets Toolbar

The tables and worksheets toolbar allows you to perform such actions as stepping backward or forward through your analysis, opening the current tab in a new window, and cloning the tab, and also displays the full path of the table.

The toolbar appears at the top of every table and worksheet and contains the following icons:

- Go back one step in this tab.
- Go forward one step in this tab.
- Move this tab to a new window.
- Clone this tab.

In addition, the toolbar also displays the path to the table displayed in the current tab.

Clicking on any of the elements in the path will take you to that particular folder in the Folders and Tables browser.

Go back one step

You can move backward through the steps of your analysis.

To go back one step in the current tab:

On the toolbar of an open table or worksheet, click the Go Back icon (←).

The table will be restored to the state before the last action was taken. You can step back all the way to the initial state of the table (when it was originally loaded into the current tab), if desired.

**Note:** This will have no effect if there are no prior actions (i.e., if no actions have yet been taken or if you have gone back through all of the steps in your history).

After going back any number of steps, you can go forward through the steps of your analysis and execute those actions once again.

**Note:** Going back one step is different from undoing the last action. Undoing the last action removes that action from your history, so that you cannot subsequently redo that action. Essentially, you can only go forward if you go back, not if you undo.
Go forward one step

After stepping back through the steps of your analysis, you can move forward through those steps once again.

To go forward one step in the current tab:

On the toolbar of an open table or worksheet, click the Go Forward icon (→).
You can only go forward through the steps of your analysis if you have previously gone back.
The actions corresponding to the next step in your analysis will be taken.

Note: This will have no effect if there are no subsequent actions (i.e., if no actions have yet been taken or if you have gone forward through all of the steps in your history).

Move tab to new window

Move the current tab to a new browser window.

To move a tab to a new window:

On the toolbar at the top of the tab you want to move, click the Move Tab icon (→).
Your existing 1010data session is opened in a new browser window, and the current tab is moved to that window. The tab is removed from your 1010data session in the original browser window, which remains active. All other tabs in that session will remain intact.

Clone a tab

Open a copy of the current table or worksheet in a new tab.

To clone a tab:

On the toolbar at the top of the tab you want to move, click the Clone Tab icon (→).
A copy of the table or worksheet you are currently viewing is opened in a new tab.

Scroll Bars

Use scroll bars to navigate through the rows and columns in your 1010data tables and worksheets.

If an entire table or worksheet cannot be displayed in the browser window (which is most likely the case for tables or worksheets of any substantial size), you will see scroll bars on the side or the bottom of the table.
Vertical Scroll Bar

The vertical scroll bar is used for traversing the rows of your table. The light gray portion of the slide shows the current position in the table, and its size indicates the percentage of rows that are currently being displayed. (For tables with large numbers of rows, it will appear extremely thin.)
The other controls have the following behavior:

- Go up one row.
- Go up one page.
- Go to the top of the table.
- Go down one row.
- Go down one page.
- Go to the bottom of the table.

You may go directly to any point in the table by clicking within the darker gray parts of the scroll bar. The top edge of the slide bar will move to the point where you click.

**Horizontal Scroll Bar**

The horizontal scroll bar is used for traversing the columns of your table. The light gray portion of the slide shows the current position in the table, and its size indicates the percentage of columns that are currently being displayed.

The other controls have the following behavior:

- Go left one column.
Go left one page.

Go to the first column in the table.

Go right one column.

Go right one page.

Go to the last column in the table.

You may go directly to any point in the table by clicking within the darker gray parts of the scroll bar. The left edge of the slide bar will move to the point where you click.

**Note:** Fixed columns will remain visible at all times, regardless of how far you scroll to the right.

---

**View a table**

Opens a table as a worksheet in a new tab.

To view a table:

1. Navigate to the desired table in the **Folders and Tables** browser.
2. Double-click the entry that you want to open.

The table will be opened as a worksheet in a new tab.

**Note:** If you use a table often, you may want to add it to your favorites. You can then find it quickly and easily in the **Favorites** section on the **Start Page**.

---

**Show table information**

Display the information about a particular table, including its title, name, ID, and owner.

To show table information:

In an open table or worksheet, click **Info > About this Table**.

A window is presented containing the following meta information for the table:

- Title
- Name
- ID
- Last Change
- Owner
- Type
- Description

---

**View multiple rows at a time**

You can toggle between viewing multiple rows of a table, which is the default, or a single row at a time.

To view multiple rows in a table:

Click **View > Multiple Rows at a Time...**

**Note:** This will only have a visible effect if your view is currently one row at a time. This will have no effect if your view is already multiple rows.
View one row at a time

You can change your view to just a single row to see all of the information pertaining to that row, which is particularly useful when a table has many columns.

To view a single row in a table:

In an open table or worksheet, click View > One Row at a Time...

**Note:** This will only have a visible effect if your view is currently multiple rows at a time. This will have no effect if your view is already one row.

A list of all the columns and their values for the current row is displayed. The current row number is also shown above the list.

You can also click on the question mark icon next to any of the column titles (曙光) to show detailed information about that particular column.

Save as a new table

After you have completed an analysis, you may save the results as a new table on the 1010data Insights Platform. You will then be able to access the results at a later time and share them with others.

To save the current table or worksheet as a new table on the 1010data Insights Platform:

1. In an open table or worksheet, click File > Save as a New Table...

The Save As a New Table dialog is presented.

2. Enter a Title for the table.

The table title is used to help describe the contents of the table (e.g., Sales Detail by Customer) and may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters.

3. Select Save the current actions in the table's description if you would like to save the Macro Language query for the current worksheet in the description for the table.

The table's description can be seen by clicking Help > About this Table or by clicking the view info action for that table in the Folders and Tables browser.

4. Under Save into folder, navigate to the folder where you want to save the new table.
**Note:** You can only save the new table in a folder that you own (own) or have permission to add to (add).

5. Click **Submit**.

The table is saved in the destination folder specified.

When you save results of an analysis as a new table, only the **results** are saved, not the actions to the original table that led to the results. If the original table were to change, the new table would not reflect those changes. It is oftentimes better to save the actions of a worksheet as a Quick Query instead. Then, when you view the Quick Query, the actions will be applied to the original table, and the results will be displayed. Not only does this save on space (which is extremely beneficial when you're dealing with large tables), but if the original table has been changed (updated, corrected, etc.), the results will reflect the changes.

---

### Save and replace table

You can replace an existing table on the 1010data Insights Platform with the results of an analysis. You will then be able to access the results at a later time and share them with others.

To replace an existing table on the 1010data Insights Platform with the results of an analysis:

1. In a worksheet containing the results of an analysis, click **File > Save and Replace Table...**
   - The **Save and Replace Table** dialog is presented.
2. Select **Save the current actions in the table's description** if you would like to save the Macro Language query for the current worksheet in the description for the table.
   - The table’s description can be seen by clicking **Help > About this Table** or by clicking **view info** for that table in the **Folders and Tables** browser.
3. Under **Replace table**, select the table you want to replace.
   - **Note:** You can only replace tables that you own (own).
4. Click **Replace the Table Selected Below**.

The selected table is overwritten.

- **Note:** Be careful! Once you have replaced the selected table, there is no way to get it back.

When you replace a table with the results of an analysis, only the **results** are saved, not the actions to the original table that led to the results. If the original table were to change, the new table would not reflect those changes. It is oftentimes better to save the actions of a worksheet as a Quick Query instead. Then, when you view the Quick Query, the actions will be applied to the original table, and the results will be displayed. Not only does this save on space (which is extremely beneficial when you're dealing with large tables), but if the original table has been changed (updated, corrected, etc.), the results will reflect the changes.

---

### Append results to an existing table

After you have completed an analysis, you may save the results by appending them to an existing table.

To append the results of an analysis to an existing table:

1. In an open table or worksheet, click **File > Append an Existing Table...**
   - The **Save and Append Table** dialog is presented.
2. Select **Save the current actions in the table’s description** if you would like to save the Macro Language query for the current worksheet in the description for the table.
Note: Be sure you want to overwrite the existing table's description with the Macro Language query for the current worksheet.

The table’s description can be seen by clicking Help > About this Table or by clicking view info for that table in the Folders and Tables browser.

3. Under Append table, select the table you want to append your results to.

Note: You can only append to tables that you own (Own).

4. Click Append the Table Selected Below.

You will be presented with a dialog confirming that you want to append the table.

5. Click OK.

The results of your analysis are appended to the selected table.

Note: Be careful! Once you have appended your results to the selected table, there is no way to undo it.

An append will add every row in the current worksheet to the selected table only for columns that exist in the selected table. If the selected table contains columns that do not appear in your worksheet, those columns will contain N/A’s for each new row. If your worksheet contains columns that do not appear in the selected table, those columns will not be included.

When you append a table with the results of an analysis, only the results are saved, not the actions to the original table that led to the results. If the original table were to change, the new table would not reflect those changes. It is oftentimes better to save the actions of a worksheet as a Quick Query instead. Then, when you view the Quick Query, the actions will be applied to the original table, and the results will be displayed. Not only does this save on space (which is extremely beneficial when you’re dealing with large tables), but if the original table has been changed (updated, corrected, etc.), the results will reflect the changes.

Merge tables

Merge two or more tables together in 1010data.

To merge two or more tables together in 1010data:

1. In the Folders and Tables browser, select the tables you want to merge together.

Note: The tables that you are merging together must have compatible columns (i.e., column names, column types, column formats); otherwise, you will receive an error when you attempt to merge them.

2. On the Folders and Tables toolbar, click the Merge icon ()

The items you have selected will be highlighted in green. You can add more tables to merge at this point, or continue to the next step.

3. Click Next.

You will be presented with a number of fields (regarding the destination folder) beneath the toolbar.

4. In the Folders and Tables browser, select the folder where you want to save the merged table.

Note: You can only save a merged table to a folder you own (Own) or have permission to modify (Own).

The folder you select will be highlighted in red.

5. In the Title text box, enter the title of the merged table.

The title is used to help describe the contents of a table (e.g., Merged Sales Detail by Customer). The title may contain any combination of uppercase and lowercase letters, numbers,
spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., Merged 2014-01-02 18:10:41).

6. In the Full Path text box, enter the table name.

The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., t662518159_yourusername). The path to the destination folder will be automatically prepended to the Full Path.

Note: If you are saving the merged table to the My Data folder, the path uploads will be automatically prepended to the Full Path, and a system-generated table name will be used (e.g., uploads.t662528755_yourusername). You will not be able to enter anything into the Full Path text box.

7. Click Merge.

Upload a table (Simple Upload)

Upload a table to 1010data.

Before you begin, ensure the data is in a file format that 1010data can read. For more information, see Supported file formats on page 286.

To upload a table:

1. In the Folders and Tables browser, select the folder where you want to upload your table.

   Note: You can only upload tables to folders you own (✓) or have permission to modify (✓).

2. On the Folders and Tables toolbar, click the Upload icon (.Upload).

   1010data displays fields related to the table beneath the toolbar.

3. In the Title text box, enter the title of the table.

   The title is used to help describe the contents of a table (e.g., Sales Detail by Customer). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., Uploaded 2014-01-02 15:14:05).

   Note: If you specify a table title within the file you are uploading (e.g., @tt Sales Item Detail in a text file, or <title>Sales Item Detail</title> in an XML file), it will override the value you enter in the Title box.

4. In the Full Path text box, enter the table name.

   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., t662528755_yourusername). The path to the parent folder will be automatically prepended to the Full Path.

   Note: If you are uploading to the My Data folder, the path uploads will be automatically prepended to the Full Path, and a system-generated table name will be used (e.g.,
5. Click Next.
   You will be prompted to choose a file.
6. Click Choose File and select the file containing the table you wish to upload.
   See Text file format on page 287 and XML file format on page 288 for details on what the contents of this file may be.
   **Note:** Even though you can upload an XML file in the user interface, 1010data recommends using the addtab transaction in the 1010data API instead.
7. Click Upload.

After the table has been successfully uploaded to 1010data, you can share the table with other 1010data users.

### Upload a table (Advanced Upload)

Using the Advanced Upload feature, you can upload a table to 1010data with a finer grain of control.

Before you begin, ensure you have completed the necessary **Prerequisites** on page 297 and that the table is in a **supported file format**.

The Advanced Upload feature provides many options for fine-grained control over the data you are uploading. In addition, the Advanced Upload feature is recommended when uploading a file in the user interface that is larger than 20 MB in size.

When you perform an Advanced Upload, you have the option of choosing either a local file or a file in your 1010data FTP account. To choose a file from your FTP account, you must first use a third-party FTP client to transfer the file to 1010data. For instructions, see **Transfer a file to your FTP account** on page 298.

To upload a table using the Advanced Upload:

1. In the **Folders and Tables** browser, select the folder where you want to upload your table.
   **Note:** You can only upload tables to folders you own (🔹) or have permission to modify (🔹).
2. On the **Folders and Tables** toolbar, click the **Upload** (🔹) icon.
   1010data displays fields related to the table beneath the toolbar.

3. In the **Title** field, enter the title of the table.
   The title is used to help describe the contents of a table (e.g., Sales Detail by Customer). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., Uploaded 2014-01-02 15:14:05).
4. In the **Full Path** field, enter the table name.
   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-
generated name will be used (e.g., t662528755_yourusername). The path to the parent folder will be automatically prepended to the Full Path.

**Note:** If you are uploading to the My Data folder, the path uploads will be automatically prepended to the Full Path, and a system-generated table name will be used (e.g., uploads.t662528755_yourusername). You will not be able to enter anything into the Full Path text box.

5. Click Advanced.

The Powerloader tab opens. By default, the FTP option is selected and any files transferred to your 1010data FTP account are listed.

5. **Click** Advanced.

The **Powerloader** tab opens. By default, the **FTP** option is selected and any files transferred to your 1010data FTP account are listed.

5. **Click** Advanced.

The **Powerloader** tab is used to select the file you want to upload and to configure how that table should be formatted in 1010data.

6. Depending where the file you want to upload is located, do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **1010data FTP account** | In the field below the **Source** options, click the file containing the table you want to upload.  
**Note:** You must have already transferred the file to your 1010data FTP account. For instructions, see **Transfer a file to your FTP account** on page 298. |
| **Local file**          | Click **Local File**, then click the **Choose Files** button and select the file containing the table you want to upload. |
7. Do one of the following:

- Click **Auto Spec**.

  Click this button to have 1010data automatically configure the settings for the table based on the data in the file. If the file is formatted and delineated properly, 1010data will identify the number of columns in your table, create a section for each column to provide the necessary information, and complete as much information as possible from the data in the file. While you may need to make some adjustments afterward, this option can save you a lot of time and effort compared to manually configuring the file yourself.

  **Note:** The **Auto Spec** button cannot be used on a compressed file. If a saved specification file does not exist for the compressed file, you can either manually configure the upload file or you can create a new specification file. To create a new specification file for a compressed file, first prepare a small sample of the table that contains all of the columns in the table. Next, upload the sample file into 1010data using the Advanced Upload feature. Once the uncompressed sample is uploaded, click **Auto Spec**. After 1010data identifies each column in the table and completes the appropriate **Column Information** fields, you can either select the compressed file in the field below the **Source** options and continue with the compressed file upload or save the specification file for later use.

- Select a previously saved specification file from the **existing spec files** drop-down list and then click **Load Spec**.

  Select this option to use a previously saved specification to configure the settings for the table. This option is best used if you regularly use the Advanced Upload feature to add tables to 1010data with the same data format. For example, if you upload weekly sales data, the specification file can automatically complete all of the configuration settings of the table for you.

  1010data identifies each column in the table and completes the appropriate **Column Information** fields.
8. Complete or edit the **File Information**, **Table Information**, and **Column Information** fields and options.

For details, see *File Information* on page 301, *Table Information* on page 304, and *Column Information* on page 305.

**Note:** Required fields are titled in red.

9. As necessary, you can add, clone, move, or delete a column before uploading the file.

For details, see *Table 6: Column Information icons* on page 308.

**Note:** After configuring the fields and options in your file, you can create a specification file so the settings can be used again. This is helpful if you regularly upload files with the same data format. To save the settings, click **Save Spec**, name the file, and click **OK**. The specification file is added to the **existing spec files** drop-down list.

10. At the top right side of the **Powerloader** tab, click **Start Load**.

1010data uploads the file and creates a new table. Once the process is complete, the **Folders and Tables** browser hides and the table opens in a new tab.

![Weekly Sales Item Detail](image)

After the file has been successfully uploaded to 1010data, you can share the table with other 1010data users.

**Close a worksheet**

Close a worksheet when you are finished working with it.

To close a worksheet:

Perform either of the following actions:

- Click **File > Close Current Worksheet**.
- Click the **Close** button ( toglyph) in the tab for the worksheet you want to close.
Rows and Columns

Within 1010data’s Trillion-Row Spreadsheet interface, you will manipulate rows and columns to view your data and perform new computations to gain further insight into your data.

Rows

Each row contains a set of related values. You can find or select rows that meet certain criteria, sort the rows of a table, or go to a specific row.

A table may contain any number of rows. Using 1010data’s web interface, the Trillion-Row Spreadsheet, you can analyze any amount of data quickly and easily.

Select rows

Row selection allows you to focus on a subset of rows. Specify up to five criteria to make your selection.

To select rows from the current table or worksheet:

1. In an open table or worksheet, click **Rows > Select Rows...**

   The **Select Rows** dialog is presented.

2. Specify the criteria for the row selection:

   For each criterion, you may choose a column and a relationship (equal to, greater than, etc.) and enter a value (or values), or you may specify a range for a given column.

   **Note:** The order in which the column headings appear in the drop-down lists can be set using the **In selection boxes, show columns in** preference under the **User Preferences** section of the **Set Preferences** dialog.

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>To specify a relationship between a column and particular values:</td>
<td>Using any of the top three selection entries:</td>
</tr>
<tr>
<td></td>
<td>1. From the first drop-down list, select a column.</td>
</tr>
<tr>
<td></td>
<td>2. From the second drop-down list, select a relationship.</td>
</tr>
<tr>
<td></td>
<td>3. In the text box, enter a value (or values).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Separate multiple values by spaces.</td>
</tr>
<tr>
<td>To specify a range for a particular column:</td>
<td>Using either of the bottom two selection entries:</td>
</tr>
<tr>
<td></td>
<td>1. From the first drop-down list, select a column.</td>
</tr>
<tr>
<td></td>
<td>2. In the first text box, enter the bottom value of the range.</td>
</tr>
<tr>
<td></td>
<td>3. In the second text box, enter the top value of the range.</td>
</tr>
</tbody>
</table>

3. Select **Keep the current row order?** if you want to display the selected rows in the same order as they appeared in the original table or worksheet.

   If this check box is clear, the rows in the resultant selection will appear in an arbitrary order.

   **Note:** For very large tables, clearing this check box can noticeably speed up the selection.

4. For the **Relationship** option:

   - Select **AND** if you want the resultant selection to include rows that meet all of the criteria.
• Select OR if you want the resultant selection to include rows that meet any of the criteria.

5. Click Select.

Only those rows that meet the criteria will be displayed. Also, if you summarize the data, only the selected rows will be included in the summary.

Note: The selection applies only to your session and does not affect the original table.

If you do several row selections in succession, each selection is applied to the previously selected rows. With each selection, the number of rows will decrease (or possibly stay the same); it will never increase.

The Selections in Effect at the top of the dialog displays every selection currently applied to the worksheet or table. The Number of Rows Selected shows the number of rows remaining after these selections.

To undo all of the selections and return to the original number of rows at any time, click Reset to All.

Examples and Tips

Here are some examples:

```
First Name: has the value(s): john
Cost: is greater than: 12,000
Date: is greater than or equal to: 1/1/99
Price: is between: 20 and 29.99
Date: is between: 1/1/00 and 7/15/00
```

You may specify more than one value in each criterion when using any of the following:
• has the value(s)
• does not have the value(s)
• contains the substring(s)
• does not contain the substring(s)
• begins with
• ends with

For example:

```
First Name: has the value(s): john peter
```

In this case, a row is selected if First Name is either john or peter.

Note: When entering a list of values, separate them by spaces.

Here are some additional examples:

```
Quantity: has the value(s): 1 2 3
Date: has the value(s): 8/15/00 8/16/00
```

If you are looking for an alphanumeric value that contains spaces, put single quotes (’ , not ”) around the value. For example:

```
Address: contains the substring(s): 'Main Street'
```
Some columns may have missing (N/A) values on some rows. To select rows where a column is (or is not) N/A, use a value of \textit{NA}. For example:

| Quantity | \textit{does not have the value(s)} | NA |

Alphanumeric values, multiple numeric values, or \textit{NA} cannot be used when specifying a range. For example, the following is not valid:

| Price | \textit{is between} | 20 30 | and | 29.99 |

**Select rows (shortcut)**

1010data provides a quick and easy way to perform a row selection on the current table or worksheet.

To select rows from the current table or worksheet using the shortcut menu:

1. In an open table or worksheet, right-click a cell on which you would like to base the desired row selection.

   A shortcut menu is presented.

2. Click the desired item:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select rows where (&lt;\text{column_name}) has the value (&lt;\text{cell_value})&gt;</td>
<td>Rows that have the same value in the same column as the cell in which you right-clicked will be selected.</td>
</tr>
<tr>
<td>Select rows where (&lt;\text{column_name}) does not have the value (&lt;\text{cell_value})&gt;</td>
<td>Rows that do not have the same value in the same column as the cell in which you right-clicked will be selected.</td>
</tr>
</tbody>
</table>

If you do several row selections in succession, each selection is applied to the previously selected rows. With each selection, the number of rows will decrease (or possibly stay the same); it will never increase.

**Select rows (advanced)**

You can define a subset of rows using a \textit{selection expression}, a mathematical formula that evaluates to 1 (true) or 0 (false).

To select rows using a selection expression:

1. In an open table or worksheet, click \textbf{Rows > Select Rows (Advanced)}...

   The \textbf{Select Rows (Advanced)} dialog is presented.

2. \textbf{(required)} In the \textbf{Expression} text box, enter a selection expression, which will be used to define a subset of rows.

   The selection expression may refer to one or more columns and may include standard arithmetic, relational, and logical operators as well as any of 1010data's functions.

   \textbf{Note:} When referring to a column in an expression, use the column name as opposed to the column heading. A list of all the column names for the table appears at the bottom of the \textbf{Select Rows (Advanced)} dialog.

For example, to select rows where the transaction ID (\textit{transid}) is between 535 and 540, use the selection expression \textit{between}(\textit{transid};535;540).

Generally, each operator and function in the selection expression deals with N/A values in a reasonable way, but see the description of each operator and function for details. For instance, \textit{price}<100 is 0
(false) for any N/A values in the price column; to select rows where a column is (or is not) N/A, use a value of NA (e.g., price<>NA).

3. (optional) Select **Treat special values as NA?** if you want special values treated as N/A in calculations. Although the majority of table columns do not have special values, some columns have special values that represent a kind of missing value. Special values are specified when the data is initially loaded into 1010data. To find out if a column has special values, show the column information for that column (or for all columns).

   **Note:** There is a performance degradation associated with selecting this option, so it is best to not select it unless special values are, in fact, present.

   In a **Price** column, for instance, a value of 999 might indicate that the price was unavailable, while a value of 888 might mean that it was not applicable. In both cases, the values would be treated as N/A rather than used in calculations if this option was selected.

4. Select **Keep the current row order?** if you want to display the selected rows in the same order as they appeared in the original table or worksheet.

   If this check box is clear, the rows in the resultant selection will appear in an arbitrary order.

   **Note:** For very large tables, clearing this check box can noticeably speed up the selection.

5. Click **Select**.

   Only those rows for which the selection expression evaluates to true will be displayed. Also, if you summarize the data, only the selected rows will be included in the summary.

   **Note:** The selection applies only to your session and does not affect the original table.

   If you do several row selections in succession, each selection is applied to the previously selected rows. With each selection, the number of rows will decrease (or possibly stay the same); it will never increase.

   The **Selections in Effect** at the top of the dialog displays every selection currently applied to the worksheet or table. The **Number of Rows Selected** shows the number of rows remaining after these selections.

   To undo all of the selections and return to the original number of rows at any time, click **Reset to All**.

### Go to a specific row

Position the table at a particular row.

To go to a specific row in a table or worksheet:

1. In an open table or worksheet, click **Rows > Go to Row...**

   The **Go to a Specific Row** dialog is presented.

2. Perform one of the following actions:

   • Enter a valid row number in the **Row** text box and click **Submit**.
   • Click **Previous** to go to the row before the current row.

      **Note:** This button is unavailable if the current row is the first row in the table.
   • Click **Next** to go to the row after the current row.

      **Note:** This button is unavailable if the current row is the last row in the table.
   • Click **First** to go to the first row in the table.

      **Note:** This button is unavailable if the current row is the first row in the table.
   • Click **Last** to go to the last row in the table.

      **Note:** This button is unavailable if the current row is the last row in the table.

   The table will be positioned at the row specified.
**Find rows**

Wherever you are in a table, you can easily find the next (or previous) row that contains certain values or meets certain criteria.

To find a particular row in the current table or worksheet:

1. In an open table or worksheet, click **Rows > Find Row...**

   The **Find Row** dialog is presented.

2. Specify the criteria for the row you want to find:

   For each criterion, you may choose a column and a relationship (equal to, greater than, etc.) and enter a value (or values), or you may specify a range for a given column.

   **Note:** The order in which the column headings appear in the drop-down lists can be set using the **In selection boxes, show columns in** preference under the **User Preferences** section of the **Set Preferences** dialog.

   **Action** | **Procedure**
   --- | ---
   To specify a relationship between a column and particular values: | Using any of the top three selection entries:
   1. From the first drop-down list, select a column.
   2. From the second drop-down list, select a relationship.
   3. In the text box, enter a value (or values).
   **Note:** Separate multiple values by spaces.

   To specify a range for a particular column: | Using either of the bottom two selection entries:
   1. From the first drop-down list, select a column.
   2. In the first text box, enter the bottom value of the range.
   3. In the second text box, enter the top value of the range.

3. Click **Find Next** (or **Find Previous**) to find the next (or previous) occurrence of the row that meets all of the criteria specified.

   The row that matches all of the search criteria becomes the current row, and its row number is displayed at the top of the **Find Row** dialog. If no rows match the search criteria, an error message indicating that no matches have been found is displayed.

**Find rows (shortcut)**

1010data provides a quick and easy way to find a row in the current table or worksheet.

To find a particular row in the current table or worksheet using the shortcut menu:

1. In an open table or worksheet, right-click a cell on which you would like to base the criteria for the row you want to find.

   A shortcut menu is presented.

2. Click the desired item:
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find next row where <code>&lt;column_name&gt;</code> has the value <code>&lt;cell_value&gt;</code></td>
<td>Find the next row that has the same value in the same column as the cell in which you right-clicked.</td>
</tr>
<tr>
<td>Find next row where <code>&lt;column_name&gt;</code> does not have the value <code>&lt;cell_value&gt;</code></td>
<td>Find the next row that does not have the same value in the same column as the cell in which you right-clicked.</td>
</tr>
<tr>
<td>Find previous row where <code>&lt;column_name&gt;</code> has the value <code>&lt;cell_value&gt;</code></td>
<td>Find the previous row that has the same value in the same column as the cell in which you right-clicked.</td>
</tr>
<tr>
<td>Find previous row where <code>&lt;column_name&gt;</code> does not have the value <code>&lt;cell_value&gt;</code></td>
<td>Find the previous row that does not have the same value in the same column as the cell in which you right-clicked.</td>
</tr>
</tbody>
</table>

The row that matches the search criteria becomes the current row.

**Find rows (advanced)**

You can find particular rows using a *selection expression*, a mathematical formula that evaluates to 1 (true) or 0 (false).

To find a particular row using a selection expression:

1. In an open table or worksheet, click **Rows > Find Row (Advanced)...**
   
   The **Find Row** dialog is presented.

2. *(required)* In the **Expression** text box, enter a selection expression, which will be used to find a particular row.

   The selection expression may refer to one or more columns and may include standard arithmetic, relational, and logical operators as well as any of 1010data's functions.

   **Note:** When referring to a column in an expression, use the column name as opposed to the column heading. A list of all the column names for the table appears at the bottom of the **Find Row** dialog.

   For example, to find a row where the transaction ID (`transid`) is between 535 and 540, use the selection expression `between(transid;535;540)`.

   Generally, each operator and function in the selection expression deals with N/A values in a reasonable way, but see the description of each operator and function for details. For instance, `price<100` is 0 (false) for any N/A values in the `price` column; to find rows where a column is (or is not) N/A, use a value of `NA` (e.g., `price<>NA`).

3. *(optional)* Select **Treat special values as NA?** if you want special values treated as N/A in calculations.

   Although the majority of table columns do not have special values, some columns have special values that represent a kind of missing value. Special values are specified when the data is initially loaded into 1010data. To find out if a column has special values, show the column information for that column (or for all columns).

   **Note:** There is a performance degradation associated with selecting this option, so it is best to not select it unless special values are, in fact, present.

   In a **Price** column, for instance, a value of 999 might indicate that the price was unavailable, while a value of 888 might mean that it was not applicable. In both cases, the values would be treated as N/A rather than used in calculations if this option was selected.
4. Click **Find Next** (or **Find Previous**) to find the next (or previous) occurrence of the row for which the selection expression evaluates to true.

The next (or previous) row for which the selection expression evaluates to true becomes the current row, and its row number is displayed at the top of the **Find Row** dialog. If no rows match the search criteria, an error message indicating that no matches have been found is displayed.

**Sort the rows of a table**

You may reorder the rows of a table such that the values in a particular column are in ascending or descending order.

You must be viewing multiple rows of a table in order to perform a sort. You will not be able to sort if you are only viewing one row at a time.

To sort the rows of a table:

In an open table or worksheet, at the top of the column on which you would like to base the sort:

- Click the up arrow icon (↑) to sort the rows such that the values in that column are in ascending order.
- Click the down arrow icon (↓) to sort the rows such that the values in that column in descending order.

Sorting may be applied to both numeric and alphanumeric columns.

**Note:** The change applies only to your current worksheet and does not affect the original table.

To reorder the table based on more than one column, simply sort by one column and then by the others. For instance, sometimes you may want to sort the table so that one column is the primary sort “key” and the second column is the secondary key. In this case, the values in the first column would be sorted across all the rows of the table, and the values in the second column would be sorted in order *only for those rows whose values in the first column are the same*. To get this effect, sort first by the second column and then by the first.

**Columns**

Every table consists of columns, which each contain data of a particular type. You can rearrange the order of columns, hide columns, show meta information about columns, or create computed columns.

Columns can be identified by either their column heading or their column name. The **column heading** may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you would like to have a multi-line column heading, you can use the backtick character (`) to separate the lines (e.g., "Percentage of `Total Sales (%)""). By default, the column heading appears at the top of the column in the 1010data web interface.
The column name is a way of referring to the column internally in value expressions and selection expressions. The column name may only contain alphanumeric characters or underscores and must begin with an alphabetic character (e.g., `percent_total_sales`). It may not contain any spaces or other special characters.

**Note:** To control whether the column heading or the column name is displayed at the top of the column in the 1010data web interface, click **View > Set Preferences** and change the **Show columns headings as** setting under the **User Interface** section.

### Computed Columns

Computed columns are columns that you add to a table, whose values are based on one or more existing columns.

A computed column is determined by a given value expression. The value expression may refer to one or more columns and may include standard arithmetic, relational, and logical operators.

For example, suppose the table has the columns **Sales** and **Cost**. You can create a new column **Margin**, which is **Sales** minus **Cost**.

In the Macro Language, the code to create this computed column would be:
Note: Column names (e.g., sales), not column headings (e.g., Sales) are used in value expressions.

In addition to simple arithmetic operators, there are more advanced mathematical functions, functions that perform mathematical operations on dates (e.g., find the number of days between the dates in two columns), functions to manipulate strings, and categorization functions (e.g., is the value in the column between 0 and 10, between 10 and 100, or greater than 100?)

For example, to find the sum of sales for each store in the Sales Item Detail table, we can create a computed column that uses the G_Function $g\_sum(G;S;X)$. In the Macro Language, the code to create this computed column would be:

```
<willbe name="sum_of_sales" value="g_sum(store;;sales)" label="Sum of Sales"/>
```

In this example, $G$ is the column we're grouping on (in our example, store); $S$ is a selection column (by omitting a value for this, we're telling the G_Function to select all rows when computing the sum); and $X$ is the column we are acting on (in our example, we want the sum of sales).

An important feature of computed columns is that missing ("N/A") values are handled automatically. For example, if Sales is N/A on one or more rows, then Margin (Sales minus Cost) will also be N/A on those rows. See the description of each operator and function for details about the way it handles N/A values.

Create a computed column

You can create a computed column whose values are determined by a given value expression.

To create a computed column in a table:

1. In an open table or worksheet, click Columns > Create Computed Column...

   The Create Computed Column dialog is presented.

2. In the Column Name text box, enter the name that you wish to give to the column. *(required)*

   The column name is a way of referring to the column internally in value expressions and selection expressions. The column name must be a single word consisting of alphanumeric characters or underscores, and must begin with an alphabetic character (e.g., last_visit_date). It may not contain any spaces or other special characters.

   Note: This is different from the Column Heading, which is the text displayed at the top of the column.

3. In the Column Heading text box, enter the text that will appear at the top of the column when the table is displayed. *(optional)*

   The column heading may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. You may leave this blank, in which case the column's heading will be the same as its name. If you would like the heading to have more than one line, use `\` to separate the lines (e.g., Date of`Last Visit).

   Note: On most American keyboards, the `\` character is immediately to the left of 1.

4. In the Value Expression text box, enter a mathematical formula that will determine the value of the computed column. *(required)*

   The value expression may refer to one or more columns and may include standard arithmetic, relational, and logical operators as well as any of the Macro Language functions.

   Note: When referring to a column in an expression, use the column name as opposed to the column heading. A list of all the column names for the table appears at the bottom of the Create Computed Column dialog.

5. Select Treat special values as NA? if you want special values treated as N/A in calculations. *(optional)*

   Although the majority of table columns do not have special values, some columns have special values that represent a kind of missing value. Special values are specified when the data is initially loaded into
the 1010data Insights Platform. To find out if a column has special values, show the column information for that column (or for all columns).

**Note:** There is a performance degradation associated with selecting this option, so it is best to not select it unless special values are, in fact, present.

In a **Price** column, for instance, a value of 999 might indicate that the price was unavailable, while a value of 888 might mean that it was not applicable. In both cases, the values would be treated as N/A rather than used in calculations if this option was selected.

6. Select the **Display Format** from the drop-down list. *(optional)*

The display format for the computed column specifies how the values will be displayed in the table.

**Note:** If set to **Default**, the format is determined by the data.

For example, dates are stored as integers in the 1010data Insights Platform (in **YYYYMMDD** form). To display a date as **MM/DD/YYYY**, choose the appropriate display format from the list.

7. Select the **Column Width** from the drop-down list. *(optional)*

This is the desired width of the column (number of characters).

**Note:** If set to **Default**, the width is determined by the data.

8. Select the **Decimal Places** from the drop-down list. *(optional)*

This is the number of decimal places to show for numbers.

**Note:** If set to **Default**, the number of decimal places is determined by the data and may be different for each row.

9. Click **Submit**.

The computed column is added to the table.

**Note:** Computed columns apply only to your session and do not affect the original table or any other tables.

**Fixed Columns**

Fixed columns, when they exist in a table, are always visible and are separated from the other columns by a vertical orange line.

Fixed columns do not scroll off the page, regardless of how far the table is scrolled in either direction. This is useful when a column has key information about each row that the user would always like to see.

In the following example, the **State** and **Month** columns are fixed columns. You can see the vertical orange line separating them from the other columns.
Fixed columns will remain visible even if you scroll all the way to the right, to the last column of the table, as shown in the following example:

Tables do not necessarily need to be loaded with fixed columns. However, you can imagine that in some tables it would be useful from an end user's perspective.
Once a table is opened, a user can actually modify which columns are fixed through one of two methods:

- Tabulations
- Macro Language

**Tabulations**

After a tabulation, the "group by" (aka `<breaks>`) columns are automatically fixed.

For example, let's do a tabulation on the **Monthly Statewide Non-Seasonally Adjusted Unemployment Statistics** table. If we group by state and take the average of the unemployment rate for each state, the resultant table will be displayed as follows:

![Example of a tabulated table showing average unemployment rates by state](image)

Note that the **State** column appears as a fixed column (to the left of the vertical orange line) because we grouped by that column in our tabulation.

**Macro Language**

The `fixed` attribute of the `<col>` element in the Macro Language can be used to fix (or unfix) columns.

The following Macro Language code will add the **Unemployed** column to the fixed columns:

```xml
<col name="unemp" fixed="1"/>
```
Because the **Unemployed** column is now a fixed column, it appears to the left of the vertical orange line, with all the other non-fixed columns to its right.

If you wanted to unfix a column, you would set the `fixed` attribute to 0:

```xml
<col name="month" fixed="0"/>
```
Notice how the **Month** column is now positioned to the right of the vertical orange line, signifying that it is not a fixed column any longer.

**Show information about one column**

Display information about a particular column in the current table or worksheet.

To show information about one column:

In an open table or worksheet, click the question mark icon (?) at the top of the column.

A new window is opened containing meta information about that column:

- Name
- Data Type
- Display Format
- Special Values
- Description

It includes summary statistics for that column:

- Minimum Value
- Average Value
- Maximum Value
- Unique Values
- Missing Values

It also displays the number of times every unique value appears in the column.
Show information about all columns

Display information about every column in the current table or worksheet.

To show information for all columns:

In an open table or worksheet, click **Columns > Column Information**.

A new window is opened containing meta information about every column in the current table or worksheet, including:

- Column Heading
- Column Name
- Data Type
- Display Format
- Text Searches
- Special Values
- Description
Example

### Determine the data type of a column

Columns can be one of the simple data types in 1010data: integer, decimal, and text.

To determine the data type of a column in 1010data:

- When viewing the table in the 1010data web interface, click the icon in the column's header.

You will be presented with a window that displays the **Data Type** for that column:

- Or, click **Columns > Column Information** from the menu bar of the 1010data web interface.

You will be presented with a window that displays the information about all of the columns in the table, including the **Data Type** for each column.
Go to a specific column

Position the table at a specific column.

To go to a specific column in a table or worksheet:

1. In an open table or worksheet, click **Columns > Go to Column**...

   The **Go to Column** dialog is presented.

2. Select the desired column from the drop-down list.

3. Click **Submit**.

   The selected column will be positioned immediately after any fixed columns.

   **Note:** The results are only visible when you are viewing multiple rows at a time.

Rearrange columns

You may choose to display a subset of the columns in a table and specify the order in which they appear.

To rearrange columns in a table or worksheet:

1. In an open table or worksheet, click **Columns > Rearrange Columns**...

   The **Select and Rearrange Columns** dialog is presented:

   - The **Available Columns** list on the left shows all the table's columns in their original order (including computed columns and columns that have been linked in from other tables or worksheets).
   - The **Displayed Columns** list on the right shows the currently selected columns in the order in which they are displayed.

2. Perform any of the following actions to customize your table view:

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To display one or more columns that are currently hidden (or to reorder columns that are currently displayed):</strong></td>
<td></td>
</tr>
<tr>
<td>1. In the <strong>Available Columns</strong> list, select the column(s) to display (or reorder).</td>
<td></td>
</tr>
<tr>
<td>2. In the <strong>Displayed Columns</strong> list, select the column after which to display the column(s) specified in the prior step.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> To display columns first, select the blank row at the top of the <strong>Displayed Columns</strong> list. (Fixed columns will always appear before all other columns.)</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Show After</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>To hide one or more columns that are currently displayed:</strong></td>
<td></td>
</tr>
<tr>
<td>1. In the <strong>Displayed Columns</strong> list, select the column(s) to remove from view.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Hide</strong>.</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Procedure</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>To display a different set of columns:</td>
<td>1. In the Available Columns list, select the column(s) to display in the current table or worksheet.</td>
</tr>
<tr>
<td></td>
<td>2. Click Show Only.</td>
</tr>
<tr>
<td>To display columns in their original order:</td>
<td>1. Click Reset.</td>
</tr>
</tbody>
</table>

**Note:** This changes only how your table or worksheet is displayed and does not affect the original table in any way.

## Hide columns

You can remove certain columns from view in a 1010data table, which can be particularly helpful for tables that have many columns.

To hide a column in a 1010data table, perform either of the following actions:

- Right-click on the header of the column that you want to hide, and click **Hide Column**.
- Click **Columns > Rearrange Columns...** and select the columns you want to hide using the **Select and Rearrange Columns** dialog.

**Note:** This affects only how your table or worksheet is displayed and does not change the original table in any way.
Summarizations and Tabulations

Some of the basic ways to analyze your data using 1010data include quick summaries, tabulations, and cross tabulations.

Oftentimes, you may want to determine the total of all the values in a particular column or the average of those values. Or perhaps you want to find the highest or lowest value in a column. A quick summary allows you to perform calculations on one or more columns in a 1010data table to ascertain these quantities very easily.

Using tabulations, you can summarize the values in a column (or columns) based on the values in another column (or columns) and display those results in a tabular format.

For example, suppose a table has a row for every employee and columns Name, Title, Department, and Salary. Using a tabulation, we can compute the number of people and average salary for each department. The result will look something like:

<table>
<thead>
<tr>
<th>Department</th>
<th>Count</th>
<th>Average Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance</td>
<td>228</td>
<td>73,946</td>
</tr>
<tr>
<td>Marketing</td>
<td>35</td>
<td>61,778</td>
</tr>
<tr>
<td>Sales</td>
<td>41</td>
<td>87,562</td>
</tr>
<tr>
<td>Engineering</td>
<td>67</td>
<td>92,962</td>
</tr>
<tr>
<td>Technology</td>
<td>34</td>
<td>69,276</td>
</tr>
</tbody>
</table>

The cells in the top row beneath the column headings are column aggregates. In this example, the total number of employees (which corresponds to the number of rows in the original table) is 228, and the average salary across all departments is 73,946.

A cross tabulation allows you to summarize the values in a column based on the values in two or more other columns and display the result as a matrix.

In our above example, we could use a cross tabulation to compute the average salary in each department for each title. This would result in a table with one row for each department and one column for each title:

<table>
<thead>
<tr>
<th>Department</th>
<th>VP</th>
<th>AVP</th>
<th>Manager</th>
<th>Grunt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance</td>
<td>143,356</td>
<td>118,979</td>
<td>85,345</td>
<td>85,345</td>
</tr>
<tr>
<td>Marketing</td>
<td>95,774</td>
<td>85,812</td>
<td>70,553</td>
<td>48,944</td>
</tr>
<tr>
<td>Sales</td>
<td>127,344</td>
<td>127,664</td>
<td>100,359</td>
<td>70,686</td>
</tr>
<tr>
<td>Engineering</td>
<td>155,863</td>
<td>125,268</td>
<td>100,945</td>
<td>74,314</td>
</tr>
<tr>
<td>Technology</td>
<td>116,181</td>
<td>94,189</td>
<td>78,594</td>
<td>53,997</td>
</tr>
</tbody>
</table>

In this example, we can see that the average salary for AVPs in Engineering is 94,189. The cells in the first row beneath the column headings and the first column next to the row headings are aggregates. The first row of data contains the average salaries across all departments for each title (e.g., the average salary for all VPs is 143,356). Similarly, the first column of data contains the average salaries across all titles for each department (e.g., the average salary for all people in the Finance department is 61,778). The top left-most cell of data is the average for all employees across all departments and titles, which is 73,946.

Certain types of summarizations require a second column to perform the computation. For instance, a weighted average requires two columns: the column on which you are calculating the average and the
column that contains the weight. Other examples of summarizations that involve two columns of data include the correlation, dot product, or covariance of two columns.

Missing values in the data are handled automatically in 1010data. For example, if you are computing the average value of a column that has some missing (N/A) values, those values are ignored when computing the average.

Quick summaries, tabulations, and cross tabulations can be performed easily using the 1010data web interface. In addition, the 1010data Macro Language functions (in particular, G_Functions) provide a comprehensive set of tools for performing similar and more advanced operations on data in 1010data. For instance, you can obtain the same information from the tabulation in the above example using a very simple G_Function: To find out the average salary for each department, you could create a computed column and use the \texttt{g_avg} function as its value expression. The results of the cross tabulation could be determined in a similar way. And this is just the tip of the iceberg when it comes to G_Functions. The potential for data discovery using these powerful tools is limitless.

### Perform a quick summary

A quick summary allows you to perform calculations on one or more columns in a table on the 1010data Insights Platform very easily.

To perform a quick summary on one or more columns:

1. In an open table or worksheet, click **Analysis > Quick Summary**...
   
   The Quick Summary dialog is presented.

2. For each column of data that you want to summarize:
   a) From the **Column** drop-down list, select the column you would like to summarize.
   b) From the **Type of Summary** drop-down list, select the type of summarization.
   c) If the type of summarization you are performing requires a second column, select that column from the **Reference Column** drop-down list.

   See **Types of Summarizations for Quick Summaries** on page 77 for which calculations require a reference column.

   **Note:** To change the number of summarizations that appear in the Quick Summary dialog, click **View > Set Preferences** and change the Number of Summarizations for Quick Summary setting under the User Interface section.

3. Click **Submit**.

   The resultant table will contain the summarizations you have specified.

Missing values in the data are handled automatically. For example, if you are computing the average value of a column that has some missing (N/A) values, those values are ignored when computing the average. See the descriptions of the individual types of summarizations to see how N/A values are handled for each.

### Example

The following table is the result of a quick summary that calculates the sum of sales, average cost, and highest number of units sold across all transactions in the **Sales Item Detail** table:
### Types of Summarizations for Quick Summaries

The **Type of Summary** drop-down in the **Quick Summary** dialog contains a number of summarizations.

<table>
<thead>
<tr>
<th>Type of Summarization</th>
<th>Description</th>
</tr>
</thead>
</table>
| **number of unique values** | The number of unique values in the **Column**.  
  - If the column contains N/A values, those values are ignored (i.e., the result is the number of unique non-N/A values).  
  - If the column contains only N/A values, the result is 0. |
| **sum** | The total for the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the sum of the non-N/A values).  
  - If the column contains only N/A values, the result is 0. |
| **average** | The average of the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the average of the non-N/A values).  
  - If the column contains only N/A values, the result is N/A. |
| **weighted average** | The average of the **Column** weighted by the **Reference Column**. *(numeric columns only)*  
  - If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the weighted average for those rows where neither the **Column** nor the **Reference Column** is N/A).  
  - If there are no such rows, the result is N/A. |
| **highest number** | The highest number in the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the highest non-N/A value).  
  - If the column contains only N/A values, the result is N/A. |
| **lowest number** | The lowest number in the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the lowest of the non-N/A values).  
  - If the column contains only N/A values, the result is N/A. |
| **standard deviation** | The standard deviation of the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the standard deviation of the non-N/A values).  
  - If the column contains only N/A values, the result is N/A. |
| **variance** | The variance of the **Column**. *(numeric columns only)*  
  - If the column contains N/A values, those values are ignored (i.e., the result is the variance of the non-N/A values). |
| **weighted std dev** | The standard deviation of the **Column** weighted by the **Reference Column**.  
(***numeric columns only***)  
- If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the weighted standard deviation for those rows where neither the **Column** nor the **Reference Column** is N/A).  
- If there are no such rows, the result is N/A. |
| **weighted variance** | The variance of the **Column** weighted by the **Reference Column**.  
(***numeric columns only***)  
- If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the weighted variance for those rows where neither the **Column** nor the **Reference Column** is N/A).  
- If there are no such rows, the result is N/A. |
| **sum of squares** | The sum of squares for the **Column**.  
(***numeric columns only***)  
- If the column contains N/A values, those values are ignored (i.e., the result is the sum of squares of the non-N/A values).  
- If the column contains only N/A values, the result is 0. |
| **correlation** | The correlation of the **Column** with the **Reference Column**.  
(***numeric columns only***)  
- If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the correlation for those rows where neither the **Column** nor the **Reference Column** is N/A).  
- If there aren't at least two such rows, the result is N/A. |
| **covariance** | The covariance of the **Column** and the **Reference Column**.  
(***numeric columns only***)  
- If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the covariance for those rows where neither the **Column** nor the **Reference Column** is N/A).  
- If there are no such rows, the result is N/A. |
| **dot product** | The dot product of the **Column** and the **Reference Column**.  
(***numeric columns only***)  
- If either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result is the dot product for those rows where neither the **Column** nor the **Reference Column** is N/A).  
- If there are no such rows, the result is 0. |
| **number of valid values** | The number of non-N/A values in the **Column**. |
| **number of N/As** | The number of N/A values in the **Column**. |
| **number of valid pairs** | The number of rows where both the **Column** and the **Reference Column** are not N/A. |
| **number of N/A pairs** | The number of rows where either the **Column** or the **Reference Column** is N/A. |
Perform a tabulation

A tabulation allows you to group the values in a column (or columns) based on the values in another column (or columns) and summarize the data for each group.

To perform a tabulation on one or more columns in a table or worksheet:

1. In an open table or worksheet, click **Analysis > Tabulation...**

   The **Tabulation** dialog is presented.

2. Enter a **Title** for the tabulation. (*optional*)

3. For each column by which you would like to group the records:
   a) From the **Column** drop-down list, select the desired column.
   b) If you want the data in this column sorted, select the order from the **Sort** drop-down.
   c) If you would like a subtotal of the summarizations for this particular group included as a row in the resultant table, select **Roll up**.

   All rows that have the same values for all of the columns specified will be considered part of one group.

   **Note:** To change the number of grouping columns that appear in the **Tabulation** dialog, click **View > Set Preferences** and change the **Number of Grouping Columns for Tabulation** setting under the **User Interface** section.

4. For each column of data that you want to summarize:
   a) From the **Column** drop-down list, select the column you would like to summarize.
   b) From the **Type of Summary** drop-down list, select the type of summarization.

   **Note:** For the number of records per group (i.e., **number of records**), you don't have to specify a column.
   c) If the type of summarization you are performing requires a second column, select that column from the **Reference Column** drop-down list.

   See **Types of Summarizations for Tabulations** on page 81 for which calculations require a reference column.

   **Note:** To change the number of summarizations that appear in the **Tabulation** dialog, click **View > Set Preferences** and change the **Number of Summarizations for Tabulation** setting under the **User Interface** section.

By default, 1010data gives the resultant summarization columns generic headings (e.g., *Sum of Sales*, *Highest Cost*) and system-generated column names (e.g., *t0*, *t1*). If you want to give the resultant summarization columns more meaningful headings and/or names, or if you would like to specify display formats for the data in those columns (i.e., type, width, decimal places), provide that information as described below:

a) To display the inputs for the additional attributes of the resultant summarization columns, either click the icon to show the inputs as a table or click the icon to show the inputs sequentially in a list.

b) In the **Result Name** text box, enter the name that you wish to give the result column. (*optional*)

   The result name is a way of referring to this column internally in value expressions and selection expressions. The result name must be a single word consisting of alphabetic characters or underscores, and must begin with an alphabetic character (e.g., *total_sales_by_store*). It may not contain any spaces or other special characters.

   **Note:** This is different from the **Result Heading**, which is the text displayed at the top of the result column.

   **Note:** To change the number of summarizations that appear in the **Tabulation** dialog, click **View > Set Preferences** and change the **Number of Summarizations for Tabulation** setting under the **User Interface** section.

   c) In the **Result Heading** text box, enter the text that will appear at the top of the result column when the table is displayed. (*optional*)
The result heading may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you would like the result heading to have more than one line, use ` to separate the lines (e.g., `Total Sales by Store`).

**Note:** On most American keyboards, the ` character is immediately to the left of 1.

d) Select the **Display Format** from the drop-down list. *(optional)*

The display format for the result column specifies how the values will be displayed in the table.

**Note:** If set to **Default**, the format is determined by the data.

For example, dates are stored as integers in 1010data (in **YYYYMMDD** form). To display a date as **MM/DD/YYYY**, choose the appropriate display format from the drop-down.

e) Select the **Column Width** from the drop-down list. *(optional)*

This is the desired width of the result column (number of characters).

**Note:** If set to **Default**, the width is determined by the data.

f) Select the **Decimal Places** from the drop-down list. *(optional)*

This is the number of decimal places to show for numbers in the result column.

**Note:** If set to **Default**, the number of decimal places is determined by the data, and may be different for each row.

5. Click **Submit**.

The result of a tabulation is a dynamic table that may be manipulated just like any other table. You may download the results, select rows, sort rows, rearrange columns, create computed columns, link in other tables, and even apply another tabulation or cross tabulation.

Missing values in the data are handled automatically. For example, if you are computing the average value of a column that has some missing (N/A) values in a particular group of rows, those values are ignored when computing the average. See the descriptions of the individual types of summarizations to see how N/A values are handled for each.

**Example**

The following table is the result of a tabulation that calculates the sum of sales for each unique grouping of both store and transaction ID, with a roll up selected for transaction ID. (The roll ups are circled in red.)
Types of Summarizations for Tabulations

The Type of Summary drop-down in the Tabulation dialog contains a number of summarizations.

<table>
<thead>
<tr>
<th>Type of Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>number of records</td>
<td>The number of rows in each group.</td>
</tr>
<tr>
<td></td>
<td>• The number of rows includes those with N/A values.</td>
</tr>
<tr>
<td>% of total records</td>
<td>The number of rows in each group as a percentage of all rows.</td>
</tr>
<tr>
<td></td>
<td>• The number of rows includes those with N/A values.</td>
</tr>
<tr>
<td></td>
<td>Note: The result is a whole number, not a fractional value. For instance, a</td>
</tr>
<tr>
<td></td>
<td>result of 20% would be represented as 20, not 0.20.</td>
</tr>
<tr>
<td>fraction of total</td>
<td>The number of rows in each group as a fraction of all rows.</td>
</tr>
<tr>
<td>records</td>
<td>• The number of rows includes those with N/A values.</td>
</tr>
<tr>
<td></td>
<td>Note: The result is a fractional value. For instance, a result of 20% would</td>
</tr>
<tr>
<td></td>
<td>be represented as 0.20.</td>
</tr>
<tr>
<td>rank of # records</td>
<td>The rank of each group, in terms of its number of records, with respect to</td>
</tr>
<tr>
<td></td>
<td>all other groups.</td>
</tr>
<tr>
<td></td>
<td>• The rank includes rows with N/A values.</td>
</tr>
<tr>
<td>number of unique values</td>
<td>The number of unique values in the Column for each group.</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is</td>
</tr>
<tr>
<td></td>
<td>the number of unique non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
<tr>
<td>sum</td>
<td>The subtotal of the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is</td>
</tr>
<tr>
<td></td>
<td>the sum of the non-N/A values).</td>
</tr>
<tr>
<td>% of grand total</td>
<td>The subtotal of the Column for each group as a percentage of the grand total. (numeric columns only)</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a percentage of the sum of the non-N/A values in the entire column).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
<tr>
<td><strong>Note</strong>: The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>fraction of grand total</th>
<th>The subtotal of the Column for each group as a fraction of the grand total. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a fraction of the sum of the non-N/A values in the entire column).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
<tr>
<td><strong>Note</strong>: The result is a fractional value. For instance, a result of 20% would be represented as 0.20.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>rank of sum</th>
<th>The rank of each group, in terms of its Column subtotal, with respect to the other groups. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its subtotal of non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result is the rank with respect to a subtotal of 0.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>average</th>
<th>The average of the Column for each group. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the average of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>rank of average</th>
<th>The rank of each group, in terms of its Column average, with respect to the other groups. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its average of non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>weighted average</th>
<th>The average of the Column, weighted by the Reference Column, for each group. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the weighted average for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is N/A.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>highest number</th>
<th>The highest number in the Column for each group. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the highest non-N/A value).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>lowest number</th>
<th>The lowest number in the Column for each group. (numeric columns only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the lowest non-N/A value).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td>Summary Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>first value</strong></td>
<td>The first value in the Column for each group. <em>(alphanumeric and numeric columns)</em> This is the first value based on the current sort order of the table (i.e., the way the data is shown when the table is viewed multiple rows at a time).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains N/A values, those rows are ignored (i.e., the result is the first of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>last value</strong></td>
<td>The last value in the Column for each group. <em>(alphanumeric and numeric columns)</em> This is the last value based on the current sort order of the table (i.e., the way the data is shown when the table is viewed multiple rows at a time).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains N/A values, those rows are ignored (i.e., the result is the last of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>standard deviation</strong></td>
<td>The standard deviation of the Column for each group. <em>(numeric columns only)</em></td>
</tr>
<tr>
<td></td>
<td>- If a group contains N/A values, those rows are ignored (i.e., the result is the standard deviation of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>variance</strong></td>
<td>The variance of the Column for each group. <em>(numeric columns only)</em></td>
</tr>
<tr>
<td></td>
<td>- If a group contains N/A values, those rows are ignored (i.e., the result is the variance of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>weighted std dev</strong></td>
<td>The standard deviation of the Column, weighted by the Reference Column, for each group. <em>(numeric columns only)</em></td>
</tr>
<tr>
<td></td>
<td>- If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the weighted standard deviation for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>- If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>weighted variance</strong></td>
<td>The variance of the Column, weighted by the Reference Column, for each group. <em>(numeric columns only)</em></td>
</tr>
<tr>
<td></td>
<td>- If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the weighted variance for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>- If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>sum of squares</strong></td>
<td>The sum of squares of the Column for each group. <em>(numeric columns only)</em></td>
</tr>
<tr>
<td></td>
<td>- If a group contains N/A values, those rows are ignored (i.e., the result is the sum of squares of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>- If a group contains only N/A values, the result for the group is 0.</td>
</tr>
<tr>
<td><strong>correlation</strong></td>
<td>The correlation of the Column and the Reference Column, for each group. <em>(numeric columns only)</em></td>
</tr>
</tbody>
</table>
- If, for a particular group, either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result for the group is the correlation for those rows where neither the **Column** nor the **Reference Column** is N/A).
- If there aren’t at least two such rows in the group, the result is N/A.

**covariance**

The covariance of the **Column** and the **Reference Column**, for each group. *(numeric columns only)*

- If, for a particular group, either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result for the group is the covariance for those rows where neither the **Column** nor the **Reference Column** is N/A).
- If there are no such rows, the result for the group is N/A.

**dot product**

The dot product of the **Column** and the **Reference Column**, for each group. *(numeric columns only)*

- If, for a particular group, either the **Column** or the **Reference Column** contains N/A values, those rows are ignored (i.e., the result for the group is the dot product for those rows where neither the **Column** nor the **Reference Column** is N/A).
- If there are no such rows, the result for the group is 0.

**number of valid values**

The number of non-N/A values in the **Column** for each group.

**number of N/As**

The number of N/A values in the **Column** for each group.

**number of valid pairs**

The number of rows where both the **Column** and the **Reference Column** are not N/A, for each group.

**number of N/A pairs**

The number of rows where either the **Column** or the **Reference Column** is N/A, for each group.

**median**

The median of the **Column** for each group. *(numeric columns only)*

- If a group contains N/A values, those rows are ignored (i.e., the result is the median of the non-N/A values).
- If there are an even number of values, the median is the average of the two middle values.
- If a group contains only N/A values, the result for the group is N/A.

**mode**

The mode of the **Column** for each group. *(numeric columns only)*

- If a group contains N/A values, those rows are ignored (i.e., the result is the mode of the non-N/A values).
- If, for a given group, there is no unique mode, the result is arbitrary.
- If a group contains only N/A values, the result for the group is N/A.

**frequency of mode**

The frequency of the mode of the **Column** for each group. *(numeric columns only)*

- If a group contains N/A values, those rows are ignored (i.e., the result is the frequency of the mode of the non-N/A values).
- If a group contains only N/A values, the result for the group is 0.

**number of modes**

The number of modes in the **Column** for each group. *(numeric columns only)*

- If a group contains N/A values, those rows are ignored (i.e., the result is the number of modes within the non-N/A values).
- If a group contains only N/A values, the result for the group is 0.
Perform a cross tabulation

A cross tabulation allows you to summarize the values in a column based on the values in two or more other columns and display the result as a matrix.

To perform a cross tabulation:

1. In an open table or worksheet, click **Analysis > Cross Tabulation...**
   
   The **Cross Tabulation** dialog is presented.

2. Enter a **Title** for the cross tabulation. *(optional)*

3. For the rows in the resultant cross tabulation, specify all of the columns in the original table by which you would like to group the data.
   
   **Note:** All rows in the original table that have the same values for all of the columns specified here will be considered part of one group.

   For each column you want included in this group:
   
   a) From the **Rows of Result** drop-down list, select the desired column.
   
   b) If you want the data in this column sorted, select the order from the **Sort** drop-down.
   
   **Note:** To change the number of grouping columns that appear in the **Cross Tabulation** dialog, click **View > Set Preferences** and change the **Number of Row Dimensions for Cross Tabulation** setting under the **User Interface** section.

4. For the columns in the resultant cross tabulation, specify all of the columns in the original table by which you would like to group the data.

   **Note:** All rows in the original table that have the same values for all of the columns specified here will be considered part of one group.

   For each column you want included in this group:
   
   a) From the **Columns of Result** drop-down list, select the desired column.
   
   b) If you want the data in this column sorted, select the order from the **Sort** drop-down.
   
   **Note:** To change the number of grouping columns that appear in the **Cross Tabulation** dialog, click **View > Set Preferences** and change the **Number of Column Dimensions for Cross Tabulation** setting under the **User Interface** section.

5. For the column of data in the original table that you want to summarize:
   
   a) From the **Column** drop-down list, select the column you would like to summarize.
   
   b) From the **Type of Summary** drop-down list, select the type of summarization.
      
      **Note:** For the number of records per group (i.e., number of records), you don't have to specify a column.
   
   c) If the type of summarization you are performing requires a second column, select that column from the **Reference Column** drop-down list.
      
      See **Types of Summarizations for Cross Tabulations** on page 87 for which calculations require a reference column.
      
      d) Select the **Display Format** from the drop-down list. *(optional)*
      
      The display format specifies how the values will be displayed in the resultant table.
      
      **Note:** If set to **Default**, the format is determined by the data.
      
      For example, dates are stored as integers in 1010data (in YYYYMMDD form). To display a date as MM/DD/YYYY, choose the appropriate display format from the drop-down.
   
   e) Select the **Column Width** from the drop-down list. *(optional)*
   
   This is the desired width (number of characters) of the columns in the resultant table.
Note: If set to Default, the width is determined by the data.

f) Select the **Decimal Places** from the drop-down list. *(optional)*

This is the number of decimal places to show for numbers in the resultant table.

**Note:** If set to Default, the number of decimal places is determined by the data, and may be different for each row.

6. Select **Use long column headings for results** if you want the column headings in the resultant table to include the grouping columns' names in addition to the grouping columns' values.

The default behavior is to display only the values of the columns you are grouping on in the column headers of the resultant table. When this option is selected, the column headings will also include the grouping column names.

**Note:** This option only affects tables that are downloaded, for example to Microsoft Excel or as a comma-separated text file. This has no effect on the appearance of the resultant tables in the 1010data web interface.

The following example is a cross tabulation showing the sum of sales where the rows are grouped by **Transaction ID** and the columns are grouped by both **Store** and **Account**.

If you selected **Use long column headings for results** and downloaded the results to Excel, the column headings would contain both the column names and values (e.g., Store=1 Account=957):

```
<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Sum Sales</th>
<th>Store=1 Account=957</th>
<th>Store=1 Account=478</th>
<th>Store=1 Account=738</th>
<th>Store=1 Account=668</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>531</td>
<td>-5.00</td>
<td>-5.00</td>
<td>1.60</td>
<td>8.25</td>
</tr>
<tr>
<td>6</td>
<td>532</td>
<td>1.60</td>
<td>0.00</td>
<td>1.60</td>
<td>0.00</td>
</tr>
<tr>
<td>7</td>
<td>534</td>
<td>8.25</td>
<td>0.00</td>
<td>0.00</td>
<td>8.25</td>
</tr>
<tr>
<td>8</td>
<td>535</td>
<td>3.85</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
```

If this was not selected, the column headings would only contain the values (e.g., 1 957):

```
<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Sum Sales</th>
<th>1 957</th>
<th>1 478</th>
<th>1 738</th>
<th>1 668</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>531</td>
<td>-5.00</td>
<td>-5.00</td>
<td>1.60</td>
<td>8.25</td>
</tr>
<tr>
<td>6</td>
<td>532</td>
<td>1.60</td>
<td>0.00</td>
<td>1.60</td>
<td>0.00</td>
</tr>
<tr>
<td>7</td>
<td>534</td>
<td>8.25</td>
<td>0.00</td>
<td>0.00</td>
<td>8.25</td>
</tr>
<tr>
<td>8</td>
<td>535</td>
<td>3.85</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
```

7. Click **Submit**.

The result of a cross tabulation is a dynamic table that may be manipulated just like any other table. You may download the results, select rows, sort rows, rearrange columns, create computed columns, link in other tables, and even apply another tabulation or cross tabulation.

Missing values in the data are handled automatically. For example, if you are computing the average value of a column that has some missing (N/A) values in a particular group of rows, those values are ignored when computing the average. See the descriptions of the individual types of summarizations to see how N/A values are handled for each.

You may reorder both the rows and the columns of a cross tabulation so that the row and column aggregates are in ascending or descending order. (The row and column aggregates are the numbers that appear in the gray cells.) To sort the columns in a cross tabulation, click [ or ] in the column header. To sort the rows in a cross tabulation, click [ or ] in the row header.
Note: In large cross tabulations, the meaningful data is often quite sparse. For example, suppose the original table was a phone book and we wanted to find the number of people with each last name in each ZIP code. In other words, we wanted a cross tabulation with one row for each last name and one column for each ZIP code, showing the total number of people in each category. Obviously, there may be no people with certain last names living in certain ZIP codes, so many cells will be zero. To focus in on those cells that do have meaningful data, we can sort both the row and column totals in descending order. This will have the effect of bringing the rows and columns with the largest numbers to the upper left.

Example

The following table is the result of a cross tabulation that calculates the sum of sales for each unique grouping of both Department and Transaction ID. The resultant table is a matrix with the Transaction ID as the Rows of Results and Department as the Columns of Results.

In this example, you can see that transaction ID 538 consisted of $5.30 spent in department 22 and $1.65 in department 29 for a grand total of $6.95, which can be found in the first column of that row (in gray). You can also see the total amount spent in department 22 from all transactions, which is $24.30, by looking at the first row in the column for that department (in gray).

Types of Summarizations for Cross Tabulations

The Type of Summary drop-down in the Cross Tabulation dialog contains a number of summarizations.
| **number of records** | The number of rows in each group.  
• The number of rows includes those with N/A values. |
|-----------------------|--------------------------------------------------------------------------------------------------|
| **% of total records** | The number of rows in each group as a percentage of all rows.  
• The number of rows includes those with N/A values.  
**Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |
| **fraction of total records** | The number of rows in each group as a fraction of all rows.  
• The number of rows includes those with N/A values.  
**Note:** The result is a fractional value. For instance, a result of 20% would be represented as 0.20. |
| **rank of # records** | The rank of each group, in terms of its number of records, with respect to all other groups.  
• The rank includes rows with N/A values. |
| **% of row records** | The number of records in each group as a percentage of the total number of records on the same row of the cross tabulation result.  
• The number of records includes those with N/A values.  
**Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |
| **fraction of row records** | The number of records in each group as a fraction of the total number of records on the same row of the cross tabulation result.  
• The number of records includes those with N/A values.  
**Note:** The result is a fractional value. For instance, a result of 20% would be represented as 0.20. |
| **rank of #records in row** | The rank of each group, in terms of its number of records, with respect to the other groups on the same row of the cross tabulation result.  
• The rank includes rows with N/A values. |
| **% of column records** | The number of records in each group as a percentage of the total number of records in the same column of the cross tabulation result.  
• The number of records includes those with N/A values.  
**Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |
| **fraction of column records** | The number of records in each group as a fraction of the total number of records in the same column of the cross tabulation result.  
• The number of records includes those with N/A values.  
**Note:** The result is a fractional value. For instance, a result of 20% would be represented as 0.20. |
| **rank of #records in column** | The rank of each group, in terms of its number of records, with respect to the other groups in the same column of the cross tabulation result.  
• The rank includes rows with N/A values. |
| **number of unique values** | The number of unique values in the **Column** for each group.  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the number of unique non-N/A values).  
| | - If a group contains only N/A values, the result for the group is 0. |

| **sum** | The subtotal of the **Column** for each group. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values).  
| | - If a group contains only N/A values, the result for the group is 0. |

| **% of grand total** | The subtotal of the **Column** for each group as a percentage of the grand total. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a percentage of the sum of the non-N/A values in the entire column).  
| | - If a group contains only N/A values, the result for the group is 0.  
| | **Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |

| **fraction of grand total** | The subtotal of the **Column** for each group as a fraction of the grand total. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a fraction of the sum of the non-N/A values in the entire column).  
| | - If a group contains only N/A values, the result for the group is 0.  
| | **Note:** The result is a fractional value. For instance, a result of 20% would be represented as 0.20. |

| **rank of sum** | The rank of each group, in terms of its **Column** subtotal, with respect to the other groups. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its subtotal of non-N/A values).  
| | - If a group contains only N/A values, the result is the rank with respect to a subtotal of 0. |

| **% of row total** | The subtotal of the **Column** for each group as a percentage of the total for that row of the cross tabulation result. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a percentage of the sum of the non-N/A values in that row of the cross tabulation result).  
| | - If a group contains only N/A values, the result for the group is 0.  
| | **Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |

| **fraction of row total** | The subtotal of the **Column** for each group as a fraction of the total for that row of the cross tabulation result. (**numeric columns only**)  
| | - If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a fraction of the sum of the non-N/A values in that row of the cross tabulation result).  
| | - If a group contains only N/A values, the result for the group is 0. |
| **rank of sum in row** | The rank of each group, in terms of its **Column** subtotal, within that row of the cross tabulation result. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its subtotal of non-N/A values).  
- If a group contains only N/A values, the result for the group is N/A. |
| **% of column total** | The subtotal of the **Column** for each group as a percentage of the total for that column of the cross tabulation result. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a percentage of the sum of the non-N/A values in that column of the cross tabulation result).  
- If a group contains only N/A values, the result for the group is 0.  
**Note:** The result is a whole number, not a fractional value. For instance, a result of 20% would be represented as 20, not 0.20. |
| **fraction of column total** | The subtotal of the **Column** for each group as a fraction of the total for that column of the cross tabulation result. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the sum of the non-N/A values in the group as a fraction of the sum of the non-N/A values in that column of the cross tabulation result).  
- If a group contains only N/A values, the result for the group is 0.  
**Note:** The result is a fractional value. For instance, a result of 20% would be represented as 0.20. |
| **rank of sum in column** | The rank of each group, in terms of its **Column** subtotal, within that column of the cross tabulation result. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its subtotal of non-N/A values).  
- If a group contains only N/A values, the result for the group is N/A. |
| **average** | The average of the **Column** for each group. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the average of the non-N/A values).  
- If a group contains only N/A values, the result for the group is N/A. |
| **rank of average** | The rank of each group, in terms of its **Column** average, with respect to the other groups. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its average of non-N/A values).  
- If a group contains only N/A values, the result for the group is N/A. |
| **rank of average in row** | The rank of each group, in terms of its **Column** average, within that row of the cross tabulation result. *(numeric columns only)*  
- If a group contains N/A values, those rows are ignored (i.e., the result is the rank with respect to its average of non-N/A values).  
- If a group contains only N/A values, the result for the group is N/A. |
<p>| <strong>rank of average in column</strong> | The rank of each group, in terms of its <strong>Column</strong> average, within that column of the cross tabulation result. <em>(numeric columns only)</em> |</p>
<table>
<thead>
<tr>
<th><strong>Summarizations and Tabulations</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>weighted average</strong></td>
<td>The average of the Column, weighted by the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result is the weighted average for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>highest number</strong></td>
<td>The highest number in the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the highest non-N/A value).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>lowest number</strong></td>
<td>The lowest number in the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the lowest non-N/A value).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>first value</strong></td>
<td>The first value in the Column for each group. (alphanumeric and numeric columns)</td>
</tr>
<tr>
<td></td>
<td>This is the first value based on the current sort order of the table (i.e., the way the data is shown when the table is viewed multiple rows at a time).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the first of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>last value</strong></td>
<td>The last value in the Column for each group. (alphanumeric and numeric columns)</td>
</tr>
<tr>
<td></td>
<td>This is the last value based on the current sort order of the table (i.e., the way the data is shown when the table is viewed multiple rows at a time).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the last of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>standard deviation</strong></td>
<td>The standard deviation of the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the standard deviation of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>variance</strong></td>
<td>The variance of the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the variance of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>weighted std dev</strong></td>
<td>The standard deviation of the Column, weighted by the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the weighted average for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td>Summarizations and Tabulations</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>weighted variance</strong></td>
<td>The variance of the Column, weighted by the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the weighted variance for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>sum of squares</strong></td>
<td>The sum of squares of the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the sum of squares of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
<tr>
<td><strong>correlation</strong></td>
<td>The correlation of the Column and the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the correlation for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there aren't at least two such rows in the group, the result is N/A.</td>
</tr>
<tr>
<td><strong>covariance</strong></td>
<td>The covariance of the Column and the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the covariance for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is N/A.</td>
</tr>
<tr>
<td><strong>dot product</strong></td>
<td>The dot product of the Column and the Reference Column, for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If, for a particular group, either the Column or the Reference Column contains N/A values, those rows are ignored (i.e., the result for the group is the dot product for those rows where neither the Column nor the Reference Column is N/A).</td>
</tr>
<tr>
<td></td>
<td>• If there are no such rows, the result for the group is 0.</td>
</tr>
<tr>
<td><strong>number of valid values</strong></td>
<td>The number of non-N/A values in the Column for each group.</td>
</tr>
<tr>
<td><strong>number of N/As</strong></td>
<td>The number of N/A values in the Column for each group.</td>
</tr>
<tr>
<td><strong>number of valid pairs</strong></td>
<td>The number of rows where both the Column and the Reference Column are not N/A, for each group.</td>
</tr>
<tr>
<td><strong>number of N/A pairs</strong></td>
<td>The number of rows where either the Column or the Reference Column is N/A, for each group.</td>
</tr>
<tr>
<td><strong>median</strong></td>
<td>The median of the Column for each group. (numeric columns only)</td>
</tr>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the median of the non-N/A values).</td>
</tr>
</tbody>
</table>
- If there are an even number of values, the median is the average of the two middle values.
- If a group contains only N/A values, the result for the group is N/A.

<table>
<thead>
<tr>
<th>mode</th>
<th>The mode of the Column for each group. <em>(numeric columns only)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the mode of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If, for a given group, there is no unique mode, the result is arbitrary.</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is N/A.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>frequency of mode</th>
<th>The frequency of the mode of the Column for each group. <em>(numeric columns only)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the frequency of the mode of the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>number of modes</th>
<th>The number of modes in the Column for each group. <em>(numeric columns only)</em></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If a group contains N/A values, those rows are ignored (i.e., the result is the number of modes within the non-N/A values).</td>
</tr>
<tr>
<td></td>
<td>• If a group contains only N/A values, the result for the group is 0.</td>
</tr>
</tbody>
</table>
Linking Tables and Worksheets

Linking provides a simple yet powerful way of combining the data from two tables.

When you link tables (or worksheets) together, you essentially combine them into a single, bigger table with all the columns from both. (The change applies only to your session and does not affect the original tables or other people in any way.) For example, if one table contains addresses and telephone numbers for a group of people and another table contains their ages, heights, and weights, linking the two tables results in a table that has all the information about each person.

Linking is quite important for analysis. For example, using the first table described above, you could easily find all the people who live in a given city. Similarly, with the second table you could find all the people older than a given age. Both are simple row selections. But suppose you want to find all people older than a given age who also live in a given city? Link the tables and it's just another row selection.

Note: When you link to a worksheet (a table with operations applied to it), the full worksheet is pulled into memory, so there is a limit on how large the worksheet can be (roughly about 250,000,000 cells). When you link to a table, no such restriction applies. See the section on Linking on page 114 under Writing Efficient Queries on page 112 for tips on how to help limit the size of the worksheet you're linking in.

If, for a particular row in the table that you are viewing, there is no information in the foreign table, N/A values are filled in for that row. In many cases, you may not be interested in such rows; after all, they have a significant amount of missing information. One way to eliminate such rows from the analysis is to do the link and then select only those rows that have non-N/A values in the columns you have linked in. Another, more efficient, method is to link-and-select, which combines the link and the selection in one operation. The result is the same as a simple link, except that only those rows for which there are matches in the foreign table are linked in.

Note that this is another way of doing row selections and may be useful in certain circumstances. Suppose, for example, that you are looking at a Sales table that has millions of rows involving thousands of customer IDs. Now suppose that you have a list of a few hundred customer IDs that you would like to select for analysis and that this list is in a text file or Excel spreadsheet. An easy way of proceeding in 1010data would be:

1. Upload the list of customer IDs as a new table.
2. Go to the Sales table and perform a link-and-select to your uploaded table, linking on the customer ID.

Your view of the Sales table will now reflect only those customers in your list.

The result of a link is a dynamic table that may be manipulated just like any other table. You may select rows, sort rows, rearrange columns, create computed columns, link in other tables, perform summarizations or tabulations, or apply any other kind of analysis.

How Rows Are Matched Up

When linking tables or worksheets, rows are matched up using link columns.

It's pretty obvious that we cannot link tables by simply putting them next to one other and gluing them together. For one thing, they probably don't have the same number of rows. Even if they did happen to have the same number of rows, there's no guarantee that the rows correspond to one another. Obviously, the tables must be combined by intelligently matching up rows. This is typically done by comparing the information in a specified column (or columns) in one table with information in the corresponding column(s) in the second table. So, for example, if both tables contained names, we could match up the tables' rows based on names. We call such columns link columns.

So far, so good. But what if some names appear in one table and not in the other? What if names appear more than once in each of the tables? Let's take a more realistic example:
These two tables both contain a **Customer ID** column so we can use that column to match their rows. But note that:

- The **Sales** table has more rows than the **Customer** table.
- A given **Customer ID** can appear several times in the **Sales** table.
- Each table contains a **Customer ID** that is not in the other (e.g., c0006 does not appear in the **Customer** table; c0002 does not appear in the **Sales** table).

The result of linking these tables together depends on whether you are linking the **Customer** table into the **Sales** table or vice versa. The more typical thing to do is the former, so let's do that first. Suppose you were looking at the **Sales** table and you linked the **Customer** table to it. Here's what you would get:
The link effectively “imports” into the Sales table all the information about each customer. Since there is no information about customer c0006, the corresponding cells are blank.

**Note:** When you do any kind of analysis, the system will automatically deal with N/A (missing) values in a way that makes sense.

Now let's see what happens when you do the reverse and link the Sales table into the Customer table (i.e., you are looking at the Customer table and link in the Sales table):

For each customer, only the information for the first sale is imported.

**Note:** Whenever there is more than one possible row to import, the first row is chosen.

If there are no rows to import, the cells are left blank (i.e., have N/A values) as in the case of customer c0002.

Note that **simple linking will never change the number of rows in your table**. If you are looking at a table that has one million rows and you link in another table that has one thousand rows, the number of rows in your view will still be one million. Likewise, if you are looking at a table that has one thousand rows and you link in another table that has one million rows, the number of rows will still be one thousand. (For those familiar with the SQL database language, this is essentially a modified left outer join.) There is, however, an action that combines linking with row selection (comparable to the SQL inner join.) This action, **link and select rows**, can reduce the number of rows in your view.

In the above examples, rows were matched based on one column (**Customer ID**) in each table. Links can also be based on more than one column, in which case rows are matched if the values in all the corresponding link columns are the same.

It is also possible to match rows whose link column values are related but not exactly the same. In 1010data, these are called as-of links.

### Linking Columns with Different Types

When linking tables in 1010data, the data type of each column being linked in the base table must match the type of each corresponding column being linked in from the foreign table.

Although 1010data will allow you to link on two columns that have differing types, the results may not be what you may expect. The reason is that because the two columns have different types, there will be no matches on which to base the link. The easiest solution is to create a computed column in one of the tables that converts a column from one data type to another so that the expected matching will occur.

For instance, a zip code column may be of type integer (i) in one table and type text (a) in another. Though it may look like these two columns have common values to link on, they will not match because they are different data types.

To find out the data type of a column, simply click the question mark icon (??) above the column heading. Below is column information for two zip code columns from two different tables, one of type integer and one of type text:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>First Name</th>
<th>Last Name</th>
<th>Zip Code</th>
<th>Date</th>
<th>Product</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>c0001</td>
<td>Susan</td>
<td>Smith</td>
<td>10101</td>
<td>07/15/00</td>
<td>dress</td>
<td>3</td>
</tr>
<tr>
<td>c0002</td>
<td>Tom</td>
<td>Doe</td>
<td>23132</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>c0003</td>
<td>Dick</td>
<td>Miller</td>
<td>12345</td>
<td>07/15/00</td>
<td>shirt</td>
<td>1</td>
</tr>
<tr>
<td>c0004</td>
<td>Harry</td>
<td>Jefferson</td>
<td>45875</td>
<td>07/18/00</td>
<td>pants</td>
<td>1</td>
</tr>
<tr>
<td>c0005</td>
<td>Jane</td>
<td>Smith</td>
<td>61438</td>
<td>07/16/00</td>
<td>shoes</td>
<td>1</td>
</tr>
</tbody>
</table>
You cannot properly link these tables together using these columns because the data types do not match. Since zip codes often have a leading 0, converting the integer column to a text column is a better solution than converting the text column to an integer column. This conversion (in coding parlance, a type cast), is done using the `string(X)` function.

To create a computed column that will contain the converted values, click Columns > Create Computed Column... and enter the `string(X)` function for the Value Expression in that dialog (specifying the zip column for the X argument):
However, this creates another issue. Since integers may not contain leading zeros, some of the string values in the new computed column will only contain four digits instead of five. This is illustrated in the screenshot below:

To avoid this issue, we can use the function `strembed(X;N;P;Y;D)` in conjunction with the `string(X)` function when we create the computed column.
By specifying '0' for X and 5 for N, \( \text{strembed}(X;N;P;Y;D) \) creates a template of five 0's. We specify \(-1\) for the \(P\) parameter, which is the index position where the zip code string (specified by \(Y\)) will be inserted into the template. Since it's a negative number, the last character in the zip code string will be positioned at the end of the template. This way, if the zip code string has four characters, one leading zero will remain from the template. If the zip code string has five characters, no leading zeros will remain. We set \(D\) to \(-1\) so that \( \text{strembed}(X;N;P;Y;D) \) will return an N/A for any zip codes greater than five digits.

So, the following is the preferred method of creating the computed column for the type cast:

And now the 4-digit zip codes correctly have leading zeros:
Now, in the other table, you can perform the link by clicking **Columns > Link in Another Worksheet...** and selecting the worksheet that contains the new computed column.

**Note:** It is important that you link in the **worksheet** and not the **table**, since the worksheet contains the new computed column.

You can then specify the new computed column in the **Link in Another Worksheet** dialog:

After clicking the **Submit** button, the information from the worksheet will be properly linked into the current table for those rows in which the information for the specified columns match.
As-of Links

As-of links allow you to match rows in a less strict way when two tables (or worksheets) are linked together. Using as-of links, you can match a row in the current table with a row in a foreign table whose value is the closest match less than or equal to the value in the current table.

To see what this means, let's start with the Sales table we used in a previous section:

<table>
<thead>
<tr>
<th>Date</th>
<th>Customer ID</th>
<th>Product</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/15/00</td>
<td>c0003</td>
<td>shirt</td>
<td>1</td>
</tr>
<tr>
<td>07/15/00</td>
<td>c0001</td>
<td>dress</td>
<td>3</td>
</tr>
<tr>
<td>07/16/00</td>
<td>c0001</td>
<td>shoes</td>
<td>1</td>
</tr>
<tr>
<td>07/16/00</td>
<td>c0006</td>
<td>tie</td>
<td>2</td>
</tr>
<tr>
<td>07/16/00</td>
<td>c0005</td>
<td>shoes</td>
<td>1</td>
</tr>
<tr>
<td>07/17/00</td>
<td>c0003</td>
<td>socks</td>
<td>10</td>
</tr>
<tr>
<td>07/18/00</td>
<td>c0004</td>
<td>pants</td>
<td>1</td>
</tr>
<tr>
<td>07/18/00</td>
<td>c0001</td>
<td>tie</td>
<td>2</td>
</tr>
</tbody>
</table>

Now, let's introduce the following new table:

<table>
<thead>
<tr>
<th>Product</th>
<th>Date</th>
<th>Medium</th>
</tr>
</thead>
<tbody>
<tr>
<td>tie</td>
<td>07/01/00</td>
<td>newspaper</td>
</tr>
<tr>
<td>tie</td>
<td>07/17/00</td>
<td>television</td>
</tr>
<tr>
<td>shoes</td>
<td>07/10/00</td>
<td>newspaper</td>
</tr>
</tbody>
</table>

This table says that our imaginary store advertised three times. On 7/1 they advertised ties in a newspaper; on 7/10 they took out another newspaper ad, this time for shoes; and on 7/17 they ran a TV commercial for their ties (clearly on a local station in the middle of the night!)

Now suppose we want to answer the question: What was the most recent type of ad before each customer's purchase? (In our small example, this won't tell us much, but in real life this could help a store manager figure out what kinds of ads are most effective.) Before we answer this question, let's see what happens with a normal link. Starting with the Sales table and linking in the Advertisements table, matching the Product and Date columns in each table, gives us:
It's no surprise that the **Medium** column is all blank since there are no matches between the **Sales** and **Advertisements** tables. The **Sales** table does not have any entries for 7/1 or 7/10 at all, and the only entry for 7/17 is for socks, while the 7/17 entry in the **Advertisements** table is for ties. So, nothing matches.

Now let's try an **as-of** link, using the same two pairs of columns, **Product** and **Date**:

There were no ads for some of the products, so many of the rows are still blank, but let's take a look at the other rows. Take the sale of ties on 7/16: The closest ad for ties **on or before** 7/16 was the newspaper ad on 7/1. Similarly, the closest ad for ties **on or before** 7/18 was the TV ad on 7/17. Now we have the information we were looking for to answer our original question.

What if you wanted to answer the question: What was the first purchase **following** each ad? You could do this by performing a reverse as-of link. See **Example: Reverse as-of links** within the `<link>` topic in the 1010data Reference Manual for an example of how to do this.

**As-of Link Guidelines**

There are several important things to keep in mind when using as-of links:

- When linking on multiple columns, as in the example above, the last pair of link columns (in our example, the **Date** columns) are the ones that are matched inexactly. The other link columns are matched exactly, as in a standard link.

- It is essential that the rows of the foreign table (i.e., the table that is being linked into the one you are viewing) be in the proper order. In particular:
  1. All rows that have a given value in the first link column must be contiguous.
In the **Product** column of our **Advertisements** table, all of the "tie" entries are contiguous and all of the "shoes" entries (though there is only one) are contiguous.

2. For a given value in the first link column, all rows that have a given value in the second link column must be contiguous (unless it is the last). A similar rule holds for the third link column, and so on.

This doesn't apply in our example, because we are only linking on two columns.

3. For a given set of values in all link columns other than the last, the values of the last link column must be in ascending order.

In our **Advertisements** table, for all of the entries that have "tie" in the **Product** column, all of the corresponding dates in the **Date** column are in ascending order.

For instance, the following table could not be used in an as-of link (linking on **Product** and **Date**, as in our example) since not all "tie" records are contiguous (the "shoes" record is stuck between them).

<table>
<thead>
<tr>
<th><strong>Product</strong></th>
<th><strong>Date</strong></th>
<th><strong>Medium</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>tie</td>
<td>07/01/00</td>
<td>newspaper</td>
</tr>
<tr>
<td>shoes</td>
<td>07/10/00</td>
<td>newspaper</td>
</tr>
<tr>
<td>tie</td>
<td>07/17/00</td>
<td>television</td>
</tr>
</tbody>
</table>

If a table is not already ordered in a way that follows these guidelines, it can be put into the proper order by sorting the last link column in ascending order, then sorting the next-to-last link column in ascending order, then sorting the next link column, and so on, ending with the first. The table can then be saved as a new table or linked to another worksheet.

**Note:** Only as-of links require that tables being linked together have a particular order; and, even in that case, only the foreign table needs be in the proper order.

**Row Shift**

Finally, when using as-of links it is possible to "shift" the match so that instead of matching a row in the current table with the row in the foreign table whose value is the closest match less than or equal to the value in the current table, you can match to the second closest or third closest.

For example, a shift of 1 means: match to the row in the foreign table that follows the row whose value is the closest match less than or equal to the value in the current table. A shift of 2 would match the next row, and so on. If the shift value is negative, the match is shifted backwards. So, for example, a shift of -1 means: match to the row in the foreign table that precedes the row whose value is the closest match less than or equal to the value in the current table.

**Link in another table**

You can link in another table on the 1010data Insights Platform to the current table or worksheet.

To link in another table on the 1010data Insights Platform to the current table or worksheet:

1. In an open table or worksheet, click **Columns > Link in Another Table**...

   The **Link in Another Table** dialog is presented.

2. In the table browser displayed in the **Link in Another Table** dialog, navigate to and select the foreign table.

3. From the first set of drop-down lists, which correspond to the current table or worksheet, select the column(s) you would like to link on.
4. From the second set of drop-down lists, which correspond to the foreign table, select the column(s) you would like to match to those specified in the previous step.

5. Enter a Suffix. (optional)

   The suffix may be any alphanumeric value and may contain underscores. In the resultant table, the suffix will be appended to the column names of the foreign table, which you are linking in, and is useful when linking tables that contain similarly-named columns.

   For example, if you are viewing your Sales Item Detail table and want to link in your Product Master table, you can append a suffix of _PM to the columns from Product Master in the resultant table:

   ![Sales Item Detail table with suffix example]

   In this example, a column named class in the Product Master table is named class_PM in the resultant table. Any reference to these columns (e.g., when creating a computed column) would use the column names with the suffix.

   Note: In the above example, column names are used for the column headings. This can be set using the Show column headings as preference under the User Preferences section of the Set Preferences dialog.

6. Enter a Label. (optional)

   In the resultant table, the label will be added to the column headings of the foreign table, which you are linking in.

   Note: You can see the label in the column headings when the Show column headings as preference is set to the label or both the name and label. This can be set under the User Preferences section of the Set Preferences dialog. In the example below, column labels are used for the column headings.

   As in the example in the previous step, if you are viewing your Sales Item Detail table and want to link in your Product Master table, you can add the label of "Product Master" to its columns in the resultant table:

   ![Sales Item Detail table with label example]

   In this example, the last three columns are from the Product Master table, as denoted by the "Product Master" label above each of them.

7. If you would like to enforce a less strict way of linking the foreign table to the current table, select As-of link? and enter a Row Shift value. (optional)
Using as-of links, you can match a row in the current table with a row in the foreign table whose value is the closest match less than or equal to the value in the current table. The **Row Shift** value allows you to shift the match that number of rows following or preceding the closest match.

8. **Click Finish.**

   The foreign table is linked in to the current table.

   The result of a link is a dynamic table that may be manipulated just like any other table. You may select rows, sort rows, rearrange columns, create computed columns, link in other tables, perform summarizations or tabulations, or apply any other kind of analysis.

**Link in another worksheet**

Linking worksheets allows you to perform various actions on two tables and then link the results.

To link in a worksheet to the current table or worksheet:

1. In an open table or worksheet, click **Columns > Link in Another Worksheet...**

   The **Link in Another Worksheet** dialog is presented.

2. From the list of open worksheets displayed in the **Link in Another Worksheet** dialog, select the foreign worksheet.

   **Note:** When you link to a worksheet (a table with operations applied to it), the full worksheet is pulled into memory, so there is a limit on how large the worksheet can be (roughly about 250,000,000 cells). When you link to a table, no such restriction applies. See the section on **Linking** on page 114 under **Writing Efficient Queries** on page 112 for tips on how to help limit the size of the worksheet you’re linking in.

3. From the first set of drop-down lists, which correspond to the current table or worksheet, select the column(s) you would like to link on.

   **Note:** To change the number of linking columns that appear in the **Link in Another Worksheet** dialog, click **View > Set Preferences** and change the **Number of Columns for Links** setting under the **User Interface** section.

4. From the second set of drop-down lists, which correspond to the foreign worksheet, select the column(s) you would like to match to those specified in the previous step.

5. **Enter a Suffix. (optional)**

   The suffix may be any alphanumeric value and may contain underscores. In the resultant table, the suffix will be appended to the column names of the foreign worksheet, which you are linking in, and is useful when linking worksheets that contain similarly-named columns.

   For example, if you are viewing your **Sales Item Detail** table and want to link in your **Product Master** worksheet, you can append a suffix of **_PM** to the columns from **Product Master** in the resultant table:

   ![Image of linked tables](image)

   In this example, a column named **class** in the **Product Master** worksheet is named **class_PM** in the resultant table. Any reference to these columns (e.g., when creating a computed column) would use the column names with the suffix.
6. Enter a Label. (optional)

In the resultant table, the label will appear at the top of those columns from the foreign worksheet, which you are linking in.

**Note:** You can see the label in the column headings when the *Show column headings as* preference is set to the label or both the name and label. This can be set under the *User Preferences* section of the *Set Preferences* dialog. In the example below, column labels are used for the column headings.

As in the example in the previous step, if you are viewing your *Sales Item Detail* table and want to link in your *Product Master* worksheet, you can add the label of "Product Master" to its columns in the resultant table:

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Units</th>
<th>Sales</th>
<th>Cost</th>
<th>Description</th>
<th>Product Master Description</th>
<th>Product Master Class</th>
<th>Product Master Less</th>
<th>Product Master Class</th>
<th>Product Master Less</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
<td>-1.84</td>
<td>LA MICRO TERRY CLOG LARGE</td>
<td></td>
<td>3423 SHOES</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
<td>0.25</td>
<td>FRUIT SNACK MIXED BERRIES</td>
<td></td>
<td>1103 NON-CHOCOLATE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>387</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
<td>PEPSI 20 OZ</td>
<td></td>
<td>1153 CARBON</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this example, the last three columns are from the *Product Master* worksheet, as denoted by the "Product Master" label above each of them.

7. If you would like to enforce a less strict way of linking the foreign worksheet to the current table, select *As-of link?* and enter a *Row Shift* value. (optional)

Using as-of links, you can match a row in the current table with a row in the foreign worksheet whose value is the closest match less than or equal to the value in the current table. The *Row Shift* value allows you to shift the match that number of rows following or preceding the closest match.

8. Click *Finish*.

The foreign worksheet is linked in to the current table.

The result of a link is a dynamic table that may be manipulated just like any other table. You may select rows, sort rows, rearrange columns, create computed columns, link in other tables, perform summarizations or tabulations, or apply any other kind of analysis.

**Note:** Changing the foreign worksheet after you link to it will not change the resultant table.

### Link and select rows

Using link-and-select, you can include only those rows that have corresponding matches in the foreign table or worksheet, thereby eliminating the need to do a subsequent row selection after the link.

To link in only those rows from another table on the 1010data Insights Platform or worksheet for which there are matches in the current table or worksheet:

1. In an open table or worksheet, click *Columns > Link and Select Rows...*

   The *Link and Select Rows* dialog is presented.

2. Select the foreign table or worksheet by performing one of the following actions:
   - In the table browser displayed in the *Link and Select Rows* dialog, navigate to and select the foreign table.
3. From the first set of drop-down lists, which correspond to the current table or worksheet, select the column(s) you would like to link on.

   **Note:** To change the number of linking columns that appear in the Link and Select Rows dialog, click **View > Set Preferences** and change the **Number of Columns for Links** setting under the **User Interface** section.

4. From the second set of drop-down lists, which correspond to the foreign table or worksheet, select the column(s) you would like to match to those specified in the previous step.

5. Enter a **Suffix**. *(optional)*

   The suffix may be any alphanumerical value and may contain underscores. In the resultant table, the suffix will be appended to the column names of the foreign table or worksheet, which you are linking in, and is useful when linking tables or worksheets that contain similarly-named columns.

   For example, if you are viewing your **Sales Item Detail** table and want to link in your **Product Master** table, you can append a suffix of \_PM to the columns from **Product Master** in the resultant table:

   **Sales Item Detail**

<table>
<thead>
<tr>
<th>transid</th>
<th>account</th>
<th>store</th>
<th>date</th>
<th>sku</th>
<th>units</th>
<th>sales</th>
<th>cost</th>
<th>itemdesc</th>
<th>class</th>
<th>class_PM</th>
<th>classes_PM</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
<td>-1.84</td>
<td>LA MICRO TERRY CLOG LARGE</td>
<td>3423</td>
<td>SHOES CORE BL</td>
<td></td>
</tr>
<tr>
<td>532</td>
<td>476</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
<td>0.25</td>
<td>FRUIT SNACK MIXED BERRIES</td>
<td>1103</td>
<td>NON-CHOCOLATE</td>
<td></td>
</tr>
<tr>
<td>533</td>
<td>476</td>
<td>1</td>
<td>05/15/12</td>
<td>387</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
<td>PEPSI 20 OZ</td>
<td>1153</td>
<td>CARBONATED DR</td>
<td></td>
</tr>
</tbody>
</table>

   In this example, a column named **class** in the **Product Master** table is named **class_PM** in the resultant table. Any reference to these columns (e.g., when creating a computed column) would use the column names with the suffix.

   **Note:** In the above example, column names are used for the column headings. This can be set using the **Show column headings as** preference under the **User Preferences** section of the **Set Preferences** dialog.

6. Enter a **Label**. *(optional)*

   In the resultant table, the label will appear at the top of those columns from the foreign table or worksheet, which you are linking in.

   **Note:** You can see the label in the column headings when the **Show column headings as** preference is set to **the label** or **both the name and label**. This can be set under the **User Preferences** section of the **Set Preferences** dialog. In the example below, column labels are used for the column headings.

   As in the example in the previous step, if you are viewing your **Sales Item Detail** table and want to link in your **Product Master** table, you can add the label of “Product Master” to its columns in the resultant table:

   **Sales Item Detail**

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Units</th>
<th>Sales</th>
<th>Cost</th>
<th>Item Description</th>
<th>Product Master</th>
<th>Product Master</th>
<th>Product Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
<td>-1.84</td>
<td>LA MICRO TERRY CLOG LARGE</td>
<td>3423</td>
<td>SHOES CORE BL</td>
<td></td>
</tr>
<tr>
<td>532</td>
<td>476</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
<td>0.25</td>
<td>FRUIT SNACK MIXED BERRIES</td>
<td>1103</td>
<td>NON-CHOCOLATE</td>
<td></td>
</tr>
<tr>
<td>533</td>
<td>476</td>
<td>1</td>
<td>05/15/12</td>
<td>387</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
<td>PEPSI 20 OZ</td>
<td>1153</td>
<td>CARBONATED DR</td>
<td></td>
</tr>
</tbody>
</table>

   In this example, the last three columns are from the **Product Master** table, as denoted by the “Product Master” label above each of them.
7. Click Finish.

Only those rows for which there are matches in the foreign table or worksheet are linked in to the current table.

The result of a link is a dynamic table that may be manipulated just like any other table. You may select rows, sort rows, rearrange columns, create computed columns, link in other tables, perform summarizations or tabulations, or apply any other kind of analysis.

**Note:** If you link in a foreign worksheet, changing it after you link to it will not change the resultant table.
Actions and Queries

An action is any operation you do on a table or worksheet that changes its state, such as performing a tabulation, selecting rows, or creating a computed column. A query is a set of one or more actions that are combined to achieve a particular result.

In 1010data, you can edit actions you've already taken, add new actions, undo the last action, or undo all the actions you've taken on a particular table or worksheet. You can also go back one or more steps in your analysis, and then subsequently go forward once again through those same steps as you develop a query.

1010data gives you a number of ways to edit your actions. You can either use the drag-and-drop interface of the GUI to add to, delete from, modify, or rearrange your current set of actions. Or, you can directly edit the Macro Language XML that comprises the current query. For example, suppose you created a computed column, performed a tabulation, then sorted the result. You might want to go back and change the formula of the computed column (perhaps because you made a mistake or because you would like to try another formula). Rather than repeat all the steps, you could edit the actions to change the computed column and then rerun the query.

There are certain practices that can make your queries more efficient, such as performing selections that eliminate the greatest number of rows first or using G_Functions on segmented tables instead of tabulations. You can find a list of suggestions on these topics as well as a range of others including sorting, linking, merging, and writing selection expressions in Writing Efficient Queries on page 112.

You can save the actions associated with a particular table or worksheet by downloading the Macro Language XML as a text file on your computer. Or, you can save the current set of actions as a Quick Query, which allows you to parameterize inputs so that you can change certain query values each time you run it. In addition, you may download the Macro Language XML for all of your saved Quick Queries (or a subset of them) as a text file to your computer.

Note: You can also save the actual results of the current query as a new table; however, the set of actions will not be saved with the new table, only the results.

Edit actions as XML

Modify the current set of actions by editing the Macro Language XML directly.

To edit the current set of actions as XML:

1. In an open table or worksheet, click Actions > Edit Actions (XML)...

   The Edit Actions (XML) dialog is presented.

   Note: You can also bring up the Edit Actions (XML) dialog by pressing x if keyboard shortcuts are enabled. Click View > Set Preferences and select Enable keyboard shortcuts under the User Interface section.

2. In the Edit Actions (XML) dialog, make any desired modifications to the Macro Language XML.

3. Click Apply (or press Control+Enter). See

   The actions will be applied to the current table or worksheet.

Edit actions using the GUI

You can use the drag-and-drop interface of the GUI to add to, delete from, modify, or rearrange your current set of actions.

To edit the current set of actions using the GUI:
1. In an open table or worksheet, click **Actions > Edit Actions...**

   The **Actions in Effect** dialog is presented.

   All the actions you have taken (selections, tabulations, etc.) are recorded as a series of instructions in the **Actions in Effect** dialog.

2. In the **Actions in Effect** dialog, make any desired modifications within the list of actions:

   **To add a new action:**

   1. Perform one of the following:

      - Click ⬇️ insert a new statement here.
      - Click the 🔄 icon next to the action where you want to add a new action and select ⬇️ insert a new statement BEFORE this line from the menu.
      - Click the 🔄 icon next to the action where you want to add a new action and select ⬇️ insert a new statement AFTER this line from the menu.
      - Click the 🔄 icon next to the action where you want to add a new action and select ⬇️ insert a new statement INTO this line from the menu.

   2. Click **Pick an action to add** and select the desired action from the list.

3. Click **Add New Action**.

4. Enter the required input for the type of action selected:

<table>
<thead>
<tr>
<th>Action</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Column</td>
<td>In the <strong>name</strong> box, enter the name of the column you would like to adjust (e.g., date). Click <strong>Add Attribute</strong> and select any of the following from the list:</td>
</tr>
<tr>
<td></td>
<td>• label - Enter a column heading (e.g. Transaction Date).</td>
</tr>
<tr>
<td></td>
<td>• format - Enter a display format for the column (e.g., type:date4y).</td>
</tr>
<tr>
<td></td>
<td>• fixed - Enter 1 to make the column a fixed column or 0 to unfix a column.</td>
</tr>
<tr>
<td>Rearrange Columns</td>
<td>In the <strong>cols</strong> box, enter a comma-separated list of column names in the order you want them displayed (e.g., transid,date,units,cost).</td>
</tr>
<tr>
<td>Link</td>
<td>In the <strong>table2</strong> box, enter the name of the table you would like to link in (e.g., training.retail.prod). In the <strong>col</strong> box, enter the name of the column in the current table on which you would like to link (e.g., sku). Click <strong>Add Attribute</strong> and select any of the following from the list:</td>
</tr>
<tr>
<td></td>
<td>• col2 - Enter the name of the column in the foreign table that you are linking on (e.g. sku).</td>
</tr>
<tr>
<td></td>
<td>• label - Enter text that will be added to the foreign table column headings in the linked table (e.g., Product Master).</td>
</tr>
<tr>
<td></td>
<td>• suffix - Enter any alphanumeric value that will be appended to the foreign table column names in the linked table (e.g., _PM).</td>
</tr>
<tr>
<td></td>
<td>• type - Enter asof if you would like to use as-of links, or select to perform a link and select.</td>
</tr>
<tr>
<td></td>
<td>• shift - Enter the number of rows to shift when performing an as-of link.</td>
</tr>
<tr>
<td>Select Rows</td>
<td>In the <strong>value</strong> box, enter a selection expression, which will be used to define a subset of rows (e.g., store=3).</td>
</tr>
<tr>
<td>Sort</td>
<td>In the <strong>col</strong> box, enter the name of the column on which you would like to base the sort (e.g., sku). Click <strong>Add Attribute</strong>, select <strong>dir</strong> from the list, and enter <strong>up</strong> or <strong>down</strong>, depending on the type of sort you want.</td>
</tr>
</tbody>
</table>
Tabulation

Under the **Tabulation** section, in the **breaks** box, enter a comma-separated list of column names by which you would like to group the records (e.g., date). Click **Add Attribute** and select any of the following from the list:

- **label** - Enter the title for the resultant table (e.g., Summary of Sales by Date).
- **cbreaks** - For the columns in a cross tabulation, enter a comma-separated list of column names by which you would like to group the records. All records that have the same values for these columns will be grouped together. If omitted, the result is a straight tabulation.
- **clabels** - Enter **long** if you want column headings in the resultant table to include the grouping column names along with the values (e.g., Color=red Size=large). Enter **short** if you want only the grouping columns' values to appear in the column headings (e.g., red large).

Under the **Summary** section, in the **source** box, enter the name of the column that you would like to summarize (e.g., sales). In the **fun** box, enter the type of summarization (e.g., sum). Click **Add Attribute** and select any of the following from the list:

- **name** - Enter a name for the summarization column; if no name is specified, a name will be assigned by default (e.g., t0).
- **weight** - For functions that require a second column (e.g., weighted average, correlation), enter the name of the second column.
- **label** - Enter a column heading for the summarization column (e.g., Sales Summary).
- **format** - Enter a display format for the column (e.g., type:nocommas).

New Column

In the **name** box, enter the name of the new column (e.g., margin). In the **value** box, enter a value expression, which is a mathematical formula that will determine the value of the computed column (e.g., sales-cost).

5. To add additional attributes, click **Add Attribute**, select the desired item from the list, and enter the value for that attribute.

6. To delete an attribute, click the 🗑 icon next to it.

7. Click **Accept Changes**.

**To edit an existing action:**

1. Click the 📝 icon next to the action you want to edit and select **edit this line** from the menu (or double-click the text of the action).

2. Make the desired changes.

3. Click **Accept Changes**.

**To delete an existing action:**

1. Click the 🗑 icon next to the action you want to edit.

2. Select **delete this line** from the menu

3. Click **OK** to confirm that you want to delete the line.

**To reorder actions:**

1. Drag the action to the desired position within the list of actions.

3. Click **Apply**.

The actions will be applied to the current table or worksheet.
Undo the last action

Return the table to its state before the last action was taken and remove that action from the history.

To undo the last action:

In an open table or worksheet, click **Actions > Undo Last Action**.

The table is returned to its state before the last action was taken, and the action is removed from the history. You can repeat this all the way to the initial state of the table (when it was originally loaded into the current tab), if desired. Also, you can undo all actions at once by clicking **Actions > Undo All Actions**.

**Note:** This will have no effect if there are no prior actions (i.e., if no actions have yet been taken or if you have undone all of the steps in your history).

**Note:** Undoing the last action is different from going back one step. Undoing the last action removes that action from your history, so that you cannot subsequently redo that action.

Undo all actions

Return the table to its initial state and remove from the history all of the actions taken.

To undo all actions:

In an open table or worksheet, click **Actions > Undo All Actions**.

The table is returned to its initial state (when it was originally loaded into the current tab), and all of the actions taken are removed from the history.

**Note:** This will have no effect if there are no prior actions (i.e., if no actions have yet been taken or if you have undone all of the steps in your history).

Undoing all actions removes those actions from your history. You cannot subsequently redo any of those actions, which is different than going back through all of the steps in your analysis.

Save actions as a text file

Save the Macro Language XML associated with the current set of actions as a text file on your computer.

To save the current set of actions as a text file:

In an open table or worksheet, click **Actions > Save Actions as Text File**.

A file named `download.txt` containing the Macro Language XML for the current set of actions is downloaded to your local system.

Writing Efficient Queries

When using large tables with more than 50 million rows, the efficiency of a query can have a significant impact on run time and memory usage.

Here are some suggestions that will make the 1010data Insights Platform perform optimally.

**General**

**Do it step-by-step**
Writing a query in its entirety and executing it all at once can be risky on large tables. It may take a long time or may not work at all, and you won't necessarily know what operations are causing the problem. Instead, run the instructions line by line to catch and pinpoint any inefficiencies.

**Use sample data**

While developing a query, use a small subset of the entire database. For example, select the first 1000 rows of the table with the selection expression: \( i <= 1000 \). If you are working with a multi-segment table (>5M rows), try to capture a subset of 2-3 segments.

**Cancel queries completely**

If a query is running longer than expected and does not seem to be finishing, you cannot stop the process by clicking the browser's stop button. Clicking the stop button frees up the browser window, but the query continues to be processed, using system resources and potentially impacting other users. Even closing the browser window will not stop the process on the 1010data servers. Instead, login to 1010data and choose the option **End existing session** when prompted. Logging in this way kills the previous query process and cleans things up.

**Consider using TenDo or the 1010data Excel Add-in**

In the case of an extremely large query, the Insights Platform may not finish processing it before reaching a set time-out period. When this occurs, the query is automatically resubmitted. Fortunately, because each query operation is cached after it is run, the Insights Platform continues to process the query from the point at which it timed-out instead of from the beginning. In nearly all cases, this allows the query to finish processing.

If the query neither completes nor fails after being resubmitted 20 times, an error message is displayed. Should this occur, 1010data recommends canceling the transaction and submitting it using TenDo or the 1010data Excel Add-in. For instructions, see the **TenDo User's Guide** or the **1010data Excel Add-in User's Guide**.

**Selections**

**Select using native columns first**

Where possible, use native columns to perform selection statements.

- Select on computed columns or perform a link-and-select only when the above is not possible.
- A link with type="select" is more efficient than a link followed by a select when trying to find only those rows in the base table that are in the foreign table.
- When batching together queries via TenDo or the Excel Add-in, use parameter substitution where the parameters are the results of a query whenever possible. This technique is much faster than the alternatives.

**Use the right order**

When performing multiple selections, always start with the most highly selective statements first and the least selective statements last. For example, if you wanted to see the transaction data of a single store for a given date range, you should perform the store selection before the date range selection.

**Don't select too many rows**

Make your selections count! Selections that keep too many rows (e.g., more than 50 million) use a significant amount of memory. For large tables, try to especially avoid selection statements that select almost the entire table. If you must select a large number of records, try an alternative approach. For example, if you select rows and then tabulate:

1. Define a computed column named **include**, whose value is the selection expression. This column will be 1 for rows you want to keep and 0 for rows you want to omit.
2. Make **include** one of the break columns in the tabulation.
3. After the tabulation, select rows where **include** is 1.
Learn what columns are indexed
Indexing is not explicitly revealed in the user interface, but can make selections on large tables much more memory efficient.

Defining Columns and Writing Selection Expressions

Choose the appropriate function
Different types of functions use different amounts of system resources. When you are defining a column, always use functions in this order for best performance: regular functions, G_Functions, tabulations.

Use G_Functions on segmented tables before resorting to tabulation
Computed columns are only calculated as needed, whereas tabulations calculate all results. Remember, time series and group summarization functions (beginning with g_ or t_) use significantly more time and memory than other functions.

Tabulate and filter before creating computed columns
Where possible, define computed columns after tabulations. Computed columns add overhead; the fewer rows they are applied to, the better.

Create a reference column
If the same computation is referenced multiple times, create a column with it and reference that thereafter.

Use built-in functions
Use 1010data functions wherever possible instead of complex expressions.

Eliminate unnecessary if’s or if-then-else’s
When possible use logical arithmetic or another categorization function. Logical arithmetic applies if the desired results are 0 if false and 1 if true.

Avoid complicated text searches
Manipulating or searching on text values is more expensive than similar operations on numeric operations. In particular, don’t use the function contains (x;y) if you can use equals (=).

Handle divide-by-zero’s
Select the Error and Infinity Handling check box in the Advanced Settings dialog. Alternatively, check if a denominator is zero before dividing and adjust your computation accordingly.

System variables
The system variables i_ or zi_ are equivalent to creating computed columns. Consider this when using them in selections or tabulations.

Be aware of data types
Integer arithmetic is faster than decimal arithmetic, which is faster than string manipulation.

Sorting
Sort after tabulating
Sort the table during or after a tabulation rather than before, especially if there are more than a few million rows.

Linking
Avoid large worksheets
Linking to large worksheets (more than a few million rows or many columns) can use a significant amount of memory.

1. If possible, avoid linking to worksheets entirely, except in cases where you can significantly pare down the number of rows.
2. To reduce the size of the foreign worksheet, select rows before linking.
3. Use a color to only link in the needed columns.
4. Try to do the analysis within the same worksheet. If necessary, save the worksheet as a table, then link it in.

Suffix and labels
Consider using a suffix and a label when you link together two data sets that share common column names. That way, you can avoid redefining a column so it has a meaningful name (not c1 or t1). Plus, any macro code that refers to a renamed column will always use more resources than those that directly reference the original column.

Tabulating

Understand the costs
Memory usage and run time is a function of the number of breaks, type of breaks (original column vs. computed column), number of result columns, complexity of the break columns (how many characters define a unique break value), and type of aggregation functions. Tabulate on original columns whenever possible.

Limit the size of the result
Do not break on a column (or set of columns) that has more than a few million different values.

Only create tabulation groups needed to give unique results
Unnecessary breaks still create overhead.

Do things piecewise
If your data set is very large and you are running into memory problems, apply the tabulation to subsets of the data and combine the results afterwards.

Round real numbers
Before using a real (floating point) column as a break column, round the values. The system may have trouble distinguishing between real numbers that are very close in value, and rounding will help ensure that the values are not that close to one another.

Adjust your advanced settings
Change your advanced settings for very large data sets and complex queries that require a lot of memory. In the Advanced Settings dialog, select a lower Blocking Level or select Do step-wise aggregation, as these two settings work together to use less memory. Note: This may slow down execution time.

Supply column names in tabulations
It is better to name the variables produced in tabulations instead of relying on the default names given in the tabulation (e.g., t0, t1, t2). If you supply column names, you don't have to create an additional computed column to rename a default tabulation name. Plus, any later code that refers to the new computed column names will always use more resources than those that directly referenced c1.

Merging

Row limitations of merged tables
Merged tables are limited to ~16 million cells (number of rows * number of columns).
Unrestricted Merges

If the `<merge>` operation appears before all other operations in a macro (except `<note>`) and the default attributes `type=all` and `match=names` are used, and no other tags are contained within the `<merge>` operation, then the merged table size is unlimited.

Saving and Downloading Tables

Understand the costs

Saving large tables can take a long time just like running large tabulations. When you save a table, it requires the system to compute all the rows and columns. This can tax the system resources unnecessarily. In some cases, it is actually faster to run the query again instead of saving the results.
Quick Queries

Quick Queries can be used to save a set of actions so that they may be rerun at a later time. Using Quick Queries, you can also parameterize specifics of the analysis so that the user is prompted for input each time it is run.

If you applied certain actions to a table (e.g., row selections, sorting, linking, computed columns, summarizations), you may specify which parameters may be input each time the Quick Query is run. For example, if you did a row selection such as Column1 is greater than 100, you may want to use something other than 100 the next time you run the query. Using Quick Queries, you can make that value an input. Similarly, you may wish to make the column choice an input (e.g., to use Column2 instead of Column1) or even the relationship (e.g., is less than instead of is greater than). Each of these parameters of the selection (value, column, and relationship) may be made an input. Similarly, for tabulations, the choice of grouping columns, result columns, and summarization methods may all be made inputs, as can the parameters of most other actions. You can also prompt the user to select the table to which the analysis is applied.

Note the difference between saving actions as a Quick Query and saving the results as a new table. When you save your actions as a Quick Query, only the actions are saved, not the results. When the Quick Query is run at a later time, the actions are applied to the table at that time. If the table had been updated or corrected, the results of the Quick Query would reflect those changes. On the other hand, when you save the results as a new table, the actual results are saved. If the original table were modified, the new table that you had previously saved would not reflect the changes.

You may run a Quick Query by double-clicking its title or icon in the Folders and Tables browser. Quick Queries are identified by the icons:
- - denotes a Quick Query that does not require any user input
- - denotes a Quick Query that prompts for user input

In addition, a Quick Query allows you to share your analysis with others, since you may give others permission to access it. When you share a Quick Query with another user or group, they must also have access to the parent folder of the Quick Query (and all of the folders in its full path) as well as any tables that the Quick Query references. View information about a particular Quick Query to find out its full path and the tables it references. For more information, see Share folders, tables, or queries on page 30.

You can also download text files containing either your Quick Queries or lists of users who have access to them.

Save as a Quick Query

After you have completed an analysis, you may save the actions as a Quick Query. You will then be able to rerun the analysis at a later time or share the Quick Query with others so that they may run it.

To save the actions in the current table or worksheet as a Quick Query:

1. Click File > Save as Quick Query...
   The Save As a Quick Query dialog is presented.
2. Specify where to save the Quick Query:
   - If you are replacing an existing Quick Query, select Replace old query?
     Be careful when you select this option. Once you click Submit, the existing Quick Query is replaced. There is no warning or pop-up message confirming this action.
   - If you are saving a new Quick Query, under Save into folder, navigate to the folder where you want to save it.
     Make sure Replace old query? is not selected, as it will take precedence.
Note: You can only save the Quick Query in a folder that you own (Down) or have permission to add to (Add).

3. In **Title of Query**, enter a title for the Quick Query.

   The title is used to help describe the behavior of the Quick Query (e.g., *Transactions by Store*) and may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters.

4. If you have any open charts that you would like to save with the Quick Query, click **Save open charts**.

5. From the **Show the result as** list, select how you would like to display the results of the Quick Query.

   You may save the results of the Quick Query in a variety of formats, such as an interactive table, a QuickApp, an Excel spreadsheet, a PDF report, or a comma-separated text file.

6. From the **Base Table** list, select whether to always start with the same table, allow the user to select any table in the same folder as the table on which you are currently working, or allow the user to select any table anywhere.

7. In the **User Prompt** box, enter the text that will appear when the user is asked to select the base table.

   The prompt will be displayed for Quick Queries when **Base Table** is set to Allow user to choose table in this folder or Allow user to choose any table.

8. For each parameter you want to prompt for input when the Quick Query is run:
   a) Select the **Input?** check box for the parameter.
   b) Enter the **User Prompt** that will be displayed to prompt for input.
   c) Select the **Input Type** for the parameter from the drop-down list.

   The **Input Type** depends on the type of parameter (e.g., column, value, relation) and the action associated with the parameter (e.g., select, sort, tabulate). See **Input Types** on page 118 for an explanation as well as a detailed list of actions and their associated parameters.

9. Click **Submit**.

   The Quick Query is saved.

Once you have saved a Quick Query, it behaves like a black box. Running it produces a result, but you cannot see the actions saved in the Quick Query, much less modify them. To see the actions and modify them, you must edit the Quick Query. For instructions, see **Edit a Quick Query** on page 129. To share the Quick Query with others, see **Share folders, tables, or queries** on page 30.

### Input Types

When you create a Quick Query, you may specify not only that a given item may be input but also the method of input, such as a text field or drop-down selection box.

Most parameters of most table actions can be made inputs. For example, in a row selection like **Column1 has the value 100**, the value 100 can be an input. In this case, you have the option of making it a text field, a drop-down selection box, or a multi-value selection box. In the first case, when the query is run, the user will be asked to type a value (e.g., 100). In the second, the user will be presented with a list of all possible values in **Column1** and will be able to select a value from a list. In the third case, the user will also be presented with a list of all possible values, but will be able to select one or more values. The choice of input types for a given item depends on the type of action and parameter.

You may also specify whether a given input item is optional or required. If an item is optional, the user may leave it blank, which, in turn, causes the query to run without that item. The result of leaving an item blank depends specifically on the type of action and parameter. If, for example, the value in a row selection is left blank, the selection is ignored and all rows are retained. On the other hand, if a grouping column in a tabulation is left blank, the tabulation is performed, but it is done with fewer (or no) grouping columns.

If an item is optional, you can make it **Opt In** or **Opt Out**. **Opt In** means that the input will start out as blank; when set to **Opt Out**, the input shows the value that appears under **Current Value**. (For a required input, the input always shows the **Current Value**.)
Action: Select

These are the input types for the various parameters associated with a Select action within a Quick Query.

Parameter: Column for criterion $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the criterion is ignored.</td>
</tr>
<tr>
<td>Dropdown,Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the criterion is ignored.</td>
</tr>
</tbody>
</table>

Parameter: Relation for criterion $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a relationship (has the value(s), is greater than, etc.) via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a relationship (has the value(s), is greater than, etc.) via a drop-down selection box. The selection box is initially shown with a relationship selected but the user may clear it. If the user clears it (i.e., chooses no relationship), the criterion is ignored.</td>
</tr>
<tr>
<td>Dropdown,Opt In</td>
<td>The user may choose a relationship (has the value(s), is greater than, etc.) via a drop-down selection box. The selection box is initially shown with no relationship selected. If the user leaves it blank (i.e., chooses no relationship), the criterion is ignored.</td>
</tr>
</tbody>
</table>

Parameter: Value for criterion $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text,Required</td>
<td>The user is required to type a value into a text field.</td>
</tr>
<tr>
<td>Text,Opt Out</td>
<td>The user may type a value into a text field. The field is initially filled in. If the user clears it, the criterion is ignored.</td>
</tr>
<tr>
<td>Text,Opt In</td>
<td>The user may type a value into a text field. The field is initially blank. If the user leaves it blank, the criterion is ignored.</td>
</tr>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a value via a drop-down selection box. The choices in the selection box are not sensitive to previous selections. (If...</td>
</tr>
<tr>
<td>Input Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dropdown, Strict, Required</td>
<td>The user is required to choose a value via a drop-down selection box. <em>The choices in the selection box are sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a value via a drop-down selection box. The selection box is initially shown with a value selected, but the user may clear it. If the user clears it (i.e., chooses no value), the criterion is ignored. <em>The choices in the selection box are not sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Dropdown, Strict, Opt Out</td>
<td>The user may choose a value via a drop-down selection box. The selection box is initially shown with a value selected, but the user may clear it. If the user clears it (i.e., chooses no value), the criterion is ignored. <em>The choices in the selection box are sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a value via a drop-down selection box. The selection box is initially shown with no value selected. If the user leaves it blank (i.e., chooses no value), the criterion is ignored. <em>The choices in the selection box are not sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Dropdown, Strict, Opt In</td>
<td>The user may choose a value via a drop-down selection box. The selection box is initially shown with no value selected. If the user leaves it blank (i.e., chooses no value), the criterion is ignored. <em>The choices in the selection box are sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Multiple, Required</td>
<td>The user is required to choose one or more values via a selection box. The choices in the selection box are not sensitive to previous selections. (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Multiple, Strict, Required</td>
<td>The user is required to choose one or more values via a selection box. <em>The choices in the selection box are sensitive to previous selections.</em> (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Input Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multiple, Opt Out</td>
<td>The user may choose one or more values via a selection box. The selection box is initially shown with one or more values selected, but the user may clear them. If no value is selected, the criterion is ignored. The choices in the selection box are not sensitive to previous selections. (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Multiple, Strict, Opt Out</td>
<td>The user may choose one or more values via a selection box. The selection box is initially shown with one or more values selected, but the user may clear them. If no value is selected, the criterion is ignored. The choices in the selection box are sensitive to previous selections. (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Multiple, Opt In</td>
<td>The user may choose one or more values via a selection box. The selection box is initially shown with no values selected. If the user leaves it blank (i.e., chooses no value), the criterion is ignored. The choices in the selection box are not sensitive to previous selections. (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
<tr>
<td>Multiple, Strict, Opt In</td>
<td>The user may choose one or more values via a selection box. The selection box is initially shown with no values selected. If the user leaves it blank (i.e., chooses no value), the criterion is ignored. The choices in the selection box are sensitive to previous selections. (If there are more than 1000 choices, a text field is used instead of a selection box.)</td>
</tr>
</tbody>
</table>

Parameter: Lower value for criterion $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text, Required</td>
<td>The user is required to type a value into a text field.</td>
</tr>
<tr>
<td>Text, Opt Out</td>
<td>The user may type a value into a text field. The field is initially filled in. If the user clears it, the criterion is ignored.</td>
</tr>
<tr>
<td>Text, Opt In</td>
<td>The user may type a value into a text field. The field is initially blank. If the user leaves it blank, the criterion is ignored.</td>
</tr>
</tbody>
</table>

Parameter: Upper value for criterion $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text, Required</td>
<td>The user is required to type a value into a text field.</td>
</tr>
</tbody>
</table>
### Parameter: Selection expression

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text,Required</td>
<td>The user is required to type a selection expression into a text field.</td>
</tr>
<tr>
<td>Text,Opt Out</td>
<td>The user may type a selection expression into a text field. The field is initially filled in. If the user clears it, no selection is done.</td>
</tr>
<tr>
<td>Text,Opt In</td>
<td>The user may type a selection expression into a text field. The field is initially blank. If the user leaves it blank, no selection is done.</td>
</tr>
</tbody>
</table>

### Action: Sort

These are the input types for the various parameters associated with a **Sort** action within a Quick Query.

### Parameter: Column

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), no sorting is done.</td>
</tr>
<tr>
<td>Dropdown,Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), no sorting is done.</td>
</tr>
</tbody>
</table>

### Parameter: Direction

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a sort direction via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a sort direction via a drop-down selection box. The selection box is initially shown with a direction selected, but the user may clear it. If the user clears it (i.e., chooses no direction), no sorting is done.</td>
</tr>
</tbody>
</table>
### Action: New Column

These are the input types for the parameter associated with a **New Column** action within a Quick Query.

#### Parameter: Value

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text,Required</strong></td>
<td>The user is required to type a value expression into a text field.</td>
</tr>
<tr>
<td><strong>Text,Opt Out</strong></td>
<td>The user may type a value expression into a text field. The field is initially filled in. If the user clears it, no column is created.</td>
</tr>
<tr>
<td><strong>Text,Opt In</strong></td>
<td>The user may type a value expression into a text field. The field is initially blank. If the user leaves it blank, no column is created.</td>
</tr>
<tr>
<td><strong>Dropdown,Required</strong></td>
<td>The user is required to choose a column via a drop-down selection box. The new column will have the same values as the selected column.</td>
</tr>
<tr>
<td><strong>Dropdown,Opt Out</strong></td>
<td>The user may choose a column via a drop-down selection box. The new column will have the same values as the selected column. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), no column is created.</td>
</tr>
<tr>
<td><strong>Dropdown,Opt In</strong></td>
<td>The user may choose a column via a drop-down selection box. The new column will have the same values as the selected column. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), no column is created.</td>
</tr>
</tbody>
</table>

### Action: Link

These are the input types for the various parameters associated with a **Link** action within a Quick Query.

#### Parameter: Linked table

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dropdown,Required</strong></td>
<td>The user is required to choose a table via a drop-down selection box.</td>
</tr>
<tr>
<td><strong>Dropdown,Opt Out</strong></td>
<td>The user may choose a table via a drop-down selection box. The selection box is initially shown with a table selected, but the user may clear it. If</td>
</tr>
</tbody>
</table>
### Input Type  

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a table via a drop-down selection box. The selection box is initially shown with no table selected. If the user leaves it blank (i.e., chooses no table), no link is done. The user clears it (i.e., chooses no table), no link is done.</td>
</tr>
<tr>
<td>Browse, Required</td>
<td>The user is required to choose a table via a table browser.</td>
</tr>
</tbody>
</table>

#### Parameter: Column in linked table

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), no link is done.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e. chooses no column), no link is done.</td>
</tr>
</tbody>
</table>

#### Parameter: Column in this table

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), no link is done.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), no link is done.</td>
</tr>
</tbody>
</table>

#### Action: Tabulate

These are the input types for the various parameters associated with a Tabulate action within a Quick Query.

#### Parameter: Row group x

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
</tbody>
</table>
### Quick Queries

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
</tbody>
</table>

#### Parameter: Column for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

#### Parameter: Summary for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a summarization method via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with a method selected, but the user may clear it. If the user clears it (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with no method selected. If the user leaves it blank (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

#### Parameter: Weight for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Input Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), equal weights are assumed.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), equal weights are assumed.</td>
</tr>
</tbody>
</table>

**Action: Cross Tabulate**

These are the input types for the various parameters associated with a Cross Tabulate action within a Quick Query.

**Parameter: Row group x**

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
</tbody>
</table>

**Parameter: Column group x**

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation is done using the remaining grouping columns, if any.</td>
</tr>
</tbody>
</table>
### Parameter: Column for result \( x \)

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

### Parameter: Summary for result \( x \)

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a summarization method via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with a method selected, but the user may clear it. If the user clears it (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with no method selected. If the user leaves it blank (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

### Parameter: Weight for result \( x \)

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown, Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown, Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), equal weights are assumed.</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>
### Action: Quick Summary

These are the input types for the various parameters associated with a **Quick Summary** action within a Quick Query.

### Parameter: Column for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown,Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

### Parameter: Summary for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a summarization method via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with a method selected, but the user may clear it. If the user clears it (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
<tr>
<td>Dropdown,Opt In</td>
<td>The user may choose a summarization method via a drop-down selection box. The selection box is initially shown with no method selected. If the user leaves it blank (i.e., chooses no method), the tabulation has one fewer result.</td>
</tr>
</tbody>
</table>

### Parameter: Weight for result $x$

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown,Required</td>
<td>The user is required to choose a column via a drop-down selection box.</td>
</tr>
<tr>
<td>Dropdown,Opt Out</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with a column selected, but the user may clear it. If the user clears it (i.e., chooses no column), equal weights are assumed.</td>
</tr>
<tr>
<td>Input Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dropdown, Opt In</td>
<td>The user may choose a column via a drop-down selection box. The selection box is initially shown with no column selected. If the user leaves it blank (i.e., chooses no column), equal weights are assumed.</td>
</tr>
</tbody>
</table>

**Run a Quick Query**

When you run a Quick Query, it executes in a new tab, prompting for the inputs it expects.

To run a Quick Query:

1. Navigate to the desired Quick Query in the **Folders and Tables** browser.
2. Double-click the Quick Query that you want to run.
   
   A new tab is opened, and the Quick Query is executed.

   **Note:** If you use a Quick Query often, you may want to add it to your favorites. You can then find it quickly and easily in the **Favorites** section on the **Start Page**.

3. Enter any inputs that the Quick Query prompts for.
4. Click **Submit**.

   The results of the Quick Query are displayed in the current tab.

   Any charts that were saved with the Quick Query are opened in compact mode and can be modified using the Chart Builder.

**Edit a Quick Query**

You can change the attributes of an existing Quick Query, such as in which format the results are saved, how the base table is specified, and which parameters will be prompted for input when the Quick Query is run.

It is important to understand that editing a Quick Query is different from editing the **information** about the Quick Query. For example, to change the prompts a user sees when a Quick Query runs, edit the Quick Query. However, to edit the meta information, such as who has access to the Quick Query, edit the **information** about the item. For more information, see **Edit information about an item** on page 29.

To edit a Quick Query:

1. Navigate to the desired Quick Query in the **Folders and Tables** browser.
2. Click the Quick Query.

   The Quick Query is highlighted in blue, and its full path appears underneath the **Folders and Tables** toolbar along with its associated actions.

3. In the list of actions underneath the toolbar, click **edit query**.

   The **Save As a Quick Query** dialog is presented.

4. In the **Save As a Quick Query** dialog, make the desired changes.
5. Specify where to save the Quick Query:

   - If you want to replace the Quick Query you are editing, select **Replace old query?**

     Be careful when you select this option. Once you click **Submit**, the existing Quick Query is replaced. There is no warning or pop-up message confirming this action.
• If you want to save this as a new Quick Query, under **Save into folder**, navigate to the folder where you want to save it.

  Make sure **Replace old query?** is not selected, as it will take precedence.

  **Note:** You can only save the Quick Query in a folder that you own (**own**) or have permission to add to (**Add**).

6. To save open charts with the Quick Query, make sure **Save open charts** is selected.

7. Click **Submit**.
Query Scheduler

The Query Scheduler allows you to create, find, edit, delete, and run query jobs.

Oftentimes, you might want to schedule a query to run on a regular basis, such as every hour or every day at a particular time. Using the Query Scheduler, you can schedule these jobs and have the completed job reports sent to any number of recipients. These reports can be provided as comma-separated text files, PDF documents, or Excel workbooks.

The Query Scheduler can be accessed by clicking Admin under the drop-down menu corresponding to your username in the top right corner of your 1010data session and then clicking on Query Scheduler on the Account Administration toolbar.

The Query Scheduler page has a text box at the top, which is used for searching, and a number of tabs below that:

- **My Jobs**
- **Other People’s Jobs** *(admin only)*
- **Job Information**
- **Run History**

The Run History tab is hidden until you click the Show Run History link in the My Jobs or Other People’s Jobs tabs. It is hidden again when you click the Clear Form button.

Please note that you will not be able to log into the GUI while any of your scheduled jobs are running. You can log in before a job starts or after it finishes. If you try to log in while a job is running, you will be shown the following message:

Warning: User is already logged in. Please choose to:
- Re-enter existing session
- End existing session

If you click the first option, the following message is displayed:

Cannot possess session. Type of session is: API
End existing session

You can choose to end the existing session, but be aware that this will kill your job mid-execution.

**My Jobs**

The My Jobs tab of the Query Scheduler page lists all jobs owned by your user ID.

There are three columns:

- **Job ID**
  - The unique identifier of the job.

- **Job Title**
  - The title (or name) of the job.

- **State**
  - The state of the job.

This indicates whether the job is scheduled to run sometime in the future (Active) or is not scheduled to run (Inactive).

If you don’t own any jobs, the message "You currently have no scheduled jobs" will appear.
Otherwise, each job will be listed on its own line. You can click on a job row to populate its information in the Job Information tab to edit, delete, or execute the job. In addition, there is a Show Run History link for each job in the list. Clicking on this link will open the Run History tab, which shows information about the last few runs of that particular job.

Other People’s Jobs (admin only)

For company administrators, the Other People’s Jobs tab of the Query Scheduler page lists all jobs owned by all users in your company, excluding those owned by your user ID.

There are three columns:

- **Job ID**
  - The unique identifier of the job.
- **Job Title**
  - The title (or name) of the job.
- **State**
  - The state of the job.
  - This indicates whether the job is scheduled to run sometime in the future (Active) or is not scheduled to run (Inactive).

If there are no jobs owned by other users in your company, the message “There are no scheduled jobs” will appear.

Otherwise, each job will be listed on its own line. You can click on a job row to populate its information in the Job Information tab to edit, delete, or execute the job. In addition, there is a Show Run History link for each job in the list. Clicking on this link will open the Run History tab, which shows information about the last few runs of that particular job.

Clicking the Refresh button will re-populate the form with updated information (in the case where another user has updated/added/deleted a job in the time since you first opened the tab).

Job Information

The Job Information tab of the Query Scheduler page allows you to create, edit, delete, or run a job.

It contains two types of fields:

- **Read-Only**
- **User Input**

To clear the form of all Read-Only fields and specified inputs, click the Clear Form button.

Read-Only Fields

- **Job Owner ID**
  - The user ID that created the job, which is not necessarily the same as Job Runner ID.
  - Administrators can set this to any user ID within their company.

- **Job Runner ID**
  - A valid 1010data user ID that will execute the job.
  - **Note:** This field is automatically set to your user ID.

- **Job ID**
The unique identifier of the job. (This field is auto-generated.)

**Cron String**

The frequency of the job.

**State**

Indicates whether the job is *Active* (scheduled to run sometime in the future) or *Inactive* (not scheduled to run).

**Current Status**

The current status of the job.

This can be one of the following:

- **Scheduled** – The job is scheduled to run, but is not in the process of running.
- **In Progress** – The job is in the process of running.
- **Failed** – The job recently ran and failed.
- **Ended** – The job recently ran and succeeded.

**Last Run Status**

The status of the job when it last ran, indicating whether it succeeded (Ended) or failed (Failed).

**Last Run TS**

The time the last job ran.

*Note:* This timestamp is in GMT.

**Last Run Msg**

The error message associated with the job if it failed in its last run.

**User Input Fields**

**Job Title**

A non-unique string that can consist of up to a maximum of 50 characters, including spaces. *(required)*

**Report Recipients (1010data IDs)**

A space-separated list of valid usernames that will receive the reports. *(required)*

This field is pre-populated with your user ID.

*Note:* There is no limit to the number of recipients of a scheduled report.

**Unsubscribed Report Recipients**

A space-separated list of user IDs that have unsubscribed from the report.

This list provides a way for company administrators and job owners to see who unsubscribed from reports (via the Unsubscribe link in the distribution emails) and, if necessary, re-subscribe them by removing them from this list.

**Quick Query/Base Table Path or ID**

The ID or path of the Quick Query to schedule, or the path to the table on which the query specified in **Query Text** will run. *(required)*

You can either specify the ID of a table (e.g., 473854) or its path (e.g., demos.test.table). The system will validate if the path exists and confirm you have access to it.

**Query Text**

The Macro Language code to run.
You must specify a base table path in **Quick Query/Base Table Path or ID**.

**Note:** Leave this field blank if you specify a Quick Query in the **Quick Query/Base Table Path or ID** field.

**Gateway Version**

The version of 1010data on which to run the job.

Possible values are:

- `prod-latest`
- `beta-latest`
- `prod-x.yz`
- `beta-x.yz`

where `x.yz` is the specific version (e.g., `prod-7.47`, `beta-8.04`)

If a **Gateway Version** is not specified, the default is the version of 1010data the user is configured to use; if there is no version configured for the user, the default is the version of 1010data the user's company is configured to use.

**Note:** This is not necessarily the same version as the one the user was logged into when they created the job.

**Output Format**

The format of the report.

The options are:

- `ALL` - all three formats
- `CSV` - comma-separated text file
- `XLS` - Excel workbook
- `PDF` - PDF document

The default option is `CSV`.

**Frequency**

How often you want the job to run.

**Hourly**

From the drop-down, select the number of hours you want to pass before running the job again.

**Daily**

Enter the time you want the job to run. From the drop-down list, select how many days you want to pass before running the job again.

**Weekly**

Enter the time you want the job to run. From the drop-down list, select which days of every week you want the job to run.

**Monthly**

Enter the time you want the job to run. From the drop-down list, select which days of every month you want the job to run.

**Note:** Execution will not always occur at the exact time specified, as it depends on the schedule queue and available resources.

The following selections will change based on the selected **Frequency** option. This combination of selections will generate a standard `crontab` entry.

**Time Zone (GMT Offset)**
The time zone in which you’d like the job to run.
It is pre-selected with the Time Zone specified under the Location section of your user preferences, though you can change it to any other option.

**Note:** Time zone offsets are set values that are not affected by DST.

**Job Expiration Date**

The date (in YYYYMMDD form) you’d like to deactivate the job.

You can click on the calendar icon (📅) to select the date from a date picker. Click anywhere outside the date picker to dismiss it.

If you set the Job Expiration Date to a past date, the job will never run. To reactivate a job, simply delete the value in this field.

**First error notification sent after n minutes**

The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*

If a job doesn’t finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for first error notification** field.

**Use the following email addresses for all error notifications**

When this check box is selected, all the email addresses in the **Recipient Email Address(es) for first error notification** field will be copied to the **Recipient Email Address(es) for second error notification** and **Recipient Email Address(es) for third error notification** fields.

**Recipient Email Address(es) for first error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn’t finish within the previously specified timeframe. *(required)*

It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

**Second error notification sent after n minutes**

The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*

If a job doesn’t finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for second error notification** field.

**Recipient Email Address(es) for second error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn’t finish within the previously specified timeframe. *(required)*

It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

**Third error notification sent after n minutes**

The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*

If a job doesn’t finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for third error notification** field.

**Recipient Email Address(es) for third error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn’t finish within the previously specified timeframe. *(required)*
It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

Run History

The Run History tab of the Query Scheduler page shows information about the last few runs of a particular job.

For every job listed in the My Jobs and Other People’s Jobs tabs, there is a link labeled Show Run History. Clicking this link will open the Run History tab with information from the last few runs of the job, with each run listed on its own line.

Each run listed in the Run History tab has a More Info link next to it. Clicking this link displays detailed information about the particular run. To hide the detailed information, click the Less Info link.

The Run History tab is hidden until you click the Show Run History link in the My Jobs or Other People’s Jobs tabs. It is hidden again when you click the Clear Form button.

Create a job

You can schedule a query to run at a specified frequency and have the results sent as a comma-separated text file, Excel workbook, or PDF to one or more users.

To create a job:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.

   The Account Administration page will be opened in a new tab.

2. On the Account Administration toolbar, click the Query Scheduler icon (📊).

3. Click the Job Information tab.

4. Enter the information pertaining to the job that you want to schedule.

   At a minimum, you must enter the information in the required fields:

   **Job Title**
   
   A non-unique string that can consist of up to a maximum of 50 characters, including spaces. *(required)*

   **Report Recipients (1010data IDs)**
   
   A space-separated list of valid usernames that will receive the reports. *(required)*

   This field is pre-populated with your user ID.

   **Note:** There is no limit to the number of recipients of a scheduled report.

   **Quick Query/Base Table Path or ID**
   
   The ID or path of the Quick Query to schedule, or the path to the table on which the query specified in Query Text will run. *(required)*

   You can either specify the ID of a table (e.g., 473854) or its path (e.g., demos.test.table). The system will validate if the path exists and confirm you have access to it.

   **First error notification sent after n minutes**
   
   The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*
If a job doesn't finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for first error notification** field.

**Recipient Email Address(es) for first error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn't finish within the previously specified timeframe. *(required)*

It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

**Second error notification sent after n minutes**

The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*

If a job doesn't finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for second error notification** field.

**Recipient Email Address(es) for second error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn't finish within the previously specified timeframe. *(required)*

It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

**Third error notification sent after n minutes**

The amount of time allowed to pass between when the job is scheduled to run and when it is supposed to finish. *(required)*

If a job doesn't finish within this amount of time, an alert email will be sent out to the list of recipients specified in the **Recipient Email Address(es) for third error notification** field.

**Recipient Email Address(es) for third error notification**

A space-separated list of valid email addresses to send an error notification if the job doesn't finish within the previously specified timeframe. *(required)*

It is pre-populated with the email address associated with your 1010data account, though you can set it to any email address(es).

See **Job Information** on page 132 for details on the other fields.

5. **Click Create New Job.**

If there are any issues with the input values, you will see an error message with the syntax: "Transaction failed: specific failure". Otherwise, you will see the message: "Job Created".

The **Job Information** tab is repopulated with some new read-only fields related to the new job.

The job is added to the **My Jobs** tab.

After the job runs as scheduled, an email containing links to the reports specified in the job (**Output Format**) will be sent to the users listed in **Report Recipients (1010data IDs)**. See **Download a completed job report** on page 139 for details on how to download these reports.

---

**Find a job**

Find previously scheduled jobs related to a particular Job ID, Job Title, or Job Owner ID. If you are a regular user, you can find jobs owned by your user ID. If you are a company administrator, you can find jobs owned by any of the users in your company.

To find a job (to view, edit, delete, or run):
1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Query Scheduler** icon ( ).

3. In the **Find Job** search box in either the **My Jobs** or **Other People’s Jobs** tab of the **Query Scheduler**, enter text related to the Job ID, Job Title, or Job Owner ID that you are searching for.

4. Click **Find Job** (or press *Enter*).

   A list of jobs that match your search criteria is presented beneath the search text box. If no jobs are found matching your search criteria, you will see the message: "No jobs found".

   **Note:** The search is case sensitive, and partial matches are listed.

   If you are an administrator, clicking **Find Job** with no parameters will return all jobs owned by all users in your company. If you are a regular user, clicking **Find Job** with no parameters will return all jobs owned by your user ID.

   In the results list, click on a job to populate the **Job Information** tab with its information, or click anywhere outside the results list to dismiss it.

### Edit a job

You can use the Query Scheduler to change the properties of a previously scheduled job.

To edit a job:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Query Scheduler** icon ( ).

3. Perform either of the following to select the job you want to edit:

   - From the **My Jobs** tab or **Other People’s Jobs** tab, click the desired job.
   - Follow the steps in **Find a job** on page 137, and select the desired job from the results.

   When you select a job, the **Job Information** tab will be populated with its information.

4. Modify the desired fields.

   See **Job Information** on page 132 for details.

5. Click **Save Job**.

   If there are any issues with the input values, you will see an error message with the syntax: "Transaction failed: specific failure". Otherwise, you will see the message: "Changes were saved".

   The **Job Information** tab is repopulated, reflecting the updated fields.

   If you own the job, it is updated in the **My Jobs** tab. If another user within your company owns the job, it is updated in the **Other People’s Jobs** tab.

### Delete a job

Using the Query Scheduler, you can remove a previously scheduled job.

To delete a job:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.
The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Query Scheduler** icon (📸).

3. Perform either of the following to select the job you want to delete:
   - From the **My Jobs** tab or **Other People’s Jobs** tab, click the desired job.
   - Follow the steps in *Find a job* on page 137, and select the desired job from the results.

When you select a job, the **Job Information** tab will be populated with its information.

4. Click **Delete Job**.

   A warning dialog is presented to confirm that you’d like to delete this job.

5. Click **OK**.

   If there are any issues with the delete, you will see an error message with the syntax: "Transaction failed: *specific failure*. Otherwise, you will see the message: "Job Deleted".

   The **Job Information** tab is cleared.

   If you own the job, it is updated in the **My Jobs** tab. If another user within your company owns the job, it is updated in the **Other People’s Jobs** tab.

### Run a job

You can use the Query Scheduler to manually execute a job that has been previously scheduled.

To run a job:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Query Scheduler** icon (📸).

3. Perform either of the following to select the job you want to run:
   - From the **My Jobs** tab or **Other People’s Jobs** tab, click the desired job.
   - Follow the steps in *Find a job* on page 137, and select the desired job from the results.

When you select a job, the **Job Information** tab will be populated with its information.

4. Click **Run Job**.

   If there are any issues with the execution of the job, you will see an error message with the syntax: "Transaction failed: *specific failure*. Otherwise, you will see the message: "Job was scheduled successfully".

   The **Job Information** tab is repopulated, reflecting the updated fields.

   **Note:** After you click **Run Job**, the Query Scheduler simply schedules the job to run the next minute and returns whether the job was scheduled successfully or not. The Query Scheduler does not wait for the job to finish its run.

After the job runs, an email containing links to the reports specified in the job (**Output Format**) will be sent to the users listed in **Report Recipients (1010data IDs)**. See *Download a completed job report* on page 139 for details on how to download these reports.

### Download a completed job report

After a scheduled job runs (or is manually executed), an email containing links to the reports specified in the job is automatically sent to the report recipients for that job.
To download a completed job report:

1. Open the email sent by the Query Scheduler regarding the completed job.
   
   This email is sent by noreply@1010data.com and contains the subject: "Completed: Job Title".

2. Click the link for the report that you want to download.
   
   **Note:** If the job specified all reports, the email will contain three links.

   A browser window is opened requesting your 1010data credentials.

3. Enter your 1010data username and password.

4. Click **Submit**.
   
   If you clicked the link:

   **CSV Report**
   
   A comma-separated text file containing the results is downloaded directly to your computer.

   **PDF Report**
   
   A PDF document containing the results is downloaded directly to your computer.

   **XLS Report**
   
   The results are displayed in your browser window.

   To download the Excel workbook containing the results to your computer, click the **Download the file** button above the results.

   **Note:** To discontinue receiving emails regarding the scheduled job, click the **Unsubscribe** link at the bottom of the email and then, on the web page that is subsequently opened in your browser, click the **Confirm** button to unsubscribe.
QuickApp Editor

The QuickApp Editor gives the user a canvas on which to build a QuickApp, a custom-tailored front-end interface to the power and speed of the 1010data analytical platform.

Using the QuickApp Editor, creating widgets such as dropdowns, input fields, sliders, checkboxes, and buttons can be done with minimal effort and maximum customization. In addition, the grid-like interface allows the user to position and resize widgets with ease, allowing the user to test out different ideas for layouts and design. Associating a query with a particular widget is simple and straightforward as the Widget Builder allows you to pull in the code from blocks in the current environment, worksheets in the current session, or by specifying the Macro Language for the query directly into the provided XML editor. Previews of both the widget and the results of its query help to eliminate any guessing as you develop your QuickApp. Furthermore, the Widget Builder generates the XML source for the widget on the fly, so you can cut and paste the Macro Language code into a larger, more complex QuickApp that you might be developing separately.

Widget Builder

The Widget Builder allows you to create new widgets as well as modify the properties of existing widgets. You can also specify the 1010data query associated with a particular widget in a variety of ways. The Widget Builder also shows you the Macro Language that coincides with the settings you have made and the query that you’ve specified for the widget.
The **Properties** section of the Widget Builder allows the user to set both class-specific and general attributes for a particular widget as well as specify ad-hoc properties that may not be available within the Widget Builder. The **Properties** section also provides a preview of the widget with the current settings in the Widget Builder.
Class properties

There are properties that are specific to each of the various classes of widgets that dictate the behavior and appearance of those widgets. These properties vary from widget to widget.

For instance, a text widget consists of content to be displayed as well as attributes such as style and color that determine the appearance of the text when it is displayed.

For example, the following text widget:

This is an example of plain text that is blue and has a bold text style.

would have the following properties under the Class properties tab in the Widget Builder:
In the **Class properties** tab for this text widget, we specify:

- the type of text widget, which is plain text (as opposed to HTML-formatted text)
- the text style, which is bold (**font-weight:bold**)
- the color of the text, which is a particular shade of blue (**#548dd4**)
- the content we want displayed (**"This is an example of plain text that is blue..."**) 

For a more complex widget, such as a sorter widget, there will be more class properties that allow you to control the behavior and appearance. Consider the following pair of sorted lists:

![Sorted Lists](image)

The **Class properties** tab for this sorter widget would look something like the following:
You can see that the Class properties tab for this sorter widget contains informations such as:

- a title (label) for each of the sorted lists ("List #1" and "List #2")
- the desired widths of each of those labels, which happens to be the same (150 pixels)
- a dynamic variable to hold the set of values in the first list (@list_1_value)
- a dynamic variable to hold the set of values in the second list (@list_2_value)
- the color of the text of the items in the list, which is white (#ffffff)
- the background color of the first sorted list, which is red (#c00000)
- the background color of the second sorted list, which is green (#00b050)

The following sections give detailed explanations of each of the elements in the Class properties tab for all of the classes available from the Class list at the top of the Widget Builder. Each section also includes one or more examples of these widgets. Some of the examples are basic, and some are more complex, showing the interactions between different widgets and illustrating such concepts as the use of dynamic variables and the way to control how and when widgets are updated. (You can read more about that particular topic in the topic Update control on page 236.)

In order to see the configuration of the Widget Builder for any of these examples, follow the instructions in View the examples in the QuickApp Editor on page 145.

**View the examples in the QuickApp Editor**

This topic shows you how to take the sample Macro Language code that is provided in the QuickApp Editor examples and bring up the Widget Builder to see the corresponding settings.

A number of QuickApp examples are provided for each of the various classes of widgets. These examples demonstrate how settings in the Widget Builder affect the behavior or appearance of the widgets. They also give you the ability to play with different settings in the Widget Builder and then see the effects on the widget.

To run an example provided for a particular widget class:
1. In the 1010data User's Guide, navigate to and open the topic under *Class properties* on page 143 for the widget you are interested in.

   Let's say we wanted to show the settings in the Widget Builder for one of the examples of the input field widget. You could navigate to and open that topic from the table of contents in the 1010data User's Guide.

2. In the topic for the widget you're interested in, scroll down to the sections that are labeled *Example* and decide on which one you'd like to explore.

   Let's say we've opened the *Input field* topic and scrolled down to the first *Example* section:
3. In an active 1010data session, open the table `pub.demo.retail.item`.

   **Note:** The same base table is used for each of the examples.

4. Click **Actions > Edit Actions (XML)**... to open the **Edit Actions (XML)** dialog.
5. From the **Example** section in the documentation, copy all of the example code.

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic first_numeric_input="" second_numeric_input="">
  <widget class="field" inputwidth="100" label="First numeric input field"
    labelwidth="150" max="100" min="0" name="hmadded_1" relpos="294,87"
    step="5" type="numeric" value="#first_numeric_input"/>
  <widget class="field" inputwidth="100" label="Second numeric input field"
    labelwidth="150" max="100" min="0" name="hmadded__2" relpos="294,147"
    type="numeric" value="#second_numeric_input"/>
  <widget class="text" name="hmadded_3" relpos="670,90"
    text="First numeric value: #(first_numeric_input)"/>
  <widget class="text" name="hmadded__4" relpos="670,156"
    text="Second numeric value: #(second_numeric_input)"/>
</dynamic>
```

6. Paste the code into the **Edit Actions (XML)** dialog.
7. Click **Apply** in the **Edit Actions (XML)** dialog.

You will see a table that contains all the metadata for the QuickApp.

<table>
<thead>
<tr>
<th>Sales Item Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns 1-8 of 8, Rows 1-4 of 4</td>
</tr>
</tbody>
</table>

8. Click **View > Show QuickApp**... to display the QuickApp.

The QuickApp containing your widget will be displayed.
9. To open the QuickApp Editor, click **View > QuickApp Editor**...

The background will turn into a grid with the widgets appearing on top of it.

10. To open the Widget Builder for a particular widget, right-click on the desired widget and click **Widget properties** from the context menu.

For example, to see the widget properties associated with the **First numeric input field** widget, right-click anywhere on it and click **Widget properties** from the menu.

The Widget Builder will open, showing the **Class properties** tab for this widget.
11. Make any desired changes to any of the properties for the widget.

Let's say we want the input field to be blue and the text color to be white:

a) Click the **Field color** field and select a blue-colored square.

b) Click the **Text color** field and select a white-colored square.
12. Click **Save** to save your changes.

You will see your changes to the widget.
13. To commit your changes to the QuickApp, right-click anywhere on the grid (in a space not occupied by a widget) and click **Commit changes to this QuickApp**.

Your QuickApp will be displayed with the changes you have made.

Feel free to explore each of the examples for the different widgets and play with the various settings to get a feel for how they work.

**Data grid**

A data grid is a scrollable table where data is displayed. Any results from a 1010data query can be displayed in this table/grid element.
Type

Determines the type of data grid.

Valid options are:

**Native grid**

Display a traditional 1010data grid.

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Units</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>357</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>534</td>
<td>338</td>
<td>1</td>
<td>05/16/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>534</td>
<td>330</td>
<td>1</td>
<td>05/16/12</td>
<td>635</td>
<td>1</td>
<td>2.25</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>CS7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>96A</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>959</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>344</td>
<td>3</td>
<td>1.02</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>366</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>CS7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

**ScrollGrid**

Display a smooth-scrolling grid.
### Label

The title of the data grid that displays the results of your query.

#### Sales Item Detail

Columns 1-7 of 8, Rows 1-12 of 35

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Units</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
<tr>
<td>534</td>
<td>387</td>
<td>1</td>
<td>05/15/12</td>
<td>387</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>534</td>
<td>738</td>
<td>1</td>
<td>05/16/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>534</td>
<td>738</td>
<td>1</td>
<td>05/16/12</td>
<td>65B</td>
<td>1</td>
<td>2.25</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>CB7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/19/12</td>
<td>96A</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>969</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>A96</td>
<td>3</td>
<td>1.02</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>466</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>CB7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

### Show rows/cols?

When selected, display information directly beneath the table title regarding the number of rows and columns in the table.

#### Sales Item Detail

Columns 1-7 of 8, Rows 1-12 of 35

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Units</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12</td>
<td>366</td>
<td>-1</td>
<td>-5</td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
<tr>
<td>534</td>
<td>387</td>
<td>1</td>
<td>05/15/12</td>
<td>387</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>534</td>
<td>738</td>
<td>1</td>
<td>05/16/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>534</td>
<td>738</td>
<td>1</td>
<td>05/16/12</td>
<td>65B</td>
<td>1</td>
<td>2.25</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>CB7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/19/12</td>
<td>96A</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>05/15/12</td>
<td>969</td>
<td>1</td>
<td>1.1</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>A96</td>
<td>3</td>
<td>1.02</td>
</tr>
<tr>
<td>536</td>
<td>748</td>
<td>2</td>
<td>05/17/12</td>
<td>466</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>CB7</td>
<td>1</td>
<td>1.65</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>A96</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>537</td>
<td>523</td>
<td>3</td>
<td>05/15/12</td>
<td>98A</td>
<td>1</td>
<td>0.5</td>
</tr>
</tbody>
</table>

### Column headers

The column heading, name, or a combination of both can be displayed at the top of each column in a data grid.

Valid options are:

#### Label

The column heading will be displayed at the top of each column (e.g., Transaction ID).
Name

The column name will be displayed at the top of each column (e.g., `transid`).

![Column name example](image)

Both

Both the column heading and the column name will be displayed at the top of each column.

![Both column display example](image)

Region format

Determines what format the data grid uses for dates and numbers.

Valid options are:

<table>
<thead>
<tr>
<th>Country</th>
<th>Date Format</th>
<th>Date+Time Format</th>
<th>Integer Limit</th>
<th>Decimal Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>MM/DD/YY</td>
<td>MM/DD/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>Europe</td>
<td>DD.MM.YY</td>
<td>DD.MM.YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>DD/MM/YY</td>
<td>DD/MM/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
</tbody>
</table>

Show repeated rows as

This determines how repeated values will be displayed within a particular column in a data grid.

Valid options are:

**Actual value**

If a particular cell has the same value as the cell in the row above it, the same value will be displayed in that cell. This is the default setting.

![Actual value example](image)

**Ditto mark**

If a particular cell has the same value as the cell in the row above it, a ditto mark (*) will be displayed in that cell.
Ditto (fixed columns only)

Within a fixed column, if a particular cell has the same value as the cell in the row above it, a ditto mark ("*) will be displayed in that cell. Otherwise, if it is not a fixed column, the same value will be displayed.

Note: In this example the State column is fixed, but Unemployment Rate is not.

Blank

If a particular cell has the same value as the cell in the row above it, the cell will appear blank.

Blank (fixed columns only)

Within a fixed column, if a particular cell has the same value as the cell in the row above it, the cell will appear blank. Otherwise, if it is not a fixed column, the same value will be displayed.
Note: In this example the State column is fixed, but Unemployment Rate is not.

Show totals?

Specifies whether to show totals when the query results displayed in the grid are from a tabulation.

Clickable column(s)

A comma-separated list of column names whose cells will be clickable.

When a cell is clicked, several interactions can take place, depending on other options that have been set.

See Variable for click value and Variable for click selector below for additional information.

Sortable column(s)

A comma-separated list of column names whose contents may be sorted in ascending or descending order.

See Variable for sorted columns and Variable for sorted directions below for additional information.

Variable for click value

When a cell in a clickable column is clicked, its value is stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Variable for click selector

When a cell in a clickable column is clicked, the name of that column is stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Variable for click row package value

When a cell in a clickable column is clicked, the entire row of data is stored in this variable as a package.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Variable for click row index value
When a cell in a *clickable* column is clicked, the index of the row of data is stored in this variable.

**Note:** The first row in the data grid has an index of 0.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Variable for sorted columns**

When a *sortable* column is sorted in ascending or descending order, the column name is added to the comma-separated list stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Variable for sorted directions**

When a *sortable* column is sorted in ascending or descending order, the sort direction (up or down) is added to the comma-separated list stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Drillable column(s)**

A comma-separated list of column names whose cells will be *drillable*.

When a cell is clicked, several interactions can take place, depending on other options that have been set.

See **Variable for drill values** and **Variable for drill selectors** below for additional information.

**Variable for drill values**

When a cell in one of the drillable columns is clicked, the value will be *appended* to a comma-separated list of values contained in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Variable for drill selectors**

When a cell in one of the drillable columns is clicked, the column name will be *appended* to a comma-separated list of column names contained in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Package Variable for drill**

When a cell in one of the drillable columns is clicked, the column name and cell value are added to the lists (sel and val, respectively) stored in this package variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

Using a package variable is helpful in cases where cell values in the drillable columns contain commas, since storing such values in **Variable for drill values** would cause an error.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_val="1" selected_col="store" selected_row_val=""
 selected_row_index_val="1" selected_value="">
  <widget base="pub.demo.retail.item" class="grid"
  clickable="store,transid"
  indexvalue="@selected_row_index_val" label="Sales Item Detail" width="800"
  name="hmadded__1" rowvalue="@selected_row_val" selector="@selected_col"
```
value = "@selected_val"
<willbe name="selected_value" value="{@selected_val}"/>
<willbe name="selected_column" value="'{@selected_col}'"/>
<willbe name="selected_index" value="{@selected_row_index_val}"/>
</widget>
<layout>
<foreach item="selected_val,selected_col,selected_row_index_val"
title="Value,Column,Row Index" tally_="@i">
<layout>
<widget class="text" text="{@title}"
style_="font-weight:bold;letter-spacing:0;"/>
<widget class="text" text="{@item}"/>
</layout>
</foreach>
</layout>
</layout>
</foreach col_name="date,transid,account,store"
col_label="Date,Transaction ID,Account,Store" tally_="@i">
<layout>
<widget class="text" text="{@col_label}"
style_="font-weight:bold;letter-spacing:0;"/>
<widget class="text" text="{selected_row_val.{@col_name}}"/>
</layout>
</foreach>
</layout>
</dynamic>

Example

<note type="base">Applied to table: pub.demo.retail.prod</note>
<base table="pub.demo.retail.prod"/>
<defblock name="drill" hier="" cols="" vals=""/>
<foreach col="{@cols}" val="{@vals}">
<sel value="{@col}='{@val}'"/>
</foreach>
<tabu breaks="{csl_pick(csl_take(@hier;1+csl_len(@cols));-1)}"
label="Tabulation">
<tcol source="sku" fun="cnt"/>
</tabu>
</defblock>
<dynamic hier="divdesc,deptdesc,classdesc,itemdesc" cols="" vals=""/>
<widget class="button" name="hmnonce__1"
newvalue_1_="{csl_drop(@cols;-1)}"
newvalue_2_="{csl_drop(@vals;-1)}" rotxlabels_="-65" text_="Roll back up"
Example

<note type="base">Applied to table: pub.demo.retail.prod</note>
<widget base="pub.demo.retail.prod" class="grid" cols="[@cols]"
    drillable="[{csl_pick(@hier;1+csl_len(@cols))}]"
    drillselector="[@cols]
    drillvalue="[@vals]" hier="[@hier]"
    insert="drill" name="hmnonce__2"
    vals="[@vals]" width="1000">
    <willbe name="test_cols" value="[@cols]'/"/>
    <willbe name="test_vals" value="[@vals]'/"/>
    <willbe name="test_hier" value="[@hier]'/" format="width:40'"/>
</widget>
</dynamic>

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<widget base="pub.demo.retail.item" class="grid"
    sortable="date,store,account"
    sortcols="@sorted_columns"
    sortdirs="@sorted_direction"/>
A table widget is suitable for the tabular display of a small number of rows (1000 or less).
Label
The text that appears as the title of the table.

Column headers

Label
Display the column labels at the top of the columns.

Name
Display the column names at the top of the columns.

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget base_="pub.demo.retail.item" class_="table" headers_="name" label_="Sales Detail (Store #1)" name="hmadded__1">
    <sel value="(store=1)"/>
  </widget>
</dynamic>

<table>
<thead>
<tr>
<th>Transaction ID</th>
<th>Account</th>
<th>Store</th>
<th>Date</th>
<th>Item SKU</th>
<th>Unit</th>
<th>Sales</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>531</td>
<td>957</td>
<td>1</td>
<td>05/15/12366</td>
<td>-1</td>
<td>-5</td>
<td>-1.84</td>
<td></td>
</tr>
<tr>
<td>532</td>
<td>478</td>
<td>1</td>
<td>05/15/1298A</td>
<td>1</td>
<td>0.5</td>
<td>0.25</td>
<td></td>
</tr>
<tr>
<td>533</td>
<td>738</td>
<td>1</td>
<td>05/16/123B7</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
<td></td>
</tr>
<tr>
<td>534</td>
<td>738</td>
<td>1</td>
<td>05/16/12A96</td>
<td>2</td>
<td>6</td>
<td>2.9</td>
<td></td>
</tr>
<tr>
<td>535</td>
<td>668</td>
<td>1</td>
<td>05/16/1265B</td>
<td>1</td>
<td>2.25</td>
<td>1.35</td>
<td></td>
</tr>
<tr>
<td>536</td>
<td>668</td>
<td>1</td>
<td>05/18/12CB7</td>
<td>1</td>
<td>1.65</td>
<td>1.1</td>
<td></td>
</tr>
<tr>
<td>537</td>
<td>668</td>
<td>1</td>
<td>05/18/1298A</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>538</td>
<td>668</td>
<td>1</td>
<td>05/18/1296A</td>
<td>1</td>
<td>1.1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>539</td>
<td>668</td>
<td>1</td>
<td>05/18/12B37</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>876</td>
<td>1</td>
<td>06/03/12CB7</td>
<td>1</td>
<td>1.65</td>
<td>1.1</td>
<td></td>
</tr>
<tr>
<td>541</td>
<td>876</td>
<td>1</td>
<td>06/03/12A96</td>
<td>4</td>
<td>1.45</td>
<td>1.45</td>
<td></td>
</tr>
<tr>
<td>542</td>
<td>876</td>
<td>1</td>
<td>06/03/1298A</td>
<td>2</td>
<td>1</td>
<td>0.5</td>
<td></td>
</tr>
<tr>
<td>543</td>
<td>876</td>
<td>1</td>
<td>06/03/1296A</td>
<td>1</td>
<td>1.1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Graphics
A graphics widget displays the results of a query in one of various chart types according to a set of given specifications.
The graphics widget displays the results of the 1010data query associated with the widget.

Most graphics properties are specified using the special `<graphspec>` pseudo-op in the query rather than by using widget properties.

**Note:** You can use the Chart Builder to save a set of chart specifications from an existing chart and include the resultant `<graphspec>` that contains those specifications as part of the 1010data query. See Create QuickApp graphics widget for more information.

**Chart type**

Specifies which type of chart is used to visualize the results of the 1010data query associated with this widget.

Valid chart types include:

- Histogram (1D)
- Histogram (2D)
- Line
- Scatter
- Pie
- Bar
- Scatter3D
- Surface
- Bubble

See Chart Types for information on each of these chart types.

**Theme**

Specifies a particular color scheme for the elements in the selected chart type.

Valid themes include:
Interactive?

Specifies whether the user can interact with the chart (e.g., zoom, pan).

Once chart interactions are enabled, you can perform the following mouse actions on the current chart:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click</td>
<td>Double-click at a particular spot on a chart to center the chart at that location.</td>
</tr>
<tr>
<td>Drag</td>
<td>Drag the pointer over an area to zoom into the corresponding rectangular region.</td>
</tr>
<tr>
<td>Wheel Up</td>
<td>Rotate the wheel button forward to zoom out of the chart.</td>
</tr>
<tr>
<td>Wheel Down</td>
<td>Rotate the wheel button backward to zoom in to the chart.</td>
</tr>
</tbody>
</table>

**Note:** Chart interactions are intended for use in full mode and are currently provided only for the Line and Scatter chart types.

Title

The text to appear above the chart.

Hide the legend?

This determines whether a legend should be displayed with the chart.

Legend position

If the legend is displayed, this determines its position relative to the chart.

**Bottom**

The legend appears below the chart.

**Right**

The legend appears to the right of the chart.

**Left**

The legend appears to the left of the chart.

**Top**

The legend appears above the chart.

Clickable column(s)

A comma-separated list of column names whose data elements will be clickable in the chart.

When a data element associated with a clickable column is clicked, several interactions can take place, depending on other options that have been set.

See Variable for click value and Variable for click selector properties below for additional information.

Variable for click value
When a data element associated with a *clickable* column is clicked, its value is stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New**... and entering the name in the field following the `@` symbol.

**Variable for click selector**

When a data element associated with a *clickable* column is clicked, the name of that column is stored in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New**... and entering the name in the field following the `@` symbol.

**Drillable column(s)**

A comma-separated list of column names whose data elements will be *drillable*.

When a data element associated with a *drillable* column is clicked, several interactions can take place, depending on other options that have been set.

See **Variable for drill values** and **Variable for drill selectors** properties below for additional information.

**Variable for drill values**

When a data element associated with a *drillable* column is clicked, the value will be *appended* to a comma-separated list of values contained in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New**... and entering the name in the field following the `@` symbol.

**Variable for drill selectors**

When a cell in one of the drillable columns is clicked, the column name will be *appended* to a comma-separated list of column names contained in this variable.

You may select a variable from the dropdown, or you can create a new variable by clicking **New**... and entering the name in the field following the `@` symbol.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget base_="pub.demo.retail.item" class_="graphics" interactive_="1" name="hmadded__1" relpos_="40,19" type_="line">
    <sel value="(store=1)"/>
    <tabu label="Tabulation on Sales Item Detail" breaks="date">
      <break col="date" sort="up"/>
      <tcol source="sales" fun="sum" label="Sum of Sales"/>
    </tabu>
    <graphspec width="600" height="400">
      <chart type="line" samples="100000">
        <data x="date" y="t0"/>
      </chart>
    </graphspec>
  </widget>
</dynamic>
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic clicked_value="" clicked_column="" store_label="" total_sales="">
  <do onchange="@clicked_column"/>
  <switch on="@clicked_column">
    <case when="m0">
      <set store_label="Store 1:"></set>
    </case>
    <case when="m1">
      <set store_label="Store 2:"></set>
    </case>
    <case when="m2">
      <set store_label="Store 3:"></set>
    </case>
  </switch>
  <set clicked_column=""/>
  <set total_sales="${@clicked_value}"/>
</do>
<widget base="pub.demo.retail.item" class="graphics"
  clickable="m0,m1,m2"
  interactive="1"
  legendpos="left"
  name="hmadded__1"
  relpos="89,36"
  selector="@clicked_column"
  theme="happy"
  tooltips="1"
  type="bar"
  value="@clicked_value">
  <tabu label="Sales by Date by Store" breaks="date" cbreaks="store"
    clabels="short">
    <break col="date" sort="up"/>
    <break col="store" sort="up"/>
    <tcol source="sales" fun="sum"/>
  </tabu>
  <graphspec width="602" height="405">
    <chart type="bar" samples="25">
      <data x="date" y="m0"/>
      <data x="date" y="m1"/>
      <data x="date" y="m2"/>
    </chart>
  </graphspec>
</widget>
<widget class="text"
  name="hmadded__5"
  relpos="174,500"
  text="<b>${@store_label}</b> ${@total_sales}" type="html"/>
</dynamic>
Input field

An input field allows the user to enter values, optionally with autocomplete suggestions or a combobox containing a list of possible values. The input field may also be constrained to numeric values.

Type

Plain

Provide an input field that allows the user to enter any value.
**Autocomplete**

Provide an input field that uses the results of a query as suggestions for autocompletion.

As the user enters values in the input field, a dropdown will dynamically display suggestions from the query results that match the substring the user has entered thus far. Matching is based on the setting of the autocomplete filter (see **Type** below) and can either display suggestions from the query results that contain the substring entered or begin with the substring entered.

The autocompletion suggestions dropdown is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Combobox**

Provide an input field that contains the results of a query as the choices in the combobox.

The combobox is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Numeric**

Provide an input field that is restricted to only numeric values.

The numeric value is constrained by the Minimum numeric value and Maximum numeric value. If an out-of-bounds value is manually entered into the field, the value will default to either the minimum or maximum value (i.e., if a value larger than the maximum is manually entered, it will be set to the maximum).

The input field also provides spin buttons that increase or decrease the value by the amount specified in **Step for numeric value**.

**Label**

The text that is displayed preceding the input field.

**Width of label**

The number of pixels allocated for the text preceding the input field.

If the text of the label is greater than the width specified, the label is truncated.

**Width of input**

The number of pixels allocated for the input field.

If the values in the input field are greater than the width specified, the values in the field are truncated.

**Height of dropdown**

The maximum height (in pixels) of the dropdown menu used by the combobox and autocomplete input fields.

The default is 200px.

**Number of hints for autocomplete**

The autocomplete dropdown will only be displayed if the number of matches is less than this value.

The default is 200.

**Type**

Specifies whether the autocomplete dropdown dynamically displays suggestions from the query results that contain the substring the user has entered thus far in the input field or begin with the substring entered.

**Contains**
The autocomplete dropdown will dynamically display suggestions from the query results that contain the substring the user has entered thus far in the input field.

**Begins With**

The autocomplete dropdown will dynamically display suggestions from the query results that begin with the substring the user has entered thus far in the input field.

**Field color**

The color of the input field.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text color**

The color of the text in the input field.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text style**

The appearance of the text in the input field.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

**Variable for value**

The variable to hold the value from the input field.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Minimum numeric value**

When the type of the input field is numeric, this is the smallest allowed value.

**Maximum numeric value**

When the type of the input field is numeric, this is the largest allowed value.
Step for numeric value

When the type of the input field is numeric, this is the value by which to increase or decrease the value in the input field when the spin buttons are clicked.

If no value is specified, the default step is 1.

Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic first_numeric_input="" second_numeric_input="">
  <widget class="field" inputwidth="100" label="First numeric input field" labelwidth="150" max="100" min="0" name="hmadded_1" relpos="294,87" step="5" type="numeric" value="@first_numeric_input"/>
  <widget class="field" inputwidth="100" label="Second numeric input field" labelwidth="150" max="100" min="0" name="hmadded_2" relpos="294,147" type="numeric" value="@second_numeric_input"/>
  <widget class="text" name="hmadded_3" relpos="670,90" text="First numeric value: {@first_numeric_input}"/>
  <widget class="text" name="hmadded_4" relpos="670,150" text="Second numeric value: {@second_numeric_input}"/>
</dynamic>
```

```
First numeric input field 20
First numeric value: 20
Second numeric input field 46
Second numeric value: 46
```

Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic plain_input="">
  <widget class="field" inputwidth="100" label="Plain input field" labelwidth="150" name="hmadded_5" relpos="170,129" value="@plain_input"/>
  <widget class="text" name="hmadded_6" relpos="515,134" text="Plain input value: {@plain_input}"/>
</dynamic>
```

```
Plain input field 1010data
Plain input value: 1010data
```

Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic combobox_input="">
  <widget base="pub.demo.retail.item" class="field" inputwidth="100" label="Combobox input field" labelwidth="150" name="hmadded_7" relpos="137,129" type="combo" value="@combobox_input"/>
  <tabu label="Tabulation on Sales Item Detail" breaks="account">
    <tcol source="account" fun="cnt" label="Count"/>
  </tabu>
</dynamic>
```

```
```
Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic autocomplete_input="">
  <widget base="pub.demo.retail.prod" class="field" inputwidth="150" label="Autocomplete input field" labelwidth="150" name="hmadded__9" relpos="112,109" type="auto" value="@autocomplete_input">
    <tabu label="Tabulation on Product Master" breaks="deptdesc">
      <tcol source="deptdesc" fun="cnt" label="Count"/>
    </tabu>
    <colord cols="deptdesc"/>
    <sort col="deptdesc" dir="up"/>
  </widget>
  <widget class="text" name="hmadded__10" relpos="517,114" text="Autocomplete input value: {@autocomplete_input}"/>
</dynamic>
```

Dropdown menu

A dropdown menu provides the user with a finite number of items from which to choose, and depending on the configuration, may allow for either single or multiple selections.
The dropdown menu is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Label**

The text that is displayed preceding the dropdown menu.

**Width of label**

The number of pixels allocated for the text preceding the dropdown menu.

If the text of the label is greater than the width specified, the label is truncated.

**Width of input**

The number of pixels allocated for the dropdown menu.

If the values in the input field are greater than the width specified, the values in the field are truncated.

The default is 240px.

**Dropdown color**

The color of the dropdown menu.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text color**

The color of the text in the dropdown menu.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
• An RGB value (e.g., rgb(238,147,12))
• A hex value (e.g., #d12345)

Text style

The appearance of the text in the dropdown menu.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

Allow multiple selections?

The user is able to select more than one item from the dropdown menu, and the results are stored as a comma-separated list in the variable associated with the dropdown. If this option is not selected, the user may only select single values.

The following is an example of a dropdown menu that allows multiple selections:

Show radio buttons?

When using QuickApps version 1, items in the dropdown list are preceded by radio buttons when this option is selected.
**Note:** This option has been removed from QuickApps version 2, since radio buttons will automatically appear before items in a dropdown menu that allows multiple selections.

**Variable for value**

The variable to hold the selections from the input field.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the @ symbol.

**Default value**

The value associated with the default option in the dropdown menu if the data does not contain the current value of the variable associated with the dropdown.

The default value is assigned to the variable associated with the dropdown menu (**Variable for value**) when the default option is selected from the dropdown menu.

**Default label**

The text for the default option in the dropdown menu.

When the default option is selected from the dropdown menu, the **Default value** is assigned to the variable associated with the dropdown menu (**Variable for value**).

**Placeholder text**

The text that is displayed when no items have yet been selected.

For instance, when the dropdown menu is first rendered, this may be text indicating that a selection must be made:

Select accounts: [Select a value...]

If a **Default label** is specified, the placeholder text will not be displayed.

**Maximum dropdown height**

The maximum height of the dropdown menu in pixels.

The default is 200px.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic dropdown_multiple="">
  <widget base="pub.demo.retail.item" class="dropdown" color="#92cddc"
    emptytext="Select a value..." inputwidth="250" label="Select accounts:
    labelwidth="150" maxheight="50" multi="1" name="hmadded_1"
    relpos="76,129"
    textstyle="font-weight:bold;letter-spacing:0;" value="@dropdown_multiple">
    <tabu label="Tabulation on Sales Item Detail" breaks="account">  
      <break col="account" sort="up"/>
      <tcol source="account" fun="cnt" label="Count"/>
    </tabu>
  </widget>
  <widget class="text" name="hmadded_2" relpos="561,134"
    text="Dropdown multiple: {@dropdown_multiple}"/>
</dynamic>
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic dropdown_single="">
  <widget base="pub.demo.retail.item" class="dropdown" color="#92cddc"
deflabel="Default" defval_="500" emptytext_="Select a value..."
  inputwidth_="250"
label_="Select account:" labelwidth_="150" name="hmadded__3" relpos_="96,144"
textstyle_="font-weight:bold;letter-spacing:0;" value_="@dropdown_single">
    <tabu label="Tabulation on Sales Item Detail" breaks="account">
      <break col="account" sort="up"/>
      <tcol source="account" fun="cnt" label="Count"/>
    </tabu>
    <colord cols="account"/>
  </widget>
  <widget class="text" name="hmadded__4" relpos_="596,149"
text_="Dropdown single: (@dropdown_single)"/>
</dynamic>

Radio buttons

Radio buttons allow the user to select one choice from a set of options.
The set of radio buttons is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Variable for value**

The variable to hold the value of the selected radio button.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Orientation**

**Horizontal**

The radio buttons are presented in a horizontal fashion.

**Vertical**

The radio buttons are presented in a vertical fashion.
Text color

The color of the text associated with the radio buttons.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Text style

The appearance of the text associated with the radio buttons.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic horizontal_selection="738">
  <widget class_="text" name="hmadded__3" relpos_="193,17"
    text_="Selected horizontal value: {@horizontal_selection}"
  >
  <widget base_="pub.demo.retail.item" class_="radio" name="hmadded__1"
    relpos_="194,75" textcolor_="#4f81bd" value_="@horizontal_selection">
    <tabu label="Tabulation on Sales Item Detail" breaks="account">
      <tcol source="account" fun="cnt" label="Count"/>
    </tabu>
    <colord cols="account"/>
  </widget>
</dynamic>

Selected horizontal value: 738

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic vertical_selection="361">
  <widget class_="text" name="hmadded__2" relpos_="179,59"
    text_="Selected vertical value: 361"
  >
</dynamic>
Selected vertical value: 361

- 26
- 361
- 469
- 478
- 523
- 668
- 709
- 738
- 748
- 876
- 957

List

A list allows the user to select individual or multiple items from a given set of values.
The list is populated using a 1010data query. The *1010data query* associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Label**

The text that is displayed above the list.

**Width of label**

The number of pixels allocated for the text above the list.

If the text of the label is greater than the width specified, the label is truncated.

**Width of list**

The number of pixels allocated for the width of the list.

If the text of the items in the list cannot be displayed in the width specified, a horizontal scroll bar will be added to the list widget.

**Height of list**

The number of pixels allocated for the height of the list.

If the total number of items in the list cannot be displayed in the height specified, a vertical scroll bar will be added to the list widget.

The default is 280px.

**Variable for value**

The variable to hold the selections from the list as a comma-separated string.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**List variable for value**
The variable to hold the selections from the list as a list-value.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

This variable will store the selections as elements in a list-value. The elements may be accessed via dot notation. For example, if you specified the variable @selected_value in the List variable for value field, you can access the second item in the list-value using the notation `{@selected_value.2}`.

For more detailed information on working with list-values, see the 1010data Reference Manual.

It is recommended that you use List variable for value over Variable for value, particularly if the items in your list contain commas.

**Note:** If a List variable for value is specified, the Variable for value will be ignored.

**Text color**

The color of the text of the items in the list.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text style**

The appearance of the text in the list.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

**Example**

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_value="98A,3B7,A96">
  <widget base ="pub.demo.retail.item" class ="list" label ="Choose SKUs:
  labelwidth_="150" listheight_="200" listwidth_="80" name="hmadded__1"
  relpos_="202,99"
  textstyle_="font-weight:400;letter-spacing:0;font-family:Impact,Charcoal,sans-serif;font-size:18px;"
  value_="@selected_value">
    <willbe name="selection" value="g_first1(sku;;)"/>
    <sel value="selection=1"/>
    <colord cols="sku"/>
  </widget>
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_value_list="{lst('98A','3B7','A96')}">
  <widget base="pub.demo.retail.item" class="list" label="Choose SKUs:
  labelwidth="150" listheight="200" listvalue="@selected_value_list" listwidth="250" name="hmadded__5" relpos="155,92" textcolor="red"
textstyle="font-weight:400;letter-spacing:0;font-family:Georgia,serif;font-size:12px;">
    <willbe name="selection" value="g_first1(sku;;)"/>
    <sel value="selection=1"/>
    <link table2="pub.demo.retail.prod" col="sku" col2="sku"/>
    <colord cols="sku,itemdesc"/>
  </widget>
  <widget class="text" name="hmadded__3" relpos="495,97" text="Selected value list: {@selected_value_list}"/>
  <widget class="text" name="hmadded__4" relpos="495,152" text="Second value: {@selected_value_list.2}"/>
</dynamic>

Choose SKUs:  

Selected value list: 98A,3B7,A96

Second value: 3B7
Sorter
A sorter allows the user to rearrange the order of items within a single sortable list or move items between a pair of sortable lists.

The sorter widget is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

Label
The text that is displayed above the sortable list (or the first list in a pair of sortable lists).

Label for alternate list
The text that is displayed above the second list in a pair of sortable lists.

Width of label
The number of pixels allocated for the text above the sortable list (or the first list in a pair of sortable lists).
If the text of the label is greater than the width specified, the label is truncated.

Width of label for alternate list
The number of pixels allocated for the text above the second list in a pair of sortable lists.
If the text of the label is greater than the width specified, the label is truncated.

Variable for value
The variable to hold the sorted list as a comma-separated string.
You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Note: You cannot use this variable when specifying a pair of sortable lists.
List variable for value

The variable to hold the sorted list (or the first list in a pair of sortable lists) as a list-value.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Note:** You must use this variable for the first list in a pair of sortable lists and not the Variable for value.

This variable will store the items in the sorted list as elements in a list-value. The elements may be accessed via dot notation. For example, if you specified the variable @selected_value in the List variable for value field, you can access the second item in the list-value using the notation `{@selected_value.2}`.

For more detailed information on working with list-values, see the 1010data Reference Manual.

It is recommended that you use List variable for value over Variable for value, particularly if the items in your list contain commas.

Variable for alternate value

The variable to hold the second list in a pair of sortable lists as a list-value.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

This variable will store the items in the sorted list as elements in a list-value. The elements may be accessed via dot notation. For example, if you specified the variable @list_2_value in the Variable for alternate value field, you can access the second item in the list-value using the notation `{@list_2_value.2}`.

Text color

The color of the text of the items in the sortable lists.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238, 147, 12))
- A hex value (e.g., #d12345)

Text style

The appearance of the text of the items in the sortable lists.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.
Item background color

The background color of the items in the sortable list (or the first list in a pair of sortable lists).

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Item background for alternate list

The background color of the items in the second list in a pair of sortable lists.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Example

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic sorted_list_value="366,98A,3B7,A96,65B,CB7,96A,969,3A4"
sorted_list_list=".(..)" list_1_value="" list_2_value=""
  <widget base_="pub.demo.retail.item" class_="sorter" itembg_="#f79646"
    label_="List to be sorted:" name="hmadded__1" relpos_="92,94"
    textcolor_="#ffffff"
    value_="@sorted_list_value">
    <link table2="pub.demo.retail.prod" col="sku" col2="sku"/>
    <willbe name="selection" value="g_first1(sku;;)"/>
    <willbe name="selection2" value="g_first1(itemdesc;;)"/>
    <sel value="selection=1"/>
    <sel value="selection2=1"/>
    <colord cols="sku,itemdesc"/>
  </widget>
  <widget class_="text" name="hmadded__2" relpos_="372,99"
    text_="Sorted list value: {@sorted_list_value}"/>
</dynamic>
```

List to be sorted:  

PEPSI 2 LITER  
LA MICRO TERRY CLOG LARGE  
DGV DECOR TOWEL 3 ROLL  
MT DEW 2 LITER  
FRUIT SNACK MIXED BERRIES  
PEPSI 20 OZ  
DUCT TAPE  
RED DEVIL SILICONE SEALANT  
MEMO BOOK 3X5  

Sorted list value: 969,366,CB7,96A,98A,3B7,A96,65B,3A4
Example

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic sorted_list_value="366,98A,3B7,A96,65B,CB7,96A,969,3A4"
        sorted_list_list="{lst('366','98A','3B7','A96','65B','CB7','96A','969','3A4')}">
    <widget base="pub.demo.retail.item" class="sorter" label_="List to be sorted:

    listvalue_="@sorted_list_list" relpos="96,93"
    textcolor="#8064a2"
    textstyle="font-weight:bold;letter-spacing:0;">
        <willbe name="selection" value="g_first1(sku;;)"/>
        <sel value="selection=1"/>
        <colord cols="sku"/>
    </widget>
<widget class="text" name="hmadded__4" relpos="295,97"
        text="Sorted list list: {@sorted_list_list}"/>
<widget class="text" name="hmadded__5" relpos="295,138"
        text="Fourth value: {@sorted_list_list.4}"
    </dynamic>
```

```
| Sorted list: 366,98A,3B7,A96,65B,CB7,96A,969,3A4 |
|-----------|----------|
| 366       | Sorted   |
| 98A       | list     |
| 3B7       | list     |
| A96       | list     |
| 65B       | list     |
| CB7       | list     |
| 96A       | list     |
| 969       | list     |
| 3A4       | list     |
|           | Fourth:  |
|           | A96      |
```

Example

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic list_1_value="" list_2_value="">
    <widget base="pub.demo.retail.item" class="sorter" itembg_="#c00000"
        label_="List #1" labelwidth_="150" listvalue_="@list_1_value"
        name="hmadded__7"
        relpos="95,95" textcolor="#ffffff" toitembg="#00b050"
        tolabel_="List #2" tolabelwidth="150"
        tolistvalue_="@list_2_value">
        <link table2="pub.demo.retail.prod" col="sku" col2="sku"/>
        <willbe name="selection" value="g_first1(sku;;)"/>
        <willbe name="selection2" value="g_first1(itemdesc;;)"/>
        <sel value="selection=1"/>
        <sel value="selection2=1"/>
        <colord cols="sku,itemdesc"/>
    </widget>
<widget class="text" name="hmadded__8" relpos="595,97"
        text="List #1: {@list_1_value}"/>
<widget class="text" name="hmadded__9" relpos="595,154"
        text="List #2: {@list_2_value}"/>
</dynamic>
```
Checkbox

A checkbox allows the user to toggle between two mutually exclusive choices.

Label

The text that is displayed for the checkbox.

Variable for value

The variable that holds the value of the checkbox when selected or cleared.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.
Value when checked

The value of the variable associated with this checkbox when it is selected.

Value when unchecked

The value of the variable associated with this checkbox when it is cleared.

Default value

The default value of the variable associated with this checkbox.

Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic store_num="2" display_graph="1" display_grid="1">
  <widget class="field" label="Input Store Number:" max="3" min="1"
     name="hmadded__1" relpos="21,26" type="numeric" value="@store_num"/>
  <widget base="pub.demo.retail.item" class="grid" errmsg="Select a store"
     invmode="hide" name="hmadded__3" relpos="10,96"
     require="{@display_grid=1}" update="auto">
    <sel value="store={@store_num}"/>
  </widget>
  <widget base="pub.demo.retail.item" class="graphics" errmsg="Select a store"
     invmode="hide" name="hmadded__4" relpos="613,97"
     require="{@display_graph=1}" type="pie" update="auto">
    <sel value="store={@store_num}"/>
  </widget>
  <widget class="checkbox" default="1" false="0" label="Display Graph"
     name="hmadded__8" relpos="428,29" true="1" value="@display_graph"/>
  <widget class="checkbox" default="1" false="0" label="Display Grid"
     name="hmadded__9" relpos="294,29" true="1" value="@display_grid"/>
</dynamic>
```

Checklist

A checklist allows the user to select one or more checkboxes that are grouped together in a list.
The checklist is populated using a 1010data query. The 1010data query associated with the widget should generate one or two columns (i.e., either values or values and labels).

**Variable for values**

The variable to hold the selected values in the checklist as a comma-separated string.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Orientation**

**Horizontal**

The checklist is presented in a horizontal fashion.

✔️ 1 ✔️ 2 ✔️ 3

**Vertical**

The checklist is presented in a vertical fashion.

✔️ 1
☐ 2
✔️ 3

**Text color**

The color of the text of the items in the checklist.
The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d1345)

**Text style**

The appearance of the text of the items in the checklist.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

---

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_values="1,3">
    <widget base_="pub.demo.retail.item" class_="checklist" label="Select stores:" labelwidth_="150" name="hmadded__1" orientation_="vertical" relpos_="157,118" textcolor_="blue" textstyle_="font-weight:bold" value_="@selected_values">
        <willbe name="selection" value="g_first1(store;;)"/>
        <sel value="selection=1"/>
        <colord cols="store"/>
        <link table2="pub.demo.retail.store" col="store" col2="store_id"/>
        <colord cols="store,city"/>
    </widget>
    <widget base_="pub.demo.retail.item" class_="grid"
        label_="Transactions for selected stores: {@selected_values}" name="hmadded__2"
        relpos_="399,119" type_="scroll">
        <sel value="store={@selected_values}"/>
    </widget>
</dynamic>
```
Slider

A slider allows the user to select either a single value or a pair of minimum/maximum values from a range of values using a drag handle interface.

Orientation

Horizontal

Present the slider in a horizontal fashion.
This is the default value.

**Vertical**

Present the slider in a vertical fashion.

---

**Variable for value**

The variable to hold the selected slider value (or the minimum value of a minimum/maximum pair of values).

This variable represents the minimum value when a **Variable for end value (range)** is specified for the maximum value.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Variable for end value (range)**

The variable to hold the maximum value of a minimum/maximum pair of values.

When a variable is specified for this field, the **Variable for value** represents the minimum value of a minimum/maximum pair of values.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Minimum numeric value**

The smallest value that can be selected using the slider.

If no value is specified, the default is 0.

**Maximum numeric value**

The largest value that can be selected using the slider.

If no value is specified, the default is 1.

**Intermediate steps (blank=smooth)**

The number of intervals to divide the slider into.

Given a value, the slider will only allow the selection of values that occur at the discrete steps that divide the intervals. If no value is specified, the slider will allow for a continuous selection of any value between the minimum and maximum.

For example, if the minimum allowable value is set to 0 and the maximum allowable value is set to 100, then setting the value of intermediate steps to 5 will divide the slider into 5 intervals, and the allowable values will consist of 0, 20, 40, 60, 80, and 100.

**Example**

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic slider_value="10">
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic slider_increment_value="16">
  <widget class="slider" max="20" min="0" name="hmadded__3"
    relpos="135,144" steps="10" value="@slider_increment_value"/>
  <widget class="text" name="hmadded__4" relpos="395,159"
    text="Increment slider value: {@slider_increment_value}"/>
</dynamic>

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic slider_start_value="46" slider_end_value="85">
  <widget class="slider" max="100" min="0" name="hmadded__7"
    relpos="100,124" tovalue="@slider_end_value" value="@slider_start_value"/>
  <widget class="text" name="hmadded__8" relpos="370,134"
    text="Slider start value: {@slider_start_value}"/>
  <widget class="text" name="hmadded__9" relpos="530,134"
    text="Slider end value: {@slider_end_value}"/>
</dynamic>

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic vertical_slider_value="73">
  <widget class="slider" max="100" min="0" name="hmadded__5"
    orientation="vertical" relpos="110,79" value="@vertical_slider_value"/>
  <widget class="text" name="hmadded__6" relpos="235,114"
    text="Vertical slider value: {@vertical_slider_value}"/>
</dynamic>
A button can be configured to perform such actions as setting the values of dynamic variables, exporting the contents of a particular widget to a specified target, triggering a refresh of invalidated widgets, saving the dynamic state of the QuickApp to a configuration file, or loading the state from a previously-saved configuration file.

**Type**

Determines the type of button.

Valid options are:

- **Dummy**
  
  Display a message in a dialog box stating the button worked.
Submit
Submit an update request to specified widgets in order to trigger a refresh of those widgets.
The list of widgets is specified in the Submit widgets field. If no widgets are specified, then all widgets receive an update request.

Reset
Reset the QuickApp to its initial state.

Export
Export the results from the query associated with this widget to the target selected in the Export target list.

Render
Download all tables and charts contained in the QuickApp to an Excel workbook.
The Excel workbook is downloaded with the file name specified by Download filename and the extension .xlsx.
If no file name is specified, the file is downloaded as download.xlsx.

Set variables
Set the value of one or more dynamic variables.
See Variable for set value and Value to set for details.

Dump configuration to table
Save the current dynamic state of the QuickApp into a table consisting of a single row with one column per dynamic variable name.
By default, the values of all dynamic variables in the QuickApp will be saved to a table in your My Data folder with the title "QA configuration dumped at YYYYMMDD HHMMSS" (where YYYYMMDD HHMMSS is the timestamp).
Additional attributes can be specified via Ad-hoc properties on page 227 to customize the configuration dump. These attributes allow you to specify the folder in which the new table is created, the title of the table, the variables to include in (or exclude from) the configuration file, access permissions, and whether to replace the table or append to it. See the 1010data Reference Manual for a complete list of these attributes.
When the dynamic state of the QuickApp is successfully saved, the path to the table containing the configuration is saved in the variable specified in the Value to set field.

Configure from query
Load the dynamic state from the results of a query.
Using the results of the 1010data query associated with this widget, the value of each dynamic variable in the QuickApp is set to the value in the last row of the column with the same name as that dynamic variable.
Therefore, tables created using Dump configuration to table can be used directly by the query associated with this type of button.

Label

Button text
The text that will appear on the button.

Button color
The color of the button.
The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text color**

The color of the text on the button.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Text style**

The appearance of the text on the button.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

**Export target**

When *Export* is selected from the *Type* drop-down, the following determines the target for the results of the query associated with this button.

Valid options are:

- **Default**
  
  The default behavior is to export the results of the query to a 1010data worksheet in a new tab.

- **Worksheet in new tab**

  Export the results of the query to a 1010data worksheet in a new tab.

- **Worksheet in this tab**

  Export the results of the query to a 1010data worksheet in the current tab, replacing the QuickApp.

- **Download CSV**

  Export the results of the query to a comma-separated values file and download it with the extension `.txt`.

  The file is downloaded with the file name specified by *Download filename*.

  If no file name is specified, the file is downloaded as `download.txt`. 
Download compressed CSV

Export the results of the query to a comma-separated values file and download it to your computer as a compressed file with the extension .zip.

The file is downloaded with the file name specified by Download filename.

If no file name is specified, the file is downloaded as download.zip.

Download to Excel

Export the results of the query to an Excel spreadsheet and download it to your computer with the extension .xls.

The file is downloaded with the file name specified by Download filename.

If no file name is specified, the file is downloaded as download.xls.

Target mode

Default

The default behavior is to export the fully expanded query. (See Expanded ops.)

Expanded ops

Export the fully expanded query to worksheet.

If the 1010data query associated with this button contains block code with parameters, the block code is expanded and the parameters replaced with their values.

For example, the following query:

```html
<block name="storeSelection" storechoice="3">
  <sel value="store={@storechoice}"/>
</block>
```

will be expanded to:

```html
<sel value="store=3"/>
```

in the target worksheet.

Unexpanded block

Export query to target worksheet as a block.

If the 1010data query associated with this button contains block code, the block code and its parameterizations are left intact in the target worksheet.

For example, the following query:

```html
<block name="storeSelection" storechoice="3">
  <sel value="store={@storechoice}"/>
</block>
```

will be exported as:

```html
<block name="hmadded__9" tag="13" instid="t26" changed="">
  <block name="storeSelection" storechoice="3">
    <sel value="store={@storechoice}"/>
  </block>
</block>
```

in the target worksheet.

See the 1010data Reference Manual for more information on blocks.

Variable for set value

The variable to set when the button is clicked.
You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Note:** If you need to set more than one variable, specify each variable in the **Ad-hoc properties** tab. Each variable must have the form: `value[SUFFIX]`, where each `[SUFFIX]` is unique for each variable.

If the button type is **Dump configuration to table**, this variable will be set to the path of the table where the dynamic state has been saved (upon successful completion).

### Value to set

The value to set the variable (specified by **Variable for set value**) when the button is clicked.

**Note:** If you need to set more than one variable, specify the values to set in the **Ad-hoc properties** tab. Each value must have the form: `newvalue[SUFFIX]`, where each `[SUFFIX]` is unique for each variable.

### Submit widgets

A comma-separated list of manually-updated widgets that will receive an update request when a button of type submit is clicked.

If no list is supplied, all widgets will be refreshed when a submit button is clicked.

**Note:** See **Update control** on page 236 for settings regarding the update mode for a particular widget.

### Download filename

The name to use for files downloaded via buttons whose **Type** is either **Export** or **Render**.

The appropriate extension (e.g., `.csv`, `.zip`, `.xls`, `.xlsx`) will be appended to the file name specified here.

If no file name is specified, the default file name is `download` (e.g., `download.csv`).

### Example

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>  
<dynamic store_num="1">  
  <widget class_="field" label_="Input Store Number:" max_="3" min_="1" name="hmadded__1" relpos_="638,35" type_="numeric" value_="@store_num"/>  
  <widget class_="button" color_="#4f81bd" height_="22" name="hmadded__2" relpos_="893,34" submit_="hmadded__3" text_="Select" textstyle_="font-weight:bold;letter-spacing:0;" type_="submit" width_="84"/>  
  <widget base_="pub.demo.retail.item" class_="grid" invmode_="block" invmsg_="Press Select for changes to take effect" name="hmadded__3" relpos_="9,10" update_="manual">  
    <sel value="store={@store_num}"/>  
  </widget>  
</dynamic>
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic store_num="3" display_graph="1" display_grid="1" dump_table=""
load_table="">
  <widget class="field" label="Input Store Number:" max="3" min="1"
name="hmadded_1" relpos="21,26" type="numeric" value="@store_num"/>
  <widget base="pub.demo.retail.item" class="grid" errmsg="Select a store"
invmode="hide" name="hmadded_3" relpos="10,96"
require="[@display_grid=1]"
update="auto">
    <sel value="store={@store_num}"/>
  </widget>
  <widget base="pub.demo.retail.item" class="graphics" errmsg="Select a store"
invmode="hide" name="hmadded_4" relpos="613,97"
require="[@display_graph=1]"
type="pie" update="auto">
    <sel value="store={@store_num}"/>
  </widget>
  <widget class="button" color="#4f81bd" dumptitle="Dump Configuration Table"
height="22" name="hmadded_7" relpos="293,25" text="Dump Config"
textstyle="font-weight:bold;letter-spacing:0;" type="dump"
value="@dump_table" width="110"/>
A hyperlink provides a means of opening an external web page in a new browser window.
Type

**Dummy**

This type of link has no effect.

**External web page**

This type of link opens the specified URL in a new browser tab.

Link text

The text that is displayed for the link within the QuickApp.

URL

The absolute path of the destination address for the external web page.

**Example**

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
    <widget class="link" name="hmadded_1" relpos="195,118" text="Click here to visit 1010data.com" type="external" url="http://www.1010data.com"/>
</dynamic>
```

[Click here to visit 1010data.com](http://www.1010data.com)
**Date picker**

The date picker allows the user to select dates via a dropdown widget or enter them into the provided input field.

The dates that can be selected via the date picker may be restricted using a 1010data query, where the first column in the query results contains integers in the date form: YYYYMMDD (e.g., 20140823).

**Label**

The text that is displayed preceding the date picker input field and dropdown widget.

**Width of label**

The number of pixels allocated for the text preceding the input field.

If the text of the label is greater than the width specified, the label is truncated.

**Width of input**

The number of pixels allocated for the input field.

If the values in the input field are greater than the width specified, the values in the field are truncated.

**Field color**

The color of the date picker field.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Field text color**

The color of the text in the date picker field.
The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Field text style**

The appearance of the text in the date picker field.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

![Field Text Style](image)

**Variable for value**

The variable to hold the value of the selected date.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Label for end (date range)**

When specifying a date range, the text that is displayed preceding the date picker input field and dropdown widget for the end date.

**Width of to label**

The number of pixels allocated for the text preceding the Label for end (date range) input field.

If the text of the label is greater than the width specified, the label is truncated.

**Variable for end value (date range)**

When specifying a date range, the variable to hold the value of the selected end date.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

**Earliest allowed date**

The earliest selectable date (in YYYYMMDD format).

**Latest allowed date**

The latest selectable date (in YYYYMMDD format).

**Date format**

The format for displaying the selected date in the date picker input field. The format may be specified using either a valid 1010data display format or a string representation.
A 1010data display format can be specified for the date format (e.g., "type:date4y"). See Display Formats for a list of valid formats.

Alternatively, a string representation may be specified using "mm" for month, "dd" for day, and "yy" (or "yyyy") for year. The following are examples of valid string representations for date formats:

- mm/dd/yy
- mm/dd/yyyy
- mm-dd-yy

**Note:** The string representation must be all lowercase letters.

For instance, the date 20141109 will be displayed as 11/09/14 when the specified date format is mm/dd/yy.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_date="20150320">
  <widget class_="date" color_="#4bacc6" format_="type:date" label_="Select a date:" labelwidth_="150" name="hmadded__1" relpos_="150,149" textcolor_="#ffff00" value_="@selected_date"/>
  <widget class_="text" name="hmadded__2" relpos_="153,94" text_="Selected date: {@selected_date}"/>
</dynamic>

Selected date: 20150320
```

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic start_date="20150405" end_date="20150523">
  <widget class_="date" color_="#5f497a" earliest_="20150401" format_="mm/dd/yyyy" label_="Select start date:" labelwidth_="150" latest_="20150601" name="hmadded__3" relpos_="107,88" textcolor_="#ffffff" tolabel_="Select end date" tolabelwidth_="150" tovalue_="@end_date" value_="@start_date"/>
</dynamic>
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_date_from_query="20120515">
  <widget base_="pub.demo.retail.item" class_="date" color_="#4f81bd" label_="Select a date:" labelwidth_="150" name="hmadded__8" relpos_="137,129" textcolor_="#ffffff" value_="@selected_date_from_query">
    <tabu label="Tabulation on Sales Item Detail" breaks="date">
      <break col="date" sort="up"/>
      <tcol source="date" fun="cnt" label="Count"/>
    </tabu>
  </widget>
</dynamic>
A text widget allows you to display plain text or arbitrary HTML within a QuickApp. To display the value of a dynamic variable within a text widget, use the syntax: "{@ [VAR_NAME] }", where [VAR_NAME] is the name of the dynamic variable. For instance, if you have a dynamic variable named selected_store, you could display the value of that variable by specifying {@selected_store} within the text in the Content field.
Type

**Plain text**

Display the text in the **Content** field as plain text.

The text will be formatted according to the **Text style** and **Text color** specified.

**HTML**

Display the text in the **Content** field with formatting based on the HTML elements within the text.

**Text style**

The appearance of the text in the input field.

**Note:** This only applies when the **Type** is **Plain text**.

When this field gets focus, a dialog is presented that allows the user to select the family, style, size, and other characteristics of the text such as letter spacing and underlining.

![Text style dialog](image)

**Text color**

The color of the text in the text widget.

**Note:** This only applies when the **Type** is **Plain text**.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Content**

The text to display in the text widget.

If the text contains HTML tags, the **Type** should be set to **HTML**.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget class_="text" color_="#548dd4" name="hmadded__1" relpos_="114,135" style_="font-weight:bold;letter-spacing:0;"
  text_="This is an example of plain text that is blue and has a bold text style."/>
</dynamic>
```
Example

An example of HTML-formatted text
This is the first paragraph.
This second paragraph has the function \(g_{\text{sum}}(G;S;X)\) in monospaced font and italicized text for emphasis.
This third paragraph has an unordered list in it:
- First item
- Second item
- Third item

Image

An image located at a specific URL can be displayed in a QuickApp.
Text/XML entry

A text/XML entry widget provides a container for displaying editable text either in a text box or an XML editor.

---

Image URL

The absolute path of the destination address of the image.

Example

```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget class="image" name="hmadded__1" relpos="260,110"
url="http://www2.1010data.com/documentationcenter/beta/1010datalogo.jpg"/>
</dynamic>
```
The contents of the text/XML entry widget can be populated using a 1010data query. The 1010data query is displayed directly in the widget.

**Mode**

- **Text box**
  Present a simple text box in which arbitrary text can be entered.

- **XML editor**
  Present an XML editor in which Macro Language code can be entered.

**XML source**

- **None**
  Display an empty text box or XML editor, depending on the selected Mode.

**Expanded ops**

- **Expanded block**
  When displaying the query associated with this widget, fully expand any block code into Macro Language operations and replace dynamic variables with parameterized values.

- **Unexpanded block**
  When displaying the query associated with this widget, do not expand block code or replace dynamic variables with parameterized values.

**Read-only?**

- When this option is selected, the content in the text box or XML editor will be displayed but may not be modified.

**Example**

```
<note type="base">Applied to table: pub.demo.retail.item</note>
```
Example

You can type anything in this text box.

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget class="textbox" height_="250" mode_="xml" name="hmadded__2"
  relpos_="97,94" source_="ops" width_="752">
    <block name="storeSelection" storechoice="3">
      <sel value="store=[@storechoice]"/>
    </block>
  </widget>
</dynamic>

1  <note type="base">Applied to table: pub.demo.retail.item</note>
2  <sel value="store=3"/>

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic>
  <widget class="textbox" height_="250" mode_="xml" name="hmadded__3"
  relpos_="97,94" source_="block" width_="752">
**Color picker**

The color picker allows the user to select a color from either the full range of colors or a predefined color palette.

<table>
<thead>
<tr>
<th>Widget: hmadde_3</th>
<th>Class: Color picker</th>
<th>Cancel</th>
<th>Save</th>
</tr>
</thead>
</table>

### Properties

<table>
<thead>
<tr>
<th>Class properties</th>
<th>General properties</th>
<th>Ad-hoc properties</th>
<th>Preview</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property description</strong></td>
<td><strong>Value</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label:</td>
<td>Select a color:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width of label:</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size of palette title:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of palette columns:</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To display an opacity slider?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Apply/Cancel buttons?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show color preview?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable the widget?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto updating while typing?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mode:</td>
<td>Palette:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label for Apply button:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label for Cancel button:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable for value:</td>
<td>@selected_color_palette</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Label

The text that is displayed preceding the color picker.
Width of label
The number of pixels allocated for the text preceding the color picker.
If the text of the label is greater than the width specified, the label is truncated.

Size of palette tile
When the Mode is set to Palette, this specifies the width (in pixels) of each tile in the color palette.

Number of palette columns
When the Mode is set to Palette, this specifies the number of columns of tiles to display in the color palette.

To display an opacity slider?
When this option is selected, a slider that controls the opacity is displayed within the color picker.

Note: This option only applies when the Mode is set to Flat.

Show Apply/Cancel buttons?
When this option is selected, Apply and Cancel buttons are displayed as part of the color picker widget.
You can customize these by specifying values in the **Label for Apply button** and **Label for Cancel button** fields.

**Show color preview?**

When this option is selected, a color preview is shown in the color picker widget.

**Enable the widget?**

Specifies whether the user is able to interact with the color picker.

When this option is selected, the user can select a color from the color picker. If this item is cleared, the user will be able to see the color picker but may not interact with it.

**Auto updating while typing?**

Specifies whether the color should be changed automatically when the user types a valid value in the input field in the color preview.

Valid values include:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

  **Note:** This only applies when the **Mode** is set to **Flat** and **Show color preview?** is selected.

**Mode**

If no **Mode** is selected, the color picker is contained within a dropdown.

**Flat**

When this option is selected, the color picker is displayed in the QuickApp.

**Palette**

When this option is selected, a color palette is displayed in the QuickApp.

The color palette used is determined by the value of `palettevalue_`. See the 1010data Reference Manual for more details on specifying the color palette.

**Label for Apply button**

The text to appear on the button which applies any changes made in the color picker widget.

**Label for Cancel button**

The text to appear on the button which cancels any changes made in the color picker widget.

**Variable for value**

The variable to hold the hexadecimal value of the selected color.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Example**

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_color="#5bf1ff">  
  <widget class_="color" label_="Select a color:" labelwidth_="100"
```
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_color_palette="white">
    <widget buttons_="1" class_="color" columns_="4" label_="Select a color:" labelwidth_="100" mode_="palette" name="hmadded_3" opacity_="1"
        relos0_="157,157" tilesize_="40" value_="@selected_color_palette"/>
    <widget class_="text" name="hmadded_6" relos0_="540,160"
        text_="Selected color: {@selected_color_palette}"/>
</dynamic>
Text style picker

The text style picker presents a dialog that can be used to select a font and related properties such as size and style.

Variable for value

The variable to hold the text style attribute selections as a string of CSS property/value pairs separated by semicolons.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamc selected_text_style=""/>
Folder browser

The folder browser allows the user to navigate a hierarchy of folders, tables, and queries from a given root folder and select any of them to get information such as the path, title, and type of the item.
Path to root folder

The root folder from which to allow browsing.

Label

The text that is displayed preceding the folder browser field.

Width of label

The number of pixels allocated for the text preceding the folder browser field.

If the text of the label is greater than the width specified, the label is truncated.

Width of input

The number of pixels allocated for the folder browser field.

If the values in the input field are greater than the width specified, the values in the field are truncated.

Width of dropdown box

The width (in pixels) of the container in which the folder browser is displayed.

Height of dropdown box

The height (in pixels) of the container in which the folder browser is displayed.

Keep open after selection?

When this option is selected, the folder browser will remain open after an item has been selected from it.

Open in the beginning?

When this option is selected, the folder browser will be displayed when the QuickApp is opened.

Close after selecting?
Show in field
Determine what is displayed in the folder browser field after a selection has been made in the folder browser.

Title
The title of the selected item is displayed in the folder browser field (e.g., "Sales Item Detail").

Path
The path of the selected item is displayed in the folder browser field (e.g., pub.demo.retail.item).

Filter entries to
Determine which items to display in the folder browser.

All
All tables, folders, and queries are displayed in the folder browser.

Tables and folders only
Only tables and folders are displayed in the folder browser. Queries are not displayed.

Tables only
Only tables are displayed in the folder browser. Folders and queries are not displayed.

Real (non-merged) tables only
Only real tables that have not been merged are displayed in the folder browser.

Real tables and folders only
Only real tables and folders are displayed in the folder browser. Queries are not displayed.

Folders only
Only folders are displayed in the folder browser. Tables and queries are not displayed.

Queries only
Only queries are displayed in the folder browser. Folders and tables are not displayed.

Non-parameterized queries only
Only queries that do not take parameters as input are displayed in the folder browser. Folders, tables, and parameterized queries are not displayed.

Accept selection of
Determine which items can be selected from the folder browser.

All
All tables, folders, and queries can be selected from the folder browser.

Tables only
Only tables can be selected from the folder browser. Folders and queries cannot be selected.

Real (non-merged) tables only
Only real tables that have not been merged can be selected from the folder browser.

Folders only
Only folders can be selected from the folder browser. Tables and queries cannot be selected.
Queries only

Only queries can be selected from the folder browser. Folders and tables cannot be selected.

Non-parameterized queries only

Only queries that do not take parameters as input can be selected from the folder browser. Folders, tables, and parameterized queries cannot be selected.

Variable for table path

The variable to hold the value of the path of the selected table, folder, or query.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Variable for table title

The variable to hold the value of the title of the selected table, folder, or query.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Variable for table type

The variable to hold the value of the type of the selected table, folder, or query.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

Types can be:

• dir (folder)
• real (table)
• merged (merged table)
• view (query)

Package variable for table info

The package variable to hold the table information.

You may select a variable from the dropdown, or you can create a new variable by clicking New... and entering the name in the field following the @ symbol.

This variable will store the table information as elements in a package. The elements may be accessed via dot notation. For example, if you specified the variable @selected_table_info in the Package variable for table info field, you can access the ID of the table in the package using the notation {@selected_table_info.id}.

Package keys for the table include:

• title (title of the item)
• path (full path of the item)
• id (internal identification number for the item)
• type (type of the item)
• owner (username of the item’s owner)
• update (date and time the item was last updated)
• users (comma-separated list of users and groups that have access to this item)
• sdesc (short description of the item)
• ldesc (long description of the item)

Note: The package should be initialized using [PACKAGE_VARIABLE_NAME]="{pkg(();)}" in the <dynamic> element. For example: selected_table_info="{pkg(())}"

For more detailed information on working with packages, see the 1010data Reference Manual.
Example

<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic selected_table_path="" selected_table_title="" selected_table_type=""
    selected_table_info="{pkg();}">
    <widget class="browser" dropheight_="250"
        infovalue="@selected_table_info"
        inputwidth_="250" keepopen_="1" label_="Select a folder:" labelwidth_="150"
        name="hmadded__1"
        path_="uploads" relpos_="110,89" titlevalue="@selected_table_title"
        typevalue="@selected_table_type"
        value_="@selected_table_path"/>
    <widget class="text" name="hmadded__2" relpos_="600,100"
        text_="Selected table path: {@selected_table_path}"/>
    <widget class="text" name="hmadded__3" relpos_="600,160"
        text_="Selected table title: {@selected_table_title}"/>
    <widget class="text" name="hmadded__4" relpos_="600,220"
        text_="Selected table type: {@selected_table_type}"/>
    <widget class="text" name="hmadded__5" relpos_="600,280"
        text_="Selected table ID: {@selected_table_info.id}"/>
    <widget class="text" name="hmadded__6" relpos_="600,340"
        text_="Selected table owner: {@selected_table_info.owner}"/>
    <widget class="text" name="hmadded__7" relpos_="600,400"
        text_="Selected table users: {@selected_table_info.users}"/>
</dynamic>

Editable grid

An editable grid provides a spreadsheet-like interface in which the user can modify as well as copy and paste data and subsequently save the changes as a temporary table that can be used by other widgets in the QuickApp.
The editable grid widget is populated using a 1010data query.

**Type**

- **Initialized**

**Label**

The text to appear above the editable grid.

**Variable for saved table value**

When the data is saved, this dynamic variable stores the table path to the temporary in-memory table.

You may select a variable from the dropdown, or you can create a new variable by clicking **New...** and entering the name in the field following the `@` symbol.

**Note:** The table that is saved is temporary and is not accessible after the QuickApp exits.

**Show save button?**

Indicates whether or not to display a save button, which allows the user to save the data within the editable grid to a temporary table.

**Show revert button?**

Indicates whether or not to display a reset button, which reverts edited data to the 1010data query associated with this widget, which initializes the editable grid.

**Show clear button?**

Indicates whether or not to display a clear button, which clears all rows in the editable grid.

**Stretch columns**

Specifies how to stretch out the columns to fill the horizontal space.
Hybrid
Last
All
None

**Column headers**
The column heading or name can be displayed at the top of each column in an editable grid, or it can be left blank.

**Label**
**Name**
None

**Show row numbers?**
This specifies whether or not to show row numbers on the editable grid.

**Show drag-to-fill handle?**
Indicates whether to permit "drag to fill range" in a column during editing.

**Show spare empty row?**
Indicates whether to allocate a new empty row as the last row in the editable grid.

*Note:* The spare row is not saved to the temporary table.

**Read-only grid?**
Indicates whether the contents in entire editable grid are read only.
When this option is selected, the contents of the grid cannot be edited. However, data within the grid may be selected and copied.

**Read-only columns**
A comma-separated list of column names that may not be edited.
Columns not in this list may be edited.

**Restrict input to valid values?**
Indicates whether to prohibit invalid values from being entered in the editable grid.
For example, text values will not be permitted in any cells in a column of type integer when this option is selected.

**Example**
```
<note type="base">Applied to table: pub.demo.retail.item</note>
<dynamic saved_table_name="">
  <widget base="pub.demo.retail.item" background="#8064a2" border="1"
    class="editgrid" halign="center" label="Editable Grid" name="hmadded__1"
    relpos="1,3" rocols="sales,cost" value="@saved_table_name" width="575"/>
  <widget background="#d99694" class="text" halign="center" height="20"
    invmode="hide" name="hmadded__2" relpos="894,52"
    require="[@saved_table_name<>']" text="Saved table name: @saved_table_name" width="341"/>
  <widget base="pub.demo.retail.item" class="grid"
    label="Store #1 Transactions" name="hmadded__4" relpos="592,101"/>
```
General properties

The General properties panel contains properties of widgets that are common across all classes, such as the width and height of the widget, its horizontal and vertical alignment within the container that holds it, and whether it is movable or resizable by the user.
Width
The width (in pixels) of the container that holds the widget.

Height
The height (in pixels) of the container that holds the widget.

Horizontal alignment
Specifies the horizontal placement of the widget with respect to the container that holds it.

Right
The widget is aligned along the right margin of the container that holds it.

Center
The widget is centered between the left and right margins of the container that holds it.

Left
The widget is aligned along the left margin of the container that holds it.

Vertical alignment
Specifies the vertical placement of the widget with respect to the container that holds it.

Top
The widget is aligned along the top margin of the container that holds it.

Middle
The widget is centered between the top and bottom margins of the container that holds it.

Bottom
The widget is aligned along the bottom margin of the container that holds it.

**Background color**

The color of the container that holds the widget.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Widget border**

Specifies whether or not to add a border around the widget.

**Padding**

The width (in pixels) of the space to add to the container that holds the widget.

The color of the padding is the **Background color**.

**Margin**

The width (in pixels) of empty space to add around the container that holds the widget.

**User-movable?**

Specifies whether or not the user can move the widget around within the QuickApp.

**User-resizable?**

Specifies whether or not the user can dynamically resize the widget within the QuickApp.

**Tooltip**

The text that appears when the mouse hovers over the widget.

**Ad-hoc properties**

The **Ad-hoc properties** panel allows the user to specify additional attributes for a particular widget, which may not be provided by the Widget Builder.

For instance, a button that dumps a configuration to an external file optionally takes a number of additional attributes that are not listed under the **Class properties** for a button in the Widget Builder. For example, the attribute `dumptitle_` is used to specify a title for the table that contains the configuration, but the QuickApp Editor does not provide a field for that attribute. You can enter `dumptitle_` under **Property name** and the table title under **Property value** and then click **Add** to add that attribute to the widget definition for that button.
Add an ad-hoc property

You can specify additional attributes for a widget by entering them on the Ad-hoc properties panel of the Widget Builder.

At times, you may want to specify a value for an attribute that may not be provided by the QuickApp Editor for a particular widget.

To add an ad-hoc property:

1. Click View > QuickApp Editor...
2. Right-click the widget you want to add the additional attribute to and select Widget properties from the context menu.
3. Click the Ad-hoc properties tab.
4. Under Property name, enter the name of the attribute.
5. Under Property value, enter the value you would like to assign to the attribute.
6. Click Add.
7. Click Save for the changes to be retained.

Delete an ad-hoc property

You can remove additional attributes that you have previously specified for a widget on the Ad-hoc properties panel of the Widget Builder.

To remove an ad-hoc property:

1. Click View > QuickApp Editor...
2. Right-click the widget you want to delete the additional attribute from and select Widget properties from the context menu.
3. Click the Ad-hoc properties tab.
4. Click **Delete** for the attribute you would like to remove.
5. Click **Save** for the changes to be retained.

**Preview**

The **Preview** panel allows you to see the appearance of the widget with its current set of attributes.

This panel allows you to test out changes to **Class properties**, **General properties**, and **Ad-hoc properties**, and see their related effects on the widget without needing to save it.

---

**Query**

The Widget Builder provides a number of ways to specify a 1010data query associated with a particular widget, including using existing block code from the current environment, importing the query from an open worksheet, providing data as an inline table, or manually entering Macro Language code for the query into a supplied XML editor. You can also see a preview of the query results. The Widget Builder also contains settings that determine when a widget is updated or invalidated.
The Widget Builder allows you to use block code that exists in the current environment for the query associated with the widget.
You can select any available block that exists in the current environment from the **Use block** list, and it will be inserted into the query associated with the current widget.

**Note:** Selected block code will run **before** any query code specified for the widget (e.g., in **Query XML**) is executed.

**Worksheets**

The Widget Builder allows you to import the Macro Language code from an open worksheet into the query associated with the current widget.
You can select any open worksheet from the **Available worksheets** list and then click **Import** to import the Macro Language code from the worksheet into the query associated with the current widget. After the code from the worksheet has been successfully imported, it can be modified in the **Query XML** tab.

**Inline data**

The Widget Builder allows you to provide data within an editable grid, which can be converted to an inline table in the query for the current widget.
You can manually enter data into the editable grid, or you can import the results from the current query (by clicking **Import**) and then modify the data in the editable grid. If you want to add or remove rows or columns from the editable grid, right-click and select the desired action from the context menu:

When you are satisfied with the contents of the editable grid and want the data to be used in the query associated with the widget, click **Use**. The contents of the editable grid will be converted into an inline table that is used by the widget. (See **Table Tree** for details about the format of the inline table.)

**Note:** Any query code previously in the **Query XML** tab for this widget will be overwritten by the inline table when **Use** is clicked.

For instance, after clicking **Use** in the **Inline data** tab in the above example, the **Query XML** tab will contain Macro Language code that looks something like the following:
After the inline table has been successfully converted, the Macro Language code associated with it can be modified in the **Query XML** tab.

For example, in the above example, if you wanted to sort the contents of the inline table, you could add a `<sort>` operation after the table in the Macro Language code in the **Query XML** tab:
You can then click the **Data preview** tab to see that the items have been sorted in ascending order:
**Query XML**

The *Query XML* tab provides you with an XML editor to directly enter the Macro Language code for the query associated with the widget.

The *Query XML* tab also has a folder browser that you can use to select the **Base table path** for the query.

For example, a sorter widget uses the results of its associated query to populate the contents of its sorted list. It expects either a one-column table consisting of the values it will use to populate the list, or a two-column table that contains values in the first column and their corresponding labels in the second column.

The Macro Language code in the following example produces a two-column table with unique SKU values in the first column and the corresponding item descriptions (which it got from linking in the product master table) in the second column.

```xml
<link table2="pm.demo.retail.prod" col1="sku" col2="sku"/>
<willbe name="selection1" value="Q_first1(itemdesc;)"/>
<willbe name="selection2" value="itemdesc;"
<col value="selection1;"/>
<col value="selection2;"/>
<order col="sku,itemdesc;"/>
```

**Note:** You can see an example of the results from this query in the *Data preview* on page 239 tab.

**Update control**

These settings control under which conditions the widget is updated as well as what actions to take when rendering a widget that either is invalid or whose associated query contains errors.
Update mode

Specifies whether the widget is updated automatically or only when it receives an update request.

Default

Auto

Update the widget automatically whenever the dynamic variables that it references change.

Manual

Update the widget only when it receives an update request.

Update requests are sent to widgets when a button of type submit is clicked. See Button on page 194 for more information.

Hold if any variables changed

If any of the variables in this comma-separated list change, invalidate the widget and await a manual update request.

Require condition to update

When this condition is false, invalidate the widget and update when the condition becomes true.

Refresh whenever condition is true

When this condition is true, update the widget (even if nothing appears to have changed).

When invalid

Specifies the action to take when rendering an invalidated widget.

Default

Hide
The widget is not displayed.

Block

The widget appears dimmed in its previously valid state, and a message is displayed.

If a Message when invalid is specified, it is displayed over the invalidated widget; otherwise, the message "Please wait..." will be used.

Leave active

The widget is displayed in its previously valid state.

Message when invalid

The text to display over a widget that is blocked when invalid.

In following example, the query associated with the grid widget references the value from the Input Store Number field, which has changed. However, the update mode of the grid widget is set to manual, so the grid widget displays a message to let the user know that they must click the Select button for the changes to take effect.
**Message when errored**

The text to display over a widget if its associated query contains errors.

In following example, the query used to populate the grid widget references the value from the **Input Store Number** field, which is empty, so the grid widget displays an error message to let the user know that they must select a store in order for the grid to display correctly.

![Data Preview Example](image)

**Data preview**

The **Data preview** tab allows you to see the results of the query associated with the widget. You can use the **Data preview** panel to make sure that the query you specified for the widget is returning the results that it is expecting.

For example, a sorter widget uses the results of its associated query to populate the contents of its sorted list. It expects either a one-column table consisting of the values it will use to populate the list, or a two-column table that contains values in the first column and their corresponding labels in the second column.

The **Data preview** tab below shows an example of a two-column table used by a sorter widget. The item SKU values are in the first columns, and the item descriptions are in the second column.
Note: You can see an example of the 1010data query used to generate this particular table in the example for Query XML on page 236.

The sorter widget will take this data and display the labels (from the second column) but will store the sorted list of values (from the first column) in the dynamic variable associated with the widget.

In the following example, you can see that the sorter widget is displaying the item descriptions, but the value of the dynamic variable associated with this sorter widget is a comma-separated list of the corresponding SKU values.
**Widget XML source**

The **Widget XML source** section provides an XML editor that contains the Macro Language code for the widget.

```xml
<widget class="graphics" clickable="m0,m1,m2" interactive="1" legendpos="left">
  <selector/>
  <table label="Sales by Date by Store" breaks="date" cbreaks="store" clabels="short">
    <break col="date" sort="up"/>
    <break col="store" sort="up"/>
    <break col="sales" sort="sum"/>
  </table>
  <graphspec width="402" height="402">
    <chart type="bar" sample="25">
      <data x="date" y="m0"/>
      <data x="date" y="m1"/>
      <data x="date" y="m2"/>
    </chart>
  </graphspec>
</widget>
```

The Macro Language in the XML editor may be modified, and these changes will be retained when the user clicks *Save*.

**Create a new widget**

You can use the Widget Builder to create a new widget in the QuickApp Editor.

To create a new widget:

1. In an open worksheet (or table), click **View > QuickApp Editor**... to launch the QuickApp Editor.
   
   You will be presented with a grid on which to place the new widget.
Note: If there are existing widgets in the QuickApp, you will see them displayed on the grid.

2. Right-click in a space not occupied by another widget or layout.

   A context menu is displayed.

   - Add a new widget here
   - Add some text here
   - Clone selected widget here
   - Add an empty layout here
   - Show dynamic variable inspector
   - Show editing toolbox
   - Commit changes to this QuickApp
   - Revert QuickApp (abandon changes)
   - Cancel

3. Click **Add a new widget here**.

   The Widget Builder is presented.
4. From the **Class** list, select the type of widget you want to create.

5. Specify the desired **Properties** and/or **Query** associated with the widget.
6. Click **Save** to save your new widget.

Your new widget will be displayed on the grid.
7. To commit your new widget to the QuickApp, right-click anywhere on the grid (in a space not occupied by the widget) and click **Commit changes to this QuickApp**.

The new widget will be displayed in the QuickApp.

---

**Modify an existing widget**

You can use the Widget Builder to modify an existing widget in the QuickApp Editor.

To modify an existing widget:

1. Open the QuickApp containing the widget you want to modify.
   
   See *Edit a Quick Query* on page 129 for guidance on opening queries for editing.

2. Click **View > QuickApp Editor...** to launch the QuickApp Editor.
   
   You will be presented with a grid containing the widgets in the QuickApp.
**Note:** If the widgets are contained in a layout, you will need to unlock the layouts before you can edit any of the widgets.

3. Right-click the widget that you want to modify.
   A context menu is displayed.

4. Click **Widget properties**.
   The Widget Builder is presented.
5. Modify the desired **Properties** and/or **Query** associated with the widget.

6. Click **Save** to save the changes.
7. To commit the changes you’ve made to the widget in the QuickApp, right-click anywhere on the grid (in a space not occupied by the widget) and click **Commit changes to this QuickApp**.

Your QuickApp will be displayed with the changes you made to the widget.
Clone an existing widget

You can use the QuickApp Editor to clone an existing widget.

To clone an existing widget:

1. Open the QuickApp containing the widget you want to clone.

   See Edit a Quick Query on page 129 for guidance on opening queries for editing.

2. Click View > QuickApp Editor... to launch the QuickApp Editor.

   You will be presented with a grid containing the widgets in the QuickApp.

   Note: If the widgets are contained in a layout, you will need to unlock the layouts before you can edit any of the widgets.

3. Right-click the widget that you want to clone.

   A context menu is displayed.
4. Click **Select/deselect for clone**.
   The widget will appear highlighted, which indicates that it is selected for cloning.

5. Right-click on the grid where you want the cloned widget to appear.

6. Click **Clone selected widget here**.
   The cloned widget will appear on the grid.
7. Modify the desired **Properties** and/or **Query** associated with the cloned widget.

   **Note:** Be sure to save your changes and commit them to the QuickApp.

   See *Modify an existing widget* on page 245 for details.
Charting

1010data provides a mechanism to generate high-quality charts, which in turn can support the notion of visual data discovery.

Charting helps us make sense of large amounts of data that might otherwise be too overwhelming to comprehend. Imagine a table with 20 columns and 100,000 rows of data. With 2 million pieces of important information right in front of you, it might be difficult to get a clear picture of what it all means. With charting, you can more easily see relationships among the data points so you can quickly glean insights and use them to improve your business.

Numerous chart types are supported in 1010data, including two-dimensional bar charts, pie charts, histograms, and bubble charts, as well as three-dimensional scatter charts and surface charts. In addition, stacked, stepped, and percentile bar chart types are provided. A number of chart types for visualizing financial data are also available, including Kagi, Renko, and candlestick charts. All chart types allow full aspect ratio rendering, so that the chart will fill the whole area when you resize the chart window.

Useful charts can be created with minimal effort using the 1010data web interface by applying one of the provided chart types to the current table or worksheet. You can use the Chart Builder to select the columns of data to be plotted and provide other chart-related parameters, such as the number of samples for a chart. You can select one of the predefined themes to display your chart or graph with a particular color palette, or you can modify individual attributes such as the color, style, or size of the title font; the degree of rotation for the ticks along a particular axis; or whether a legend should be included and where it should appear in relation to the chart.
Once a chart is created, a graphics widget can be generated containing the underlying Macro Language code, which can then be used in the development of a QuickApp. You can edit the XML directly and modify a chart by manipulating the appropriate 1010data Macro Language elements and attributes; or, once familiar with the graphics-related XML, you can build your own charts from scratch.

<note type="base">Applied to table: pub.fin.fred2.bls.smsu</note>
<widget class_="graphics">
  <sel value="(state='PA')"/>
  <sel value="between(month;'1/76';'12/90')"/>
  <graphspec width="1008" height="631" theme="happy">
    <chart type="line" title="Monthly Unemployment - Pennsylvania">
      <data x="month" y="unemp"/>
    </chart>
  </graphspec>
</widget>

Figure 3: Example of a QuickApp created from the Chart Builder

Charts can be saved along with the associated tables or worksheets as a Quick Query, preserving their settings and attributes as well as the state of the table or worksheet with which they are associated. The Quick Query can be run at a later time, allowing further modifications to the charts contained within.

For each table, you can have multiple charts, allowing you to branch off different paths of analysis. You can also freeze a chart, essentially memorizing the current state of the table. The chart will remain in that state, regardless of any changes to the table with which it is associated, until you unfreeze it, at which point it will sync back up with the current state of the table.

You can also export any of your charts in PDF format, making your data available for internal or external business reports.
Chart Builder

The Chart Builder allows you to create new charts or modify the appearance of existing charts using a drag-and-drop interface and customizable settings.

The Chart Builder is presented in the Create Chart window and consists of a number of panels. These panels allow you to configure the type of chart, the columns of data to be plotted, and a number of customizable settings such as the size of the chart, its background color, title, theme, axes, ticks, and legend. Any changes with respect to these settings are reflected immediately in the chart.

The chart is displayed in the center panel and is surrounded by panels to the left, right, and bottom. These panels include the following:

- Data Columns
- Chart Parameters
- Customization Settings
- XML Graphics Specification

These panels can be individually hidden from view (or shown, if currently hidden) using the toggle buttons on the menu bar or the splitter toggles, which are located in the center of each of the panel dividers.
The Chart Builder operates in full mode, wherein it occupies the full real estate beneath the Tables and Worksheets Toolbar in your 1010data session. You can also view the chart in compact mode by clicking the icon in the top right corner of the Create Chart window (or by double-clicking on the title bar). In this mode, the chart panel is displayed in a floating window that can be moved within your 1010data session. This can be helpful when working with the corresponding table or worksheet, as the results of any changes to the table, such as selections, are reflected immediately in the Create Chart window.
If you lose visibility of the Create Chart window in compact mode, you can press either Shift+Left Arrow or Shift+Right Arrow to cycle through the various windows open in your 1010data session until the Create Chart window is visible again.

The Create Chart window can be hidden while in compact mode by clicking the icon in the top right corner, so that only the title bar of the Create Chart window is visible. To show the window again, click the icon.

If you are viewing a chart in compact mode, you can click the in the top right corner of the Create Chart window to return to full mode (or double-click on the title bar).

To close a chart that you are currently viewing, click the .

**Note:** You should save the chart if you want to be able to access it again; otherwise, the chart will no longer be available once you close the window.

**Data Columns**

This panel lists all of the columns from the current table or worksheet that are available for plotting in a 1010data chart.

The Data Columns panel appears on the left side of the Chart Builder and contains a list of all the columns from the current table or worksheet.
Each entry in the list consists of a column heading and the type of the values in that column. **NUM** indicates the values in the column are numerical; **STR** indicates string values.

Any entry in the Data Columns list can be dragged to a Drop column input in the Chart Parameters panels for plotting.

In the following example, if you wanted to plot the values associated with the column heading Month along the X-axis, you would drag that entry into the Drop column box under the DATA (X-AXIS) section in the Chart Parameters panel. If you wanted to plot the values associated with the column heading Unemployed along the Y-axis, you would drag that entry into the Drop column box under DATA (Y-AXIS).
Chart Parameters

This panel allows the user to select the chart type, specify chart-specific settings (including the columns of data to be plotted), and enable chart interactions.

The Chart Parameters panel appears on the left side of the Chart Builder next to the Data Columns panel.

The Chart Parameters panel consists of the following sections:

- **Select Chart**
- **Settings**
- **Data**
- **Interactions**

**Select Chart**

The **Select Chart** section allows you to choose the type of chart you would like to create.

If you select a particular chart type from the **Chart** menu of an open table or worksheet, the Chart Builder is displayed with that chart type highlighted in red, indicating it is selected.

If you select **Create Chart...** from the **Chart** menu of an open table or worksheet, the Chart Builder is displayed with no chart type selected and **Drop column** boxes available for the X-, Y-, and Z-axis. In this case, you can select a chart type in one of two ways:

- The Chart Builder can suggest types of charts based on the data you want to plot.
  
  You can drag columns from the Data Columns panel into the corresponding **Drop column** box for each axis. The Chart Builder will highlight suggested chart types in blue in the **Select Chart** section. When you select a particular chart type, it will be highlighted in red.

  For example, if you specify columns for the X-axis and Y-axis, the Chart Builder will suggest chart types that typically require two variables, such as a **Line** chart or a **Bar** chart. If you also specify a column for
the Z-axis, chart types that typically require three variables, such as a **Scatter (3D)** or **Surface** chart, would be highlighted.

- Or, if you know the type of chart you want, simply select that chart type in the **Select Chart** section.

Once a chart type is selected, settings related to that particular chart type will appear in the **Settings** section, and **Drop column** boxes will be provided in separate **Data** sections for the data required to plot the selected chart type.

### Settings

The **Settings** section displays a number of general parameters related to the chart, such as the number of samples to include in the chart or whether to use a linear or logarithmic scale for a particular axis.

It also displays settings that are specific to the chart type selected in the **Select Chart** section. For instance, if you select a **Bar** chart, you will see settings for **Bar orientation** and **Layout**.

See **Chart Settings** on page 260 for a detailed listing of the general and chart-specific parameters that may appear under the **Settings** section.

### Data

One or more **Data** sections are provided, depending on the type of chart selected in the **Select Chart** section. The parenthetical text within each of the **Data** headings gives an indication of how that data will be plotted for the selected chart type.

For example, if you selected a **Bar** chart type, you would see the following sections:

- **DATA (LABELS)**
- **DATA (BARS)**

whereas for a **Candlestick** chart, you would see:

- **DATA (DATES)**
- **DATA (OPEN)**
- **DATA (HIGH)**
- **DATA (LOW)**
- **DATA (CLOSE)**

If no chart type is selected, the following sections are displayed by default:

- **DATA (X-AXIS)**
- **DATA (Y-AXIS)**
- **DATA (Z-AXIS)**

You can drag and drop the columns from the Data Columns panel into the **Drop column** boxes in these sections so that the data from those columns is plotted accordingly in the chart.

**Note:** You cannot drag columns from one **Data** section to another.

### Interactions

Chart interactions allow you to zoom in or out of the current chart. You can also center the chart around a certain point by double-clicking in the desired spot on the chart.

Once chart interactions are enabled, you can perform the following mouse actions on the current chart:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click</td>
<td>Double-click at a particular spot on a chart to center the chart at that location.</td>
</tr>
<tr>
<td>Drag</td>
<td>Drag the pointer over an area to zoom into the corresponding rectangular region.</td>
</tr>
</tbody>
</table>
### Action | Description
--- | ---
Wheel Up | Rotate the wheel button forward to zoom out of the chart.
Wheel Down | Rotate the wheel button backward to zoom in to the chart.

**Note:** Chart interactions are intended for use in full mode and are currently provided only for the **Line** and **Scatter** chart types.

### Chart Settings

The **Settings** section provides a number of general and chart-specific settings.

#### General

**Samples**

Specify the number of samples to use when plotting a chart.

**X-Scale**

- **Linear**
  
  Use a linear scale for the X-axis.

- **Log**
  
  Use a logarithmic scale for the X-axis.

**Y-Scale**

- **Linear**
  
  Use a linear scale for the Y-axis.

- **Log**
  
  Use a logarithmic scale for the Y-axis.

**X-Range (min)**

Specify the minimum value to be plotted along the X-axis.

**X-Range (max)**

Specify the maximum value to be plotted along the X-axis.

**Y-Range (min)**

Specify the minimum value to be plotted along the Y-axis.

**Y-Range (max)**

Specify the maximum value to be plotted along the Y-axis.

#### Line Chart

**Layout**

- **Default**
  
  No fill under the plotted line.

- **Filled**
  
  Fill the area below the plotted line with color.
Scatter Chart

**Layout**

- **Default**
  
  Scatter points appear as separate entities on the chart.

- **Filled**
  
  A line extends from each scatter point to the X-axis.

Pie Chart

**Layout**

- **Default**
  
  Pie slices extend into the center of the chart.

- **Donut**
  
  The center of the chart is empty, providing the data in the shape of a ring.

Bar Chart

**Bar orientation**

- **Default**
  
  Bars are displayed vertically in the chart.

- **Horizontal**
  
  Bars are displayed horizontally in the chart.

**Layout**

- **Default**
  
  Each grouping in a particular data set is displayed as a separate bar in the chart.

- **Stacked**
  
  All of the related groupings of data in a particular data set are stacked on top of one another contiguously in a single bar.

- **Stepped**
  
  All of the related groupings of data in a particular data set are displayed next to one another in an ascending series of separate bars.

- **Percentile**
  
  All of the related groupings of data in a particular data set are stacked on top of one another contiguously in a single bar; the height of each grouping in the bar corresponds to its value in relation to the other groupings in the same data set.

Histogram (1D) Chart

**Layout**

- **Default**

- **Stacked**

**Bins**

You can select a particular binning method or choose a specific bin size.
The following are the available binning methods:

**Default**

**Sturges**
- Compute the number of bins based on the length of data

**Scott**
- Asymptotically minimize the mean square error

**Freedman-Diaconis**
- Twice the interquartile range divided by the cube root of sample size

**Knuth**
- Balance likelihood and prior probability of a piecewise uniform model

**Wand**
- One-level recursive approximate Wand binning

The following are the available bin sizes:
10
20
50
100

**Heights**

**Count**
- The number of values lying in each bin

**Cumulative Count**
- Cumulative counts

**Survival Count**
- Survival counts

**Probability**
- Fraction of values lying in each bin

**CDF**
- Cumulative distribution function

**SF**
- Survival function

**HF**
- Hazard function

**CHF**
- Cumulative hazard function
Histogram (2D) Chart

Bins
You can select a particular binning method or choose a specific bin size.
The following are the available binning methods:

Default

Sturges
Compute the number of bins based on the length of data

Scott
Asymptotically minimize the mean square error

Freedman-Diaconis
Twice the interquartile range divided by the cube root of sample size

Knuth
Balance likelihood and prior probability of a piecewise uniform model

Wand
One-level recursive approximate Wand binning

The following are the available bin sizes:

10
20
50
100

Heights

Count
The number of values lying in each bin

Cumulative Count
Cumulative counts

Survival Count
Survival counts

Probability
Fraction of values lying in each bin

CDF
Cumulative distribution function

SF
Survival function

HF
Hazard function
CHF
Cumulative hazard function

**Reset chart parameters**
Clear the chart type, settings, and data column assignments for the current chart.

To reset the chart parameters:

In the Chart Parameters panel of the Chart Builder, click **Reset**.

This clears the settings in the **Select Chart**, **Settings**, and **Data** sections in that panel.

**Enable chart interactions**
When chart interactions are enabled, you can zoom in or out of the current chart, or center the chart at a specified location.

To enable chart interactions:

Under the section labeled **Interactions** in the Chart Parameters panel of the Chart Builder, click **Enable Interactions**.

**Note:** You must be viewing a chart in full mode to enable chart interactions.

Once chart interactions are enabled, you can perform the following mouse actions on the current chart:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click</td>
<td>Double-click at a particular spot on a chart to center the chart at that location.</td>
</tr>
<tr>
<td>Drag</td>
<td>Drag the pointer over an area to zoom into the corresponding rectangular region.</td>
</tr>
<tr>
<td>Wheel Up</td>
<td>Rotate the wheel button forward to zoom out of the chart.</td>
</tr>
<tr>
<td>Wheel Down</td>
<td>Rotate the wheel button backward to zoom in to the chart.</td>
</tr>
</tbody>
</table>

**Note:** Chart interactions are intended for use in full mode and are currently provided only for the **Line** and **Scatter** chart types.

**Customization Settings**
The Chart Builder provides a number of customizable settings that control the way a chart is displayed, including the size of the chart, background color, appearance of the title and the axes, and placement of the legend.

The Customization Settings panel appears on the right side of the Chart Builder.
General

These settings determine the general appearance of the chart and allow you to select a predefined theme as a basis for the color palette.

Chart width

The width of the chart in pixels.

Chart height

The height of the chart in pixels.

Background color

The color to be used for the background of the chart.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Theme

Predefined color palettes that determine the color of the graph elements.

Available themes include:

- Default
- Happy
- Excel
- Maximum
Title

These settings apply to the appearance of the title for the chart.

Show title?

If Yes, the title will be displayed above the chart; otherwise, the chart will appear without a title.

If no Title text is specified, but Show title? is set to Yes, the title of the base table will be used.

Title text

The text to appear above the chart.

Title size

The font size of the title text.

Background color

The color to be used for the background of the title.

The color can be selected using the color picker or can be specified as:

• Any valid HTML color name (e.g., red, blue, cyan)
• An RGB value (e.g., rgb(238,147,12))
• A hex value (e.g., #d12345)

Color

The color to be used for the title font.

The color can be selected using the color picker or can be specified as:

• Any valid HTML color name (e.g., red, blue, cyan)
• An RGB value (e.g., rgb(238,147,12))
• A hex value (e.g., #d12345)

Font family

The font family specification for the title.

Font weight

The weight or thickness of the title.

Font slant

The type of emphasis to be applied to the title.

Axes

These settings determine the appearance of the X, Y, and Z axes and their associated labels and markers.

Show X-axis

If Yes, the X-axis will be displayed for the chart; otherwise, the chart will appear without an X-axis.

X-axis color

The color of the X-axis and X-axis markers.

The color can be selected using the color picker or can be specified as:

• Any valid HTML color name (e.g., red, blue, cyan)
• An RGB value (e.g., rgb(238,147,12))
• A hex value (e.g., #d12345)

X-axis size
The font size of the X-axis markers.

**Font family**
The font family specification for the X-axis markers.

**Font weight**
The weight or thickness of the X-axis markers.

**Font slant**
The type of emphasis to be applied to the X-axis markers.

**Show X-label**
If **Yes**, the X-axis label will be displayed for the chart; otherwise, the chart will appear without an X-axis label.

If no **X-label** is specified, but **Show X-label?** is set to **Yes**, the column heading associated with the X-axis will be used by default. If multiple columns are specified for the X-axis, no default label will be displayed.

**X-label**
The text to appear under the X-axis.

**X-label size**
The font size of the X-axis label.

**X-label color**
The color to be used for the X-axis label.

The color can be selected using the color picker or can be specified as:
- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**X-label background**
The color to be used for the background of the X-axis label.

The color can be selected using the color picker or can be specified as:
- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Font family**
The font family specification for the X-axis label.

**Font weight**
The weight or thickness of the X-axis label.

**Font slant**
The type of emphasis to be applied to the X-axis label.

**Show Y-axis**
If **Yes**, the Y-axis will be displayed for the chart; otherwise, the chart will appear without a Y-axis.

**Y-axis color**
The color of the Y-axis and Y-axis markers.
The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Y-axis size**

The font size of the Y-axis markers.

**Font family**

The font family specification for the Y-axis markers.

**Font weight**

The weight or thickness of the Y-axis markers.

**Font slant**

The type of emphasis to be applied to the Y-axis markers.

**Show Y-label**

If **Yes**, the Y-axis label will be displayed for the chart; otherwise, the chart will appear without a Y-axis label.

If no **Y-label** is specified, but **Show Y-label?** is set to **Yes**, the column heading associated with the Y-axis will be used by default. If multiple columns are specified for the Y-axis, no default label will be displayed.

**Y-label**

The text to appear next to the Y-axis.

**Y-label size**

The font size of the Y-axis label.

**Y-label color**

The color to be used for the Y-axis label.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Y-label background**

The color to be used for the background of the Y-axis label.

The color can be selected using the color picker or can be specified as:

- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

**Font family**

The font family specification for the Y-axis label.

**Font weight**

The weight or thickness of the Y-axis label.

**Font slant**

The type of emphasis to be applied to the Y-axis label.
Show Z-axis

If Yes, the Z-axis will be displayed for the chart; otherwise, the chart will appear without a Z-axis.

Z-axis color

The color of the Z-axis and Z-axis markers.
The color can be selected using the color picker or can be specified as:
- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Z-axis size

The font size of the Z-axis markers.

Font family

The font family specification for the Z-axis markers.

Font weight

The weight or thickness of the Z-axis markers.

Font slant

The type of emphasis to be applied to the Z-axis markers.

Show Z-label

If Yes, the Z-axis label will be displayed for the chart; otherwise, the chart will appear without a Z-axis label.

If no Z-label is specified, but Show Z-label? is set to Yes, the column heading associated with the Z-axis will be used by default. If multiple columns are specified for the Z-axis, no default label will be displayed.

Z-label

The text to appear next to the Z-axis.

Z-label size

The font size of the Z-axis label.

Z-label color

The color to be used for the Z-axis label.
The color can be selected using the color picker or can be specified as:
- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Z-label background

The color to be used for the background of the Z-axis label.
The color can be selected using the color picker or can be specified as:
- Any valid HTML color name (e.g., red, blue, cyan)
- An RGB value (e.g., rgb(238,147,12))
- A hex value (e.g., #d12345)

Font family
The font family specification for the Z-axis label.

**Font weight**
The weight or thickness of the Z-axis label.

**Font slant**
The type of emphasis to be applied to the Z-axis label.

**Ticks**
These settings allow the ticks along the axes to be rotated.

**X-tick rotation**
Rotate the ticks along the X-axis by the selected number of degrees.

**Y-tick rotation**
Rotate the ticks along the Y-axis by the selected number of degrees.

**Z-tick rotation**
Rotate the ticks along the Z-axis by the selected number of degrees.

**Data Series**
These settings control the appearance of different arrays of values within the current chart.

**Colors**

**Thicknesses**

**Opacities**

**Line strokes**

**Show line markers?**

**Line marker types**

**Line marker colors**

**Line marker sizes**

**Show scatter markers?**

**Scatter marker types**

**Scatter marker colors**

**Scatter marker sizes**

**Scatter point sizes**

**Grid**
This setting determines whether the chart is displayed with a grid or not.

**Show grid?**
This determines whether a grid should be displayed with the corresponding chart.

**Default**
- The default setting.

**Yes**
- The grid is displayed.

**No**
- The grid is not displayed.

---

**Legend**

These settings control whether a legend should be displayed with the corresponding chart, and if so, where it should appear.

**Show legend?**
- This determines whether a legend should be displayed with the corresponding chart.

**Default**
- The default setting.

**Yes**
- The legend is displayed according to the specified **Position**.

**No**
- The legend is not displayed.

**Position**
- If the legend is to be displayed, this determines its position relative to the chart.

**Bottom**
- The legend appears below the chart.

**Top**
- The legend appears above the chart.

**Left**
- The legend appears to the left of the chart.

**Right**
- The legend appears to the right of the chart.

---

**Info**

This sections displays the running time of the chart and information about sampling.

**Running time**
- The running time of the chart.

**Is chart sampled?**
- Displays whether the chart was sampled or not.

**Samples**
- If the chart was sampled, this displays how many samples.
Sampling type

If the chart was sampled, this displays how the chart was sampled.

XML Graphics Specification

This panel shows the 1010data Macro Language associated with the current chart. The XML Graphics Specification panel appears below the chart in the Chart Builder.

This panel is not editable; however, you can copy the code from this panel and paste it into your own Macro Language in the Edit Actions (XML) dialog, or you can click Drop QuickApp in the Chart Builder to create a graphics widget for use in a QuickApp.

Toggle Chart Builder panels

The Chart Builder panels can be shown or hidden from view by either using the toggle buttons on the Chart Builder menu bar or the toggle handles on the sides of the panels.

To toggle the Chart Builder panels:

- Use the panel toggle buttons on the Chart Builder menu bar (Grid, Settings, Actions).
  
  - Toggles the Data Columns and Chart Parameters panels.
  
  - Toggles the Customization Settings panel.
  
  - Toggles the Data Columns, Chart Parameters, and Customization Settings panels.

- Use the panel toggle handles on the sides of the panels:
Note: When a panel is hidden from view, the toggle handle runs along the border of the window; however, its color changes when you position the mouse over the toggle, which makes it easier to locate.
Chart Types

Numerous chart types are supported in 1010data, including two-dimensional line, bar, pie, and bubble charts; three-dimensional scatter and surface charts; and chart types for visualizing financial data such as Kagi, Renko, and Candlestick charts.

Line

A two-dimensional chart that displays a series of data points interconnected by line segments.

Line charts can show the change in a particular variable over time and are often used to identify trends in data.

![Monthly Unemployment – Pennsylvania](image)

Scatter

A two-dimensional chart that plots a set of related values as a collection of individual data points.

Scatter charts are often used to show the non-linear relationship between variables. They help to visualize the distribution of data points within a particular data set and can help to identify any outliers.

![Early 1995 Snowfall – Fargo, North Dakota](image)

Pie

A circular chart that is divided into sections representing various subsets of data in relation to the whole.

Pie charts are used to show the proportional relationship between various subsets of data and are most effective when the number of subsets is relatively small.
A *donut chart* is a variation of the pie chart, with a blank center in the middle of the chart.

![Donut Chart Example](image)

**Bar**

A chart with either horizontal or vertical bars that proportionally represent the values of various subsets of data.

![Bar Chart Example](image)

**Scatter (3D)**

A three-dimensional chart that is often used to show the change in variables over time. Scatter (3D) charts show concentrations of data points and patterns within a given data set.
Surface

A chart that displays a three-dimensional graphic of interrelated data points. Surface charts use wireframes and shading to show relationships among the variables.

Bubble

A chart that displays each data point as a bubble. The position of the bubble represents two dimensions of the data, and the size of the bubble corresponds to a third dimension.
Histogram (1D)

A chart that shows the distribution of data using contiguous columns (bins).

The height of each bin, which represents a grouping of data, indicates the frequency of occurrence of that particular group within the given data set.

Histogram (2D)

A chart that uses bins of equal size to show the distribution of data.

The density of the distribution is indicated by the coloring of the bins.
Candlestick

A chart that is typically used to illustrate the price movement of a security, currency, or derivative over time.

Candlestick charts consist of entries that use the candle "body" to represent the opening and closing price and the "wick" to represent the highest and lowest trades of the security on a particular day.

Kagi

A chart that shows the trend of a financial asset, irrespective of its day-to-day fluctuations.

The vertical lines in a Kagi chart depend on price action; horizontal lines connect changes in the direction of its movement.
Renko

A chart that uses "bricks" of a predetermined size to show the price movement of a stock or other financial asset.

A new brick is added when the price surpasses the top or bottom value of the previous brick. Because Renko charts are time independent, the time axis is not constantly spaced.

Point & Figure

A chart that consists of alternating green and red columns, which indicate the rising and falling price movements of a financial asset over a given date range.

The column changes when the price changes direction by a set value.
Line Break

A chart that is useful for detecting changes in trends for a particular security over a specified time interval.

A new line is drawn when the closing price exceeds the previous day's high or low. Consecutive green lines indicate a trend in higher closing prices; consecutive red lines show a trend in lower closing prices.

Box & Whisker

A chart that displays quartiles, as well as minimum and maximum values, along a single axis. These types of charts are useful for understanding the distribution of values within a series or groups of series.
Create a chart based on chart type

Create a chart for the current table or worksheet by selecting a chart type and then specifying the data columns to be plotted.

To create a chart based on chart type:

1. In an open table or worksheet, perform either of the following actions:
   - Select the type of chart from the Chart menu.
   - Click Chart > Create Chart... and then select the chart type in the Select Chart section of the Create Chart window.

   The selected chart type will be highlighted in red in the Chart Parameters panel of the Chart Builder.

2. For each column that you want to plot, drag it from the Data Columns panel into the Drop column box in the Data section associated with the axis where you want that data plotted.

   Note: You cannot drag columns from one Data section to another. If you want to remove a column from a Data section, hover your mouse over the column in that section and click the icon.

3. Make any desired changes in the Settings section.
For instance, if you selected a **Pie** chart type, you can display it as a donut chart by changing the **Layout** setting to **Donut**.

4. Make any desired changes in the Customization Settings panel.

   For example, you can enter a title for the chart, change the tick rotation for a particular axis, select a different color for the background, or change the position of the legend.

5. Click **Update**.

   The chart will be displayed in the center panel based on your specifications.

   **Note:** If you make further changes in the **Settings** section or add/remove columns from any of the **Data** sections, you must click **Update** to see those changes reflected in the chart. Modifications made in the Customization Settings panel take effect immediately.

You should save the chart if you want to be able to access it again; otherwise, the chart will no longer be available once you close the **Create Chart** window.

### Change an existing chart

To make changes to an existing chart, you must edit the Quick Query associated with that chart.

To change an existing chart:

1. In the **Folders and Tables** browser, navigate to the Quick Query that is associated with the chart.
2. Click the Quick Query.

   The Quick Query is highlighted in blue, and the full path for that Quick Query appears underneath the **Folders and Tables** toolbar along with its associated actions.
3. In the list of actions underneath the toolbar, click **edit query**.

   A new tab is opened containing the Quick Query, and the **Save As a Quick Query** dialog is presented.
4. Under the table heading, click the link labeled **Click here** to view data multiple rows at a time.

   The chart and its associated base table will be displayed.
5. Make any changes to the chart or its associated base table.
6. Click **File > Save as Quick Query**...

   The **Save As a Quick Query** dialog is presented.
7. Specify where to save the Quick Query:

   - If you want to replace the Quick Query you are editing, select **Replace old query?**
     
     Be careful when you select this option. Once you click **Submit**, the existing Quick Query is replaced. There is no warning or pop-up message confirming this action.
   - If you want to save this as a new Quick Query, under **Save into folder**, navigate to the folder where you want to save it.

     Make sure **Replace old query?** is not selected, as it will take precedence.

     **Note:** You can only save the Quick Query in a folder that you own (own) or have permission to add to (Add).
8. To save open charts with the Quick Query, make sure **Save open charts** is selected.
9. Click **Submit**.

### Resize a chart

Change the width and height dimensions of a chart.
To resize an existing chart:

While viewing a chart in an existing table or worksheet:

• If the chart is in compact mode: drag any of the window borders to the desired size.
• If the chart is in full mode, perform any of the following actions:
  • On the menu bar of the Chart Builder, click the icon to fit the current chart to the available canvas area.
  • On the bottom right corner of the chart, click the sizing handle and drag the window to the desired size.
  • Under the General section in the Customization Settings panel of the Chart Builder, enter the desired Chart width and Chart height.

Note: Resizing the window not only has a visual effect but also changes the width and height attributes of the chart.

Freeze a chart

Freeze the state of the current chart, which suppresses automatic updating.

Typically, 1010data charts are automatically updated as changes are made to the underlying table or worksheet. Perform a row selection, and the associated chart will change accordingly. Freezing a chart allows you to suppress those updates, essentially providing a visual snapshot of the data in the state when the chart was frozen.

To freeze a chart:

From the menu bar of the Create Chart window in an existing chart, select Freeze.

A chart will remain frozen, regardless of any changes to the table with which it is associated, until you unfreeze it, at which point it will sync back up with the current state of the table.

Clone a chart

Make a duplicate of the current chart in a new window.

To clone a chart:

From the menu bar of the Create Chart window in an existing chart, click Clone.

A new Create Chart window is opened containing a copy of the current chart. Any changes you make to this new chart will not affect the original. You can have multiple charts, allowing you to branch off different paths of analysis.

Create QuickApp graphics widget

Save the chart specifications as a graphics widget for use in a QuickApp.

To create a graphics widget from the current chart:
From the menu bar of the **Create Chart** window in an existing chart, click **Drop QuickApp**.

A new worksheet with a tab labeled **Drop QA** is opened in your 1010data session, and the **Edit Actions (XML)** dialog is populated with the Macro Language that produces the current chart.

You can use the Macro Language XML code that is generated for the graphics widget in your QuickApp development. Copy and paste the graphics widget XML directly into your QuickApp code, or save the worksheet as a Quick Query for future use.

```xml
<note type="base">Applied to table: pub.fin.fred2.bls.smsu</note>
<widget class_="graphics">
  <sel value="(state='PA')"/>
  <sel value="between(month;'1/76';'12/90')"/>
  <graphspec width="1008" height="631" theme="happy">
    <chart type="line" title="Monthly Unemployment - Pennsylvania">
      <data x="month" y="unemp"/>
    </chart>
  </graphspec>
</widget>
```

![Figure 4: Example of a QuickApp created from the Chart Builder](image)

### Export a chart to PDF

You can download the chart you are currently viewing to your computer as a PDF.

To export a chart:

- From the menu bar of the **Create Chart** window in an existing chart, click **Export**.

The chart is downloaded to your computer as a PDF document with the file name `download.pdf`.

### Save a chart

You can select to save the open charts when you save the current table or worksheet as a Quick Query.

To save a chart:

1. Click **File > Save as Quick Query...**

   The **Save As a Quick Query** dialog is presented.

2. Specify where to save the Quick Query:

   - If you are replacing an existing Quick Query, select **Replace old query?**
     
     Be careful when you select this option. Once you click **Submit**, the existing Quick Query is replaced. There is no warning or pop-up message confirming this action.

   - If you are saving a new Quick Query, under **Save into folder**, navigate to the folder where you want to save it.

   Make sure **Replace old query?** is not selected, as it will take precedence.
**Note:** You can only save the Quick Query in a folder that you own (down) or have permission to add to (up).

3. In **Title of Query**, enter a title for the Quick Query.
   
The title is used to help describe the behavior of the Quick Query (e.g., *Transactions by Store*) and may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters.

4. If you have any open charts that you would like to save with the Quick Query, click **Save open charts**.

5. From the **Show the result as** list, select how you would like to display the results of the Quick Query.
   
   You may save the results of the Quick Query in a variety of formats, such as an interactive table, a QuickApp, an Excel spreadsheet, a PDF report, or a comma-separated text file.

6. From the **Base Table** list, select whether to always start with the same table, allow the user to select any table in the same folder as the table on which you are currently working, or allow the user to select any table anywhere.

7. In the **User Prompt** box, enter the text that will appear when the user is asked to select the base table.
   
The prompt will be displayed for Quick Queries when **Base Table** is set to **Allow user to choose table in this folder** or **Allow user to choose any table**.

8. For each parameter you want to prompt for input when the Quick Query is run:
   a) Select the **Input?** check box for the parameter.
   b) Enter the **User Prompt** that will be displayed to prompt for input.
   c) Select the **Input Type** for the parameter from the drop-down list.
   
The **Input Type** depends on the type of parameter (e.g., column, value, relation) and the action associated with the parameter (e.g., select, sort, tabulate). See **Input Types** on page 118 for an explanation as well as a detailed list of actions and their associated parameters.

9. Click **Submit**.

   The Quick Query is saved.

When you run the Quick Query containing the saved charts, they will be opened in compact mode, and you will be able to make further modifications to them using the Chart Builder.
Uploading and downloading

Upload your data to 1010data in a text or XML file, or download the current table or worksheet in a variety of formats.

Uploading data

You may create a new table by uploading your own data to 1010data.

To upload a table in the 1010data user interface, data must be in a supported file format. Certain restrictions apply to the type of files supported. These restrictions are based on the user interface method used to upload the file and whether the file will be transferred to 1010data using an FTP server. For more information, see Supported file formats on page 286.

You must be authorized to add tables to a folder. Folders that you have permission to add tables to are marked with the Uploader (♦) or Owner (♂) icons in the Folders and Tables browser. Once your table is uploaded into 1010data, it will be visible to only those people to whom you give permission. If you need to grant permission to multiple users, consider creating a group. For more information, see Create a new group on page 372.

Supported file formats

Before uploading a table using the 1010data user interface, data from your current system must be exported into a file format that 1010data can read.

The supported file formats vary based on whether you perform a Simple Upload or an Advanced Upload in the 1010data user interface.

Note: Delimited files must contain only printable ASCII characters; UTF-8 strings with multi-byte characters are not allowed.

Compatible file formats include the following:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.csv</td>
<td>A comma-separated values file.</td>
</tr>
<tr>
<td>.txt</td>
<td>A standard comma-, tab-, pipe-, or space-separated text file. For details about what the text file may contain, see Text file format on page 287.</td>
</tr>
<tr>
<td>.xml</td>
<td>An XML file specifying the table and column attributes using defined XML elements. For details about what the XML file may contain, see XML file format on page 288. Note: The XML file format is only supported when performing a Simple Upload.</td>
</tr>
<tr>
<td>.zip, .7z, .rar, .gz</td>
<td>A compressed file containing either a .txt or .csv file. Note: Compressed file formats are only supported when using the FTP option while performing an Advanced Upload.</td>
</tr>
</tbody>
</table>

Note: Microsoft Excel spreadsheet file formats (e.g., .xls and .xlsx) are not supported for upload in the 1010data user interface. To upload an Excel spreadsheet file, save the file as a comma-, tab-, pipe, or space-separated text file or use the 1010data Excel Add-in to upload the file directly from Excel.
Text file format

1010data allows you to upload data in a comma-, tab-, pipe-, or space-separated text file, which may also contain specifications for table and column attributes.

Table and Column Attributes

(Deprecated as of version 9.41)

In addition to the data you are uploading to 1010data, a text file may have up to eight lines beginning with `@` to provide metadata:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@tt</td>
<td>The title of the table</td>
</tr>
<tr>
<td>@id</td>
<td>User IDs that can access the table</td>
</tr>
<tr>
<td>@gp</td>
<td>Groups that can access the table</td>
</tr>
<tr>
<td>@lk</td>
<td>Table name for linking</td>
</tr>
<tr>
<td></td>
<td>If you plan to link this table into other tables, specify a short (one or two word) title here. When the table is linked, this title will appear in its column headings. This will help distinguish which columns come from which tables. To specify a multi-line header, use <code>\</code> to separate the lines. (On most American keyboards the <code>\</code> character is immediately to the left of 1.)</td>
</tr>
<tr>
<td>@cn</td>
<td>Column names (one for each column)</td>
</tr>
<tr>
<td></td>
<td>Column names may only consist of alphanumeric characters or underscores, and must begin with an alphabetic character (e.g., <code>last_visit_date</code>). They may not contain any spaces or other special characters.</td>
</tr>
<tr>
<td></td>
<td>If you don't specify column names, 1010data will assign column names for you (e.g., <code>c0</code>, <code>c1</code>, <code>c2</code>)</td>
</tr>
<tr>
<td>@ch</td>
<td>Column headings (one for each column)</td>
</tr>
<tr>
<td></td>
<td>To specify a multi-line header, use <code>\</code> to separate the lines. (On most American keyboards the <code>\</code> character is immediately to the left of 1.)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Column headers consisting of multiple words must be enclosed in quotation marks.</td>
</tr>
<tr>
<td>@ct</td>
<td>Column data types (one for each column)</td>
</tr>
<tr>
<td></td>
<td>A column's data type specifies the type of data in the column; valid values are:</td>
</tr>
<tr>
<td></td>
<td>• <code>i</code> (integer or whole number)</td>
</tr>
<tr>
<td></td>
<td>• <code>f</code> (floating-point or real or decimal number)</td>
</tr>
<tr>
<td></td>
<td>• <code>a</code> (alphanumeric text)</td>
</tr>
<tr>
<td>@cf</td>
<td>Column display formats (one for each column)</td>
</tr>
<tr>
<td></td>
<td>A column's display format describes how the column's data should be displayed. See Display formats on page 324.</td>
</tr>
</tbody>
</table>

Each of these lines is optional and can appear in any order, but must be located at the top of the file.

Take the following sample text file:

`@tt My Table
@id sandy,peter
@cn col1,col2,col3
@ch "Column 1","Second","Third Column"
@ct i,a,f
@cf "type:num;width:2","type:char;width:3","type:num;width:3;dec:1"`
Notice that some lines begin with an @ symbol. These lines contain information about the table and each of the columns. For example, the line beginning with @tt contains the title of the table. Similarly, the line beginning with @ch specifies the heading for each column. The lines that do not start with @ contain the actual column/row data. So, for example, the value of the first row of the first column is the number 10; the value of the first row of the second column is abc, and so forth.

It is also valid for a file to have no lines that begin with @ (i.e., for the file to contain only column/row data). If any of the @ lines is missing, 1010data will attempt to configure the settings for the table based on the data in the file. However, the file may fail to load. If the file fails to load, use the Advanced Upload feature to upload the table. For instructions, see Upload a table (Advanced Upload) on page 18.

Separators

You can use commas, tabs, spaces, or pipes as delimiters within a text file. If you use spaces, multiple contiguous spaces are considered to be the same as a single space. Use the same separator throughout the file.

Here is a sample file where values are separated by spaces:

<table>
<thead>
<tr>
<th></th>
<th>abc</th>
<th>3.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>def</td>
<td>7.8</td>
</tr>
<tr>
<td>25</td>
<td>gh</td>
<td>5.1</td>
</tr>
</tbody>
</table>

Note: For large files, it is better to use commas, tabs, pipes, or single spaces to separate values. Using multiple spaces, as in the example above, makes the files much larger, and it will take that much longer for you to transmit the data.

XML file format

You can upload data to 1010data using an XML file, specifying the table and column attributes via XML elements.

Even though you can upload an XML file in the user interface by performing a Simple Upload, 1010data recommends using the addtab transaction in the 1010data API instead. For more information, see addtab (Load a large table) in the 1010data API Reference Manual.

Note: The XML file format is not supported when performing an Advanced Upload in the user interface.

An XML file must have an .xml file extension and the following format (spaces and indentations are optional):

```
<table>
  <title>table title</title>
  <sdesc>short description</sdesc>
  <ldesc>long description</ldesc>
  <link>link title</link>
  <maxdown>download limit</maxdown>
  <cols>
    <th name="name of first column"
      type="data type of first column"
      format="data format for first column">
      heading for first column
    </th>
    <th name="name of second column"
      type="data type of second column"
      format="data format for second column">
      heading for second column
    </th>
  </cols>
</table>
```
Table and Column Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;title&gt;</td>
<td>The title of the table</td>
</tr>
<tr>
<td>&lt;link&gt;</td>
<td>Table name for linking, specify a short (one or two word) title here. When</td>
</tr>
<tr>
<td></td>
<td>the table is linked, this title will appear in its column headings. This will</td>
</tr>
<tr>
<td></td>
<td>help distinguish which columns come from which tables. To specify a multi-line</td>
</tr>
<tr>
<td></td>
<td>header, use the backtick (`) special character to separate the lines. (On</td>
</tr>
<tr>
<td></td>
<td>most American keyboards the ` character is immediately to the left of 1.)</td>
</tr>
<tr>
<td>&lt;maxdown&gt;</td>
<td>The maximum number of data items (rows x columns) that can be downloaded at</td>
</tr>
<tr>
<td></td>
<td>a time</td>
</tr>
<tr>
<td>type</td>
<td>Column data types (one for each column)</td>
</tr>
<tr>
<td></td>
<td>An attribute of the &lt;cols&gt; element, type specifies the type of data in the</td>
</tr>
<tr>
<td></td>
<td>column; valid values are:</td>
</tr>
<tr>
<td></td>
<td>• i (integer)</td>
</tr>
<tr>
<td></td>
<td>• f (decimal)</td>
</tr>
<tr>
<td></td>
<td>• a (text)</td>
</tr>
<tr>
<td></td>
<td>For more information about data types, see Data types on page 321</td>
</tr>
</tbody>
</table>
Column display formats (one for each column) *(optional)*

An attribute of the `<cols>` element, `format` describes how the column's data should be displayed. See *Display formats* on page 324.

**Note:** `<title>`, `<sdesc>`, `<ldesc>`, `<link>`, and `<maxdown>` are optional. `<th>` may be used in place of `<td>` and vice versa.

See *Table Tree* for detailed information about the structure of the XML file.

**Example**

Here's an example of an XML file:

```xml
<table>
  <title>Sales Item Detail</title>
  <cols>
    <th name="transid" type="i">Transaction ID</th>
    <th name="account" type="i">Account</th>
    <th name="store" type="i">Store</th>
    <th name="date" type="i" format="type:date">Date</th>
    <th name="sku" type="a">Item SKU</th>
    <th name="units" type="i">Units</th>
    <th name="sales" type="f">Sales</th>
    <th name="cost" type="f">Cost</th>
  </cols>
  <data>
    <tr>
      <td>531</td>
      <td>957</td>
      <td>1</td>
      <td>20120515</td>
      <td>366</td>
      <td>-1</td>
      <td>-5</td>
      <td>-1.84</td>
    </tr>
    <tr>
      <td>535</td>
      <td>709</td>
      <td>2</td>
      <td>20120515</td>
    </tr>
  </data>
</table>
```
<table>
<thead>
<tr>
<th>CB7</th>
<th>1</th>
<th>1.65</th>
<th>1.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>535</td>
<td>709</td>
<td>2</td>
<td>20120515</td>
</tr>
<tr>
<td>96A</td>
<td>1</td>
<td>1.1</td>
<td>1</td>
</tr>
<tr>
<td>538</td>
<td>668</td>
<td>1</td>
<td>20120518</td>
</tr>
<tr>
<td>969</td>
<td>1</td>
<td>1.1</td>
<td>1</td>
</tr>
<tr>
<td>538</td>
<td>668</td>
<td>1</td>
<td>20120518</td>
</tr>
<tr>
<td>3B7</td>
<td>1</td>
<td>1.1</td>
<td>0.56</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Upload a table (Simple Upload)

Upload a table to 1010data.

Before you begin, ensure the data is in a file format that 1010data can read. For more information, see Supported file formats on page 286.

To upload a table:

1. In the Folders and Tables browser, select the folder where you want to upload your table.

   **Note:** You can only upload tables to folders you own (✔️) or have permission to modify (✔️).

2. On the Folders and Tables toolbar, click the Upload icon (🔺).

   1010data displays fields related to the table beneath the toolbar.

3. In the Title text box, enter the title of the table.

   The title is used to help describe the contents of a table (e.g., Sales Detail by Customer). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., Uploaded 2014-01-02 15:14:05).

   **Note:** If you specify a table title within the file you are uploading (e.g., @tt Sales Item Detail in a text file, or <title>Sales Item Detail</title> in an XML file), it will override the value you enter in the Title box.

4. In the Full Path text box, enter the table name.

   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-generated name will be used (e.g., t662528755_yourusername). The path to the parent folder will be automatically prepended to the Full Path.
Note: If you are uploading to the My Data folder, the path uploads will be automatically prepended to the Full Path, and a system-generated table name will be used (e.g., uploads.t662528755_yourusername). You will not be able to enter anything into the Full Path text box.

5. Click Next.
   You will be prompted to choose a file.

6. Click Choose File and select the file containing the table you wish to upload.
   See Text file format on page 287 and XML file format on page 288 for details on what the contents of this file may be.
   
   Note: Even though you can upload an XML file in the user interface, 1010data recommends using the addtab transaction in the 1010data API instead.

7. Click Upload.
   After the table has been successfully uploaded to 1010data, you can share the table with other 1010data users.

Upload a table (Advanced Upload)

Using the Advanced Upload feature, you can upload a table to 1010data with a finer grain of control.

Before you begin, ensure you have completed the necessary Prerequisites on page 297 and that the table is in a supported file format.

The Advanced Upload feature provides many options for fine-grained control over the data you are uploading. In addition, the Advanced Upload feature is recommended when uploading a file in the user interface that is larger than 20 MB in size.

When you perform an Advanced Upload, you have the option of choosing either a local file or a file in your 1010data FTP account. To choose a file from your FTP account, you must first use a third-party FTP client to transfer the file to 1010data. For instructions, see Transfer a file to your FTP account on page 298.

To upload a table using the Advanced Upload:

1. In the Folders and Tables browser, select the folder where you want to upload your table.
   
   Note: You can only upload tables to folders you own (✓) or have permission to modify (☐).

2. On the Folders and Tables toolbar, click the Upload (🧬) icon.
   1010data displays fields related to the table beneath the toolbar.

3. In the Title field, enter the title of the table.
   
   The title is used to help describe the contents of a table (e.g., Sales Detail by Customer). The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you leave this field blank, a system-generated title will be used (e.g., Uploaded 2014-01-02 15:14:05).

4. In the Full Path field, enter the table name.
   
   The table name must begin with a letter and can only contain numbers, letters, and underscores. It cannot contain any spaces or other special characters. If you leave this field blank, a system-
generated name will be used (e.g., t662528755_yourusername). The path to the parent folder will be automatically prepended to the Full Path.

**Note:** If you are uploading to the My Data folder, the path uploads will be automatically prepended to the Full Path, and a system-generated table name will be used (e.g., uploads.t662528755_yourusername). You will not be able to enter anything into the Full Path text box.

5. **Click Advanced.**

The Powerloader tab opens. By default, the FTP option is selected and any files transferred to your 1010data FTP account are listed.

6. **Depending where the file you want to upload is located, do one of the following:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **1010data FTP account** | In the field below the Source options, click the file containing the table you want to upload.  
**Note:** You must have already transferred the file to your 1010data FTP account. For instructions, see Transfer a file to your FTP account on page 298. |
| **Local file**       | Click Local File, then click the Choose Files button and select the file containing the table you want to upload. |
7. Do one of the following:
   - Click **Auto Spec**.
     
     Click this button to have 1010data automatically configure the settings for the table based on the data in the file. If the file is formatted and delineated properly, 1010data will identify the number of columns in your table, create a section for each column to provide the necessary information, and complete as much information as possible from the data in the file. While you may need to make some adjustments afterward, this option can save you a lot of time and effort compared to manually configuring the file yourself.
     
     **Note:** The **Auto Spec** button cannot be used on a compressed file. If a saved specification file does not exist for the compressed file, you can either manually configure the upload file or you can create a new specification file. To create a new specification file for a compressed file, first prepare a small sample of the table that contains all of the columns in the table. Next, upload the sample file into 1010data using the Advanced Upload feature. Once the uncompressed sample is uploaded, click **Auto Spec**. After 1010data identifies each column in the table and completes the appropriate Column Information fields, you can either select the compressed file in the field below the Source options and continue with the compressed file upload or save the specification file for later use.
   
   - Select a previously saved specification file from the **existing spec files** drop-down list and then click **Load Spec**.
     
     Select this option to use a previously saved specification to configure the settings for the table. This option is best used if you regularly use the Advanced Upload feature to add tables to 1010data with the same data format. For example, if you upload weekly sales data, the specification file can automatically complete all of the configuration settings of the table for you.

1010data identifies each column in the table and completes the appropriate Column Information fields.
### File Information
- **Type**: [_filename]
- **Short Description**: [description]
- **Long Description**: [description]
- **Link Header**: [header]
- **User**: [user]
- **Pending**: [pending]
- **Table Information**
  - **Name**: [name]
  - **Description**: [description]
  - **Type**: [type]
  - **Format**: [format]
  - **Options**: [options]
- **Column Information**
  - **Name**: [name]
  - **Header**: [header]
  - **Type**: [type]
  - **Options**: [options]
- **Advanced Options**

---

Start Page  | Advanced Uploader  | 296
8. Complete or edit the **File Information**, **Table Information**, and **Column Information** fields and options.

For details, see *File Information* on page 301, *Table Information* on page 304, and *Column Information* on page 305.

**Note:** Required fields are titled in red.

9. As necessary, you can add, clone, move, or delete a column before uploading the file.

For details, see *Table 6: Column Information icons* on page 308.

**Note:** After configuring the fields and options in your file, you can create a specification file so the settings can be used again. This is helpful if you regularly upload files with the same data format. To save the settings, click **Save Spec**, name the file, and click **OK**. The specification file is added to the **existing spec files** drop-down list.

10. At the top right side of the **Powerloader** tab, click **Start Load**.

1010data uploads the file and creates a new table. Once the process is complete, the **Folders and Tables** browser hides and the table opens in a new tab.

After the file has been successfully uploaded to 1010data, you can share the table with other 1010data users.

**Prerequisites**

After completing the necessary prerequisites, you can use the Advanced Upload feature to upload your own data into 1010data.

You must have the following in place to perform an Advanced Upload:

| **1010data account with API access** | To use the Advanced Upload feature, you need to have API access added to your 1010data account.  
If you are not sure whether you have API access, contact 1010data Support. For instructions, see *Submit a support request* on page 34. |
|--------------------------------------|-------------------------------------------------------------------------------------------------|
Once you have API access as part of your 1010data account, the Advanced Upload feature preference setting needs to be enabled in 1010data. This preference is typically enabled at the time API access is added to your account.

If you do not see the Advanced button in the user interface, either contact 1010data Support or have your company administrator verify that the Enable Powerloader UQ via Advanced Upload button preference setting is enabled. The preference setting is located under the GUI Preferences tab in the User Manager. For more information, see GUI Preferences on page 355.

The following table lists the items you must have in place to use FTP when performing an Advanced Upload.

<table>
<thead>
<tr>
<th>Advanced Upload preference enabled</th>
</tr>
</thead>
</table>

In order to use FTP to transfer files to 1010data, you must first contact 1010data Support to set up your 1010data FTP account. This FTP account provides the access needed to transfer a file through FTP to 1010data before uploading it into the 1010data platform with the Advanced Upload feature. Your 1010data FTP account uses the same username and password as your 1010data account.

**Note:** If you change your 1010data account password, your 1010data FTP account password is automatically updated. However, this change may not take place immediately and can take up to one hour to complete. Continue to use your old 1010data account password for your FTP account until the change has taken place.

<table>
<thead>
<tr>
<th>1010data FTP account</th>
</tr>
</thead>
</table>

In order to use FTP to transfer files to 1010data, you must first contact 1010data Support to set up your 1010data FTP account. This FTP account provides the access needed to transfer a file through FTP to 1010data before uploading it into the 1010data platform with the Advanced Upload feature. Your 1010data FTP account uses the same username and password as your 1010data account.

<table>
<thead>
<tr>
<th>Third-party FTP client</th>
</tr>
</thead>
</table>

If you intend to use FTP to transfer files to 1010data, you need a third-party FTP client installed on your computer.

There are many free FTP clients available. While 1010data does not recommend or support a specific FTP client, many of our Advanced Upload users choose to use a free, open-source FTP client called FileZilla.

### Transfer a file to your FTP account

Using a third-party FTP client, you can transfer a file to your 1010data FTP account.

Before you begin, make sure you have the following items in place:

- 1010data account with API access
- 1010data FTP account
- Third-party FTP client

For more information, see Prerequisites on page 297.

Files transferred to 1010data using FTP are stored in your 1010data FTP account. When you perform an advanced upload, you have the option of choosing either a local file or a file in your 1010data FTP account.

To transfer a file to your 1010data FTP account:

1. Download and install a third-party FTP client.

   There are many free FTP clients available. While 1010data does not recommend or support a specific FTP client, many Advanced Upload users choose to use a free, open-source FTP client called FileZilla. For this reason, the FileZilla interface, shown below, is used for illustrative purposes.
2. Configure your third-party FTP client to connect to the 1010data FTP server.

Regardless of the FTP client you use, all FTP clients require and display the same basic information. The following connection information is required.

<table>
<thead>
<tr>
<th>FTP connection information</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The URL of the 1010data FTP server.</td>
<td>ftp2.1010data.com</td>
</tr>
<tr>
<td>Note: Some 1010data clients may use a different FTP server. Contact 1010data Support if you cannot connect to the default server.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>Your 1010data FTP account username. Your 1010data FTP account uses the same username as your 1010data account.</td>
<td>Your 1010data account username</td>
</tr>
<tr>
<td>Password</td>
<td>Your 1010data FTP account password. Your 1010data FTP account uses the same password as your 1010data account.</td>
<td>Your 1010data account password</td>
</tr>
</tbody>
</table>
### FTP connection information

<table>
<thead>
<tr>
<th>FTP connection information</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> If you change your 1010data password, your FTP account password is automatically updated. However, this change may not take place immediately and can take up to one hour to complete. Continue to use your old 1010data account password for your FTP account until the change has taken place.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>The TCP/IP port your computer uses to communicate with the 1010data FTP server. <strong>Note:</strong> 1010data uses the secure FTP protocol.</td>
<td>22</td>
</tr>
</tbody>
</table>

**Note:** The field labels above may differ slightly from those displayed in other third-party FTP client software.

3. Connect to the 1010data FTP server.

In FileZilla, this is accomplished by clicking **Quickconnect**.

![Quickconnect](image)

**Note:** If you experience problems connecting to the 1010data FTP server, contact your IT department to ensure that FTP file transfers are not blocked by your corporate firewall or proxy server.

4. Locate and transfer the desired file to your 1010data FTP account.

Most FTP clients look and operate similarly. In FileZilla, the left side of the screen displays local folders and files. The right side displays your 1010data FTP account folder on the server. To transfer a file to your 1010data FTP account, simply drag the file from the left pane to the right pane.
The FTP client transfers the file to your 1010data FTP account. Once the file is transferred to your 1010data FTP account, you can use the Advanced Upload feature to upload it into the 1010data platform.

File Information

Descriptions for fields and options in the File Information section of the Powerloader tab.

The tables in this topic explain the fields and options available in the File Information section of the Powerloader tab.

**Note:** Required fields are titled in red.

### Table 2: File Information fields and options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The format of data in the file (table).</td>
</tr>
<tr>
<td>Fixed</td>
<td>Fields (columns) in the file have a fixed length. For example, in each record (row) of the table, the first column is always 10 characters, the second is three characters, and the third is 20 characters.</td>
</tr>
<tr>
<td>Delimited</td>
<td>Fields (columns) in the file may be different lengths; a character is used to separate each field in the record (row) of the table. One of</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>the most common file formats is CSV (comma-separated values). For example, each field in a CSV delimited file is separated by a comma (,) character.</td>
</tr>
<tr>
<td>Ignore Nulls</td>
<td>Determines how 1010data treats a null character in an upload file.</td>
</tr>
<tr>
<td>Y</td>
<td>1010data ignores the null character and continues to upload the data included after the null character. An N/A is inserted in place of the null.</td>
</tr>
<tr>
<td>N</td>
<td>Unless masked, 1010data will interpret a null character as the end of the file. Any data in the file after the null character will not be included in the upload.</td>
</tr>
<tr>
<td>Record Delimiter</td>
<td>The delimiter used to indicate the end of each record (row) in the file (table). A delimiter is a sequence of one or more characters used to specify the boundary between separate, independent regions in plain text files. In general, the two most commonly used record delimiters in 1010data are CRLF and LF.</td>
</tr>
<tr>
<td>CRLF</td>
<td>The Carriage Return Line Feed (CRLF) (\r\n, 0x0D 0x0A) record delimiter is used in Microsoft Windows, DOS (MS-DOS, PC DOS, etc.), DEC TOPS-10, RT-11, CP/M, MP/M, Atari TOS, OS/2, Symbian OS, Palm OS, Amstrad CPC, and most other early non-Unix and non-IBM OSes. Select this option for PC files.</td>
</tr>
<tr>
<td>NL</td>
<td>The New Line (NL) (0x15) record delimiter is used in EBCDIC systems—mainly IBM mainframe systems, including z/OS (OS/390) and i5/OS (OS/400).</td>
</tr>
<tr>
<td>LF</td>
<td>The Line Feed (LF) (\n, 0x0A) record delimiter is used in Multics, Unix and Unix-like systems (Linux, OS X, FreeBSD, AIX, Xenix, etc.), BeOS, Amiga, RISC OS, and others. Select this option for Mac OS files.</td>
</tr>
<tr>
<td>CRNL</td>
<td>The Carriage Return New Line (CRNL) (0x0D 0x15) record delimiter is used for files delimited by the EBCDIC carriage return character followed by the EBCDIC new line character. The CRNL record delimiter is rarely used.</td>
</tr>
<tr>
<td>None</td>
<td>The last column of each row does not have a delimiter. This option is used for fixed-width files.</td>
</tr>
<tr>
<td>Field Delimiter</td>
<td>The character used to separate each field (column) in the record (row) of the file (table). This field displays when <strong>Delimited</strong> is selected from the <strong>Type</strong> drop-down list.</td>
</tr>
</tbody>
</table>
### Field Delimiter

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A comma ( , ) is used to separate the columns in each row of the table.</td>
<td>Tab</td>
</tr>
<tr>
<td>A tab stop is used to separate the columns in each row of the table.</td>
<td>Pipe</td>
</tr>
<tr>
<td>A pipe (</td>
<td>) is used to separate the columns in each row of the table.</td>
</tr>
<tr>
<td>A character other than a comma, tab, or pipe is used to separate the columns in each row of the table. When Other is selected, 1010data displays the Other field next to the Field Delimiter drop-down list. You must enter the character that is used to separate the columns in each row of the table. <strong>Note:</strong> Only ASCII special characters may be used as a field delimiter.</td>
<td></td>
</tr>
</tbody>
</table>

**Other**

The character other than a comma, tab, or pipe that is used to separate each field (column) in the record (row) of the file (table).

This field only displays if Other is selected in the Field Delimiter drop-down list.

**# of Records to Skip**

The number of records (rows) to skip when uploading the file (table).

For example, the first row of a table usually contains names and not data. To exclude the first row of the table in the upload, enter 1. When the file is uploaded, the Insights Platform will ignore the first row in the table and start uploading the data beginning with row 2.

**Load**

The total number of records (rows) in the file (table) to upload.

For example, to include only the first 100 rows of the table in the upload, enter 100. 1010data will upload the first 100 rows in the table and then ignore any rows that follow.

---

### Advanced Options

The advanced options provide additional settings for input file handling and data structuring in 1010data.

To view these additional fields, click the Advanced Options link.

**Table 3: Advanced Options fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Masking character</strong></td>
<td>The character used to encapsulate fields that may contain the delimiting character. By default, 1010data uses the quotation mark ( &quot; ) character. For example, a field of text data may also contain a comma—a common field delimiter. To prevent 1010data from splitting the data field at the comma, that field needs to be surrounded by the indicated masking character.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Note:** If this field is left blank, 1010data uses the quotation mark (" ) for the masking character. To set the masking character to none, enter \0.

**Maximum masking width**
The maximum number of characters within a masked field that 1010data will consider when identifying field delimiter characters to ignore. The default maximum masking width is 1000 characters.

For example, if a masked field is 2000 characters in length, but the maximum masking width is set at 1000, only the field delimiter characters that occur within the first 1000 characters of the field are ignored. Any field delimiter characters after the first 1000 characters will be treated as a standard field delimiter.

**Rows per seg**
The maximum number of records (rows) in the file (table) to include in a single segment. The default is 5 million rows and, in general, should not be adjusted.

However, if the uploaded table will be used for aggressive expanding purposes, the maximum number of rows in each segment may need to be reduced. Contact 1010data Support to discuss your needs and we will help you determine the appropriate setting.

**GPG Password**
The password used to decrypt a file encrypted with GNU Privacy Guard (GPG).

GPG is free encryption software that is compliant with the OpenPGP standard. You can use GPG to encrypt files that contain sensitive data, such as protected health information (PHI) regulated by the Health Insurance Portability and Accountability Act (HIPPA), for example, before sending them to 1010data.

To encrypt a file using GPG for use in 1010data, contact 1010data Support to obtain a public GPG key.

### Table Information

Descriptions for fields and options in the **Table Information** section of the **Powerloader** tab.

The table in this topic explains the fields and options available in the **Table Information** section of the **Powerloader** tab.

**Note:** Required fields are titled in red.
Table 4: Table Information fields and options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your table. This is the unique name of the table used for identification in the 1010data system.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of your table. This is for your own recognition of the table and does not necessarily have to be unique.</td>
</tr>
<tr>
<td>Short Description</td>
<td>A brief description of the data contained in your table.</td>
</tr>
<tr>
<td>Long Description</td>
<td>A detailed explanation of the data contained in your table.</td>
</tr>
<tr>
<td>Link Header</td>
<td>Denotes columns that were not originally part of your table but have made part of the table as the result of linking another table.</td>
</tr>
<tr>
<td>Time Series</td>
<td>Enables the functionality to group together, or segment, like information in the uploaded table. A table must be segmented before <em>g_functions</em> or <em>Time Series functions</em> can be used to analyze the data in the table. When Yes is selected, 1010data displays the Time Series Break Order field in the Column Information section for each column in the table. The Time Series Break Order field is used to segment the table. For more information, see Column Information on page 305.</td>
</tr>
<tr>
<td>Stripe Factor</td>
<td>Configures how segments are stored on 1010data servers that are provisioned to a client. <strong>Fully Mirrored</strong> All segments are stored on all available client-provisioned 1010data servers. This option provides full data redundancy and is the recommended setting. <strong>Striped</strong> Each segment is stored on at least two client-provisioned servers. This option reduces the amount of space used on each server, but provides only partial data redundancy.</td>
</tr>
<tr>
<td>User</td>
<td>Shows the users who have permission to view the table. You can specify additional users you want to have access to the table in this field.</td>
</tr>
</tbody>
</table>

---

**Column Information**

Descriptions for fields, options, and icons in the Column Information section of the Powerloader tab.

For every column in your table, you need to provide the information required by 1010data. If your data file was formatted and delineated properly, the Auto Spec button should have identified the number of columns in your table, created a section for you to provide the necessary information, and populated as much information as possible from the data in the file. The following tables provide descriptions of all fields, options, and icons available in the Column Information sections of the Powerloader tab.

**Note:** Required fields are titled in red.
### Table 5: Column Information fields and options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Name** | Also known as the column name, the **Name** provides a unique identifier for each column of a table in the 1010data interface.  

The **Name** may only contain alphanumeric characters or underscores and must begin with an alphabetic character (e.g., `percent_total_sales`). It may not contain any spaces or other special characters. |
| **Header** | Also known as the column heading, the **Header** is the label of the column that displays by default at the top of a column in the user interface.  

The **Header** may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters (e.g., "Percentage of Total Sales (%)"). |
| **Type** | The kind of data contained in the column. The most common options include the following:  

- **Text**
  
The column contains text, as opposed to numbers. When this option is selected, the **Format Type** drop-down changes to the **Force Case** drop-down.  

- **Integer**
  
The column contains only whole numbers. For example, 1, 53, and 1,234,597 are all integers.  

- **Float**
  
The column contains numbers with place values to the right of a decimal point. For example, 1.1, 23.845 and 0.37383636833930 are all floating point numbers.  

- **Expression**
  
Allows you to derive the value of a column with a 1010data Macro Language expression.  

- **Big Integer**
  
The column contains 64-bit integer data representing very large and very small whole numbers. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>In addition to the types explained above, there are also numerous options for date and time data. These data formats apply 1010data date formatting measures to the date data in the source file. Dates in the source file can be formatted with dashes (&quot;-&quot;), forward-slashes (&quot;/&quot;), and spaces (&quot; &quot;). Data uploaded with just date information are created as <strong>integers</strong> in 1010data, with time-handling formats applied as specified in the <strong>Type</strong> drop-down menu. Data with date and time data are created as <strong>floats</strong> in 1010data, with the applicable time-handling formats applied as specified in the <strong>Type</strong> drop-down menu.</td>
</tr>
<tr>
<td><strong>Force Case</strong></td>
<td>Allows you to convert the text data in the column to all upper or all lower case letters. Select <strong>N</strong> to keep the text data as is.</td>
</tr>
<tr>
<td></td>
<td>This option is displayed only when <strong>Text</strong> or <strong>Expression</strong> is selected from the <strong>Type</strong> drop-down list.</td>
</tr>
<tr>
<td><strong>Format Type</strong></td>
<td>Defines how the data is displayed on the screen. For example, you can choose to exclude commas in numbers or change the way a date is formatted. Choices made in the <strong>Format Type</strong> do not change the type of data in the column, only the way the data is displayed.</td>
</tr>
<tr>
<td></td>
<td>This option is displayed only when <strong>Integer</strong>, <strong>Float</strong>, or <strong>Expression</strong> is selected from the <strong>Type</strong> drop-down list.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>The width of the column in the table. This field is used for fixed-width files.</td>
</tr>
<tr>
<td></td>
<td>This field is displayed only when <strong>Fixed</strong> is selected from the <strong>Type</strong> drop-down list in the <strong>File Information</strong> section.</td>
</tr>
<tr>
<td><strong>Time Series Break Order</strong></td>
<td>Allows you to group together, or segment, like information in the uploaded table. A table must be segmented before <strong>g_functions</strong> or <strong>Time Series functions</strong> can be used to analyze the data in the table.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Time Series Break Order</strong> field accepts whole number sequential values starting with 1.</td>
</tr>
<tr>
<td></td>
<td>For <strong>g_functions</strong>, a minimum of two columns must be identified. The first column, indicated by entering a 1 in the <strong>Time Series Break Order</strong> field, is the data that will be grouped together in the same segment. The second column, indicated by entering a 2 in the <strong>Time Series Break Order</strong> field, is used to order the data.</td>
</tr>
<tr>
<td></td>
<td>For <strong>Time Series functions</strong>, a minimum of three columns must be identified. The first column, indicated by entering a 1 in the <strong>Time Series Break Order</strong> field, is the data that will be grouped together in the same segment. The second, up to the last column, indicated by entering a 2 (and then sequential whole numbers for each additional column) in <strong>Time Series Break Order</strong> field, identifies the grouping arguments. The last column, indicated by entering the next highest sequential number in the <strong>Time Series Break Order</strong> field, is used to order the data.</td>
</tr>
<tr>
<td></td>
<td>For example, if you enter a 1 for the <strong>AccountID</strong> column and a 2 for the <strong>Store</strong> column and a 3 for the <strong>Date</strong> column, 1010data will break the data up into groups ensuring that all records with a unique combination of <strong>AccountID</strong> and <strong>Store</strong> are in the same group and will sort the table by <strong>Date</strong>.</td>
</tr>
</tbody>
</table>
1010data will always sort the table being loaded by the column with the highest value in the **Time Series Break Order** field. If in the previous example a 3 was not entered for the **Date** column, 1010data would group all unique **AccountID** values in the same segment and sort the table by the **Store** column.

This field is displayed only when **YES** is selected from the **Time Series** drop-down list in the **Table Information** section.

### Column Information icons

Above the fields in each **Column Information** section are the following icons:

- ![Column Information icons](image)

The table below contains a description of the function of each of these icons.

**Table 6: Column Information icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Column" /></td>
<td>Add a new column to the table. All the values in the new column will be blank.</td>
</tr>
<tr>
<td><img src="image" alt="Clone Column" /></td>
<td>Clone a column so that an exact copy, with all associated values, is created.</td>
</tr>
<tr>
<td><img src="image" alt="Move Up" /></td>
<td>Move this column up in the order. This will move the column to the left in the final table.</td>
</tr>
<tr>
<td><img src="image" alt="Move Down" /></td>
<td>Move this column down in the order. This will move the column to the right in the final table.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete this column.</td>
</tr>
</tbody>
</table>

### Advanced Options

The advanced options provide additional settings for columns.

To view these additional fields, click the **Advanced Options** link.

**Table 7: Advanced Options fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column Help</strong></td>
<td>Explains the values and their meaning in a given column. When a user clicks the <strong>Show Information</strong> icon at the top of a column, the text entered in this field is displayed in the <strong>Description</strong> field under <strong>Meta Information</strong>.</td>
</tr>
</tbody>
</table>
| **Expression** | Macro Language expression for computed columns. Also helps control formatting for date and time data.  
  **Note:** Expressions are built from a subset of the 1010data Macro Language. All functions from the Macro Language are available for use in expressions except for g_ (group), r_ (row), and ts_ (time-series) functions. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Column</td>
<td>When you choose the Y option in this drop-down menu, the column will remain in its current position when you scroll horizontally through the table columns in the 1010data Trillion-Row Spreadsheet.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Creates the column in 1010data, but hides it. The column will be available in the <strong>Rearrange columns</strong> dialog in 1010data. Hidden columns are also available for use in expressions.</td>
</tr>
<tr>
<td>Destroy Column</td>
<td>Excludes the column from the new table. The column will not be available in the 1010data base table after it is created.</td>
</tr>
<tr>
<td>Dec Places</td>
<td>The number of digits to display after a decimal point. This option is displayed only when <strong>Float</strong> or <strong>Expression</strong> is selected from the <strong>Type</strong> drop-down list.</td>
</tr>
<tr>
<td>Display Width</td>
<td>The number of characters to display in the column.</td>
</tr>
<tr>
<td>Compression Settings</td>
<td>Controls how the column is compressed when a table is created in 1010data during a data upload. In general, the <strong>Default</strong> compression setting should be used. However, if the table is extremely large and the column contains unique text values, the compression settings may need to be changed. Contact 1010data Support to discuss your needs and we will help you determine the appropriate settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Default</strong></td>
</tr>
<tr>
<td></td>
<td>Uses the default compression settings.</td>
</tr>
<tr>
<td></td>
<td><strong>Custom</strong></td>
</tr>
<tr>
<td></td>
<td>Allows for custom compression settings. When selected, the <strong>Type</strong>, <strong>Method</strong>, and <strong>Enumerate</strong> drop-down lists are enabled.</td>
</tr>
<tr>
<td>Type</td>
<td>Determines the <strong>Default</strong> values for <strong>Method</strong> and <strong>Enumerate</strong>. This drop-down list is enabled when <strong>Custom</strong> is selected from the <strong>Compression Settings</strong> drop-down list.</td>
</tr>
<tr>
<td></td>
<td><strong>Default</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Dynamic</strong> is the default setting.</td>
</tr>
<tr>
<td></td>
<td><strong>Static</strong></td>
</tr>
<tr>
<td></td>
<td>Allows you to manually select the options for <strong>Method</strong> and <strong>Enumerate</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Dynamic</strong></td>
</tr>
<tr>
<td></td>
<td>1010data will determine the best <strong>Method</strong> and <strong>Enumerate</strong> settings to use based on the data in the column.</td>
</tr>
<tr>
<td>Method</td>
<td>The type of compression to use. This drop-down list is enabled when <strong>Custom</strong> is selected from the <strong>Compression Settings</strong> drop-down list.</td>
</tr>
<tr>
<td></td>
<td><strong>Default</strong></td>
</tr>
</tbody>
</table>
|                       | The result of this option changes based on whether **Static** or **Dynamic** is selected from the **Type** drop-down list. If **Dynamic** is
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>selected, leave Method set to Default. This allows 1010data to determine the best type of compression to use based on the data in the column. If Static is selected, and Method is set to Default, lzo compression is used.</td>
<td></td>
</tr>
<tr>
<td><strong>bitpack</strong></td>
<td>Very fast compression and decompression speeds. Only for compact integer vectors with few unique row values. Integer vectors cannot have 0I, -0I, or 0N infinity values.</td>
</tr>
<tr>
<td><strong>lzo</strong></td>
<td>Moderate compression ratios. Fast compression and very fast decompression speeds. This is the recommended compression method.</td>
</tr>
<tr>
<td><strong>bzzip2</strong></td>
<td>Greater compression ratio than lzo compression. Slower compression and decompression speeds than lzo compression.</td>
</tr>
<tr>
<td><strong>lzma</strong></td>
<td>Excellent compression ratio. Very slow compression and moderately fast decompression speeds.</td>
</tr>
<tr>
<td><strong>Enumerate</strong></td>
<td>Enumeration is faster for string sets that have several repeated values because instead of storing the same string over and over, the repeated string is stored once and indexed. In general, leave Enumerate set to Default. This drop-down list is enabled when Custom is selected from the Compression Settings drop-down list.</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>The result of this option changes based on the type of data selected in the column data Type drop-down list (not the compression Type drop-down list). If Text is selected and Enumerate is set to Default, enumeration is used. If Integer or Float is selected and Enumerate is set to Default, enumeration is not used.</td>
</tr>
<tr>
<td>yes</td>
<td>Use enumeration. This setting should be selected when there are a lot of repeated strings. <strong>Note:</strong> Static strings are always enumerated.</td>
</tr>
<tr>
<td>no</td>
<td>Enumeration is not used. This setting should be selected when there are no repeated row values in a very large string column.</td>
</tr>
</tbody>
</table>

**Downloading Data**

You may download table data (including the results of an analysis) as a comma- or tab-separated text file, an XML file, Excel workbook, or as a paginated or partitioned report in PDF format. In addition, tables and charts within QuickApps can be downloaded to an Excel workbook or within a PDF.
Text files and XML files may optionally be downloaded in compressed form which may be uncompressed using standard software like WinZip. Downloading compressed files is faster and may allow you to download larger amounts of data.

**Note:** There are restrictions as to the amount of data you may download. This prevents large, bandwidth-clogging downloads and wholesale downloads of proprietary databases.

### Download to Microsoft Excel

You can download the current table or worksheet to an Excel workbook (as either an .xlsx or .xls file), or you can download the tables and charts contained within a QuickApp to an Excel workbook (.xlsx).

To download to Microsoft Excel:

1. In an open table or worksheet, click **Download > To Microsoft Excel**.
2. Select the download format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XLSX</td>
<td>Download the current table or worksheet to an Excel workbook with the extension .xlsx</td>
</tr>
<tr>
<td>XLS (old format)</td>
<td>Download the current table or worksheet to an Excel workbook with the extension .xls</td>
</tr>
<tr>
<td>QuickApp as XLSX</td>
<td>Download all tables and charts contained in the QuickApp to an Excel workbook with the extension .xlsx</td>
</tr>
</tbody>
</table>

**Note:** To change how tables appear when downloaded as Excel workbooks, click **View > Set Preferences** and change the **Excel Downloads** setting under the **Downloads** section.

### Excel Considerations

Certain considerations should be taken into account when downloading 1010data tables or worksheets to Excel in the old XLS format.

**Note:** These considerations apply to tables or worksheets downloaded using **Download > To Microsoft Excel > XLS (old format)** in the 1010data GUI.

### Opening Excel After Downloading

Typically, when you choose to download to Excel, a dialog box should pop up with the option to **Open** or **Save**. If this does not happen, or if Excel opens in the browser window, you may be able to change the behavior by doing the following:

1. Open Windows Explorer.
2. Click the **Tools > Folder Options**.
3. Click **File Types**.
4. In the **Registered file types** list, select the **XLS** extension, and click **Advanced**.
5. In the **Edit File Type** dialog:
   - Select **Confirm open after download**.
   - Clear **Browse in same window**.
   - Click **OK**.

**Note:** These instructions apply to Windows XP and Excel 2003. The procedure may be different or unavailable with other versions.
Recalculating Cell Values

If Excel is set to recalculate cell values manually, values in tables downloaded from 1010data to Excel may not appear correctly. For example, values may appear as 0’s in fields that you know should contain a text value.

You can press F9 in Excel to manually recalculate all active workbooks, Shift+F9 to recalculate the active worksheet, or you can change the calculation mode to automatic.

Displayed Values vs. Actual Values

When downloading a table or worksheet to Excel, the values that are downloaded are the displayed values, not the actual values. For instance, a value of 123.12 in a column with a display format of dec:0 in 1010data would be downloaded to Excel as 123. In this case, the decimal portion would not be taken into account in calculations done in Excel, resulting in possible computational irregularities. Therefore, it is highly recommended that you perform all calculations in 1010data before downloading your table or worksheet to Excel to ensure that calculations are performed using the actual values.

Download as a comma-separated text file

You can download the current table or worksheet as a comma-separated text file.

To download as a comma-separated text file:

1. In an open table or worksheet, click Download > As Comma-Separated Text File.
2. Select the download format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not compressed</td>
<td>Download the current table or worksheet as a comma-separated text file named download.txt</td>
</tr>
<tr>
<td>Compressed</td>
<td>Download the current table or worksheet as a compressed comma-separated text file named download.zip</td>
</tr>
</tbody>
</table>

Note: Downloading compressed files is faster and may allow you to download larger amounts of data.

Download as a tab-separated text file

You can download the current table or worksheet as a tab-separated text file.

To download as a tab-separated text file:

1. In an open table or worksheet, click Download > As Tab-Separated Text File.
2. Select the download format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not compressed</td>
<td>Download the current table or worksheet as a tab-separated text file named download.txt</td>
</tr>
<tr>
<td>Compressed</td>
<td>Download the current table or worksheet as a compressed tab-separated text file named download.zip</td>
</tr>
</tbody>
</table>

Note: Downloading compressed files is faster and may allow you to download larger amounts of data.

Download as an XML file

You can download the current table or worksheet as an XML file.
To download as an XML file:

1. In an open table or worksheet, click Download > As XML.
2. Select the download format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not compressed</td>
<td>Download the current table or worksheet as an XML file named download.xml</td>
</tr>
<tr>
<td>Compressed</td>
<td>Download the current table or worksheet as an XML file named download.zip</td>
</tr>
</tbody>
</table>

**Note:** Downloading compressed files is faster and may allow you to download larger amounts of data.

See Table Tree for information about the structure of the XML file.

**Download as a PDF**

You can download the current table or worksheet as a paginated or partitioned report in PDF format, or you can download the tables and charts contained within a QuickApp to a PDF.

To download as a PDF:

1. In an open table or worksheet, click Download > To PDF.
2. Select the download format:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paginated Report</td>
<td>Download the current table or worksheet as a simple, paginated report in PDF format</td>
</tr>
</tbody>
</table>

The Produce a Paginated Report dialog is presented. See Paginated Report Parameters on page 314 for details.

The inputs start out with reasonable values. You may change any of them according to the nature of the report and your preferences. Once you have produced a report, your inputs are remembered so that the next time you return to the Produce a Paginated Report dialog, it will be filled in with your last inputs.

**Note:** The title, footnotes, and column headers are automatically repeated on every page.

<table>
<thead>
<tr>
<th>Partitioned Report</th>
<th>Download the current table or worksheet in PDF format as a partitioned report with blank lines between groups of rows and subtotals</th>
</tr>
</thead>
</table>

The Produce a Partitioned Report dialog is presented. See Partitioned Report Parameters on page 316 for details.

Most of the inputs start out with reasonable values. You may change any of them according to the nature of the report and your preferences. Your changes are remembered throughout your session. Inputs that start out with a blank value are, for the most part, optional. Only the column used to determine the primary partitions is required.

**Note:** The title, footnotes, and column headers are automatically repeated on every page.

| QuickApp as PDF | Download all tables and charts contained in the QuickApp |

3. If you selected Paginated Report or Partitioned Report, click Submit.

The PDF is downloaded to a file named download.pdf.
Paginated Report Parameters

The parameters in the Produce a Paginated Report dialog allow you to control settings related to the appearance of the report; specify a title, subtitle, and footnotes for the report; and select the columns for which totals are shown.

General

Paper Size
   Specifies the size of the page.
   You should generally set this to the type of paper in your printer.

Orientation
   Specifies whether the report should be printed portrait (tall and narrow) or landscape (short and wide).
   For reports with just a few columns, portrait is probably best in that it allows more rows to fit on a page. For reports with many columns, landscape is best.

Borders?
   When selected, specifies that the report should have lines around the table and between columns.

Shading
   Specifies how alternate lines should be shaded. Line shading makes wide reports easier to read.

Page Numbers?
   When selected, specifies that a page number should be included on the bottom of each page.

Titles & Notes

Report Title
   The title that appears at the top of each page of the report.

Subtitle
   The subtitle appears beneath the title.

Footnote(s)
   Footnotes appear on the bottom of each page (just above the page number, if Page Numbers? is selected).
   To enter more than one row of footnotes, type the first row, press Enter, type the second row, and so on. The input box will automatically scroll both horizontally and vertically.

You may include special codes in a title, subtitle, or footnote that serve as placeholders for certain values. When the report is produced, the placeholders are replaced with the corresponding values. For example, $PAGE is replaced with the page number and $PAGES is replaced with the total number of pages in the report. A reasonable subtitle could therefore be $PAGE of $PAGES. To include the current date and time on a report, use something like $MONTH/$DAY/$YEAR $HOUR:$MINUTE:$SECOND.

Here is a list of available placeholders:

$PAGE        The page number of this page
$PAGES       The total number of pages in the report
$YEAR        The current year (e.g., 04 for 2004)
$MONTH       The current month (e.g., 05 for May)
$DAY         The current day of month (e.g., 06 for the sixth)
The current hour (e.g., 15 for 3 p.m.)
The current minute (e.g., 05)
The current second (e.g., 05)

When producing a report from the results of a Quick Query, the following placeholders are also available:
The user prompt for the first Quick Query input item
The user prompt for the second Quick Query input item
The user prompt for the nth Quick Query input item
The user’s input for the first Quick Query input item
The user’s input for the second Quick Query input item
The user’s input for the nth Quick Query input item

Fonts

Report Title
The font type and size for the title of the report.
Subtitle
The font type and size for the subtitle of the report.
Footnotes
The font type and size for the footnotes of the report.

Column Headings
The font type and size for the column headings of the report.

Column Data
The font type and size for the column data of the report.

Totals
You can show totals for one or more columns by selecting the columns here. Totals are shown at the end of the report and are sums.

Note: If a column has averages and you wish to show the average of the averages, you cannot do this in a report. Instead, use a tabulation to compute the average of the averages.

Advanced

Page Margins
The width of the page margins (top and bottom, left and right).

Column Separation
The width of the separation between columns.
Even with a separation of 0 inches, the data from two adjacent columns is separated by a small amount. For clarity, however, it is often better to use a wider separation.
Partitioned Report Parameters

In addition to controlling settings related to the appearance of the report, the parameters in the **Produce a Partitioned Report** dialog allow you to specify partitions and page breaks as well as to select which columns to total or subtotal.

**General**

**Paper Size**
- Specifies the size of the page.
- You should generally set this to the type of paper in your printer.

**Orientation**
- Specifies whether the report should be printed portrait (tall and narrow) or landscape (short and wide).
- For reports with just a few columns, portrait is probably best in that it allows more rows to fit on a page. For reports with many columns, landscape is best.

**Borders?**
- When selected, specifies that the report should have lines around the table and between columns.

**Shading**
- Specifies how alternate lines should be shaded. Line shading makes wide reports easier to read.

**Page Numbers?**
- When selected, specifies that a page number should be included on the bottom of each page.

**Titles & Notes**

**Report Title**
- The title that appears at the top of each page of the report.

**Subtitle**
- The subtitle appears beneath the title.

**Footnote(s)**
- Footnotes appear on the bottom of each page (just above the page number, if **Page Numbers?** is selected).
- To enter more than one row of footnotes, type the first row, press **Enter**, type the second row, and so on. The input box will automatically scroll both horizontally and vertically.

You may include special codes in a title, subtitle, or footnote that serve as placeholders for certain values. When the report is produced, the placeholders are replaced with the corresponding values. For example, $PAGE is replaced with the page number and $PAGES is replaced with the total number of pages in the report. A reasonable subtitle could therefore be $PAGE of $PAGES. To include the current date and time on a report, use something like $MONTH/$DAY/$YEAR $HOUR:$MINUTE:$SECOND.

Here is a list of available placeholders:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$PAGE</td>
<td>The page number of this page</td>
</tr>
<tr>
<td>$PAGES</td>
<td>The total number of pages in the report</td>
</tr>
<tr>
<td>$YEAR</td>
<td>The current year (e.g., 04 for 2004)</td>
</tr>
<tr>
<td>$MONTH</td>
<td>The current month (e.g., 05 for May)</td>
</tr>
<tr>
<td>$DAY</td>
<td>The current day of month (e.g., 06 for the sixth)</td>
</tr>
</tbody>
</table>
$\text{HOUR}$  The current hour (e.g., 15 for 3 p.m.)
$\text{MINUTE}$  The current minute (e.g., 05)
$\text{SECOND}$  The current second (e.g., 05)

When producing a report from the results of a Quick Query, the following placeholders are also available:

$\text{QQPROMPT1}$  The user prompt for the first Quick Query input item
$\text{QQPROMPT2}$  The user prompt for the second Quick Query input item
$\text{QQPROMPTn}$  The user prompt for the $n$th Quick Query input item
$\text{QQINPUT1}$  The user's input for the first Quick Query input item
$\text{QQINPUT2}$  The user's input for the second Quick Query input item
$\text{QQINPUTn}$  The user's input for the $n$th Quick Query input item

**Fonts**

**Report Title**

The font type and size for the title of the report.

**Subtitle**

The font type and size for the subtitle of the report.

**Footnotes**

The font type and size for the footnotes of the report.

**Column Headings**

The font type and size for the column headings of the report.

**Column Data**

The font type and size for the column data of the report.

**Partitions**

These inputs allow you to specify how to divide the report into partitions. Partitions are separated by blank lines and may optionally have subtotals. The report is split up based on the values in one or more columns with one partition for each value of those column(s).

For example, the following report has no partitions:

<table>
<thead>
<tr>
<th>Year</th>
<th>Company</th>
<th>Division</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>12,348</td>
</tr>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Office Services</td>
<td>6,786</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>45,220</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>87,329</td>
</tr>
<tr>
<td>2000</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>13,212</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>50,021</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>49,877</td>
</tr>
</tbody>
</table>
Adding partitions based on **Year** would produce the following report:

<table>
<thead>
<tr>
<th>Year</th>
<th>Company</th>
<th>Division</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>12,348</td>
</tr>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Office Services</td>
<td>6,786</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>45,220</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>87,329</td>
</tr>
<tr>
<td>2000</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>13,212</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>50,021</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>49,877</td>
</tr>
</tbody>
</table>

Note the blank line separating different values of **Year**.

Partitions based on both **Year** and **Company** would produce:

<table>
<thead>
<tr>
<th>Year</th>
<th>Company</th>
<th>Division</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>12,348</td>
</tr>
<tr>
<td>1999</td>
<td>ABC Inc.</td>
<td>Office Services</td>
<td>6,786</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>45,220</td>
</tr>
<tr>
<td>1999</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>87,329</td>
</tr>
<tr>
<td>2000</td>
<td>ABC Inc.</td>
<td>Consumer Products</td>
<td>13,212</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Insurance</td>
<td>50,021</td>
</tr>
<tr>
<td>2000</td>
<td>XYZ Inc.</td>
<td>Banking</td>
<td>49,877</td>
</tr>
</tbody>
</table>

In this case, a blank line separates different values of both **Year** and **Company**, with a somewhat wider separation between years. The partitions based on **Year** are the *primary partitions*; those based on **Company** are the *secondary partitions*.

Alternatively, if we made **Company** primary and **Year** secondary, we would get:

<table>
<thead>
<tr>
<th>Company</th>
<th>Year</th>
<th>Division</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC Inc.</td>
<td>1999</td>
<td>Consumer Products</td>
<td>12,348</td>
</tr>
<tr>
<td>ABC Inc.</td>
<td>1999</td>
<td>Office Services</td>
<td>6,786</td>
</tr>
<tr>
<td>ABC Inc.</td>
<td>2000</td>
<td>Consumer Products</td>
<td>13,212</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>1999</td>
<td>Insurance</td>
<td>45,220</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>1999</td>
<td>Banking</td>
<td>87,329</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>2000</td>
<td>Insurance</td>
<td>50,021</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>2000</td>
<td>Banking</td>
<td>49,877</td>
</tr>
</tbody>
</table>
The columns used to define the primary or secondary partitions may be displayed in ascending or descending order. (In the examples above, ascending order is used.) This sort is applied on top of whatever sorts are already in effect.

**Page Breaks**

You may control page breaks by choosing one of the following options:

- **anywhere**
  
  Each page will be filled completely and page breaks may occur in the middle of partitions.

- **only between partitions**
  
  Pages will generally break between the finest-level partitions.

  The report may have more than one partition on a page but will not start a partition unless it can fit the entire partition on the page. Of course, if a partition is too large to fit on one page, there will be a page break in the middle of the partition.

- **only between primary or secondary partitions**
  
  Pages will generally break between those partitions (and not between tertiary partitions).

  The report may have more than one primary or secondary partition on a page but will not start a secondary partition unless it can fit the entire partition on the page. Of course, if a secondary partition is too large to fit on one page, there will be a page break in the middle of the partition. In this case, tertiary partitions are not treated specially so, if a secondary partition is larger than one page, the page break within the partition can occur at any point, even in the middle of a tertiary partition.

- **only between primary partitions**
  
  Pages will generally break between primary partitions (and not between secondary or tertiary partitions).

  The report may have more than one primary partition on a page but will not start a primary partition unless it can fit the entire partition on the page. Of course, if a primary partition is too large to fit on one page, there will be a page break in the middle of the partition. In this case, secondary and tertiary partitions are not treated specially so, if a primary partition is larger than one page, the page break within the partition can occur at any point, even in the middle of a secondary or tertiary partition.

**Totals and Subtotals**

You can show totals and subtotals for one or more columns by selecting the columns here. Totals are shown at the end of the report and subtotals are shown after each partition; both are sums.

Using the last example shown above, adding totals and subtotals for **Sales** would produce:

<table>
<thead>
<tr>
<th>Company</th>
<th>Year</th>
<th>Division</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC Inc.</td>
<td>1999</td>
<td>Consumer Products</td>
<td>12,348</td>
</tr>
<tr>
<td>ABC Inc.</td>
<td>1999</td>
<td>Office Services</td>
<td>6,786</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>19,134</td>
</tr>
<tr>
<td>ABC Inc.</td>
<td>2000</td>
<td>Consumer Products</td>
<td>13,212</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>13,212</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>1999</td>
<td>Insurance</td>
<td>45,220</td>
</tr>
<tr>
<td>XYZ Inc.</td>
<td>1999</td>
<td>Banking</td>
<td>87,329</td>
</tr>
</tbody>
</table>
Note: If a column has averages and you wish to show the average of the averages for all rows or for each partition, you cannot do this in a partitioned report. Instead, use a tabulation to compute the average of the averages.

Advanced

Page Margins
The width of the page margins (top and bottom, left and right).

Column Separation
The width of the separation between columns.

Even with a separation of 0 inches, the data from two adjacent columns is separated by a small amount. For clarity, however, it is often better to use a wider separation.

Download via FTP

With FTP access, you may save large data files for download via FTP.

Note: If you need to download large amounts of data, contact support@1010data.com and ask for an FTP account.

To download the current table or worksheet via FTP:
1. In an open table or worksheet, click Download... > Via FTP.
2. Specify a file name and various file attributes (e.g., delimiter, whether to include column headers, etc.)
3. Click Submit.

The system will create the file in your FTP folder.

For large downloads, it may take the system some time to create the file. Normally, once the file is created, the system will notify you to that effect. If, however, your browser loses the connection before such notification (e.g., in the event of a proxy-server or firewall timeout), be aware that the system will continue to create the file. If you wait a sufficient amount of time and then log onto your FTP account, you should see the file there.

Note: Logging into the user interface to start a new session will end your previous session and stop the file creation.

4. Log onto your FTP account and download the file.
Data types and display formats

Data types govern how data is stored internally, and display formats control how that data is displayed.

Each column in the 1010data Insights Platform contains data of a particular category, such as numbers, dates, times of day, or alphanumeric text. The type of values determines the data type of the column.

In the Insights Platform, these values (numbers, dates, times, alphanumeric values) are stored in one of the simple data types: integer, decimal, and text. The way in which these values are displayed is defined by the display format specified for the column in which those values reside. The way the values are displayed is not necessarily similar to or the same as how the values are stored.

For example, the value 1,234.56 contains a comma, but the internal value is just a decimal number (1234.56). Commas may aid how the values are read by users, but they are not included in the data that is stored. Furthermore, although two decimal places are displayed, the stored value may be more precise. Though the number appears to be 1234.56, it may actually be 1234.55574. Displaying the number rounded to two decimal places is part of the column's display format.

It may or may not be easy to tell what the data type of a column is by looking at it. For instance, 123 might be an integer, text, or a decimal number with a display format that shows no decimal places, i.e., dec:0.

Another example that shows the difference between how a value is represented in the 1010data Insights Platform and how it appears in the table view is dates and time. A date is simply stored as an integer in the date form (YYYYMMDD). The display format identifies the value as a date and displays it as such. For instance, a number such as 20031115 may be displayed as:
- 11/15/03 using the date display format.
- 11/15/2003 using the date4y display format.

Time is also stored as an integer in the time form (HHMMSS). A number like 224556 can be displayed as:
- 10:45:56p using the hms12 display format.
- 22:46 using the hm24 display format.

Because dates and times are stored as integers, the platform technically allows these columns to be summed or added to other numeric columns; however, the results are generally meaningless. To do arithmetic with such columns, use the functions provided for this purpose, e.g., to add a number of days to a date, use shift(X;Y). For more information, see shift(X;Y).

Data types

There are four simple data types that represent how information is internally stored in the 1010data Insights Platform.

The simple data types in the platform are:
- integer
- decimal
- text

The integer data type is often used to hold information like transaction IDs and store numbers. Integers are also used to represent date or time values, using the date, month, quarter, and time forms. For instance, the date 12/10/2013 is stored as the integer 20131210. The time 10:25:30 is stored as the integer 102530. For more information, see Integer on page 322.

The big integer data type supports whole number values that exceed the range that is supported by the integer data type. Most commonly, big integer columns are used in links, selections, and tabulations, since data such as keys and IDs are often stored in columns of this type. For more information, see Big integer.
The decimal data type may contain values such as sales prices, unemployment rates, interest rates, and floating-point values. In the 1010data Insights Platform, a decimal data type can also hold a value that contains a combination of date and time information. For more information, see Decimal on page 322.

The text data type is used for alphanumeric values that may include symbols, and spaces, such as customer IDs, product names, sizes, ZIP codes, or geographic locations. For more information, see Text on page 323.

In the Insights Platform, the data types are represented in various ways.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Type name</th>
<th>Sigil</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>integer</td>
<td>integer</td>
<td>i</td>
<td>Whole numbers between -2,147,483,646 and 2,147,483,646</td>
</tr>
<tr>
<td></td>
<td>int</td>
<td></td>
<td></td>
</tr>
<tr>
<td>decimal</td>
<td>decimal</td>
<td>f</td>
<td>64-bit floating-point values</td>
</tr>
<tr>
<td></td>
<td>dec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>text</td>
<td>text</td>
<td>a</td>
<td>String values that contain uppercase and lowercase letters, numbers, spaces, and symbols</td>
</tr>
<tr>
<td></td>
<td>alpha</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The data type of a column is referred to by its type name or its sigil in different contexts. Different interfaces may tend to use one or the other or both.

Data types are different from display formats, which control how values are displayed within columns.

**Integer**

The integer data type (int) is used to represent whole numbers that can be stored within 32-bits.

Columns of type integer can store information such as:

- Transaction IDs (3026049)
- Identification numbers (24)
- Dates (20161201)
- Time (121837)

Dates and time are represented by the integer data type. For more information, see Dates and time on page 323.

Valid integer values are -2,147,483,646 to 2,147,483,646.

**Note:** If the values, or the results of mathematical functions applied to these values, will be outside of this range, use the decimal data type instead.

In some places in the 1010data Insights platform, the integer data type (i) is also represented as i.

**Decimal**

The decimal data type (dec) is used to represent 64-bit floating point values.

Columns of type decimal can store information such as:

- Sales prices (6.95)
- Unemployment rates (7.1)
- Interest rates (5.35)

Columns of type decimal are often used to represent values that contain a fractional part, e.g., 1.25, or numbers that fall outside the valid range for columns of type integer.
Use decimal data types when the values need to be represented contain a fractional part, or if they fall outside the valid range for integers, which is -2,147,483,646 to 2,147,483,646. For example, although UPC codes do not have a fractional part, they should be stored as a decimal data type instead of an integer because they are typically 12-digit numbers. Decimal values may be positive or negative.

Numbers cast to decimal data type are computed & stored as IEEE 754 double floating point values. In most cases, the system holds a minimum 15 places of decimal precision. The maximum is roughly 1.7976931348623158e308.

The decimal data type also holds the floating point value that represents the date and time together as a \textit{date+time} value. For more information, see \textit{Date+Time} on page 324.

In some places in the 1010data Insights platform, the decimal data type (\texttt{dec}) is also represented as \texttt{f}.

**Text**

The text data type (\texttt{text}) is used to represent values that contain uppercase and lowercase letters, numbers, spaces, and symbols.

Columns of type text can store information such as:

- Customer IDs (9a90e2f6)
- Product names (GARLIC GUACAMOLE ZESTY)
- Sizes (500 ML)
- Geographic locations (Boulder, CO)

Columns of type text may have values that appear to be integers, decimals, or big integers. It may be difficult to distinguish these values from other numeric values in columns of type decimal or type integer. Text type values cannot be summed (via a quick summary) or added to another column (using a computed column). There are some numeric values that should be stored in columns of type text. For example:

- Social security numbers
- Zip codes (00616)
- SKUs (94873)

These numeric values are not added together, are not added to other values, and may begin with a 0, which would be removed in an integer, decimal, or big integer column, even though it is a valid and necessary part of that value.

Columns of type integer, decimal, or big integer should be used when mathematical functions need to be performed on the numeric values.

In some places in the 1010data Insights platform, the text data type (\texttt{text}) is also represented as \texttt{a} or \texttt{alpha}.

**Dates and time**

While dates and times are typically stored in columns that have an integer or decimal data type, they must be specified in a valid form to produce the expected results.

Most date and time values are represented in columns that have an integer data type. The \textit{date+time} form, which contains both date and time information in one value, is unique, and it is represented a column that has a decimal data type. Functions that operate on dates and times sample the input values in the column to make sure they are in the correct data type (integer or decimal). As long as the data type is correct, the function is performed on the input. Note that the values in the column are not checked to make sure that they are valid. If the values are not valid, the function returns an erroneous or illogical output value.

**Dates**

Values that contain date-related information can be specified in the following forms:
## Data types and display formats

### Date

<table>
<thead>
<tr>
<th>Form</th>
<th>Syntax</th>
<th>Example</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>date</td>
<td>YYYYMMDD</td>
<td>11/5/2008</td>
<td>20081105</td>
</tr>
<tr>
<td>month</td>
<td>YYYYMM</td>
<td>11/2008</td>
<td>200811</td>
</tr>
<tr>
<td>quarter</td>
<td>YYYYQ</td>
<td>4Q2008</td>
<td>20084</td>
</tr>
<tr>
<td>year</td>
<td>YYYY</td>
<td>2008</td>
<td>2008</td>
</tr>
</tbody>
</table>

For dates to be considered valid and produce a correct result, they must appear in the format above, and the values for `MM`, `DD`, and `Q` must stay within the expected range. `MM` values range from 01-12, `DD` values from 01-31, and `Q` 1-4. If a function is expecting a date value as input and the value passed to the function is outside the valid range or supported format, the function returns an erroneous or illogical output.

### Time

Values that contain time-related information can be specified in following format:

<table>
<thead>
<tr>
<th>Form</th>
<th>Syntax</th>
<th>Example</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>time</td>
<td>HHMMSS</td>
<td>12:46:18</td>
<td>124618</td>
</tr>
</tbody>
</table>

For times to be considered valid and produce a correct result, they must appear in the syntax above, and the values for each portion of `HH`, `MM`, and `SS` must stay within the expected range. `HH` values range from 00-12, and `MM` and `SS` values range from 00-59. If a function is expecting a time value as input and that value is outside the valid range or supported syntax, the function returns an erroneous or illogical output.

### Date+Time

Values that contain a combination of date and time information can be specified in the following form:

<table>
<thead>
<tr>
<th>Form</th>
<th>Syntax</th>
<th>Example</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>date+time</td>
<td>XXXX.YYYYYYYYYYYY</td>
<td>12/10/13_10:25:30</td>
<td>-7691.56562470746</td>
</tr>
</tbody>
</table>

The `date+time` input uses a convention similar to the Julian date, but uses 1/1/2035 as the epoch (or reference) point. Specifically, the value `XXXX.YYYYYYYYYYYY` is the number of days before the epoch will occur. The value is typically negative because the count uses the epoch as the starting point and counts backwards to the given `date+time`:
- `XXXX` is the number of full days from the given date to the epoch
- `YYYYYYYYYYYY` is the fraction of the current day remaining until midnight

So, for the above example, on 12/10/2013 at 10:25:30 there is still `.56562470746` of the day remaining until midnight and 7691 full days until midnight on 1/1/2035.

Values in the date+time form are stored in columns that have a decimal data type.

### Display formats

Display formats control how values are displayed within columns in the 1010data Insights Platform.

#### Syntax

The syntax for using display formats is:

```
[type:value;] [width:value;] [dec:value]
```

where the `value` for each parameter is as follows:
<table>
<thead>
<tr>
<th>parameter</th>
<th>value</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>Any Display Format listed in the tables below (e.g., nocommas, monthshort4y)</td>
</tr>
<tr>
<td>width</td>
<td>The number of characters to display in the column. Valid values are 1 through 100. If the contents of a cell exceeds the specified width, the value is truncated. In this case, the number of visible characters is reduced by two, and &quot; &gt;&quot; is appended to the value. For example, for width:4, the string Example would be displayed as Ex &gt;. Clicking on the &gt; displays the full contents of the cell in a separate window.</td>
</tr>
<tr>
<td>dec</td>
<td>The number of decimal places to show (valid values are 0 through 9)</td>
</tr>
</tbody>
</table>

**Note:** For integer values, a decimal point and that many 0's will be appended to the integer. The dec parameter does not affect text values.

A single type, width, or dec format may each be applied to a particular column.

**Note:** Multiple parameters of the same format will be removed; only the first instance will be retained. For example, if the specified display format is format="type:num;type:char;width:3", it will be changed to format="type:num;width:3" when the query is submitted.

**Examples**

The secs(X) function returns the number of seconds since midnight for the time given as input. With no display format applied, a computed column using this function would use the default display format, num, and show values like 54,163 and 49,525.

To display the values in the computed column without the commas, use the nocommas display format:

```
<wilbe name="secsexample" value="secs(thistime)" label="Secs since `midnight"
format="type:nocommas"/>
```

Those same values would now be displayed as 54163 and 49525.

Display formats can also show only a certain number of decimal places for a column. For example, to show two decimal places for the numbers in a particular column, specify the following display format for that column:

```
<wilbe name="margin" value="sales-cost" label="Margin"
format="type:num;dec:2"/>
```

**Number Display Formats**

The following display formats can be applied to values with the integer or decimal data type:

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>num</td>
<td>1234567.89</td>
<td>1,234,567.89</td>
</tr>
<tr>
<td>nocommas</td>
<td>11,121,314.15</td>
<td>11121314.15</td>
</tr>
<tr>
<td>pct</td>
<td>0.9583</td>
<td>95.83%</td>
</tr>
</tbody>
</table>

**Currency Display Formats**

Currency formatting uses an additional property: unit:[VALUE], where the [VALUE] is a valid ISO 4217 currency letter code, as shown below:

```
format="type:currency;width:10;unit:EUR"
```

For the full list of currency codes, see Currency codes (ISO 4217) on page 327.
The default value if no code is provided is USD. The number of decimal places shown by default is determined by the standard for the particular currency code used. If a value is provided to the `dec` property, that value will override the default for that currency.

Currency display formats can be applied to columns of integer or decimal type:

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Example Value</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>currency</td>
<td>EUR</td>
<td>123456.789</td>
<td>€123,456.79</td>
</tr>
</tbody>
</table>

**Date Display Formats**

The following display formats can be applied to integers in the `date` form (YYYYMMDD):

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>date</td>
<td>19981015</td>
<td>10/15/98</td>
</tr>
<tr>
<td>date4y</td>
<td>19981015</td>
<td>10/15/1998</td>
</tr>
<tr>
<td>ansidate</td>
<td>19981015</td>
<td>1998-10-15</td>
</tr>
</tbody>
</table>

**Note:** If the date display formats are applied to numbers that are not in the `date` form, the behavior is unexpected.

**Month Display Formats**

The following display formats can be applied to integers in the `month` form (YYYYMM):

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>month</td>
<td>200310</td>
<td>10/03</td>
</tr>
<tr>
<td>month4y</td>
<td>200310</td>
<td>10/2003</td>
</tr>
<tr>
<td>monthshort</td>
<td>200310</td>
<td>Oct03</td>
</tr>
<tr>
<td>monthshort4y</td>
<td>200310</td>
<td>Oct2003</td>
</tr>
<tr>
<td>monthshortdash</td>
<td>200310</td>
<td>Oct-03</td>
</tr>
<tr>
<td>monthshortdash4y</td>
<td>200310</td>
<td>Oct-2003</td>
</tr>
<tr>
<td>monthlong</td>
<td>200310</td>
<td>October03</td>
</tr>
<tr>
<td>monthlong4y</td>
<td>200310</td>
<td>October2003</td>
</tr>
<tr>
<td>monthlongdash</td>
<td>200310</td>
<td>October-03</td>
</tr>
<tr>
<td>monthlongdash4y</td>
<td>200310</td>
<td>October-2003</td>
</tr>
</tbody>
</table>

**Note:** If the month display formats are applied to numbers that are not in the `month` form, the behavior is unexpected.

**Quarter Display Formats**

The following display formats can be applied to integers in the `quarter` form (YYYYQQ):

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>quarter</td>
<td>20032</td>
<td>2Q03</td>
</tr>
<tr>
<td>quarter4y</td>
<td>20032</td>
<td>2Q2003</td>
</tr>
</tbody>
</table>

**Note:** If the quarter display formats are applied to numbers that are not in the `quarter` form, the behavior is unexpected.
Time Display Formats

The following display formats can be applied to integers in the *time* form (HHMMSS):

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>hms24</td>
<td>224556</td>
<td>22:45:56</td>
<td></td>
</tr>
<tr>
<td>hms12</td>
<td>224556</td>
<td>10:45:56p</td>
<td></td>
</tr>
<tr>
<td>hm24</td>
<td>224556</td>
<td>22:46</td>
<td>The time is rounded to the nearest minute.</td>
</tr>
<tr>
<td>hm12</td>
<td>224556</td>
<td>10:46p</td>
<td>The time is rounded to the nearest minute.</td>
</tr>
</tbody>
</table>

**Note:** If the time display formats are applied to numbers that are not in the *time* form, the behavior is unexpected.

Date+Time Display Formats

The following display formats can be applied to values with the decimal data type in the *date+time* form (XXXX.YYYYYYYYYYYY):

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>datehms24</td>
<td>-7691.56562470746</td>
<td>12/10/13_10:25:30</td>
<td></td>
</tr>
<tr>
<td>anssidatet ime</td>
<td>-7691.56562470746</td>
<td>2013-12-10 10:25:30</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** If the *date+time* display format is applied to numbers that are not in the *date+time* form, the behavior is unexpected.

Text Display Formats

The following display format can be applied to text:

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Example Value</th>
<th>Displayed Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>char</td>
<td>10/15/98</td>
<td>10/15/98</td>
<td></td>
</tr>
<tr>
<td>url</td>
<td><a href="http://www.1010data.com">www.1010data.com</a></td>
<td><a href="http://www.1010data.com">www.1010data.com</a></td>
<td>Creates an http: link of the text. If the text is not a valid URL, the behavior is unexpected.</td>
</tr>
<tr>
<td>email</td>
<td><a href="mailto:info@1010data.com">info@1010data.com</a></td>
<td><a href="mailto:info@1010data.com">info@1010data.com</a></td>
<td>Creates a mailto: link of the text. If the text is not a valid email address, the behavior is unexpected.</td>
</tr>
</tbody>
</table>

Currency codes (ISO 4217)

The following table provides a list of valid 4217 letter codes.

**Table 8: ISO 4217 Codes**

<table>
<thead>
<tr>
<th>Entity</th>
<th>Currency</th>
<th>Code</th>
<th>Minor Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFGHANISTAN</td>
<td>Afghani</td>
<td>AFN</td>
<td>2</td>
</tr>
<tr>
<td>ÅLAND ISLANDS</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>ALBANIA</td>
<td>Lek</td>
<td>ALL</td>
<td>2</td>
</tr>
<tr>
<td>ALGERIA</td>
<td>Algerian Dinar</td>
<td>DZD</td>
<td>2</td>
</tr>
<tr>
<td>AMERICAN SAMOA</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>ANDORRA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>ANGOLA</td>
<td>Kwanza</td>
<td>AOA</td>
<td>2</td>
</tr>
<tr>
<td>ANGUILLA</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>ANTARCTICA</td>
<td>No universal currency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANTIGUA AND BARBUDA</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>ARGENTINA</td>
<td>Argentine Peso</td>
<td>ARS</td>
<td>2</td>
</tr>
<tr>
<td>ARMENIA</td>
<td>Armenian Dram</td>
<td>AMD</td>
<td>2</td>
</tr>
<tr>
<td>ARUBA</td>
<td>Aruban Florin</td>
<td>AWG</td>
<td>2</td>
</tr>
<tr>
<td>AUSTRALIA</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>AUSTRIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>AZERBAIJAN</td>
<td>Azerbaijani Manat</td>
<td>AZN</td>
<td>2</td>
</tr>
<tr>
<td>BAHAMAS</td>
<td>Bahamian Dollar</td>
<td>BSD</td>
<td>2</td>
</tr>
<tr>
<td>BAHRAIN</td>
<td>Bahraini Dinar</td>
<td>BHD</td>
<td>3</td>
</tr>
<tr>
<td>BANGLADESH</td>
<td>Taka</td>
<td>BDT</td>
<td>2</td>
</tr>
<tr>
<td>BARBADOS</td>
<td>Barbados Dollar</td>
<td>BBD</td>
<td>2</td>
</tr>
<tr>
<td>BELARUS</td>
<td>Belarussian Ruble</td>
<td>BYR</td>
<td>0</td>
</tr>
<tr>
<td>BELGIUM</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>BELIZE</td>
<td>Belize Dollar</td>
<td>BZD</td>
<td>2</td>
</tr>
<tr>
<td>BENIN</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>BERMUDA</td>
<td>Bermudian Dollar</td>
<td>BMD</td>
<td>2</td>
</tr>
<tr>
<td>BHUTAN</td>
<td>Ngultrum</td>
<td>BTN</td>
<td>2</td>
</tr>
<tr>
<td>BHUTAN</td>
<td>Indian Rupee</td>
<td>INR</td>
<td>2</td>
</tr>
<tr>
<td>BOLIVIA, PLURINATIONAL STATE OF</td>
<td>Boliviano</td>
<td>BOB</td>
<td>2</td>
</tr>
<tr>
<td>BOLIVIA, PLURINATIONAL STATE OF</td>
<td>Mvdol</td>
<td>BOV</td>
<td>2</td>
</tr>
<tr>
<td>BONAIRE, SINT EUSTATIUS AND SABA</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>BOSNIA AND HERZEGOVINA</td>
<td>Convertible Mark</td>
<td>BAM</td>
<td>2</td>
</tr>
<tr>
<td>BOTSWANA</td>
<td>Pula</td>
<td>BWP</td>
<td>2</td>
</tr>
<tr>
<td>BOUVET ISLAND</td>
<td>Norwegian Krone</td>
<td>NOK</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>BRAZIL</td>
<td>Brazilian Real</td>
<td>BRL</td>
<td>2</td>
</tr>
<tr>
<td>BRITISH INDIAN OCEAN TERRITORY</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>BRUNEI DARUSSALAM</td>
<td>Brunei Dollar</td>
<td>BND</td>
<td>2</td>
</tr>
<tr>
<td>BULGARIA</td>
<td>Bulgarian Lev</td>
<td>BGN</td>
<td>2</td>
</tr>
<tr>
<td>BURKINA FASO</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>BURUNDI</td>
<td>Burundi Franc</td>
<td>BIF</td>
<td>0</td>
</tr>
<tr>
<td>CAMBODIA</td>
<td>Riel</td>
<td>KHR</td>
<td>2</td>
</tr>
<tr>
<td>CAMEROON</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>CANADA</td>
<td>Canadian Dollar</td>
<td>CAD</td>
<td>2</td>
</tr>
<tr>
<td>CABO VERDE</td>
<td>Cabo Verde Escudo</td>
<td>CVE</td>
<td>2</td>
</tr>
<tr>
<td>CAYMAN ISLANDS</td>
<td>Cayman Islands Dollar</td>
<td>KYD</td>
<td>2</td>
</tr>
<tr>
<td>CENTRAL AFRICAN REPUBLIC</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>CHAD</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>CHILE</td>
<td>Unidad de Fomento</td>
<td>CLF</td>
<td>4</td>
</tr>
<tr>
<td>CHILE</td>
<td>Chilean Peso</td>
<td>CLP</td>
<td>0</td>
</tr>
<tr>
<td>CHINA</td>
<td>Yuan Renminbi</td>
<td>CNY</td>
<td>2</td>
</tr>
<tr>
<td>CHRISTMAS ISLAND</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>COCOS (KEELING) ISLANDS</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>COLOMBIA</td>
<td>Colombian Peso</td>
<td>COP</td>
<td>2</td>
</tr>
<tr>
<td>COLOMBIA</td>
<td>Unidad de Valor Real</td>
<td>COU</td>
<td>2</td>
</tr>
<tr>
<td>COMOROS</td>
<td>Comoro Franc</td>
<td>KMF</td>
<td>0</td>
</tr>
<tr>
<td>CONGO</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>CONGO, DEMOCRATIC REPUBLIC OF THE</td>
<td>Congolese Franc</td>
<td>CDF</td>
<td>2</td>
</tr>
<tr>
<td>COOK ISLANDS</td>
<td>New Zealand Dollar</td>
<td>NZD</td>
<td>2</td>
</tr>
<tr>
<td>COSTA RICA</td>
<td>Costa Rican Colon</td>
<td>CRC</td>
<td>2</td>
</tr>
<tr>
<td>CÔTE D’IVOIRE</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>CROATIA</td>
<td>Croatian Kuna</td>
<td>HRK</td>
<td>2</td>
</tr>
<tr>
<td>CUBA</td>
<td>Peso Convertible</td>
<td>CUC</td>
<td>2</td>
</tr>
<tr>
<td>CUBA</td>
<td>Cuban Peso</td>
<td>CUP</td>
<td>2</td>
</tr>
<tr>
<td>CURAÇAO</td>
<td>Netherlands Antillean</td>
<td>ANG</td>
<td>2</td>
</tr>
<tr>
<td>CYPRUS</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>CZECH REPUBLIC</td>
<td>Czech Koruna</td>
<td>CZK</td>
<td>2</td>
</tr>
<tr>
<td>DENMARK</td>
<td>Danish Krone</td>
<td>DKK</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>DJIBOUTI</td>
<td>Djibouti Franc</td>
<td>DJF</td>
<td>0</td>
</tr>
<tr>
<td>DOMINICA</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>DOMINICAN REPUBLIC</td>
<td>Dominican Peso</td>
<td>DOP</td>
<td>2</td>
</tr>
<tr>
<td>ECUADOR</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>EGYPT</td>
<td>Egyptian Pound</td>
<td>EGP</td>
<td>2</td>
</tr>
<tr>
<td>EL SALVADOR</td>
<td>El Salvador Colon</td>
<td>SVC</td>
<td>2</td>
</tr>
<tr>
<td>EL SALVADOR</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>EQUATORIAL GUINEA</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>Eritrea</td>
<td>Nakfa</td>
<td>ERN</td>
<td>2</td>
</tr>
<tr>
<td>ESTONIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>ETHIOPIA</td>
<td>Ethiopian Birr</td>
<td>ETB</td>
<td>2</td>
</tr>
<tr>
<td>EUROPEAN UNION</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>FALKLAND ISLANDS</td>
<td>Falkland Islands Pound</td>
<td>FKP</td>
<td>2</td>
</tr>
<tr>
<td>FAROE ISLANDS</td>
<td>Danish Krone</td>
<td>DKK</td>
<td>2</td>
</tr>
<tr>
<td>FIJI</td>
<td>Fiji Dollar</td>
<td>FJD</td>
<td>2</td>
</tr>
<tr>
<td>FINLAND</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>FRANCE</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>FRENCH GUIANA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>FRENCH POLYNESIA</td>
<td>CFP Franc</td>
<td>XPF</td>
<td>0</td>
</tr>
<tr>
<td>FRENCH SOUTHERN TERRITORIES</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>GABON</td>
<td>CFA Franc BEAC</td>
<td>XAF</td>
<td>0</td>
</tr>
<tr>
<td>GAMBIA</td>
<td>Dalasi</td>
<td>GMD</td>
<td>2</td>
</tr>
<tr>
<td>GEORGIA</td>
<td>Lari</td>
<td>GEL</td>
<td>2</td>
</tr>
<tr>
<td>GERMANY</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>GHANA</td>
<td>Ghana Cedi</td>
<td>GHS</td>
<td>2</td>
</tr>
<tr>
<td>GIBRALTAR</td>
<td>Gibraltar Pound</td>
<td>GIP</td>
<td>2</td>
</tr>
<tr>
<td>GREECE</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>GREENLAND</td>
<td>Danish Krone</td>
<td>DKK</td>
<td>2</td>
</tr>
<tr>
<td>GRENADA</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>GUADELOUPE</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>GUAM</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>GUATEMALA</td>
<td>Quetzal</td>
<td>GTQ</td>
<td>2</td>
</tr>
<tr>
<td>GUERNSEY</td>
<td>Pound Sterling</td>
<td>GBP</td>
<td>2</td>
</tr>
<tr>
<td>GUINEA</td>
<td>Guinea Franc</td>
<td>GNF</td>
<td>0</td>
</tr>
<tr>
<td>GUINEA-BISSAU</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>GUYANA</td>
<td>Guyana Dollar</td>
<td>GYD</td>
<td>2</td>
</tr>
<tr>
<td>HAITI</td>
<td>Gourde</td>
<td>HTG</td>
<td>2</td>
</tr>
<tr>
<td>HAITI</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>HEARD ISLAND AND MCDONALD ISLANDS</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>HOLY SEE (VATICAN CITY STATE)</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>HONDURAS</td>
<td>Lempira</td>
<td>HNL</td>
<td>2</td>
</tr>
<tr>
<td>HONG KONG</td>
<td>Hong Kong Dollar</td>
<td>HKD</td>
<td>2</td>
</tr>
<tr>
<td>HUNGARY</td>
<td>Forint</td>
<td>HUF</td>
<td>2</td>
</tr>
<tr>
<td>ICELAND</td>
<td>Iceland Krona</td>
<td>ISK</td>
<td>0</td>
</tr>
<tr>
<td>INDIA</td>
<td>Indian Rupee</td>
<td>INR</td>
<td>2</td>
</tr>
<tr>
<td>INDONESIA</td>
<td>Rupiah</td>
<td>IDR</td>
<td>2</td>
</tr>
<tr>
<td>INTERNATIONAL MONETARY FUND (IMF)</td>
<td>SDR (Special Drawing Right)</td>
<td>XDR</td>
<td>N.A.</td>
</tr>
<tr>
<td>IRAN, ISLAMIC REPUBLIC OF</td>
<td>Iranian Rial</td>
<td>IRR</td>
<td>2</td>
</tr>
<tr>
<td>IRAQ</td>
<td>Iraqi Dinar</td>
<td>IQD</td>
<td>3</td>
</tr>
<tr>
<td>IRELAND</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>ISLE OF MAN</td>
<td>Pound Sterling</td>
<td>GBP</td>
<td>2</td>
</tr>
<tr>
<td>ISRAEL</td>
<td>New Israeli Sheqel</td>
<td>ILS</td>
<td>2</td>
</tr>
<tr>
<td>ITALY</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>JAMAICA</td>
<td>Jamaican Dollar</td>
<td>JMD</td>
<td>2</td>
</tr>
<tr>
<td>JAPAN</td>
<td>Yen</td>
<td>JPY</td>
<td>0</td>
</tr>
<tr>
<td>JERSEY</td>
<td>Pound Sterling</td>
<td>GBP</td>
<td>2</td>
</tr>
<tr>
<td>JORDAN</td>
<td>Jordanian Dinar</td>
<td>JOD</td>
<td>3</td>
</tr>
<tr>
<td>KAZAKHSTAN</td>
<td>Tenge</td>
<td>KZT</td>
<td>2</td>
</tr>
<tr>
<td>KENYA</td>
<td>Kenyan Shilling</td>
<td>KES</td>
<td>2</td>
</tr>
<tr>
<td>KIRIBATI</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>KOREA, DEMOCRATIC PEOPLE’S REPUBLIC OF</td>
<td>North Korean Won</td>
<td>KPW</td>
<td>2</td>
</tr>
<tr>
<td>KOREA, REPUBLIC OF</td>
<td>Won</td>
<td>KRW</td>
<td>0</td>
</tr>
<tr>
<td>KUWAIT</td>
<td>Kuwaiti Dinar</td>
<td>KWD</td>
<td>3</td>
</tr>
<tr>
<td>KYRGYZSTAN</td>
<td>Som</td>
<td>KGS</td>
<td>2</td>
</tr>
<tr>
<td>LAO PEOPLE’S DEMOCRATIC REPUBLIC</td>
<td>Kip</td>
<td>LAK</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>LATVIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>LEBANON</td>
<td>Lebanees Pound</td>
<td>LBP</td>
<td>2</td>
</tr>
<tr>
<td>LESOTHO</td>
<td>Loti</td>
<td>LSL</td>
<td>2</td>
</tr>
<tr>
<td>LESOTHO</td>
<td>Rand</td>
<td>ZAR</td>
<td>2</td>
</tr>
<tr>
<td>LIBERIA</td>
<td>Liberian Dollar</td>
<td>LRD</td>
<td>2</td>
</tr>
<tr>
<td>LIBYA</td>
<td>Libyan Dinar</td>
<td>LYD</td>
<td>3</td>
</tr>
<tr>
<td>LIECHTENSTEIN</td>
<td>Swiss Franc</td>
<td>CHF</td>
<td>2</td>
</tr>
<tr>
<td>LITHUANIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>LUXEMBOUR</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>MACAO</td>
<td>Pataca</td>
<td>MOP</td>
<td>2</td>
</tr>
<tr>
<td>MACEDONIA, THE FORMER YUGOSLAV REPUBLIC OF</td>
<td>Denar</td>
<td>MKD</td>
<td>2</td>
</tr>
<tr>
<td>MADAGASCAR</td>
<td>Malagasy Ariary</td>
<td>MGA</td>
<td>2</td>
</tr>
<tr>
<td>MALAWI</td>
<td>Kwachha</td>
<td>MWK</td>
<td>2</td>
</tr>
<tr>
<td>MALAYSIA</td>
<td>Malaysian Ringgit</td>
<td>MYR</td>
<td>2</td>
</tr>
<tr>
<td>MALDIVES</td>
<td>Rufiyaa</td>
<td>MVR</td>
<td>2</td>
</tr>
<tr>
<td>MALI</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>MALTA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>MARSHALL ISLANDS</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>MARTINIQUE</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>MAURITANIA</td>
<td>Ouguiya</td>
<td>MRO</td>
<td>2</td>
</tr>
<tr>
<td>MAURITIUS</td>
<td>Mauritius Rupee</td>
<td>MUR</td>
<td>2</td>
</tr>
<tr>
<td>MAYOTTE</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>MEMBER COUNTRIES OF THE AFRICAN DEVELOPMENT BANK GROUP</td>
<td>ADB Unit of Account</td>
<td>XUA</td>
<td>N.A.</td>
</tr>
<tr>
<td>MEXICO</td>
<td>Mexican Peso</td>
<td>MXN</td>
<td>2</td>
</tr>
<tr>
<td>MEXICO</td>
<td>Mexican Unidad de Inversion (UDI)</td>
<td>MXV</td>
<td>2</td>
</tr>
<tr>
<td>MICRONESIA, FEDERATED STATES OF</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>MOLDOVA, REPUBLIC OF</td>
<td>Moldovan Leu</td>
<td>MDL</td>
<td>2</td>
</tr>
<tr>
<td>MONACO</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>MONGOLIA</td>
<td>Tugrik</td>
<td>MNT</td>
<td>2</td>
</tr>
<tr>
<td>MONTENEGRO</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>MONTSERRAT</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>MOROCCO</td>
<td>Moroccan Dirham</td>
<td>MAD</td>
<td>2</td>
</tr>
<tr>
<td>MOZAMBIQUE</td>
<td>Mozambique Metical</td>
<td>MZN</td>
<td>2</td>
</tr>
<tr>
<td>MYANMAR</td>
<td>Kyat</td>
<td>MMK</td>
<td>2</td>
</tr>
<tr>
<td>NAMIBIA</td>
<td>Namibia Dollar</td>
<td>NAD</td>
<td>2</td>
</tr>
<tr>
<td>NAMIBIA</td>
<td>Rand</td>
<td>ZAR</td>
<td>2</td>
</tr>
<tr>
<td>NAURU</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>NEPAL</td>
<td>Nepalese Rupee</td>
<td>NPR</td>
<td>2</td>
</tr>
<tr>
<td>NETHERLANDS</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>NEW CALEDONIA</td>
<td>CFP Franc</td>
<td>XPF</td>
<td>0</td>
</tr>
<tr>
<td>NEW ZEALAND</td>
<td>New Zealand Dollar</td>
<td>NZD</td>
<td>2</td>
</tr>
<tr>
<td>NICARAGUA</td>
<td>Cordoba Oro</td>
<td>NIO</td>
<td>2</td>
</tr>
<tr>
<td>NIGER</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>NIGERIA</td>
<td>Naira</td>
<td>NGN</td>
<td>2</td>
</tr>
<tr>
<td>NIUE</td>
<td>New Zealand Dollar</td>
<td>NZD</td>
<td>2</td>
</tr>
<tr>
<td>NORFOLK ISLAND</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>NORTHERN MARIANA ISLANDS</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>NORWAY</td>
<td>Norwegian Krone</td>
<td>NOK</td>
<td>2</td>
</tr>
<tr>
<td>OMAN</td>
<td>Rial Omani</td>
<td>OMR</td>
<td>3</td>
</tr>
<tr>
<td>PAKISTAN</td>
<td>Pakistan Rupee</td>
<td>PKR</td>
<td>2</td>
</tr>
<tr>
<td>PALAU</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>PALESTINE, STATE OF</td>
<td>No universal currency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PANAMA</td>
<td>Balboa</td>
<td>PAB</td>
<td>2</td>
</tr>
<tr>
<td>PANAMA</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>PAPUA NEW GUINEA</td>
<td>Kina</td>
<td>PGK</td>
<td>2</td>
</tr>
<tr>
<td>PARAGUAY</td>
<td>Guarani</td>
<td>PYG</td>
<td>0</td>
</tr>
<tr>
<td>PERU</td>
<td>Nuevo Sol</td>
<td>PEN</td>
<td>2</td>
</tr>
<tr>
<td>PHILIPPINES</td>
<td>Philippine Peso</td>
<td>PHP</td>
<td>2</td>
</tr>
<tr>
<td>PITCAIRN</td>
<td>New Zealand Dollar</td>
<td>NZD</td>
<td>2</td>
</tr>
<tr>
<td>POLAND</td>
<td>Zloty</td>
<td>PLN</td>
<td>2</td>
</tr>
<tr>
<td>PORTUGAL</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>PUERTO RICO</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>QATAR</td>
<td>Qatari Rial</td>
<td>QAR</td>
<td>2</td>
</tr>
<tr>
<td>RÉUNION</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>ROMANIA</td>
<td>New Romanian Leu</td>
<td>RON</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>RUSSIAN FEDERATION</td>
<td>Russian Ruble</td>
<td>RUB</td>
<td>2</td>
</tr>
<tr>
<td>RWANDA</td>
<td>Rwanda Franc</td>
<td>RWF</td>
<td>0</td>
</tr>
<tr>
<td>SAINT BARTHÉLEMY</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SAINT HELENA, ASCENSION AND TRISTAN DA CUNHA</td>
<td>Saint Helena Pound</td>
<td>SHP</td>
<td>2</td>
</tr>
<tr>
<td>SAINT KITTS AND NEVIS</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>SAINT LUCIA</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>SAINT MARTIN (FRENCH PART)</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SAINT PIERRE AND MIQUELON</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SAINT VINCENT AND THE GRENADINES</td>
<td>East Caribbean Dollar</td>
<td>XCD</td>
<td>2</td>
</tr>
<tr>
<td>SAMOA</td>
<td>Tala</td>
<td>WST</td>
<td>2</td>
</tr>
<tr>
<td>SAN MARINO</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SAO TOME AND PRINCIPE</td>
<td>Dobra</td>
<td>STD</td>
<td>2</td>
</tr>
<tr>
<td>SAUDI ARABIA</td>
<td>Saudi Riyal</td>
<td>SAR</td>
<td>2</td>
</tr>
<tr>
<td>SENEGAL</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>SERBIA</td>
<td>Serbian Dinar</td>
<td>RSD</td>
<td>2</td>
</tr>
<tr>
<td>SEYCHELLES</td>
<td>Seychelles Rupee</td>
<td>SCR</td>
<td>2</td>
</tr>
<tr>
<td>SIERRA LEONE</td>
<td>Leone</td>
<td>SLL</td>
<td>2</td>
</tr>
<tr>
<td>SINGAPORE</td>
<td>Singapore Dollar</td>
<td>SGD</td>
<td>2</td>
</tr>
<tr>
<td>SINT MAARTEN (DUTCH PART)</td>
<td>Netherlands Antillean Guilder</td>
<td>ANG</td>
<td>2</td>
</tr>
<tr>
<td>SISTEMA UNITARIO DE COMPENSACION REGIONAL DE PAGOS &quot;SUCRE&quot;</td>
<td>Sucre</td>
<td>XSU</td>
<td>N.A.</td>
</tr>
<tr>
<td>SLOVAKIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SLOVENIA</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SOLOMON ISLANDS</td>
<td>Solomon Islands Dollar</td>
<td>SBD</td>
<td>2</td>
</tr>
<tr>
<td>SOMALIA</td>
<td>Somali Shilling</td>
<td>SOS</td>
<td>2</td>
</tr>
<tr>
<td>SOUTH AFRICA</td>
<td>Rand</td>
<td>ZAR</td>
<td>2</td>
</tr>
<tr>
<td>SOUTH GEORGIA AND THE SOUTH SANDWICH ISLANDS</td>
<td>No universal currency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOUTH SUDAN</td>
<td>South Sudanese Pound</td>
<td>SSP</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>SPAIN</td>
<td>Euro</td>
<td>EUR</td>
<td>2</td>
</tr>
<tr>
<td>SRI LANKA</td>
<td>Sri Lanka Rupee</td>
<td>LKR</td>
<td>2</td>
</tr>
<tr>
<td>SUDAN</td>
<td>Sudanese Pound</td>
<td>SDG</td>
<td>2</td>
</tr>
<tr>
<td>SURINAME</td>
<td>Surinam Dollar</td>
<td>SRD</td>
<td>2</td>
</tr>
<tr>
<td>SVALBARD AND JAN MAYEN</td>
<td>Norwegian Krone</td>
<td>NOK</td>
<td>2</td>
</tr>
<tr>
<td>SWAZILAND</td>
<td>Lilangeni</td>
<td>SZL</td>
<td>2</td>
</tr>
<tr>
<td>SWEDEN</td>
<td>Swedish Krona</td>
<td>SEK</td>
<td>2</td>
</tr>
<tr>
<td>SWITZERLAND</td>
<td>WIR Euro</td>
<td>CHE</td>
<td>2</td>
</tr>
<tr>
<td>SWITZERLAND</td>
<td>Swiss Franc</td>
<td>CHF</td>
<td>2</td>
</tr>
<tr>
<td>SWITZERLAND</td>
<td>WIR Franc</td>
<td>CHW</td>
<td>2</td>
</tr>
<tr>
<td>SYRIAN ARAB REPUBLIC</td>
<td>Syrian Pound</td>
<td>SYP</td>
<td>2</td>
</tr>
<tr>
<td>TAIWAN, PROVINCE OF CHINA</td>
<td>New Taiwan Dollar</td>
<td>TWD</td>
<td>2</td>
</tr>
<tr>
<td>TAJIKISTAN</td>
<td>Somoni</td>
<td>TJS</td>
<td>2</td>
</tr>
<tr>
<td>TANZANIA, UNITED REPUBLIC OF</td>
<td>Tanzanian Shilling</td>
<td>TZS</td>
<td>2</td>
</tr>
<tr>
<td>THAILAND</td>
<td>Baht</td>
<td>THB</td>
<td>2</td>
</tr>
<tr>
<td>TIMOR-LESTE</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>TOGO</td>
<td>CFA Franc BCEAO</td>
<td>XOF</td>
<td>0</td>
</tr>
<tr>
<td>TOKELAU</td>
<td>New Zealand Dollar</td>
<td>NZD</td>
<td>2</td>
</tr>
<tr>
<td>TONGA</td>
<td>Pa’anga</td>
<td>TOP</td>
<td>2</td>
</tr>
<tr>
<td>TRINIDAD AND TOBAGO</td>
<td>Trinidad and Tobago Dollar</td>
<td>TTD</td>
<td>2</td>
</tr>
<tr>
<td>TUNISIA</td>
<td>Tunisian Dinar</td>
<td>TND</td>
<td>3</td>
</tr>
<tr>
<td>TURKEY</td>
<td>Turkish Lira</td>
<td>TRY</td>
<td>2</td>
</tr>
<tr>
<td>TURKMENISTAN</td>
<td>Turkmenistan New Manat</td>
<td>TMT</td>
<td>2</td>
</tr>
<tr>
<td>TURKS AND CAICOS ISLANDS</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>TUVALU</td>
<td>Australian Dollar</td>
<td>AUD</td>
<td>2</td>
</tr>
<tr>
<td>UGANDA</td>
<td>Uganda Shilling</td>
<td>UGX</td>
<td>0</td>
</tr>
<tr>
<td>UKRAINE</td>
<td>Hryvnia</td>
<td>UAH</td>
<td>2</td>
</tr>
<tr>
<td>UNITED ARAB EMIRATES</td>
<td>UAE Dirham</td>
<td>AED</td>
<td>2</td>
</tr>
<tr>
<td>UNITED KINGDOM</td>
<td>Pound Sterling</td>
<td>GBP</td>
<td>2</td>
</tr>
<tr>
<td>UNITED STATES</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>UNITED STATES</td>
<td>US Dollar (Next day)</td>
<td>USN</td>
<td>2</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>UNITED STATES MINOR OUTLYING ISLANDS</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>URUGUAY</td>
<td>Uruguay Peso en Unidades Indexadas (UURUIURUI)</td>
<td>UYI</td>
<td>0</td>
</tr>
<tr>
<td>URUGUAY</td>
<td>Peso Uruguayo</td>
<td>UYU</td>
<td>2</td>
</tr>
<tr>
<td>UZBEKISTAN</td>
<td>Uzbekistan Sum</td>
<td>UZS</td>
<td>2</td>
</tr>
<tr>
<td>VANUATU</td>
<td>Vatu</td>
<td>VUV</td>
<td>0</td>
</tr>
<tr>
<td>VENEZUELA, BOLIVARIAN REPUBLIC OF</td>
<td>Bolivar</td>
<td>VEF</td>
<td>2</td>
</tr>
<tr>
<td>VIET NAM</td>
<td>Dong</td>
<td>VND</td>
<td>0</td>
</tr>
<tr>
<td>VIRGIN ISLANDS (BRITISH)</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>VIRGIN ISLANDS (U.S.)</td>
<td>US Dollar</td>
<td>USD</td>
<td>2</td>
</tr>
<tr>
<td>WALLIS AND FUTUNA</td>
<td>CFP Franc</td>
<td>XPF</td>
<td>0</td>
</tr>
<tr>
<td>WESTERN SAHARA</td>
<td>Moroccan Dirham</td>
<td>MAD</td>
<td>2</td>
</tr>
<tr>
<td>YEMEN</td>
<td>Yemeni Rial</td>
<td>YER</td>
<td>2</td>
</tr>
<tr>
<td>ZAMBIA</td>
<td>Zambian Kwacha</td>
<td>ZMW</td>
<td>2</td>
</tr>
<tr>
<td>ZIMBABWE</td>
<td>Zimbabwe Dollar</td>
<td>ZWL</td>
<td>2</td>
</tr>
<tr>
<td>ZZ01_Bond Markets Unit European EURCO</td>
<td>Bond Markets Unit European Composite Unit (EURCO)</td>
<td>XBA</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ02_Bond Markets Unit European EMU-6</td>
<td>Bond Markets Unit European Monetary Unit (E.M.U.-6)</td>
<td>XBB</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ03_Bond Markets Unit European EUA-9</td>
<td>Bond Markets Unit European Unit of Account 9 (E.U.A.-9)</td>
<td>XBC</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ04_Bond Markets Unit European EUA-17</td>
<td>Bond Markets Unit European Unit of Account 17 (E.U.A.-17)</td>
<td>XBD</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ06_Testing_Code</td>
<td>Codes specifically reserved for testing purposes</td>
<td>XTS</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ07_No_Currency</td>
<td>The codes assigned for transactions where no currency is involved</td>
<td>XXX</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ08_Gold</td>
<td>Gold</td>
<td>XAU</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ09_Palladium</td>
<td>Palladium</td>
<td>XPD</td>
<td>N.A.</td>
</tr>
<tr>
<td>ZZ10_Platinum</td>
<td>Platinum</td>
<td>XPT</td>
<td>N.A.</td>
</tr>
<tr>
<td>Entity</td>
<td>Currency</td>
<td>Code</td>
<td>Minor Unit</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>ZZ11_Silver</td>
<td>Silver</td>
<td>XAG</td>
<td>N.A.</td>
</tr>
</tbody>
</table>
Preferences and Advanced Settings

Preferences

These settings control general user preferences as well as those related to location, the user interface, the macro language, and downloads.

General Preferences

The **General** section of the **Set Preferences** dialog contains general user preferences, such as allowing tables resulting in 0 rows from a selection.

**Allow 0 row tables when the macro is annotated with `<meta>empty<meta>`**

When selected, this allows selections resulting in tables with 0 rows, if the macro contains `<meta>empty<meta>`.

If this is not selected (or if this is selected, but the macro does not contain the empty `<meta>` element), the user will receive an error saying that no rows were selected.

Location Preferences

The **Location** section of the **Set Preferences** dialog contains settings related to location, such as the time zone used when displaying dates and times as well as the format for displaying dates and numbers based on region.

**Time Zone**

The time zone that is used when showing the date and time on reports.

The options are presented as offsets to the Greenwich Mean Time.

For example, New York is in the Eastern Time Zone of the United States, and Eastern Standard Time (EST) is 5 hours behind Greenwich Mean Time. Therefore, the appropriate selection for New York would be **GMT-5**.

**Region Format**

This determines the order in which dates are presented (or downloaded as formatted values), when using the **date**, **date4y**, and **datehms24** display formats as well as how numbers (i.e., integers and decimals) are displayed.

<table>
<thead>
<tr>
<th></th>
<th>Date</th>
<th>Date+Time</th>
<th>Integer</th>
<th>Decimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>MM/DD/YY</td>
<td>MM/DD/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>Europe</td>
<td>DD.MM.YY</td>
<td>DD.MM.YY_HH:MM:SS</td>
<td>10.000</td>
<td>0.001</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>DD/MM/YY</td>
<td>DD/MM/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>ANSI</td>
<td>YYYY-MM-DD</td>
<td>YYYY-MM-DD HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
</tbody>
</table>

User Interface Preferences

The **User Interface** section of the **Set Preferences** dialog contains settings related to the user interface, such as how column headings are displayed and the manner in which certain dialogs are configured.

**Return focus to browser window**

When selected, the browser window regains focus after a query completes. If the browser window was behind other windows or was minimized, it becomes the active window.
By default, in certain operating systems (e.g., pre-Windows XP), whenever you get a response from the system, the browser window grabs the focus. You can disable this behavior by clearing this check box.

**Enable keyboard shortcuts**

When selected, keyboard shortcuts for switching tabs, editing actions, showing column information, and searching for items are enabled.

**Show "Run Macro" in the "File" menu**

In earlier versions of 1010data, queries could be saved as macros and run in this way. This option is provided for legacy reasons.

**Display progress bar**

When selected, a dialog containing a progress bar will appear while a query is processing. The progress bar shows the percentage of total operations completed within the current query.

**Show advanced query error information**

When selected, more detailed information related to query errors is presented.

**Show columns headings as**

The column heading, name, or a combination of both can be displayed at the top of each column in a table.

- **the label**
  
  The column heading will be displayed at the top of each column (e.g., **Unemployment Rate**).

- **the name**
  
  The column name will be displayed at the top of each column (e.g., **unemp_rate**).

- **both the name and label**
  
  Both the column heading and the column name will be displayed at the top of each column.

**When viewing a table multiple rows at a time, if a cell has the same value as the one above it, show**

This determines how repeated values will be displayed within a particular column in a table.
the value

If a particular cell has the same value as the cell in the row above it, the same value will be displayed in that cell. This is the default setting.

<table>
<thead>
<tr>
<th>State</th>
<th>Month</th>
<th>Unemployment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI</td>
<td>06/99</td>
<td>3.1</td>
</tr>
<tr>
<td>MI</td>
<td>10/99</td>
<td>3.1</td>
</tr>
<tr>
<td>MI</td>
<td>04/00</td>
<td>3.1</td>
</tr>
<tr>
<td>MI</td>
<td>10/00</td>
<td>3.1</td>
</tr>
<tr>
<td>MI</td>
<td>04/98</td>
<td>3.2</td>
</tr>
<tr>
<td>MI</td>
<td>09/99</td>
<td>3.2</td>
</tr>
<tr>
<td>MI</td>
<td>12/99</td>
<td>3.2</td>
</tr>
</tbody>
</table>

a ditto mark (all columns)

If a particular cell has the same value as the cell in the row above it, a ditto mark (") will be displayed in that cell.

<table>
<thead>
<tr>
<th>State</th>
<th>Month</th>
<th>Unemployment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI</td>
<td>06/99</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>10/99</td>
<td>&quot;</td>
</tr>
<tr>
<td></td>
<td>04/00</td>
<td>&quot;</td>
</tr>
<tr>
<td></td>
<td>10/00</td>
<td>&quot;</td>
</tr>
<tr>
<td></td>
<td>04/98</td>
<td>3.2</td>
</tr>
<tr>
<td></td>
<td>09/99</td>
<td>&quot;</td>
</tr>
<tr>
<td></td>
<td>12/99</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

a ditto mark (fixed columns only)

Within a fixed column, if a particular cell has the same value as the cell in the row above it, a ditto mark (") will be displayed in that cell. Otherwise, if it is not a fixed column, the same value will be displayed.

<table>
<thead>
<tr>
<th>State</th>
<th>Month</th>
<th>Unemployment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI</td>
<td>06/99</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>10/99</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>04/00</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>10/00</td>
<td>3.1</td>
</tr>
<tr>
<td></td>
<td>04/98</td>
<td>3.2</td>
</tr>
<tr>
<td></td>
<td>09/99</td>
<td>3.2</td>
</tr>
<tr>
<td></td>
<td>12/99</td>
<td>3.2</td>
</tr>
</tbody>
</table>

Note: In this example the State column is fixed, but Unemployment Rate is not.

a blank (all columns)

If a particular cell has the same value as the cell in the row above it, the cell will appear blank.
Within a fixed column, if a particular cell has the same value as the cell in the row above it, the cell will appear blank. Otherwise, if it is not a fixed column, the same value will be displayed.

Note: In this example the State column is fixed, but Unemployment Rate is not.

In selection boxes, show columns in

- the order that they appear in the table
  - Column headings will appear within the drop-down lists in the same order that they appear in the table.
- alphabetical order
  - Column headings will appear in the drop-down lists in alphabetical order and will include column names for any linked tables.
- alphabetical order but with columns from linked tables last
  - Column headings will appear in the drop-down lists in alphabetical order; however, column headings for any linked tables will appear separately (in alphabetical order) at the bottom of the list.

Use combo boxes instead of select boxes

- When selected, combo boxes will be used instead of select boxes for the drop-down lists in all dialogs.

Number of decimal places

- Specifies the number of decimal places to display for numbers in the 1010data grid.

Number of Summarizations for Quick Summary
The number of summarizations available in the Quick Summary dialog. The default is 10.

Number of Grouping Columns for Tabulation
The number of grouping columns available in the Tabulation dialog. The default is 3.

Number of Summarizations for Tabulation
The number of summarizations available in the Tabulation dialog. The default is 10.

Number of Row Dimensions for Cross Tabulation
The number of rows of results available in the Cross Tabulation dialog. The default is 3.

Number of Column Dimensions for Cross Tabulation
The number of columns of results available in the Cross Tabulation dialog. The default is 3.

Number of Columns for Links
The number of available columns to match when linking tables or worksheets using the link dialogs (e.g., Link in Another Table, Link in Another Worksheet, Link and Select Rows). The default is 3.

Default folder path to save a quick query or new table
The path to the folder where quick queries and new tables are saved by default. If no path is specified, the user's My Data folder is the default location.

Macro Language Preferences
The Macro Language section of the Set Preferences dialog contains settings related to the 1010data Macro Language and the Edit Actions (XML) dialog.

Enable syntax highlighting
When selected, Macro Language elements, attributes, and values are color coded within the Edit Actions (XML) dialog.

```
1 <note type="base">Applied to table: training.retail.item</note>
2 <sel value="{(date=20120515)}">/
3 <tabu label="Sales by Transaction ID" breaks="transid">
4 <col source="sales" fun="sum" label="Sum of Sales"/>
5 <col source="units" fun="sum" label="Sum of Units"/>
6 </tabu>
```

Wrap text on Edit Actions page
When selected, text that is too long to fit on one line in the Edit Actions (XML) dialog is wrapped to the next line.

In the following example, the <note> element on line 2 wraps to the next line.

```
1 <note type="base">Applied to table: training.retail.item</note>
2 <note type="link">The following link is to table: All Databases/Training Examples/Retail/Product Master</note>
3 <link table2="training.retail.prod" col="sku" col2="sku"/>
```

If this option was not selected, the <note> element would appear only on one line (and a horizontal scroll bar would appear at the bottom of the Edit Actions (XML) dialog).
Note: This option is only available when Enable syntax highlighting is selected.

**Automatically indent on Edit Actions page**

When selected, the line following an opening tag for a particular Macro Language element is indented by the number of spaces specified by Indent spaces for nested elements.

For instance, the following screen shot shows the automatic indentation of the line following the opening `<tabu>` tag:

```xml
1 <note type="base">Applied to table: pub.demo.retail.item</note>
2 <tabu label="Sales by Date" breaks="date">
3  <tcol source="sales" fun="sum" label="Sum of `Sales"/>
```

If this option is not selected, the line following the opening `<tabu>` tag is not indented:

```xml
1 <note type="base">Applied to table: pub.demo.retail.item</note>
2 <tabu label="Sales by Date" breaks="date">
3  <tcol source="sales" fun="sum" label="Sum of `Sales"/>
```

**Enable autocomplete**

When selected, a drop-down menu of context-related options is presented as you type in Macro Language element names, attributes, and values for certain attributes (such as functions) in the Edit Actions (XML) dialog.

For instance, if you type `<` in the Edit Actions (XML) dialog, a list of context-dependent element names will be presented.

```xml
1 <note type="base">Applied to table: training.retail.item</note>
2  <sel value="(date=20120515)"/>
3  <link merge willbe colord sel sort tabu col base note
```

If you type `fun="` when you are specifying a tabulation column (`<tcol>`) element, a list of summarization functions will appear in the drop-down list.
Note: This option is only available when Enable syntax highlighting is selected.

Indent spaces for nested elements

The number of spaces to indent nested Macro Language elements. The default is 2.

In the following example, the `<tcol>` elements nested within the `<tabu>` element are indented two spaces.

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" breaks="transid">
  <tcol source="sales" fun="sum" label="Sum of Sales"/>
  <tcol source="units" fun="sum" label="Sum of Units"/>
</tabu>
```

Put each attribute on a separate line

When selected, each attribute for a particular Macro Language element will appear on its own line.

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" breaks="transid">
  <tcol source="sales" fun="sum" label="Sum of Sales"/>
  <tcol source="units" fun="sum" label="Sum of Units"/>
</tabu>
```

The default is for all attributes to appear on the same line:

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" breaks="transid">
  <tcol source="sales" fun="sum" label="Sum of Sales"/>
  <tcol source="units" fun="sum" label="Sum of Units"/>
</tabu>
```

Break up long selection and value expressions

When selected, this breaks up lengthy value expressions in `<sel>` statements over multiple lines, with each selection criterion on a separate line, prefaced by an `&`.
In a `<link>`, show the linked table with

Select whether a table ID or a table name (path) will be displayed as the value of the `table2` attribute for a `<link>` element in the Macro Language.

**name**

In the **Edit Actions (XML)** dialog, the value of the `table2` attribute for a `<link>` element is displayed as the table's name.

**ID**

In the **Edit Actions (XML)** dialog, the value of the `table2` attribute for a `<link>` element is displayed as the table's ID.

Automatically add comments for the following:

When selected, a `<note>` element containing a comment is automatically added for the table that the macro is being applied to and the table that is being linked to.

In the following example:

- The `<note>` on line 1 contains the comment that was automatically added about the table the macro was applied to (`training.retail.item`).
- The `<note>` on line 2 contains the comment that was automatically added about the table that was linked to (`training.retail.prod`) in the `<link>` statement on line 3.

**Downloads Preferences**

The **Downloads** section of the **Set Preferences** dialog contains preferences related to Excel downloads and end-of-record delimiters.

**Excel Downloads**

Choose whether tables downloaded in Excel format should be decorated with colorful borders, fills, and fonts (and include tabulation totals), or if they should appear as plain data.

**Decorated with totals**
Tables will be decorated with colorful borders, fills, and fonts. Also, totals will appear at the top of tabulation columns.

Plain

Tables will not be decorated with any special formatting, and totals will not appear at the top of tabulation columns.

End-of-record delimiter

Select whether a line feed, or carriage return and line feed, are used to signify the end of a record.

LF

A line feed will be used as the end-of-record delimiter.

CRLF

A carriage return and line feed will be used as the end-of-record delimiter.

Include an end-of-record delimiter after the last record?

Select whether an end-of-record delimiter should be included after the last record.

QuickApp Preferences

The QuickApp section of the Set Preferences dialog contains settings related to the development and rendering of QuickApps.

Grid Type

Display all grid widgets in QuickApps as either the traditional 1010data grid or as a smooth-scrolling grid.

Native Grid

Display a traditional 1010data grid.
Set preferences

Change settings related to location, the user interface, the macro language, and downloads.

To set preferences:

1. In an open table or worksheet, click View > Set Preferences...

   The Set Preferences dialog is presented.

2. Make desired changes.

3. Click Submit.
Advanced Settings

Settings related to the time-out period, error and infinity handling, step-wise aggregation, and blocking level.

Time-Out Period

When running long queries, your browser may time out after several minutes. You should be able to eliminate many of the time-outs by changing this setting to the time-out interval (or lower).

For example, if you are timing out after five minutes, set this to five minutes. If you are timing out after seven-and-a-half minutes, set it to seven minutes.

Please be aware that when a time-out period is set, your browser's progress bar may not function properly.

Note: Time-outs are usually caused by your proxy server or firewall. If you experience such time-outs, first speak to your technology support person to see if they can change your proxy server or firewall settings. If that's not possible, then try changing this setting.

Error and Infinity Handling

Some computations (e.g., dividing by zero) can result in errors or "infinity" values (\(0I, -0I, 0i,\) or \(-0i\)). Selecting this option can help reduce or eliminate this behavior.

Specifically:

- Division by zero \((X/0)\) returns \(0i\) or \(-0i\) if the numerator is not zero.
  
- Checking this box causes \(N/A\) to be returned instead of \(0i\) and \(-0i\).

- Exponentiation \((X^Y)\) can generate error messages if \(X\) is negative.
  
- Checking this box mostly eliminates such messages and causes \(N/A\) to be returned in the event of an error.

- The range functions \((range1, range1f, etc.)\) return \(0I, -0I, 0i,\) or \(-0i\) for column values that lie outside the specified ranges.
  
- Checking this box causes \(N/A\) to be returned instead.

Do step-wise aggregation

Select this option to help alleviate virtual memory problems when working with large tables. Using this feature saves memory but is slower.

Blocking Level

Select lower numbers to help alleviate virtual memory problems when doing row selections and tabulations on large tables. Lower numbers save memory but may cause queries to run slower.

Set advanced settings

Change settings related to the time-out period, error and infinity handling, step-wise aggregation, and blocking level.

To set advanced settings:

1. In an open table or worksheet, click Actions > Advanced...

   The Advanced Settings dialog is presented.

2. Make the desired changes.

3. Click Apply.
The **Account Administration** page allows you to change your user profile or password, modify user-related information, download account-specific information, schedule queries, and manage your groups. Company administrators can also modify company-related information.

The **Account Administration** page can be launched by clicking **Admin** under the drop-down menu corresponding to your username in the top right corner of your 1010data session.

### Account Administration Toolbar

The **Account Administration** toolbar allows you to change your user profile or password, download account-specific information, and manage your groups.

The **Account Administration** toolbar appears at the top of the **Account Administration** browser and may consist of any number of the following icons based on your permissions and preferences:

1. **User Profile**
   - Change your user profile information.
2. **Change Password**
   - Change your password.
3. **User Manager**
   - Manage account-related settings for the current user. Company administrators can also manage account-related settings for any user.
4. **My Downloads**
   - Download text files containing account-specific information.
5. **Group Manager**
   - Manage your groups.
6. **Query Scheduler**
   - Create, find, edit, delete, and run scheduled query jobs.

Company administrators will see an additional icon on the **Account Administration** toolbar:

7. **Company Manager**
   - Change company-related information.

**Note:** This option cannot be seen by users without admin permissions and is available only to customers with dedicated servers. To inquire about admin permissions, please email support@1010data.com.

### Change your user profile information

Change your first name, last name, or email address.

To change your user profile information:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.
   - The **Account Administration** page will be opened in a new tab.
2. On the **Account Administration** toolbar, click the **User Profile** icon (📝).
   - **Note:** If **Enable the User Manager in the Admin App** has been selected in the User Manager, the **User Profile** icon will not appear on the **Account Administration** toolbar. In this case, you can change your user profile information via the User Manager. See **User Manager** on page 351 for more information.
3. In the **First Name**, **Last Name**, and **Email** text boxes, make any necessary changes.
4. Click **Submit Changes**.
When your user profile information has been successfully changed, you will see the message Changes were saved! in the area directly beneath the Account Administration toolbar.

## Change your password

Change your 1010data password.

To change your 1010data password:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.
   
   The Account Administration page will be opened in a new tab.

2. On the Account Administration toolbar, click the Change Password icon ( ModiﬁcationIcon).

3. In the Old Password text box, enter your current 1010data password.

4. In the New Password text box, enter your new 1010data password.
   
   **Note:** Passwords may only contain uppercase and lowercase letters and numbers. Symbols and spaces are not permitted.

5. In the Retype New Password text box, enter your new 1010data password again.
   
   **Note:** The values for New Password and Retype New Password must match.

6. Click Submit Changes.

When your password has been successfully changed, you will see the message Changes were saved! in the area directly beneath the Account Administration toolbar.

## Download account-specific information

Download text files containing either your Quick Queries or lists of users who have access to your shared folders, tables, and queries.

To download account-specific information:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.

   The Account Administration page will be opened in a new tab.

2. On the Account Administration toolbar, click the My Downloads icon ( ModiﬁcationIcon).

You will see a list of downloadable text files:

<table>
<thead>
<tr>
<th>my macros</th>
<th>my quick queries</th>
</tr>
</thead>
<tbody>
<tr>
<td>my quick queries</td>
<td>Downloads a plain text file to your local system containing all of the Quick Queries you have created. The Quick Queries are separated by dashed lines.</td>
</tr>
<tr>
<td>my macros and quick queries</td>
<td></td>
</tr>
<tr>
<td>who can see my stuff (by table)</td>
<td>Downloads a plain text file to your local system containing a list of your shared folders, tables, and queries and the users that have access to them.</td>
</tr>
<tr>
<td>who can see my stuff (by user)</td>
<td>Downloads a plain text file to your local system containing a list of users and the shared folders, tables, and queries to which each has access.</td>
</tr>
</tbody>
</table>

3. Click the desired item.

The text file corresponding to the item you selected will be downloaded to your local system.
User Manager

The User Manager allows users to manage information related to their 1010data accounts. Company administrators can also create, find, edit, and deactivate users.

The User Manager page has three tabs:

- User Info
- Account Settings
- GUI Preferences

In addition, company administrators also see a text box in which to enter a first name, last name, user ID, email address, or company name and a Find Users button, which is used to initiate the search based on the entered criteria.

There are also four buttons below the text box that are available to company administrators:

Create New User
Create a new 1010data user.

Create Multiple Users
Create multiple 1010data users by uploading a CSV file that contains the users' information.

Save Multiple Users
Change settings for multiple 1010data users at the same time.

Clear Form
Clear the values from the fields on all of the User Manager tabs.

User Info

The User Info tab of the User Manager page contains personal information about a particular user as well as information related to that user's ID, password, and expiration date.

Personal Information

User ID
A unique combination of alphanumeric characters and underscores. (required)

The recommended form for a user ID is:
<compid>_<first initial of first name><last name>

Each user must have a user ID that is unique across all companies which use 1010data. For instance, even if you only have one John Smith within your company, another company may already be utilizing the user ID jsmith. If you try creating a user with a user ID that already exists, you will get an error message telling you that the user ID is already in use. It is recommended that you add the company ID as a prefix to each user ID that you create to help ensure the uniqueness of your company's user IDs (e.g., rd_jsmith).

Note: This field is editable only by company administrators.

First Name
The user's first name. (required)

Last Name
The user's last name. (required)

Middle Initial
The user’s middle initial.

**Email Address**
A valid email address for the user. *(required)*
This setting must be set correctly. It is used for a user to reset his/her password and to receive important notifications from 1010data. Do not create an ID without a valid email address.

**Email List**
A space-separated list of additional email addresses associated with the user.

**Password**
An alphanumeric value containing between 6-15 characters.
The password can be set when creating a user, but it is not required. If a password is not specified, the system will generate a random one. If the administrator prefers to set the password, it should be set to a random string and should not be shared with the user. The existing password is not displayed due to security reasons. The correct way to provide the password to the user is to request that they click **Forgot Your Password?** on [www2.1010data.com](http://www2.1010data.com).

**Note:** Company administrators can set/change a password for any user. The user that is currently logged into 1010data may also change his or her own password using this field.

**Company Name**
The name of the company the user works for.

**Note:** This field is editable only by company administrators.

**Phone Number**
The phone number for the user.

**Street Address**
The street address for the user.

**City**
The city for the user.

**State**
The state for the user.

**Country**
The country for the user.

**Zip Code**
The zip code for the user.

**Profession**
The job title of the user.

**ID Information**

**Save changes to User Groups?**
Select this checkbox to modify a user’s group membership.

A company administrator can add or remove users to and from groups by adding or deleting groups from **User Groups**.

**Note:** Changes to **User Groups** will not take effect unless this checkbox has been selected.
User Groups

A space-separated list of all the groups to which this user belongs.

Idle Time

The amount of time (in minutes) the user can stay logged in without performing an action before they are logged out of the system.

This is important to set, as a user with a large amount of memory mapped can sit in the system and take up space, even though they are done with their work. A good default value for dormant time is 60 minutes, but this value can be changed to something smaller or slightly larger, if need be.

**Note:** This field is editable only by company administrators.

Deactivate

If this is set to **Yes**, the user is deactivated and can no longer log in to 1010data. If **No**, the user can log in and access the system.

**Note:** This field is available only to company administrators.

User Expiration Date

The date (in **YYYYMMDD** form) when this user account expires.

**Note:** After this date, the user will be denied access to the system.

You can click on the calendar icon (📅) to select the date from a date picker. Click anywhere outside the date picker to dismiss it.

**Note:** This field is editable only by company administrators.

Password Set Date

The user will be asked to change their password 45 days after this date. (The date appears in **YYYYMMDD** form.)

The default cycle of 45 days can be modified by setting the **Password Expiration Cycle**.

**Note:** When creating a user, it is recommended to set this to a date well in the past (e.g., one year before the date of creation) in order to make sure a user changes their default password when their user ID is given to them.

You can click on the calendar icon (📅) to select the date from a date picker. Click anywhere outside the date picker to dismiss it.

To turn off the password reset feature, clear the date in the **Password Set Date** field and save the changes for the user.

**Note:** This field is editable only by company administrators.

Password Expiration Cycle

The number of days the user will be asked to change their password after the **Password Set Date**.

**Note:** This field is editable only by company administrators.

User Creation Time

The date (in **YYYYMMDD** form) that this user was created in 1010data. *(read only)*

User Administrator

The user ID of the administrator that created this user in 1010data. *(read only)*

Previous Login Time

The date (in **YYYYMMDD** form) of this user's last login. *(read only)*
Previous Time User was Updated
The date (in YYYYMMDD form) this user’s information was last updated. (read only)

Previous User to Update ID
The user ID that last updated this user’s information. (read only)

Previous Version to Update ID
The version of 1010data that was used when this user’s information was last updated. (read only)

Account Settings
The Account Settings tab of the User Manager page contains account-related information for a particular user, including the default version of 1010data they log in to and the amount of local disk space they’re allowed to use.

Version
The version of 1010data this user is configured to use.

Possible values are:
- prod-latest
- beta-latest
- prod-x.yz
- beta-x.yz

where x.yz is the specific version (e.g., prod-9.53, beta-10.17)

Note: If a version is not specified for a user, the company version is the default. See Company Manager (admin only) on page 375 for more information.

Restricted IPs
The IP addresses from which this user is restricted to log into 1010data.

Note: This field is editable only by company administrators.

API Access
This specifies if the user has access to the 1010data API. (read only)

Client time-out period
When running long queries, your browser may time out after several minutes. You should be able to eliminate many of the time-outs by changing this setting to the time-out interval (or lower).

For example, if you are timing out after five minutes, set this to five minutes. If you are timing out after seven-and-a-half minutes, set it to seven minutes.

Please be aware that when a time-out period is set, your browser’s progress bar may not function properly.

Note: Time-outs are usually caused by your proxy server or firewall. If you experience such time-outs, first speak to your technology support person to see if they can change your proxy server or firewall settings. If that's not possible, then try changing this setting.

Maximum Download (Cells)
The number of cells a user can download in a single transaction.

Note: This field is editable only by company administrators.

Unlimited
When this checkbox is selected, there is no limit on the number of cells a user can download in a single transaction.

**Note:** This field is available only to company administrators.

**Maximum Download (Rows)**

The number of rows a user can download in a single transaction.

**Note:** This field is editable only by company administrators.

**Unlimited**

When this checkbox is selected, there is no limit on the number of rows a user can download in a single transaction.

**Note:** This field is available only to company administrators.

**Total Disk Space (GB)**

The amount of disk a user can use for saving tables.

A default of ~5GB is good as it will prevent large save tables that might be unintentional but will allow a regular user to make small tables. This is a ceiling for the disk space a user can use, but be aware that the value this compares against is not computed with 100% accuracy.

**Disk Space Used (GB)**

The total amount of disk space a user has already used for saving tables. *(read only)*

**Total Disk Space for FTP storage (GB)**

The amount of disk space a user can use for uploading tables via FTP. *(read only)*

To request FTP access, please email support@1010data.com.

**Worksheet Limit**

The maximum size of the foreign table when linking worksheets. *(read only)*

**Vendor ID**

The ID used to identify the user’s company in the vendor portal.

**Vendor Name**

The description of the user’s company in the vendor portal.

**Vendor Access Level**

The access level of the user’s company in the vendor portal.

**GUI Preferences**

The GUI Preferences tab of the User Manager page contains information related to a particular user’s preferences in the 1010data web interface.

**Note:** Many of these settings can also be changed using the Set Preferences dialog in the 1010data user interface. See Preferences on page 338 for more information.

**General**

**Favorite Folders and Tables (ids)**

A space-separated list of numeric table IDs that the user has flagged as favorites.

**Allow 0 row tables when the macro is annotated with empty**
When selected, this allows selections resulting in tables with 0 rows, if the macro contains `<meta>empty<meta>`.

If this is not selected (or if this is selected, but the macro does not contain the empty `<meta>` element), the user will receive an error saying that no rows were selected.

**Location**

**Time Zone**

The time zone that is used when showing the date and time on reports.

The options are presented as offsets to the Greenwich Mean Time.

For example, New York is in the Eastern Time Zone of the United States, and Eastern Standard Time (EST) is 5 hours behind Greenwich Mean Time. Therefore, the appropriate selection for New York would be GMT-5.

**Region Format**

This determines the order in which dates are presented (or downloaded as formatted values), when using the `date`, `date4y`, and `datehms24` display formats as well as how numbers (i.e., integers and decimals) are displayed.

<table>
<thead>
<tr>
<th>Region</th>
<th>Date</th>
<th>Date+Time</th>
<th>Integer</th>
<th>Decimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>MM/DD/YY</td>
<td>MM/DD/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>Europe</td>
<td>DD.MM.YY</td>
<td>DD.MM.YY_HH:MM:SS</td>
<td>10.000</td>
<td>0,001</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>DD/MM/YY</td>
<td>DD/MM/YY_HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
<tr>
<td>ANSI</td>
<td>YYYY-MM-DD</td>
<td>YYYY-MM-DD HH:MM:SS</td>
<td>10,000</td>
<td>0.001</td>
</tr>
</tbody>
</table>

**User Interface**

**Return focus to browser window**

When selected, the browser window regains focus after a query completes. If the browser window was behind other windows or was minimized, it becomes the active window.

By default, in certain operating systems (e.g., pre-Windows XP), whenever you get a response from the system, the browser window grabs the focus. You can disable this behavior by clearing this check box.

**Enable keyboard shortcuts**

When selected, keyboard shortcuts for switching tabs, editing actions, showing column information, and searching for items are enabled.

**Show "Run Macro" in the "File" menu**

In earlier versions of 1010data, queries could be saved as macros and run in this way. This option is provided for legacy reasons.

**Display progress bar**

When selected, a dialog containing a progress bar will appear while a query is processing. The progress bar shows the percentage of total operations completed within the current query.

**Show advanced query error information**

When selected, more detailed information related to query errors is presented.

**Enable the User Manager in the Admin App**
When enabled, users that are not administrators will see the **User Manager** tab from the **Account Administration** page. The information for that user will be pre-populated on the **User Manager** page. The **User Manager** tab replaces the **User Info** and **Change Password** tabs.

**Show column headings as**

The column heading, name, or a combination of both can be displayed at the top of each column in a table.

**the label**

The column heading will be displayed at the top of each column (e.g., **Unemployment Rate**).

```
<table>
<thead>
<tr>
<th>Unemployment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.9</td>
</tr>
<tr>
<td>9.4</td>
</tr>
<tr>
<td>8.7</td>
</tr>
</tbody>
</table>
```

**the name**

The column name will be displayed at the top of each column (e.g., **unemp_rate**).

```
<table>
<thead>
<tr>
<th>unemp_rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.9</td>
</tr>
<tr>
<td>9.4</td>
</tr>
<tr>
<td>8.7</td>
</tr>
</tbody>
</table>
```

**both the name and label**

Both the column heading and the column name will be displayed at the top of each column.

```
<table>
<thead>
<tr>
<th>Unemployment Rate</th>
<th>unemp_rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.9</td>
<td>8.9</td>
</tr>
<tr>
<td>9.4</td>
<td>9.4</td>
</tr>
<tr>
<td>8.7</td>
<td>8.7</td>
</tr>
</tbody>
</table>
```

**Handling of repeated values within a column**

This determines how repeated values will be displayed within a particular column in a table.

**the value**

If a particular cell has the same value as the cell in the row above it, the same value will be displayed in that cell. This is the default setting.
If a particular cell has the same value as the cell in the row above it, a ditto mark (\(\star\)) will be displayed in that cell.

### a ditto mark (fixed columns only)

Within a fixed column, if a particular cell has the same value as the cell in the row above it, a ditto mark (\(\star\)) will be displayed in that cell. Otherwise, if it is not a fixed column, the same value will be displayed.

### a blank (all columns)

If a particular cell has the same value as the cell in the row above it, the cell will appear blank.

---

**Note:** In this example the **State** column is fixed, but **Unemployment Rate** is not.
Within a fixed column, if a particular cell has the same value as the cell in the row above it, the cell will appear blank. Otherwise, if it is not a fixed column, the same value will be displayed.

**Note:** In this example the State column is fixed, but Unemployment Rate is not.

**In selection boxes, show columns in**

This determines how column headings will appear within the drop-down lists in row selection dialogs (e.g., **Select Rows, Find Row**).

- **the order that they appear in the table**
  
  Column headings will appear within the drop-down lists in the same order that they appear in the table.

- **alphabetical order**
  
  Column headings will appear in the drop-down lists in alphabetical order and will include column names for any linked tables.

- **alphabetical order but with columns from linked tables last**
  
  Column headings will appear in the drop-down lists in alphabetical order; however, column headings for any linked tables will appear separately (in alphabetical order) at the bottom of the list.

**Use combo boxes instead of select boxes**

When selected, combo boxes will be used instead of select boxes for the drop-down lists in all dialogs.

**Number of decimal places**

Specifies the number of decimal places to display for numbers in the 1010data grid.

**Number of Summarizations for Quick Summary**
The number of summarizations available in the *Quick Summary* dialog. The default is 10.

**Number of Grouping Columns for Tabulation**

The number of grouping columns available in the *Tabulation* dialog. The default is 3.

**Number of Summarizations for Tabulation**

The number of summarizations available in the *Tabulation* dialog. The default is 10.

**Number of Row Dimensions for Cross Tabulation**

The number of rows of results available in the *Cross Tabulation* dialog. The default is 3.

**Number of Column Dimensions for Cross Tabulation**

The number of columns of results available in the *Cross Tabulation* dialog. The default is 3.

**Number of Columns for Links**

The number of available columns to match when linking tables or worksheets using the link dialogs (e.g., *Link in Another Table, Link in Another Worksheet, Link and Select Rows*). The default is 3.

**Default folder path to save a quick query or new table**

The path to the folder where quick queries and new tables are saved by default. If no path is specified, the user's *My Data* folder is the default location.

**Macro Language**

**Enable syntax highlighting**

When selected, Macro Language elements, attributes, and values are color coded within the *Edit Actions (XML)* dialog.

```xml
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)'/">
<tabu label="Sales by Transaction ID' breaks="transid">
<tool source="sales" fun="sum" label="Sum of Sales'/">
<tool source="units" fun="sum" label="Sum of Units'/">
</tabu>
```

**Wrap text on Edit Actions page**

When selected, text that is too long to fit on one line in the *Edit Actions (XML)* dialog is wrapped to the next line.

In the following example, the `<note>` element on line 2 wraps to the next line.

```xml
<note type="base">Applied to table: training.retail.item</note>
<note type="link">The following link is to table: All Databases/Training Examples/Retail/Product Master</note>
<link table2="training.retail.prod" col="sku" col2="sku"/>
```

If this option was not selected, the `<note>` element would appear only on one line (and a horizontal scroll bar would appear at the bottom of the *Edit Actions (XML)* dialog).
Note: This option is only available when **Enable syntax highlighting** is selected.

**Automatically indent on Edit Actions page**

When selected, the line following an opening tag for a particular Macro Language element is indented by the number of spaces specified by **Indent spaces for nested elements**.

For instance, the following screen shot shows the automatic indentation of the line following the opening `<tabu>` tag:

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<tabu label="Sales by Date" breaks="date">
  <tcol source="sales" fun="sum" label="Sum of `Sales"/>
</tabu>
```

If this option is not selected, the line following the opening `<tabu>` tag is not indented:

```xml
<note type="base">Applied to table: pub.demo.retail.item</note>
<tabu label="Sales by Date" breaks="date">
  <tcol source="sales" fun="sum" label="Sum of `Sales"/>
</tabu>
```

**Enable autocomplete**

When selected, a drop-down menu of context-related options is presented as you type in Macro Language element names, attributes, and values for certain attributes (such as functions) in the **Edit Actions (XML)** dialog.

For instance, if you type `<` in the **Edit Actions (XML)** dialog, a list of context-dependent element names will be presented.

```xml
<note type="base">Applied to table: training.retail.item</note>
<sel value="[date=20120515]"/>
```

If you type `fun="` when you are specifying a tabulation column `<tcol>` element, a list of summarization functions will appear in the drop-down list.
Note: This option is only available when **Enable syntax highlighting** is selected.

**Indent spaces for nested elements**

The number of spaces to indent nested Macro Language elements. The default is 2.

In the following example, the `<tcol>` elements nested within the `<tabu>` element are indented two spaces.

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" break="transid">
    <tcol label="Sales" fun="sum" label="Sum of Sales"/>
    <tcol label="Units" fun="sum" label="Sum of Units"/>
</tabu>
```

**Put each attribute on a separate line**

When selected, each attribute for a particular Macro Language element will appear on its own line.

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" break="transid">
    <tcol label="Sales" fun="sum" label="Sum of Sales"/>
    <tcol label="Units" fun="sum" label="Sum of Units"/>
</tabu>
```

The default is for all attributes to appear on the same line:

```
<note type="base">Applied to table: training.retail.item</note>
<sel value="(date=20120515)"/>
<tabu label="Sales by Transaction ID" break="transid">
    <tcol label="Sales" fun="sum" label="Sum of Sales"/>
    <tcol label="Units" fun="sum" label="Sum of Units"/>
</tabu>
```

**Break up long selection and value expressions**

When selected, this breaks up lengthy value expressions in `<sel>` statements over multiple lines, with each selection criterion on a separate line, prefaced by an `&`. 
In a `<link>`, show the linked table ID instead of its name

Select whether a table ID or a table name (path) will be displayed as the value of the `table2` attribute for a `<link>` element in the Macro Language.

**name**

In the Edit Actions (XML) dialog, the value of the `table2` attribute for a `<link>` element is displayed as the table's name.

```
<note type="base">Applied to table: training.retail.item</note>
<note type="link">The following link is to table: All Databases/Training Examples/Retail/Product Master</note>
<link table2="training.retail.prod" col="sku" col2="sku"/>
```

**ID**

In the Edit Actions (XML) dialog, the value of the `table2` attribute for a `<link>` element is displayed as the table's ID.

```
<note type="base">Applied to table: training.retail.item</note>
<note type="link">The following link is to table: All Databases/Training Examples/Retail/Product Master</note>
<link table2="1835009" col="sku" col2="sku"/>
```

Automatically add comments for the following

When selected, a `<note>` element containing a comment is automatically added for the table that the macro is being applied to and the table that is being linked to.

In the following example:

- The `<note>` on line 1 contains the comment that was automatically added about the table the macro was applied to (`training.retail.item`).
- The `<note>` on line 2 contains the comment that was automatically added about the table that was linked to (`training.retail.prod`) in the `<link>` statement on line 3.

```
<note type="base">Applied to table: training.retail.item</note>
<note type="link">The following link is to table: All Databases/Training Examples/Retail/Product Master</note>
<link table2="1835009" col="sku" col2="sku"/>
```

**Downloads**

**Excel Downloads**

Choose whether tables downloaded in Excel format should be decorated with colorful borders, fills, and fonts (and include tabulation totals), or if they should appear as plain data.

**Decorated with totals**

Tables will be decorated with colorful borders, fills, and fonts. Also, totals will appear at the top of tabulation columns.
Tables will not be decorated with any special formatting, and totals will not appear at the top of tabulation columns.

### End-of-record delimiter
Select whether a line feed, or carriage return and line feed, are used to signify the end of a record.

**LF**
A line feed will be used as the end-of-record delimiter.

**CRLF**
A carriage return and line feed will be used as the end-of-record delimiter.

### Include an end-of-record delimiter after the last record
Select whether an end-of-record delimiter should be included after the last record.

### Advanced

#### Display NA for error or “infinity” values
Some computations (e.g., dividing by zero) can result in errors or “infinity” values (0\text{i}, -0\text{i}, 0\text{i}, or -0\text{i}). Selecting this option can help reduce or eliminate this behavior.

Specifically:

- Division by zero \((X/0)\) returns 0\text{i} or -0\text{i} if the numerator is not zero.
  
  Checking this box causes \text{N/A} to be returned instead of 0\text{i} and -0\text{i}.
- Exponentiation \((X^Y)\) can generate error messages if \(X\) is negative.
  
  Checking this box mostly eliminates such messages and causes \text{N/A} to be returned in the event of an error.
- The range functions \((\text{rangel}, \text{rangelf}, \text{etc.})\) return 0\text{i}, -0\text{i}, 0\text{i}, or -0\text{i} for column values that lie outside the specified ranges.
  
  Checking this box causes \text{N/A} to be returned instead.

#### Do step-wise aggregation
Select this option to help alleviate virtual memory problems when working with large tables. Using this feature saves memory but is slower.

### Blocking Level
Select lower numbers to help alleviate virtual memory problems when doing row selections and tabulations on large tables. Lower numbers save memory but may cause queries to run slower.

**Enable Query Scheduler**

When enabled, the Query Scheduler tab shows up in the Account Administration toolbar. The Query Scheduler allows you to run scheduled reports.

Certain other settings are needed for users to be able to run scheduled reports (e.g., API access, FTP folder setup), so before turning this on, a company administrator should email support@1010data.com and request access for the target user.

See Query Scheduler on page 131 for more information.

**Note:** This setting is available to all company administrators.

**Enable Powerloader UQ via Advanced upload button**

When enabled, the Advanced button will be displayed when the user clicks the Upload icon in the Folders and Tables toolbar. The Advanced button provides access to the Advanced Upload feature.

The Advanced Upload feature provides many options for fine-grained control over the data you are uploading. In addition, the Advanced Upload feature is recommended when uploading a file in the user interface that is larger than 20 MB in size.

**Note:** This setting is available to all company administrators.

**Edit your user information**

You can change user information, account settings, and GUI preferences associated with the 1010data user ID that you used to log into the current session.

To edit the information associated with your 1010data user ID:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.
   
   The Account Administration page is opened in a new tab.

2. On the Account Administration toolbar, click the User Manager icon ( ).

   **Note:** If the User Manager icon ( ) is not available in the Account Administration toolbar, contact support@1010data.com to have it enabled. If you cannot access the User Manager, you can still change certain items in your user profile. See Change your user profile information on page 349 and Change your password on page 350 for more information.

3. Make your changes to the desired fields under User Info, Account Settings, and GUI Preferences.

4. Click Save User.

If your changes have been successfully saved, you will see the message: Changes were saved!

**Create a new user (admin only)**

A company administrator can create a new user in 1010data.

**Note:** If you have a large number of users to create, or simply know of a user whose preferences and settings may already match your new user, you can use that existing user as a template for creating the new user. Simply find the existing user you want to use as the template, select that user (as if you were going to edit the user's information), modify the fields with the new user's information (at minimum, you should update all the required fields), and click Create New User.

Alternatively, you can add multiple users by providing a CSV file containing all the relevant information for each user. See Create multiple users (admin only) on page 366 for more information.
To create a new user:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.
   
   The Account Administration page is opened in a new tab.

2. On the Account Administration toolbar, click the User Manager icon.

3. Enter the information in the User Info, Account Settings, and GUI Preferences tabs for the new user.

   Note: Required fields are denoted by a red asterisk.

4. Click Create New User.

   If you receive a message similar to the following: Transaction failed: requid is not authorized to assign this server, contact support@1010data.com.

Create multiple users (admin only)

A company administrator can create multiple 1010data users by uploading a CSV file containing the users’ information.

You need specific access to the bulkedit/bulkadd functionality. To request this functionality, please email support@1010data.com.

In addition, you must have a CSV file containing the users’ information. For details on what that file may contain as well as an example, see Bulk edit file format on page 367.

To create multiple users:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.

   The Account Administration page is opened in a new tab.

2. On the Account Administration toolbar, click the User Manager icon.

3. Click Create Multiple Users.

4. Click Choose File (or Browse) and select the CSV file containing the users’ information.

5. Click Upload.

   This uploads the file to your My Data folder, reads the data, and creates the new ids.

   During this process, you’ll see some of the following status messages appear:

   1. Your file is uploading...
   2. Upload Successful! or Upload failed: error
   3. Reading table...
   4. Table Read Successful! or Failed to read uploaded table: error
   5. Creating users...

   If all users were created successfully, the status changes to Users Created!, and the newly created user IDs are displayed in an area below the search box. You are then automatically placed in bulk edit mode, where you can make changes to the IDs you just created and can click Save Multiple Users to save those changes. To exit this mode, click Clear Form.

   If there were any errors with the creations, the status changes to BULKEDIT: Some users failed, see above error msg(s), and any error messages are displayed in an area below the search box.

   If you receive a message similar to the following: Transaction failed: requid is not authorized to assign this server, contact support@1010data.com.
### Bulk edit file format

Company administrators can create multiple users at one time by providing a CSV file containing the information for those users.

### User Fields

The following table contains all available user fields along with their descriptions, valid values, and sample inputs.

For more detailed information about each of these fields, see:

- *User Info* on page 351
- *Account Settings* on page 354
- *GUI Preferences* on page 355

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Type</th>
<th>Sample Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>uid</td>
<td>User ID</td>
<td>text</td>
<td>mycomp_jsmith</td>
</tr>
<tr>
<td>first</td>
<td>First name</td>
<td>text</td>
<td>John</td>
</tr>
<tr>
<td>last</td>
<td>Last name</td>
<td>text</td>
<td>Smith</td>
</tr>
<tr>
<td>mi</td>
<td>Middle initial</td>
<td>text</td>
<td>R</td>
</tr>
<tr>
<td>email</td>
<td>Email address</td>
<td>text</td>
<td><a href="mailto:jsmith@mycomp.com">jsmith@mycomp.com</a></td>
</tr>
<tr>
<td>emaillist</td>
<td>Email list</td>
<td>text</td>
<td><a href="mailto:johnsmith@gmail.com">johnsmith@gmail.com</a></td>
</tr>
<tr>
<td>company</td>
<td>Company name</td>
<td>text</td>
<td>My Company</td>
</tr>
<tr>
<td>phone</td>
<td>Phone number</td>
<td>text</td>
<td>123-456-7890</td>
</tr>
<tr>
<td>street</td>
<td>Street address</td>
<td>text</td>
<td>10 Main Street</td>
</tr>
<tr>
<td>city</td>
<td>City</td>
<td>text</td>
<td>New York</td>
</tr>
<tr>
<td>state</td>
<td>State</td>
<td>text</td>
<td>NY</td>
</tr>
<tr>
<td>country</td>
<td>Country</td>
<td>text</td>
<td>USA</td>
</tr>
<tr>
<td>zip</td>
<td>Zip code</td>
<td>text</td>
<td>10101</td>
</tr>
<tr>
<td>profess</td>
<td>Profession</td>
<td>text</td>
<td>Analyst</td>
</tr>
<tr>
<td>dormantmin</td>
<td>Idle time (minutes)</td>
<td>integer</td>
<td>60</td>
</tr>
<tr>
<td>inactive</td>
<td>Deactivate</td>
<td>Valid values are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1</td>
<td></td>
</tr>
<tr>
<td>expiredate</td>
<td>User expiration date</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(YYYYMMDD)</td>
<td>20201231</td>
</tr>
<tr>
<td>pwddate</td>
<td>Password set date</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(YYYYMMDD)</td>
<td>20010101</td>
</tr>
<tr>
<td>pwdatecycle</td>
<td>Password expiration cycle</td>
<td>integer</td>
<td>45</td>
</tr>
<tr>
<td>version</td>
<td>Version</td>
<td>text</td>
<td>prod-9.53</td>
</tr>
<tr>
<td>ip</td>
<td>Restricted IPs</td>
<td>text</td>
<td>127.0.0.1</td>
</tr>
<tr>
<td>timeout</td>
<td>Client time-out period (seconds)</td>
<td>integer</td>
<td>600</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Type</td>
<td>Sample Input</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>maxdown</td>
<td>Maximum download (cells)</td>
<td>integer</td>
<td>100000</td>
</tr>
<tr>
<td>maxrows</td>
<td>Maximum download (rows)</td>
<td>integer</td>
<td>100000</td>
</tr>
<tr>
<td>totdisk</td>
<td>Total disk space (GB)</td>
<td>integer</td>
<td>5000000</td>
</tr>
<tr>
<td>timezone</td>
<td>Time zone (GMT offset)</td>
<td>integer</td>
<td>-5</td>
</tr>
<tr>
<td>region_fmt</td>
<td>Region format</td>
<td>text</td>
<td>US</td>
</tr>
<tr>
<td>favorites</td>
<td>Favorite folders and tables (IDs)</td>
<td>space-separated</td>
<td>174638 374757</td>
</tr>
<tr>
<td>err_stack_info</td>
<td>Show advanced query error information</td>
<td>Valid values are:</td>
<td>0</td>
</tr>
<tr>
<td>focus</td>
<td>Focus browser on query completion</td>
<td>Valid values are:</td>
<td>1</td>
</tr>
<tr>
<td>shortcut</td>
<td>Enable keyboard shortcuts</td>
<td>Valid values are:</td>
<td>1</td>
</tr>
<tr>
<td>allow_empty_tables</td>
<td>Allow 0 row tables when macro is annotated with empty</td>
<td>Valid values are:</td>
<td>1</td>
</tr>
<tr>
<td>grid_labels</td>
<td>Grid labels</td>
<td>Valid values are:</td>
<td>both</td>
</tr>
<tr>
<td>showids</td>
<td>Show table IDs instead of paths in Macro Language code</td>
<td>Valid values are:</td>
<td>0</td>
</tr>
<tr>
<td>ditto</td>
<td>Handling of repeated values within column</td>
<td>Valid values are:</td>
<td>blank</td>
</tr>
<tr>
<td>sortcols</td>
<td>Column order in selections</td>
<td>Valid values are:</td>
<td>0</td>
</tr>
<tr>
<td>combo</td>
<td>Use combo boxes</td>
<td>Valid values are:</td>
<td>0</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Type</td>
<td>Sample Input</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------------</td>
</tr>
<tr>
<td>inf2na</td>
<td>Reduce the number of 0i's</td>
<td>Valid values are: 0, 1</td>
<td>0</td>
</tr>
<tr>
<td>excel_d1</td>
<td>Excel downloads</td>
<td>Valid values are: new, old</td>
<td>old</td>
</tr>
<tr>
<td>down_eor</td>
<td>End-of-record delimiter in downloads</td>
<td>Valid values are: lf, crlf</td>
<td>crlf</td>
</tr>
<tr>
<td>down_last</td>
<td>Include a record delimiter at end of file downloads</td>
<td>Valid values are: 0, 1</td>
<td>1</td>
</tr>
<tr>
<td>tab_condense</td>
<td>Do step-wise aggregation</td>
<td>Valid values are: 0, 1</td>
<td>1</td>
</tr>
<tr>
<td>s_res_n</td>
<td>Number of summarizations for quick summary</td>
<td>integer</td>
<td>20</td>
</tr>
<tr>
<td>maxrows_blk</td>
<td>Tabulation block size</td>
<td>integer</td>
<td>2</td>
</tr>
<tr>
<td>t_breaks_n</td>
<td>Number of grouping columns for tabulation</td>
<td>integer</td>
<td>6</td>
</tr>
<tr>
<td>t_res_n</td>
<td>Number of summarizations for tabulation</td>
<td>integer</td>
<td>20</td>
</tr>
<tr>
<td>x_rbreaks_n</td>
<td>Number of row dimensions for cross tabulation</td>
<td>integer</td>
<td>10</td>
</tr>
<tr>
<td>x_cbreaks_n</td>
<td>Number of column dimensions for cross tabulation</td>
<td>integer</td>
<td>10</td>
</tr>
<tr>
<td>l_cols_n</td>
<td>Number of columns for links</td>
<td>integer</td>
<td>20</td>
</tr>
<tr>
<td>syntax_h</td>
<td>Enable syntax highlighting in Edit Actions (XML) dialog</td>
<td>Valid values are: 0, 1</td>
<td>1</td>
</tr>
<tr>
<td>oe_wrap</td>
<td>Wrap text on Edit Actions (XML) dialog</td>
<td>Valid values are: 0, 1</td>
<td>1</td>
</tr>
<tr>
<td>progressbar</td>
<td>Show the progress bar</td>
<td>Valid values are: 0, 1</td>
<td>1</td>
</tr>
</tbody>
</table>
## Field Name | Description | Type | Sample Input
--- | --- | --- | ---
auto_hint | Enable autocomplete in **Edit Actions (XML)** dialog | Valid values are: 0, 1 | 1
nestmacro | Number of spaces to indent nested elements in Macro Language code | integer | 3
splitattr | Show each attribute on a separate line in Macro Language code | Valid values are: 0, 1 | 0
splitexpr | Show each ANDed expression on a separate line in Macro Language code | Valid values are: 0, 1 | 0
autocomment | Autocomment Macro Language code | Valid values are: base, link, base link | link

### Example

The following is an excerpt from a sample CSV file:

<table>
<thead>
<tr>
<th>uid,first,last,email,dormantmin,expiredate,progressbar</th>
</tr>
</thead>
<tbody>
<tr>
<td>mycomp_jsmith,John,Smith,<a href="mailto:jsmith@mycomp.com">jsmith@mycomp.com</a>,60,20201231,0</td>
</tr>
<tr>
<td>mycomp_manderson,Maggy,Anderson,<a href="mailto:manderson@mycomp.com">manderson@mycomp.com</a>,60,,0</td>
</tr>
</tbody>
</table>

### Find existing users (admin only)

A company administrator can search for existing 1010data users based on certain criteria such as user ID, first name, last name, email, or company name. They could also get a list of all users by entering no criteria at all.

To find existing users:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.
   
   The **Account Administration** page is opened in a new tab.

2. On the **Account Administration** toolbar, click the **User Manager** icon (🔗).

3. In the text box at the top of the form, enter the first name, last name, ID, email, or company name of the user(s) you want to find.

   **Note:** To see a list of all the users you have permission to access, leave the text box empty.

4. Click **Find Users** (or press **Enter**).

   A list of users that match your search criteria is presented beneath the search text box. If no users are found matching your search criteria, you will see the message: "No users found".

   **Note:** The search is not case sensitive, and partial matches are listed.

In the results list, click the desired **User ID** to populate the **User Manager** with its information, or click anywhere outside the results list to dismiss it.
Edit an existing user (admin only)

A company administrator can edit an existing 1010data user's information.

To edit an existing user's information in 1010data:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.

   The Account Administration page is opened in a new tab.

2. On the Account Administration toolbar, click the User Manager icon ().

3. In the text box at the top of the form, enter the first name, last name, ID, email, or company name of the user(s) you want to find.

   Note: To see a list of all the users you have permission to access, leave the text box empty.

4. Click Find Users (or press Enter).

   A list of users that match your search criteria is presented beneath the search text box. If no users are found matching your search criteria, you will see the message: "No users found".

   Note: The search is not case sensitive, and partial matches are listed.

5. In the search results list, click the username whose information you want to edit.

6. Make your changes to the desired fields in the User Info, Account Settings, and GUI Preferences tabs.

7. Click Save User.

   If you receive a message similar to the following: Transaction failed: requid is not authorized to assign this server, contact support@1010data.com.

   If your changes have been successfully saved, you will see the message: Changes were saved!

Edit multiple existing users (admin only)

A company administrator can edit the information for more than one existing 1010data user at the same time. This is helpful when you may want to make changes to certain fields or settings and apply those changes to a number of users.

You need specific access to the bulkedit/bulkadd functionality. To request this functionality, please email support@1010data.com.

To edit multiple existing 1010data users' information:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.

   The Account Administration page is opened in a new tab.

2. On the Account Administration toolbar, click the User Manager icon ().

3. Specify the users whose information you want to edit by performing one of the following actions.

   • Press Save Multiple Users and enter a space- or newline-separated list of the user IDs you want to modify.
   • Find the users you want to modify (see Find existing users (admin only) on page 370), click the checkbox associated with each user whose information you want to edit (or select the All Users checkbox if you want to select all of the users that appear in the search results list), and click Submit.

   Note: You can repeat this step to add more user IDs to the set that you are modifying.

4. Make your changes to the desired fields in the User Info, Account Settings, and GUI Preferences tabs.

5. Click Save Multiple Users.
A notification dialog is displayed that says any populated field on the User Manager tabs will replace the corresponding field in the selected users.

6. Click OK if you wish to continue.

If your changes have been successfully saved, you will see the message: Users Updated!

### Deactivate an existing user (admin only)

A company administrator can deactivate an existing user in 1010data.

To deactivate an existing user:

**Note:** 1010data does not allow you to delete users, only deactivate them.

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page is opened in a new tab.

2. On the **Account Administration** toolbar, click the **User Manager** icon (🔍).

3. In the text box at the top of the form, enter the first name, last name, ID, email, or company name of the user(s) you want to find.

   **Note:** To see a list of all the users you have permission to access, leave the text box empty.

4. Click **Find Users** (or press **Enter**).

   A list of users that match your search criteria is presented beneath the search text box. If no users are found matching your search criteria, you will see the message: "No users found".

   **Note:** The search is not case sensitive, and partial matches are listed.

5. In the search results list, click the username that you want to deactivate.

6. Click **Deactivate User**.

   You will be presented with a dialog confirming that you want to deactivate the user.

7. Click **OK**.

   The user will be deactivated and will no longer be able to log in to 1010data and access the system. On their next attempt to log in, they will be notified that their user ID has been suspended and will be prompted to contact support@1010data.com.

   You can also deactivate a user by editing that user's information and setting the **Deactivate** field in the **User Info** tab to **Yes**, then clicking **Save User**. Conversely, you can reactivate a user by setting the **Deactivate** field to **No**.

### Group Manager

The **Group Manager** allows you to create, find, edit, and delete your own groups in 1010data.

The **Group Manager** provides a centralized place where you can manage your groups. A group is a set of users and/or other groups. Groups can help you manage the permission you give users to view and edit such items as your folders, tables, and queries. You can share access with a group, thereby eliminating the need to share access with each individual in the group.

**Note:** You can only manage groups that you own; however, company administrators can manage any group owned by any ID in the company.

### Create a new group

Create a new group of 1010data users.

To create a new group in 1010data:
1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Group Manager** icon 🗯.

3. In the **Group ID** text box, enter the name of the group. *(required)*

   The **Group ID** can only contain letters, numbers, and underscores. It cannot contain any spaces or other special characters.

   **Note:** You cannot change the name of the group once it has been created.

4. Select which value to use for the **Group ID prefix**.

   The selected value will be automatically prepended to the value you enter in the **Group ID** text box:

   - **User ID** - Your user ID will be automatically prepended to the value you enter in the **Group ID** text box (e.g., `rd_jsmith_marketingteam`).
   - **Company ID** - Your company ID will be automatically prepended to the value you enter in the **Group ID** text box (e.g., `acme_supportgroup`).

5. In the **Owner** box, enter the name of the owner of the group. *(required)*

   This field will contain your user ID by default, but it may be changed so that you can assign a different owner to the group. This must be a valid user ID; otherwise, you will receive an error when you try to create the group.

6. In the **Users** box, enter a space-separated list of usernames that you would like to include in this group. *(optional)*

   If there are any invalid usernames (i.e., do not exist, do not have the same company ID), an error message will be returned when you try to create the new group.

7. In the **Title** text box, enter a title to help identify the group. *(optional)*

   The title may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters.

8. In the **Description** text box, enter a description about the group. *(optional)*

9. Click **Create New Group**.

   The group is created.

   The following values in the **Group Manager** are populated:

   - **Group Creation Time**
   - **Previous Time Group was Updated**
   - **User to Create Group**
   - **Previous User to Update Group**
   - **Previous Version to Update Group**

   **Note:** These values cannot be changed by the user.

---

**Find an existing group**

Find an existing 1010data group.

To find an existing group in 1010data:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Group Manager** icon 🗯.
3. In the text box at the top of the form, enter the group title, group owner, or group ID associated with the group you want to find, or leave the text box empty to see a list of all the groups you own.

4. Click **Find Groups** (or press **Enter**).

   A list of groups that match your search criteria is presented beneath the search text box. If no groups are found matching your search criteria, you will see the message: "No groups found".

   **Note:** The search is not case sensitive, and partial matches are listed.

   In the results list, click on a group to populate the **Group Manager** with its information, or click anywhere outside the results list to dismiss it.

---

**Edit an existing group**

Edit the details of an existing 1010data group.

To edit an existing group in 1010data:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Group Manager** icon (ți).

3. Find the group that you want to edit.

4. Make your desired changes:
   a) In the **Users** box, enter a space-separated list of usernames that you would like to include in this group. *(optional)*

      If there are any invalid usernames (i.e., do not exist, do not have the same company ID), an error message will be returned when you try to save the changes.
   b) In the **Title** text box, enter a title to help identify the group. *(optional)*
   c) In the **Description** text box, enter a description about the group. *(optional)*

   **Note:** You cannot change the **Group ID** or the **Owner** once the group has been created.

5. Click **Save Group**.

   If your changes have been successfully saved, you will see the message: *Changes were saved!*

---

**Delete an existing group**

Delete an existing 1010data group.

You must be the owner of a group to delete it.

To delete an existing group in 1010data:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click **Admin**.

   The **Account Administration** page will be opened in a new tab.

2. On the **Account Administration** toolbar, click the **Group Manager** icon (ți).

3. Find the group that you want to delete.

4. Click **Delete Group**.

   You will be presented with a dialog confirming that you want to delete the group.

5. Click **OK**.
Company Manager (admin only)

The Company Manager allows a company administrator to change company-related information within 1010data.

**Company ID**
A unique combination of alphanumeric characters and underscores specifying the ID of the company. *(read only)*

**Company**
The name of the company.

**Administrator ID**
The user ID of the company administrator(s). *(read only)*

**Administrator**
The full name of the company administrator.

**Maximum # of IDs**
The maximum number of active user IDs that a company is allowed to own. *(read only)*

**Maximum # of concurrent logins**
The maximum number of users in the company that can be logged in at the same time. *(read only)*

**Users (read only)**
A listing of all user IDs owned by the company. *(read only)*

**Active Users count**
The number of active user IDs owned by the company.

- The Calculate button initiates this calculation.

  **Note:** This calculation can be resource intensive. If the company owns many user IDs, this action could take some time and possibly lock the session.

**Street Address**
**City**
**State**
**Zip Code**
**Country**
The full address of the company.

**Email Address**
The primary email address associated with the company.

**Email List**
A space-separated list of additional email addresses associated with the company.

**Phone Number**
The phone number of the company.

**Version**
The version of 1010data the company (and, by default, all users within the company) is configured to use.
Possible values are:

- prod-latest
- beta-latest
- prod-x.yz
- beta-x.yz

where $x.yz$ is the specific version (e.g., prod-6.92, beta-7.36)

Note: The company version is used by default for users who do not have a specific version set for their particular ID.

Company Creation Time

The date (in YYYYMMDD form) that this company was originally created in 1010data. (read only)

Previous Time Company was Updated

The date (in YYYYMMDD form) this company's information was last updated. (read only)

User to Create Company

The user ID of the administrator who created this company in 1010data. (read only)

Previous User to Update Company

The user ID of the administrator who previously updated this company's information. (read only)

Previous Version to Update Company

The version of 1010data that was used when this company's information was last updated. (read only)

Edit company information (admin only)

A company administrator can edit an existing company's information in 1010data.

To edit a company's information in 1010data:

1. Under the drop-down menu corresponding to your username in the top right corner of your 1010data session, click Admin.
   
   The Account Administration page will be opened in a new tab.

2. On the Account Administration toolbar, click the Company Manager icon ( الرغم).

3. Make your changes to the desired fields.

4. Click Save Company.

   If your changes have been successfully saved, you will see the message: Changes were saved!
Localization

1010data offers support for data localization via currency and date formats, as well as UTF-8 encoding. Localization is the process of adapting a product or content for specific locale, country, region, or market. 1010data offers support for data that is specific to a particular place in the world. 1010data clients operate with local data in areas as varied as Germany, China, and the United States.

**Note:** While 1010data supports localized data, the web interface and documentation are not currently available in other languages.

UTF-8 encoding for data displayed in most languages

UTF-8 is a data encoding standard with built-in support for most world languages, such as Mandarin. 1010data’s support for UTF-8 encoding enables localization support as follows:

- Textual data, including product descriptions, addresses, and metadata, can be loaded and displayed in any language
- Data loaded using valid UTF-8 characters will be properly displayed in the 1010data web interface
- Data downloaded using available targets, such as Excel and delimited files, will display correctly assuming an application with UTF-8 support is used to view the file

Support for most world currencies via display formats

1010data can display accurate formats for most world currencies. For a list of all supported currency formats, see the [Currency Unit Codes](#) topic in the 1010data User's Guide.

For an example of how to use the currency unit codes, see the example in the Display Formats topic of the 1010data User's Guide.

Support for most date and numeric display formats

1010data also has many available options for displaying dates and other numeric forms of data. Display format functionality provides considerable flexibility for displaying numeric data. For instance, the number 1,234,567.89 can also be displayed as 1234567.89 using a `nocommas` display format. For a full list of available display formats, see the [Display Formats](#) topic of the 1010data User's Guide.

In addition to display format specifiers, user preferences exist for dates and numeric numbers. Showing dates and numbers in the European convention can be done by setting the appropriate Location Preferences.
Appendix A: Missing Values

Most databases contain at least some missing data values. The values may be missing due to non-availability, non-applicability, data processing errors, or even intentional omission. Missing values are also referred to as "N/A" values (for "not available" or "not applicable").

N/A values can also be created as a result of certain analyses. Here are some examples:

- A cross tabulation produces results for every combination of values from the specified grouping columns. If there is no data for certain combinations, those results are N/A. For example, suppose we are analyzing a company’s sales. The database shows the details of each transaction, including the product sold, the location in which it was sold, and dollar value of the sale. What we would like to know is the average sale size in dollars for each product in each location, a natural cross tabulation. But suppose that a particular product is not sold in a particular location. The average sale size for that product and location is N/A and shows as blank in the result of the cross tabulation.

- When tables are linked, if a particular row in the current table has no match in the "foreign" table, the row is padded with N/A values. For example, suppose we are looking at employee data and we have two tables that give information about each employee. The first shows the address for each employee and the second shows salary-related information. If we were looking at the address table and linked in the salary table, we would have a table that showed both address information and salary information. But suppose that, for some reason, there is no salary information for a particular employee; the salary for that employee shows as blank (N/A) in the combined table.

- Computed columns can have N/A values. This usually happens when one or more of the referenced columns contain N/As, but certain computations can produce N/A results even if the inputs are not N/A.

Accurate analysis requires understanding the nature and source of N/A values and the appropriate ways of dealing with them. The following sections describe how N/A values are represented in the system and how they are handled in selection and value expressions and tabulations. Some additional techniques for handling such values are discussed as well.

Representing N/A Values

The first thing we should say is that missing values aren't really missing. That may sound like a contradiction in terms, but here is what we mean: When you see a blank value, it isn't that there is no value there at all, rather there is a special value that indicates that meaningful data is missing. The special value may display as blank, but in the database there really is a value. That is why we prefer to refer to a missing value as an N/A value.

Special values are commonly used to represent missing or meaningless data, although different people use different values. The number 999, for example, it often used as a numeric N/A value, especially in a column containing whole numbers. Take the table:

<table>
<thead>
<tr>
<th>Name</th>
<th>Age</th>
</tr>
</thead>
<tbody>
<tr>
<td>Susan</td>
<td>31</td>
</tr>
<tr>
<td>Tom</td>
<td>25</td>
</tr>
<tr>
<td>Dick</td>
<td>40</td>
</tr>
<tr>
<td>Harry</td>
<td>999</td>
</tr>
<tr>
<td>Jane</td>
<td>34</td>
</tr>
</tbody>
</table>

Since it is unlikely that anyone will actually be 999 years old, it is safe to use 999 as the N/A value for age. 999 also has the nice property that it is easily recognizable. Similarly, values like 999.99 or 999.999 are often used for decimal numbers.

In 1010data, we use our own special values. For example, in columns that contain text, we use "" (the empty string). In numeric columns, we use one of two other values, depending on whether the column
contains whole numbers or decimal numbers. What these values are isn't really important; what is important is that they are treated differently than other values.

1. They display as blank.
2. They are treated specially in selection and value expressions and tabulations. For example, if a computed column's value expression is `col1+col2` and `col1` (or `col2`) is N/A on a particular row, the computed column will also be N/A on that row. (See the following sections about N/A handling in selection and value expressions and tabulations.)

Because the system automatically treats these values specially, we try to use them to represent N/As whenever we can. When loading data into a table, if the source data contains other types of N/A values (999, 999.99, NA, etc.), we usually convert those values into our N/A values. We do not convert such values unless the technical documentation for the data specifically says the values are in fact N/A values or if it is patently obvious that is the case. It is therefore entirely possible that some columns in some tables may contain 999, for instance. Please be aware of this when doing computations; if `col1` has 999s in it, and you compute `col1+col2`, the result may not be terribly meaningful!

**Looking for N/A Values**

Before using a database, it is only prudent to see how many N/A values there are in various columns. There are many ways of doing this.

You can use row selection to select rows where a particular column is N/A. For example:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>has the value(s)</th>
<th>N/A</th>
</tr>
</thead>
</table>

Or you can tabulate on the column to get all its unique values and look for N/A in the result.

But perhaps the most convenient method is to use the tabulation summary designed for this very purpose: number of N/As. In a quick summary, this allows you to determine the number of N/As in each of several columns in one operation and, in a tabulation or cross tabulation, to determine the number of N/As for each group. Related summarization methods include number of valid values, number of valid pairs, and number of N/A pairs.

**Automatic Handling of N/A Values**

N/A values are handled automatically in selection and value expressions and tabulations.

**N/A Values in Selection and Value Expressions**

Assuming that missing values are represented by our special N/A values, what happens when these values are used in a computation? Specifically, if we create a computed column that references one or more other columns, and those columns contain N/As, what will be the value of the computed column?

For example, if `col3` is `col1+col2` and one or both of `col1` and `col2` are N/A, what will `col3` be? What if `col3` is `col1>col2` or `round(col1;10)`?

For most functions and operators, if any argument is N/A, the result is N/A, but this is not always true. See the description of each operator and function for details about N/A handling.

**N/A Values in Tabulations**

What happens when N/A values are encountered in a quick summary or tabulation?

For example, when summing the values in a particular group of rows, what if some of the values are N/A?

The answer is that, as a general rule of thumb, N/A values are ignored. In the case of sum, for example, the result is the sum of the non-N/A values. But there are exceptions to the rule. See the description of each summary type for details about N/A handling in quick summaries, tabulations, and cross tabulations.
Manual Handling of Missing or Invalid Values

1010data's built-in N/A handling often provides satisfactory results, but there are cases where it makes sense to deal directly with N/As or invalid values.

These are some that are commonly used techniques for dealing with N/A or invalid values (i.e., values that are outside an expected range or have other problems).

**Discarding Bad Values**

The most obvious technique is to select only rows which have no bad (N/A or invalid) values before doing further analysis. For example, using simple row selection:

![Quantity does not have the value(s)](NA)

In advanced rows selection, you may also use `NA` in the selection expression. For example, `quantity<>NA`.

Discarding all bad values has the advantage of simplicity and may work well with databases with relatively few such values, but it may not always be the best thing to do. Consider the case where a computation is performed using five columns. If, on a particular row, even one of those columns has a bad value, you will be throwing out the entire row and losing the good values of the other four columns. In some cases, in fact, you could be throwing out the more important data just because you are missing some less important data.

**Fixing Bad Values**

Instead of throwing out good data, it may be possible to “fix” the bad data so that the analysis can be completed using as much information as possible. Specifically, it may be possible, using computed columns, to replace many of the bad values with plug values or values derived from other columns. Take the following table:

<table>
<thead>
<tr>
<th>College Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codes</td>
</tr>
<tr>
<td>Susan</td>
</tr>
<tr>
<td>Tom</td>
</tr>
<tr>
<td>Dick</td>
</tr>
<tr>
<td>Harry</td>
</tr>
<tr>
<td>Jane</td>
</tr>
</tbody>
</table>

Note that there are two pieces of information missing.

Suppose we want to answer the following question: What will be the average age of a student upon completion of his or her program? This is a simple enough calculation. First, define a computed column, `grad_age`, that gives the required age for each student. The value expression for this column is simply: `enroll_age+program`. Then use a quick summary to get the average for `grad_age`.

Let's see what happens when we do this. First we add the computed column:
Because we were missing some information, two of the five results are N/A. This doesn't bode well, but we push on. Taking the average of the new column gives a final result of 22.7 years.

Can we do better? Well, consider that most college students are enrolled in four-year programs. (Let's assume this is a four-year college.) We will probably not be very wrong to assume that Dick Miller is enrolled in this type of program as well. So it would make sense to “fill in” the blank with 4. How do we do this? One way is to add a computed column called `adjusted_program` with the value expression:

```
if( program<>NA ; program ; 4 )
```

In other words, `adjusted_program` will have the same value as `program` unless `program` is N/A, in which case `adjusted_program` will have the value 4. Applying this to the original table gives:

<table>
<thead>
<tr>
<th>First Name</th>
<th>Last Name</th>
<th>Enroll Year</th>
<th>Age at Enrollment</th>
<th>Program Type (# of Years)</th>
<th>High School Graduation Year</th>
<th>Adjusted Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>Susan</td>
<td>Smith</td>
<td>2002</td>
<td>19</td>
<td>4</td>
<td>2002</td>
<td>4</td>
</tr>
<tr>
<td>Tom</td>
<td>Doe</td>
<td>2001</td>
<td>19</td>
<td>5</td>
<td>2001</td>
<td>5</td>
</tr>
<tr>
<td>Dick</td>
<td>Miller</td>
<td>2002</td>
<td>20</td>
<td></td>
<td>2000</td>
<td>4</td>
</tr>
<tr>
<td>Harry</td>
<td>Jefferson</td>
<td>2003</td>
<td>18</td>
<td>4</td>
<td>2003</td>
<td>4</td>
</tr>
<tr>
<td>Jane</td>
<td>Smith</td>
<td>2003</td>
<td>4</td>
<td></td>
<td>1990</td>
<td>4</td>
</tr>
</tbody>
</table>

We have thus effectively filled in one of the missing values with a reasonable plug value.

How about the second missing value? It would be a shame to discard the data for Jane Smith, since she is clearly an older student. Ignoring her would give a distorted final result. Fortunately, we can apply another good guess to further clean the data. While people enroll in college at all sorts of ages, most people graduate high school at around age 18. (There are exceptions, of course, but suppose we know enough about this subject to feel comfortable with that assumption.) Given that we know when Jane graduated from high school (1990) and enrolled in college (2003), we can make a pretty good guess that she was 31 when she enrolled in college (31=18+2003-1990). So let's add a second computed column, `adjusted_enroll_age`, with the value expression:

```
if( enroll_age<>NA ; enroll_age ; 18+enroll_year-hsgrad_year )
```

We have thus effectively filled in one of the missing values with a reasonable plug value.
Now that we have essentially filled in all the missing values, let's get back to our original question: specifically, what will be the average age of a student upon completion of his or her program? As before, we will add a computed column, `grad_age`, that gives the required age for each student, but this time we will use columns `adjusted_program` and `adjusted_enroll_age` instead of `program` and `enroll_age`. The value expression for this column is: `adjusted_enroll_age+adjusted_program` and the result is:

Finally, we get the average for the last column and come up with 25.4. Compare this to the 22.7 that we got earlier and note that this is probably a more accurate result even if our assumptions aren't perfect. Even if, in reality, Dick is enrolled in a five-year program and Jane was 17 or 19 when she graduated high school, our new result of 25.4 is closer to the truth than 22.7 was.

Of course, it isn't always possible to fill in missing data, but when it can be done, it can be quite beneficial or even essential.
The glossary provides a list of terms and definitions with which you should be familiar when using 1010data.

**action**

An action is any operation applied to a table or worksheet that changes its state. Examples of actions include performing a tabulation, selecting rows, or creating a computed column.

See also:
- *operation* on page 388
- *Actions and Queries* in the 1010data User’s Guide

**aggregation**

An aggregation is the collection of information in a summary form, for purposes such as statistical analysis. A common reason to perform an aggregation is to get more information about particular groups based on specific variables such as age, profession, or income.

In database management, an aggregation is the result of a function that takes the values of multiple rows which are grouped together and calculates a single value of more significant meaning or measurement. Common types of aggregations include: average, count, maximum, median, minimum, and sum.

See also:
- *summarization* on page 393
- *tabulation* on page 393

**analytical database**

An analytical database is typically used to store, manage, and consume data. It is designed and built specifically for use with business intelligence (BI) solutions. An analytical database stores business, market, or project data used in business analysis, projections, and forecasting processes. An analytical database generally provides faster query response times than a relational database and is often more scalable.

**Application Programming Interface (API)**

An application programming interface (API) is a set of routines, protocols, and tools for building software and applications.

The 1010data Application Programming Interface allows a client application running on a user’s machine to access and query data on the 1010data servers. This allows customized applications and interfaces to take advantage of 1010data’s database management services and fast analytics engine.

The API uses HTTP and XML and is compatible with any client application written in a language that supports HTTP transactions (such as Java, Visual Basic, C++, Python, and PERL).

See also:
- *1010data API Reference Manual*
**block**

Blocks in 1010data are self-contained, modular pieces of code that can be reused. Because a block is modular, it can be inserted within a query, at which point the Macro Language code referenced by the block is executed.

Blocks extend their reusability by also allowing for parameterization through the use of variables. Variables can be referenced within a block, and their corresponding values will be substituted for the references. This means that the value of a variable can be changed, and that change will propagate throughout the block.

See also:
- *Blocks* in the *1010data Reference Manual*

**cache**

The cache is an internal store of computational results as well as the history of actions performed by queries during your 1010data session. Performance is enhanced by the use of the cache since the results of prior actions may be used in subsequent queries, thereby eliminating the need to re-run those actions.

The bigger your cache, the more memory in your workspace is used. Clearing your cache frees up workspace memory, but previously cached operations are no longer saved.

See also:
- *workspace* on page 396

**column**

A column is a set of data values of a particular type arranged in a vertical list. For example, a column in a table may contain a list of last names for all the employees at a company.

Each column name in a particular 1010data table must be unique.

See also:
- *column label* on page 384
- *column name* on page 385
- *row* on page 390
- *Columns* in the *1010data Insights Platform Legacy Interface User's Guide*

**column label**

The column label is an optional descriptive column title.

The column label may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. You can create a multi-line column label by using the backtick character (`) to separate the lines (e.g., "Percentage of Total Sales (%)”).

The column label, column name, or a combination of the two may be displayed in the column header at the top of a column in the grid.

If a column label is not explicitly specified, the column name is used as the column label.

See also:
- *column* on page 384
- *column name* on page 385
column name

The column name is the name used to refer to a column in Macro Language code. It can be used in value and selection expressions, as the value of a Macro Language element’s attribute, or as the value of a parameter in a 1010data function.

The column name may only contain alphanumeric characters or underscores and must begin with an alphabetic character (e.g., `percent_total_sales`). It may not contain any spaces or other special characters.

The column name, column label, or a combination of the two may be displayed in the column header at the top of a column in the grid.

See also:
- `column` on page 384
- `column label` on page 384

columnar database

A columnar database is a database management system (DBMS) that stores data in columns instead of rows. Columnar databases speed up the time it takes to return a query by efficiently reading and writing data from and to memory and hard disk storage. In a columnar database, all the column 1 values are physically stored together, followed by all the column 2 values, and so forth.

computed column

A computed column is a column that is added to a table in a query. A computed column is determined by a given value expression. The value expression may refer to one or more columns and may include standard arithmetic, relational, and logical operators.

For example, if you had a table of sales data, you could create a computed column for the margin by specifying a value expression that subtracted the cost column from the sales column.

See also:
- `Computed Columns` in the 1010data Insights Platform Legacy Interface User’s Guide

Consumer Insights Platform (CIP)

The Consumer Insights Platform (CIP) is a collection of reports that can be adapted to different datasets. Access to the CIP can be controlled and permissioned.

cross tabulation

A cross tabulation is the result of an operation that allows you compare the relationship between two variables. In 1010data, a cross tabulation summarizes the values in a column based on the values in two or more other columns and displays the result as a matrix.

See also:
- `Summarizations and Tabulations` in the 1010data Insights Platform Legacy Interface User’s Guide
- `Perform a tabulation` in the Getting Started Guide
- `Cross tabulations` in the Getting Started Guide
**dynamic variable**

A dynamic variable represents a scalar value in a QuickApp. A dynamic variable is declared and can be set to an initial value in the opening `<dynamic>` tag in the Macro Language code for the QuickApp. The dynamic variable can be referenced in a QuickApp using the syntax `@var` (where `var` is the name of the dynamic variable). Dynamic variables may be referenced in both scalar expressions and value assignments.

**environment**

An environment is a single 1010data system installation on a particular server cluster. Users and tables exist within a particular environment. One of the most common environments is accessible from www2.1010data.com.

**Excel Add-in**

The 1010data Excel Add-in is a utility that enables Microsoft Excel to communicate directly with the 1010data server.

Using the 1010data Excel Add-in, you can run a query on 1010data from Excel and have the results directly downloaded into an Excel worksheet. You can also upload data from an Excel worksheet to a 1010data session.

See also:

- 1010data Excel Add-in User's Guide

**expression**

An expression is the composite of any number of values, variables, column names, operators, and functions that evaluates to a certain value. The resultant value can be one of the simple 1010data types, such as integer, decimal, or text; or it can be one of the complex types, such as package, list-value, or model.

An expression is similar to a formula in Microsoft® Excel®.

Expressions may contain various operators (e.g., +) and functions (e.g., min(X;Y)) and may refer to column names (e.g., price) as well as explicit values (e.g., 1.01). They may also contain certain predefined variables (e.g., i_).

See also:

- scalar expression on page 390
- selection expression on page 391
- value expression on page 394

**function**

In 1010data, a function is a computational tool used in an expression that computes the result for a given set of arguments, which provide input. Functions can perform mathematical operations on numerical values (e.g., calculate the sum of a certain group of values), be applied to date values (e.g., find the number of days between two dates), or manipulate string values (e.g., return the result of concatenating two strings together).
1010data offers a broad collection of over 300 computational functions for everything from string manipulation to complex statistical modeling. The Function Reference in the 1010data Reference Manual contains documentation for these functions and is organized into categories, such as mathematical, time and date, and string. One of the most powerful categories of functions is the Group Functions (or g_functions), which perform operations on groups of values.

See also:
• Function Reference in the 1010data Reference Manual

**g_function**

Group functions (g_functions) are used to perform various kinds of calculations across a particular set of rows, grouping by unique values, within one or more columns in a table.

Oftentimes, especially with basic g_functions, the operation will perform some calculation on one set of data while grouping by another. For instance, you can use a g_function to calculate total sales by store or average temperature by city. In both these instances, the data that comes after the word “by” (store and city) is a group. G_functions can provide similar functionality as tabulations, but are often faster and do not result in the loss in granularity of the data on which they operate.

See also:
• Group Functions in the 1010data Reference Manual

**linking**

Linking two tables or worksheets together combines the columns from both into a single, larger worksheet. The results apply only to your session; the original tables or worksheets are not affected. Linking in 1010data is similar to a VLOOKUP in Excel and various types of SQL joins.

**Note:** Linking differs from merging. Linking combines the columns of two tables or worksheets together whereas merging combines the rows of two or more tables or worksheets together. Links align worksheets side by side, while merges combine worksheets vertically.

See also:
• merging on page 388
• Linking Tables and Worksheets in the 1010data Insights Platform Legacy Interface User’s Guide

**link header**

The link header is the text that is prepended to column headings from a foreign table after a link operation.

It can be specified using the Label field within any link-related dialog in the Trillion-Row Spreadsheet (e.g., Link in Another Worksheet), the label attribute in the opening tag of the <link> operation, or in the <link> element in the XML Table Tree when using the API.

**list-value**

A list-value is a variable that contains multiple values called elements. Similar to lists in other high-level languages, list-values in 1010data provide a useful way to collect scalar values into a single variable and refer to them by index.

See also:
• package on page 389
Macro Language

The 1010data Macro Language is the XML-based compositional language in which 1010data queries are written. Macro Language consists of a set of elements. These include data transformation operations, block code, and application development elements. Each of these elements has a set of attributes that are used to provide additional information to the element.

For example, in the 1010data Macro Language, there is a `<sort>` element that is used to sort the data in a table. The `<sort>` element has a `col` attribute, which specifies the column whose values will be used to order the rows, and a `dir` attribute, which specifies the direction in which to sort. In the Macro Language code, this example would be written: `<sort col="date" dir="up"/>

See also:

• Macro Language Elements in the 1010data Reference Manual

merging

Merging two or more tables or worksheets combines their rows together into a single, larger worksheet. The rows from the foreign table(s) are appended to the end of the base table in the order in which they are specified. The results apply only to your session; the original tables or worksheets are not affected. Linking in 1010data is similar to a various types of SQL unions.

Note: Merging differs from linking. Merging combines the rows of two or more tables or worksheets together whereas linking combines the columns of two tables or worksheets together. Links align worksheets side by side, while merges combine worksheets vertically.

You can perform a merge using the `<merge>` operation, which can be performed within a 1010data query, or the `merge` API transaction, which can be used in a client application or QuickApp.

See also:

• linking on page 387
• `<merge>` in the 1010data Reference Manual
• merge (Merge table) in the 1010data API Reference Manual

Open Database Connectivity (ODBC)

Open Database Connectivity (ODBC) is an open standard application programming interface (API) for accessing a database.

The 1010data ODBC driver is a software utility that serves two primary functions. First, it provides a standard interface so that applications can connect to 1010data directly. Second, it allows the 1010data system to understand SQL. The 1010data ODBC driver conforms to the ODBC 3.0 specification.

See also:

• 1010data ODBC Driver User’s Guide

operation

An operation performs a specific action on data in a table or worksheet. At the core of 1010data are five basic operations: Select, Link, Tabulate, Create Computed Column, and Merge. These operations, as well as the other data transformation operations, take one or more tables as input and produce a resultant table as their output.
See also:
- *action* on page 383

### package

Packages are compound variables containing key/value pairs. Packages use keys to reference their values, making them similar to a dictionary or associative array in other languages. Referencing package values is very similar to accessing values in lists, except the values in the package are referenced by keys, not index values.

See also:
- *list-value* on page 387

### PowerLoader

PowerLoader is a browser-based user interface that allows you to load your data into the 1010data platform. PowerLoader is useful for loading flat text files such as comma-separated value (`.csv`) and tab-delimited (`.txt`) files.

See also:
- *PowerLoader User's Guide*

### prelink

A prelink is a precalculated linkage between two tables on a specific set of columns. Each prelink is saved with the base table on which it is applied. During an analysis, the link does not need to be calculated, only read. A prelink improves the speed of linking larger tables together.

### query

A query is a list of the actions performed on a table to achieve a particular result or to perform a specific analysis. In other words, a query is the sequence of transformations that are performed on a particular base table.

See also:
- *Actions and Queries* in the 1010data Insights Platform Legacy Interface User's Guide

### Quick Query

A Quick Query is a saved query that can be rerun at anytime. Quick Queries are used to save your work so that you can use it later or share it with others. Quick Queries allow simple parameterization, the ability to choose different inputs when running the saved query.

See also:
- *Quick Queries* in the 1010data Insights Platform Legacy Interface User's Guide
QuickApp

A QuickApp™ is an interactive application that provides a custom front-end interface to the 1010data analytical platform. Depending on the functionality built into a QuickApp, a user can interact with data, provide input, and view the results of queries in tabular or graphical form.

QuickApps are built using a set of tags in 1010data's Macro Language: <dynamic>, <widget>, and <layout>. These tags work in conjunction with block code and the other data transformation operations to specify how the QuickApp should accept user inputs and display query data.

See also:

- widget on page 395
- Intro to QuickApps tutorial

row

A row consists of a set of related values from all the columns in a particular table. The data within a row may appear in any order by rearranging the columns in a table without changing the underlying structure of the table.

See also:

- column on page 384
- Rows in the 1010data Insights Platform Legacy Interface User’s Guide

SAM Pool

Shared Access Management (SAM) pools enables a single set of credentials to be shared between client side threads to leverage multiple threads of parallelism on the 1010data Insights Platform.

scalar expression

A scalar expression is an expression that results in a scalar value. In Macro Language code, a scalar expression is surrounded by braces (e.g. {sqr(5)}). Unlike value expressions, which operate on and result in vectors, scalar expressions use scalar values and variables to evaluate to scalars.

See also:

- expression on page 386
- selection expression on page 391
- value expression on page 394
- Scalar Expressions in 1010data in the 1010data Reference Manual

scalar value

A scalar value is either an individual value such as an integer or string, or a value containing multiple components which can be referenced individually or as a whole such as a package or list-value. A scalar value is different than a vector.

A scalar variable can be referenced in a query using the syntax @var (where var is the name of the scalar variable). Scalar variables may be referenced in both scalar expressions and value assignments.

See also:
segby

Segby is a specific segmentation where the values in the segby columns govern the way the rows are split. If a table is segby a given column, no unique value of the column can be found in more than one segment. This allows for quick computation of aggregate/grouping functions (e.g., sums, averages, etc.) on that column since it is only necessary to look in one file for each unique value of that column. To achieve this, the rows of the table frequently need to be reordered.

See also:
- segmentation on page 391
- sortseg on page 392

segmentation

Segmentation is the process of partitioning/splitting a table horizontally in the underlying file structure so that not all rows live in the same file.

For example, a 45-row table can be split so that each "segment" (i.e., file) contains ten rows; this would yield five segments, where the first four segments contain ten rows and the last segment contains five.

The 1010data Insights Platform provides two specialized forms of segmentation: segby and sortseg. If a table is segby a given column, no unique value of the column can be found in more than one segment. If a table is sortseg on a particular column, not only are unique column values not allowed to be found in different segments, the segments themselves are internally sorted on the sortseg column. These specialized forms of segmentation allow for optimized performance when aggregating (or using g_functions) on the segmented column.

See also:
- segby on page 391
- sortseg on page 392

selection expression

A selection expression is an expression used for selecting a subset of rows from a table or worksheet, usually based on some comparison criteria.

A selection expression is used in the value attribute of the <sel> operation. A selection expression generally resolves to a 0 or 1. Rows for which the expression evaluates to 1 remain in the resultant worksheet; rows where the expression evaluates to 0 are omitted. However, there are exceptions such as when you are using the expand or sample attributes.

See also:
- expression on page 386
- scalar expression on page 390
- value expression on page 394
- <sel> in the 1010data Reference Manual
- Writing Expressions in the 1010data Reference Manual
**session**

A session is an instance of a particular user ID logged into 1010data within a certain environment. You can only have one active session at a time for a single user ID across all environments. In addition, a session can only have one transaction occurring at a time; two queries cannot be run simultaneously in the same session.

**shifting**

Shifting allows you to move rows of data according to a defined interval. The interval could be based on time, a count of rows, or a relative relationship between two points in a vector. For example, to compare sales data of the current month to sales data for the same month one year prior, you can shift the rows in your worksheet so that the same month from the two different years are in adjacent columns. Once the aggregations are in the same row, calculations such as the difference between the two or percent of change is simple.

Performing a time comparison analysis allows you to examine how your data changes from one time period to another.

See also:
- time series on page 394

**Software Development Kit (SDK)**

A software development kit (SDK) is a set of tools or functions that provide for the creation of applications for a certain software package, software framework, hardware platform, computer system, operating system, or similar development platforms. With any of the 1010data SDKs, developers can create native and web-based applications that use the 1010data analytics engine.

1010data offers SDKs supporting many popular programming languages including C, C++, .NET, Java®, Python, and Visual Basic® for Applications (VBA).

**sortseg**

Sortseg, like segby, is a specific segmentation governed by the sortseg columns. It has an even stronger restriction than segby. Not only are unique column values not allowed to be found in different segments, the segments themselves are internally sorted on the sortseg column. The table itself is not guaranteed to be globally sorted, but the segments are guaranteed to be disjoint on the sortseg column.

See also:
- segmentation on page 391
- segby on page 391

**sticky**

Sticky refers to a value, such as a row number or the number of rows in a worksheet, that remains persistent despite changes to the current worksheet.

For instance, a sticky row number for a particular row is determined from the current worksheet at a given evaluation point in the query. A sticky row number will not change regardless of whether the number of rows or relative position of that row changes due to operations performed on that worksheet after the evaluation point. There are three sticky system values: \(i\), \(i\_\_\) and \(n\_\).
As an example, consider a row that was the 100th row in a base table but which is the 5th row after a transformation. The sticky row number for that row would still be 100.

See also:
- System Variables in the 1010data Reference Manual

**summarization**

Data summarization is the calculation of certain statistics and the display of those results in the form of tables, graphs, or charts. In other words, a summarization is information gathered and displayed in summary form. For example, a simple summarization could calculate the total sales in dollars for every store in a retail chain during a given period of time. In 1010data, the results of the summarization would be a worksheet with two columns and one row for each store in the original table. The first column lists the store identifier, and the second contains the total sales in dollars for that store.

See also:
- aggregation on page 383
- tabulation on page 393
- Summarizations and Tabulations in the 1010data Insights Platform Legacy Interface User's Guide

**table**

A table is a collection of data that is stored as rows and columns. In 1010data, a table is the permanent, unchanging version of the data that is saved on the server. 1010data uses a columnar database to store its tables, which differs from a relational database.

See also:
- columnar database on page 385
- worksheet on page 395
- Tables and Worksheets in the 1010data Insights Platform Legacy Interface User's Guide

**tabulation**

A tabulation allows you to group the values in a column (or columns) based on the values in another column (or columns) and summarize the data for each group. For example, a table containing demographic information of employees in a company could be used to determine the total number of employees by age group and gender. In this example, a tabulation could group the employee records by gender and then summarize the total number of employees in each age group.

See also:
- aggregation on page 383
- summarization on page 393
- Summarizations and Tabulations in the 1010data Insights Platform Legacy Interface User's Guide

**TenDo**

TenDo™ is a command-line interface for executing and automating queries in 1010data.

See also:
- TenDo User's Guide
TenUp

TenUp™ is a command-line interface for extracting data from ODBC-compliant databases and loading it into 1010data.

See also:

- *TenUp User's Guide*

**time series**

A time series is a sequence of data points ordered by time. In 1010data, many functions operate on table data as a function of time. Most notably, many `g_functions` accept an order argument which is often a column of chronological values (e.g., date or time).

See also:

- *shifting* on page 392
- *window* on page 395

**transformation**

A transformation is the result of a set of operations or actions that have been applied to a table or worksheet.

**Trillion-Row Spreadsheet (TRS)**

The 1010data Trillion-Row Spreadsheet® (TRS) is a graphical user interface (GUI) that allows you to visually interact with your data on the 1010data platform. The 1010data GUI is a browser-based interface that is used mostly for ad hoc data analysis.

**Universal Calculation Library (UCL)**

The Universal Calculation Library (UCL) is a 1010data library of blocks that provides a collection of commonly performed calculations for mortgage-backed security (MBS) data. Numerous MBS data sets are supported by the UCL, including eMBS and CoreLogic.

**user ID**

A user ID is associated with an individual account in 1010data. A user ID can only be logged in to one session of 1010data in a particular environment at a time.

**value expression**

A value expression is a mathematical formula that is used to determine the value of a computed column or as a qualifier when selecting rows.

See also:

- *expression* on page 386
- *scalar expression* on page 390
• *selection expression* on page 391
• *Writing Expressions* in the *1010data Reference Manual*

**vector**

A vector is an entity having multiple values of the same type that can be operated on as a single unit. In 1010data, an example of a vector is a column, in which there is one value for each row in the column. Operations and certain functions are applied to the column as a whole, essentially performing the calculation or action on all of the values in the column.

**widget**

A widget is an individual component of a QuickApp that can be used for displaying data, accepting user input, or both.

A widget can be used to visually represent the results of a block of Macro Language code, such as in a spreadsheet-like grid or a bar chart. It typically contains a single 1010data query that defines the data that it displays. Widgets can also be used as a means for user input, such as an input field or drop-down list.

See also:
• `<widget>` in the *1010data Reference Manual*
• *Intro to QuickApps* tutorial

**window**

A window is an interval period specified in certain 1010data functions related to moving and shifting calculations. These functions allow you to examine how your data changes from one interval to another. For example, an ongoing analysis that compares store sales of the current week to store sales for the previous week uses a moving seven-day window that is one week prior to the current date. The size of an interval can be determined by a number of factors such as a number of rows, a given time period, or any other ordered sequence.

See also:
• *shifting* on page 392
• *time series* on page 394
• *Shifting and Windows* in the *1010data Reference Manual*
• *Moving Calculations* in the *1010data Reference Manual*

**worksheet**

A worksheet represents the temporary state of the data after one or more operations have been applied to a base table in 1010data. Any operations performed on a worksheet are temporary and do not impact the state of the original table.

See also:
• *table* on page 393
• *Tables and Worksheets* in the *1010data Insights Platform Legacy Interface User’s Guide*
workspace

The workspace is the amount of virtual memory that has been allocated to your 1010data session. As you perform an analysis, 1010data stores computational results as well as the history of actions performed by queries in the cache. The workspace indicates the amount of memory you have used. Clearing the cache cleans out your workspace so that you have the maximum amount of virtual memory available to your 1010data session.

See also:

- *cache* on page 384
- *Workspace* in the *1010data User's Guide*
Index

@cf 287
@ch 287
@cn 287
@ct 287
@gp 287
@id 287
@lk 287
@tt 287

1010data
   log in 8
   log out 36
   URLs 8, 10
   User's Guide 33
   web addresses 8, 10
1010data User's Guide 33

A
account
   administration 349
Account Administration toolbar 349
accounts
   administration 349
adding multiple users 366
admin 349, 351, 375
announcements 11
APIs
   download 33
asof 101

B
browser
   Folders and Tables 12
bugs
   report 33
bulkadd 366
bulk add 366
bulkedit 371
bulk edit 371

C
cache
   clear 31, 32
Change Log 33
Change Password 349
changes 33
column headings 63
column information
   show 34
column names 63
Company Manager 349, 375
contents
   delete 16, 25
go to 16, 27
   move 16, 25
   reorder 16, 24
   search for 16, 25, 34

D
delimiter 287
dialogs
   Edit XML 34
documentation 33
Documentation Center 33
downloads 349, 350
drivers
   download 33

E
Edit XML dialog
   open 34
enhancements 33
Excel spreadsheets 286

F
favorites
   add 12
   remove 12
features
   request 33
Filter Manager 349
find 34
fixes 33
folders
   delete 25
   go to 27
   move 25
   search for 25, 34
   shared 350
Folders and Tables browser
   hide 12
   pin 12
   show 12
Folders and Tables toolbar 12, 16
freshdesk 8

G
Group Manager 349, 372
groups
   create 372, 372
   delete 372, 374
   edit 372, 374
   find 372, 373
GUI preferences 351
T

tables
delete 16, 25
go to 16, 27
merge 16, 24, 49
move 16, 25
recently added 11
reorder 16, 24
search for 16, 25, 34
shared 350
updated 11
upload 16, 17, 18, 50, 51, 292, 293
tabs
initial 11
next 34
previous 34
switch 34
Technical Interfaces 33
toolbars
Account Administration 349
Folders and Tables 12, 16
tools
download 33
training materials 33

U
updated items 11
URLs 8, 10
User Manager 349, 351
user profile
change 349
User Profile 349
user profiles
change 349
users
adding 366
adding multiple 366
create 351
deactivate 351, 372
delete 372
edit 351, 371, 371
manage 349, 351
multiple 366, 371
search for 351

V
virtual memory 31, 32

W
worksheets
recent 11, 36
workspace 31, 32
wsfull 31